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Release Notes - Genesys Engage cloud
(Services Level)
To improve your experience, Genesys Engage cloud has upgraded the following components on the
corresponding dates.

For information about releases after March 31, 2021, see Genesys Engage Cloud Release Notes.

Tip
Click the arrows in a column heading to view items in either alphabetical or
ascending/descending order.

Related Topics

• Administrator's Guide
• System requirements
• Bandwidth requirements
• Release Management and Communications

Genesys Engage cloud
Component Available Since Latest Version

Agent Desktop v8.5 May 18, 2020 8.5.202.76
Agent Desktop v9 January 27, 2021 9.0.000.77
Agent Setup March 25, 2021 9.0.000.82
Genesys Engage cloud APIs March 25, 2021
Authentication Service November 2, 2020 9.0.000.68
Callback March 11, 2021 9.0.043.00
Cloud Data Download Service January 16, 2020 9.0.003.00
intelligent Workload Distribution March 4, 2021 9.0.000.64
Co-browse November 2, 2020 9.0.012.00
CRM Gplus Adapters May 18, 2020 8.5.202.76
Gplus Adapter for Microsoft
Dynamics 365 August 02, 2022

Gplus Adapter for ServiceNow July 05, 2022
Gplus Adapter (V.9) for Salesforce March 25, 2021 9.0.000.59
CX Contact February 22, 2021 9.0.024.04
Designer (v8.5) June 01, 2018 8.5.202.96
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Genesys Engage cloud
Component Available Since Latest Version

Designer March 26, 2021 9.0.116.09
Digital Channels March 19, 2021 9.0.000.83
Genesys Customer Experience
Insights (CX Insights) March 05, 2021 9.0.018.00

Genesys Portal January 12, 2021 8.5.300.06
Genesys Predictive Engagement April 8, 2020
Genesys Predictive Routing July 12, 2021 9.0.018.15
GVP PaaS December 21, 2018 9.0.0
GVP Reporting January 23, 2017 8.5.151.29
IVR Administration October 27, 2015 8.5.200.83
Outbound April 6, 2020 15.15.0
Platform Administration October 29, 2017 8.5.220.47
Real-Time Reporting v8.5 August 18, 2017 8.5.106.05
Real-Time Reporting v9 September 28, 2020 9.0.006.00
Recording, QM and Interaction
Analytics January 22, 2020 8.5.510.30

Screen Recording Service March 30, 2021 8.5.370.93
Genesys Softphone April 23, 2021 9.0.015.04
Genesys Softphone VDI Adapter March 25, 2021 9.0.015.03
WebRTC Media Service October 14, 2020 9.0.000.62
Genesys Widgets March 31, 2021 9.0.017.17
Workforce Management August 30, 2021 8.5.218.43

Customer Care
As always, Genesys Customer Care is available to answer any questions you may have regarding this
service event. If you have service issues after the service event, please contact Genesys Customer
Care by opening a case in the My Support Portal, http://www.genesys.com/customer-care, or call
Genesys Customer Care at:

North America (USA & Canada)

• +506-674-6767 (International)
• +888-369-5555 (Toll-free, N. America only)

Europe, Middle East, Africa

• +44 (0) 127-645-7002 (International)

Asia Pacific

• +61-7-3368-6868 (International)

Release Notes - Genesys Engage cloud (Services Level)
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Agent Desktop (V.8)
Note: Not all changes listed below may pertain to your deployment.

• May 18, 2020 (8.5.202.76)
• November 5, 2019 (8.5.202.67)
• July 23, 2019 (8.5.202.62)
• May 16, 2019 (8.5.202.60)
• October 15, 2018 (8.5.202.51)
• September 17, 2018 (8.5.202.50)
• August 20, 2018 (8.5.202.48)
• July 16, 2018 (8.5.202.47)
• June 18, 2018 (8.5.202.42)
• May 21, 2018 (8.5.202.39)
• April 16, 2018 (8.5.202.30)
• March 12, 2018 (8.5.202.23)
• January 29, 2018 (8.5.202.15)
• January 16, 2018 (8.5.201.99 UPDATE)
• November 13, 2017 (8.5.201.99)
• October 16, 2017 (8.5.201.95)
• Known Issues
• Limitations
• Archive

May 18, 2020 (8.5.202.76)

What's New
Browser support

• Google Chrome browser version v80+.

Background Tabs Throttling improvement

Agent Desktop (V.8)
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• Agent Desktop has been improved so that when it is in a tab in the background on some browsers, the
Background Tabs Throttling feature does not cause background tasks, such as Softphone Connector,
to time out due to inactivity on the Agent Desktop tab.

November 5, 2019 (8.5.202.67)

What's New
Resolved Issues

• Improved performance to avoid read timeouts in some scenarios. (HTCC-30719)

July 23, 2019 (8.5.202.62)

What's New
Resolved Issues

• The amount of time needed to restore service in network outage recovery scenarios is improved.
(HTCC-30521)

May 16, 2019 (8.5.202.60)

What's New
System recovery time

• The system recovery time after network outages affecting voice services has been improved.

October 15, 2018 (8.5.202.51)

What's New
Filtering virtual agent groups

Agent Desktop (V.8)
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• Team Communicator now also supports filtering by virtual agent groups.

September 17, 2018 (8.5.202.50)

What's New
Resolved Issues

• Agents can now one-step transfer a call to a routing point using a number containing non-numerical
characters. Previously, Agent Desktop removed the non-numerical characters, causing the operation to
fail. (HTCC-30073)

August 20, 2018 (8.5.202.48)

What's New
Resolved Issues

• Agent Desktop no longer displays an error during an agent logout when the agent is considered already
logged out by the back-end server. (HTCC-30040)

• In SIP Cluster environments, the After Call Work state is now correctly ended for business calls when an
agent switches to After Call Work and then to either Not Ready or Ready while the call is in the
Established state. Previously, this scenario was supported only for non-SIP Cluster environments.
(HTCC-29983)

July 16, 2018 (8.5.202.47)

What's New
Resolved Issues

• In environments where Screen Recording is enabled, if the connection with screen recording server is
lost while an agent is logged in, the agent can now log out of Agent Desktop. Previously, the logout
operation failed. (HTCC-29820)

• If Agent Desktop loses connection to the backend server, it now recovers the correct agent state for
agents who have multiple active multimedia interactions. (HTCC-29778)

Agent Desktop (V.8)
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June 18, 2018 (8.5.202.42)

What's New
Resolved Issues

• Special characters in the names of attached files are now ignored by Agent Desktop. Previously,
attachments with file names that included special characters could not be opened. (HTCC-29709)

• If there is a short disconnection between Agent Desktop and Genesys Softphone, when the connection
is reestablished, Agent Desktop now correctly restores the voice media state to the state prior to
disconnection. Previously, if an agent was in a Not Ready state prior to disconnection, Agent Desktop
changed the state to Ready. (HTCC-29686)

• The default definition of the 'Average Handling Time for Chat media' statistic has been changed to the
total chat handling time divided by the total number of chat interactions. (HTCC-28948)

May 21, 2018 (8.5.202.39)

What's New
Statistics

• Agents can now select one statistic to be visible at all times while the application is in focus.

Resolved Issues

• The default volume for the Agent Desktop microphone and speakers no longer gets reset to 0.
(HTCC-29651)

• Display names are now correctly included with the From Address when emails are sent. (HTCC-29552)

April 16, 2018 (8.5.202.30)

What's New
Virtual Desktop Infrastructure

• Agent Desktop now supports running within VMWare Horizon 7 Client Virtual Desktop Infrastructure
(VDI).

Agent Desktop (V.8)
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Resolved Issues

• Supervisors can now monitor agents who are logged in on a different site than the supervisor.
(HTCC-26057)

• Agent Desktop now maintains contact with the back-end servers when agents perform workbin related
actions. (HTCC-29502)

March 12, 2018 (8.5.202.23)

What's New
Agent groups

• You can now specify which agent group is displayed in the Team Communicator .

Standard Responses

• Agents can now use a free text search to find Standard Responses.

Resolved Issues

• Background colors and table borders in inbound email interactions are now displayed. (HTCC-29149)
• For Microsoft Internet Explorer users, Agent Desktop no longer displays two scroll bars for inbound email

messages that extend beyond the size of the window. (HTCC- 29159)
• When an agent is handling a voice interaction using Genesys Softphone, the speaker and microphone

volumes can now correctly be controlled from the Agent Desktop interaction toolbar. (HTCC-28670)

January 29, 2018 (8.5.202.15)

What's New
Caller ID display name

• When an agent selects the caller ID for outgoing calls, Agent Desktop passes both the descriptive name
and the phone number to be displayed to the call recipient.

Pending Agent State

• The state timer no longer starts immediately if an agent sets his or her status to Not Ready, Not Ready
Reason, or any other state while he or she is still handling an interaction. The timer for that state does
not start until the call is released, the chat is marked as Done, or the email is sent or put into a
workbin.

Agent Desktop (V.8)
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Resolved Issues

• Agents can now open and view embedded images as attachments in inbound email interactions.
Previously, embedded images were not accessible to agents. (HTCC-29015)

• All chat interactions for whom the contact is known are now displayed in the Contact History. Previously,
some chat interactions did not appear in the history of the contact. (HTCC-28835)

• Agent Desktop now verifies that URLs sent to contacts using the Chat Push URL feature are validated to
prevent XSS issues. (HTCC-28830)

• If Microsoft Internet Explorer 11 becomes unresponsive while an agent is handling a voice interaction,
ask Genesys to disable speaker and microphone volume control. (HTCC-28659)

• In Genesys Softphone environments that use dynamic sign-on, Agent Desktop now returns to the login
page if the application cannot connect to Genesys Softphone or if it becomes stuck. (HTCC-28645)

• Supervisors can now monitor an agent by selecting an agent from Team Communicator Favorites, even
if the favorites are sorted by category. Previously, the supervisor had to refresh the browser to have
this feature available. (HTCC-28623)

• Team Communicator Favorites and Team Communicator Recents no longer fail to display if one or more
of the recent entries contains an item that includes one or more of the following unsupported
characters: (,),[,],{,} ,|,?,",\ (HTCC-28866)

• Agent Desktop no longer loses calls that are put on hold while an agent makes a consultation call.
Previously, when an agent clicked Resume after ending a consultation call, Agent Desktop sometimes
lost the call and the agent had to retrieve the call through their hard phone. (HTCC-28827)

January 16, 2018 (8.5.201.99 UPDATE)

What's New
Resolved Issues

• Refreshing the Agent Desktop browser page during login can result in the connection to Screen
Recording Client not being established. When the connection issue is detected, agents are requested to
provide their password again to re-establish the connection. Previously, Agent Desktop did not request
agents to re-enter their password and the connection was not re-established. (HTCC-28935)

Agent Desktop (V.8)
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November 13, 2017 (8.5.201.99)

What's New
In-line forwarding

• In-line forwarding from History: Agents can now forward from the History view, inbound and outgoing
email interactions that are in the 'Done' state.

• In-line email forwarding: This feature allows agents to forward an email as part of the body of an email
instead of as an attachment. This enables agents to add comments and attachments before sending
the forwarded email.

Browser support

• Microsoft Edge on Windows 10 operating system.

Resolved Issues

• Agent Desktop now correctly populates the From field of reply email interactions. Previously, the From
field sometimes used the default address. (HTCC-27300)

October 16, 2017 (8.5.201.95)

What's New
Resolved Issues

• The interaction duration timer that is displayed in the toolbar of chat interactions now starts when the
interaction is accepted by an agent. Previously, the timer started when the interaction entered the
queue. (HTCC-27707)

Known Issues

• Agent Desktop can become stuck for consulted agents if the consulting agent marks the chat as Done
while the consultation chat is still active. (HTCC-30244)

Workarounds

The consulted agent should refresh their browser to make the Mark Done button become available
to close the consultation chat.

To prevent this scenario, the consulting agent should end the consultation chat before ending the
chat with the contact.

Agent Desktop (V.8)
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Limitations

• Limitation: If you are using Genesys Softphone in Connector mode, Genesys recommends that you do
not assign the same default Place to more than one agent. If you do, and the second agent logs in
during the session of the first agent, the first agent is disconnected from the audio and the second
agent will not be aware that their login on the voice channel has failed. If you must make this default
Place assignment, ensure that the two agents do not log in during the same period.

• Recommendation: For Internet Explorer 10 and 11 with protected mode enabled, Internet Explorer
always opens the target of the link in a new window or tab when you click a hyperlink in attached data.
To work around this limitation, add the Agent Desktop host and the linked website to the list of trusted
sites. (HTCC-26857)

• Limitation: To use Microsoft Edge for Windows 10 with Genesys Softphone Dynamic Configuration
Connector and Genesys Interaction Recording (GIR) Screen Recorder, you must disable loopback for
Edge. You can accomplish this by executing the following command to disable loopback for Edge (this
requires admin rights): CheckNetIsolation LoopbackExempt -a -n=
"Microsoft.MicrosoftEdge_8wekyb3d8bbwe"

• Limitation: The following characters are not supported for the 'id' of Corporate Favorites :?|{}[]()"\,

• Limitation: If a user closes the browser or if the browser crashes with a released voice interaction still
open, it will remain in the “In Progress” state. It is then not possible to apply “Done” to those voice
interactions in the History view. (HTCC-17820)

Archive
[+] Click to show archived release notes

September 21, 2017 (8.5.201.91 UPDATE)

What's New
Resolved Issues

• Agents can now reply to an inbound email in environments that have only a single 'From' address to
choose from in the list of From addresses used for outgoing email. (HTCC-28336)

Agent Desktop (V.8)
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September 18, 2017 (8.5.201.91)

What's New
Resolved Issues

• Agents, when they look at the contact history, can no longer see that a call was silently monitored by a
supervisor. (HTCC-28024)

• Agent Desktop now takes into account HTML standard responses in all cases. Previously, sometimes
Agent Desktop used the plain text part of the response instead of the HTML, causing the response to
not display as expected. (HTCC-27743)

August 21, 2017 (8.5.201.87)

What's New
Password authentication

• SIP Server password authentication support with Agent Desktop and Softphone
If you have a DN configured, Agent Desktop can now pass authentication information to the
Softphone so it can securely log in to SIP Server.

Resolved Issues

• When placing calls to parties outside of your contact center, if an agent dials a number that includes
dashes, spaces, brackets or other non-numerical characters, the number is now converted to a
correctly formatted phone number in all scenarios. Previously Agent Desktop attempted to dial the
number, including the non-numerical characters, causing the call to fail. (HTCC-27922)

• Agent Desktop Team Communicator no longer incorrectly reports missed calls in the list of Recent calls
after the list of target types is updated. (HTCC-27914)

• Agents can now change their state from either the My Channels tab or the Global State menu when
there are issues in the environment. Previously, some states were missing from these areas.
(HTCC-27931)

July 17, 2017 (8.5.201.84)

What's New

• Agent Desktop introduces the new Genesys branding in the user interface.

Resolved Issues

Agent Desktop (V.8)
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• On Internet Explorer, the scrollbar in Team Communicator is now available, if needed. Previously, the
scrollbar wasn’t appearing even if there were more items than currently displayed. The only way to
access those items was to use the mouse wheel or arrow keys. (HTCC-27745)

• When configuring a signature in an HTML standard response, Agent Desktop no longer inserts empty
lines for each carriage return. (HTCC-27743)

• Agent Desktop now cancels the After Call Work state for business calls when the agent switches from
After Call Work to Not Ready or Ready if the call is established. (HTCC-27726)

• Agent Desktop now correctly handles web content specified in the configuration. Previously, these URLs
were encoded incorrectly and could not be displayed. (HTCC-27712)

• Auto answer is now disabled for inbound calls if there is already an active call. (HTCC-27667)
• The "Cancel the invitation" hyperlink is no longer displayed to the target agent during a single-step

conference if this agent was previously engaged in a chat consultation. (HTCC-27637)
• Agent Desktop now correctly aligns text in columns with column heads. (HTCC-27317)

June 19, 2017 (8.5.201.80)

What's New
Resolved Issues

• Agents can now complete conferences or transfers of calls to parties that they are consulting with when
the Team Communicator filter is set up without any internal targets (Agent, Agent Group, Routing Point,
or Skill). (HTCC-27443)

• When agents use the keypad to dial numbers, the tones played are now correct. (HTCC-27428)
• For Microsoft Internet Explorer users, while running the Service Client API for toasts with Agent Desktop

pinned in the Windows Task Bar, the exclamation point symbol is no longer displayed on top of the
Agent Desktop Task Bar icon. (HTCC-27562)

April 17, 2017 (8.5.201.71)

What's New
Browser support

• Google Chrome browser version 54+
• Firefox browser version 45+

Case information links

• Clicking links in case information now opens targets in the same browser window or tab.

Agent Desktop (V.8)
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Resolved Issues

• You can now use the underscore character ("_") in Team Communicator searches for agents, agent
groups, virtual agent groups, routing points, and skills. The underscore character cannot be used in an
agent username. (HTCC-11594)

• Not Ready state Reason codes are now correctly managed during logout and login. Previously, if an
agent logged out after setting a Not Ready Reason code then logged back in, the previous Not Ready
Reason code was incorrectly retained after login. (HTCC-25532)

April 11, 2017 (8.5.201.66 UPDATE)

What's New
Resolved Issues

• Routing Points can now be used as Personal Favorites. Previously, creating a Routing Point as a Personal
Favorite could result in no Favorites (Corporate or Personal) being displayed the next time the agent
logged in. (HTCC-27005)

March 28, 2017 (8.5.201.66)

What's New
Resolved Issues

• When an agent receives an interaction notification and a toast native to the browser is displayed on top
of the Agent Desktop notification, the agent can now close it by clicking on it. (HTCC-26894)

January 30, 2017 (8.5.201.61)

What's New
In Progress emails

• Agents can now open “In Progress” emails from the contact interaction history. This capability allows
agents to respond in real time to queued, outstanding customer inquiries.

Login improved

Agent Desktop (V.8)
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• Agents can now login to Agent Desktop if at least one media is available. Previously, if one of the
assigned media channels was not available, agents could not login.

Dialling

• Agents can now manually dial agents and routing points, even if these are configured to be excluded
from the list of favorites available to the agent.

Place recall

• Agent Desktop now remembers the most recently used Place and suggests it to the agent at the next
login. Previously, agents had to fill in the Place for every session login.

Team Communicator

• The Corporate Favorite list can now be overridden by a routing strategy to allow greater target selection
flexibility in the Team Communicator.

Resolved Issues

• Browser zoom is now correctly supported. Previously, a warning message was displayed if the browser
zoom wasn't set to 100 percent. Other display issues could also occur. (HTCC-25148)

• Agent Desktop now displays an improved error message if a default place is set for an agent, but the
agent specifies a different place during login in environments where agents cannot change their place.
(HTCC-25124)

• When the list of statistics is refreshed in Contact Center Statistics, Agent Desktop now correctly scrolls
the list to display the objects that were being displayed before the refresh. Previously, when the list of
statistics was refreshed, Agent Desktop scrolled to the top of the list. (HTCC-25107)

• When a voice consultation is started from a multimedia interaction, such as chat or email, the notes
recorded for the multimedia interaction are now correctly added in the notes for the voice consultation.
(HTCC- 25631)

• Agent Desktop no longer plays a tone when a chat interaction is selected in the History tab.
(HTCC-25771)

• Agent Desktop now supports global and individual media state management through the My Agents tab
for multimedia-only agents. (HTCC-25909, SAASNOC-32295)

• Agents can now see the details of selected interactions in the Contact History and My History views for
all pages in the search results. Previously, details were available only for results displayed on the first
page of these views. (HTCC-25701)

• Agents can now launch a new session of Agent Desktop immediately after closing the previous one.
Previously in this scenario, the new session wasn't fully initialized resulting in unexpected behavior.
(HTCC-24943)

• When marking a call or a chat done without selecting a disposition while dispositions are mandatory,
the warning message displayed is now in the format: "You must select a '<Business Attribute Display
Name>' before closing", where '<Business Attribute Display Name>' is the configured business
attribute display name. (HTCC-25595)

• For the Service Client API, the operationName attribute of events related to the Do Not Disturb state is
now set to DoNotDisturbOn instead of the previous state. (HTCC-26136)

Agent Desktop (V.8)
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November 14, 2016 (8.5.201.50)

What's New
Accessibility compliance

• The following Agent Desktop features are Web Content Accessibility Guideline (WCAG) 2.0 level A
compliant for people with disabilities:

Web Chat

Email

Outbound Campaign

Agent Workbin and Interaction Queue Management

Standard Response Library

Advanced interaction search

• Advanced interaction search is a new module allowing users to search for historical customer
interactions within and outside the context of the 'My History' and 'Contact History' views. This
capability allows users specify multiple search attributes and conditions when searching.

Invoke Agent Desktop toasts

• You can now use Service Client API to invoke toasts within Agent Desktop that have the ability to allow
users to act or decline.

Citrix support

• Citrix XenApp 7 and Citrix XenDesktop 7 support.

Resolved Issues

• The voicemail bell/tone now correctly plays when a new voicemail is received. (HTCC-23603)
• If changing the agent state on the voice channel fails and digital channels were specified in the request,

Historical Reporting continues to work. Previously in this scenario, Historical Reporting failed.
(HTCC-24728)

• Supervisors can now monitor agents on the Chat channel who have specified a place during login. This
also includes Hot Seating environments. (HTCC-24528)

• The Call Monitoring icon is now correctly displayed when a call is being both monitored and recorded.
Previously, the Call Monitoring icon was not displayed to an agent while the call was being recorded,
only before or after recording. (HTCC-24511)

• In the My Statistics view, only the 'Objects' column can be used to sort the statistics; and in the Contact
Center Statistics view, only the 'Contact Center Resource' column can be used to sort the statistics.
Previously, the other column heads could be clicked on, even though they were not sortable.
(HTCC-24389)

Agent Desktop (V.8)
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October 17, 2016 (8.5.201.45)

What's New
Accessibility compliance

• The following Agent Desktop features are Web Content Accessibility Guideline (WCAG) 2.0 level A
compliance for people with disabilities:

Inbound voice

Voice recording controls

Voicemail

Team communicator

Contact directory

Contact profile and interaction history

My history

My channels

My messages

My statistics and contact center statistics

Note and Disposition

Supervisor voice monitoring, coaching, and barge-in

My agents

Resolved Issues

• In environments that use SAML, during login, if an agent makes a mistake while entering his or her
Place during login, Agent Desktop now correctly displays an error message requesting the agent to
enter the correct Place. Previously, the agent was redirected to a dead-end page. (HTCC-23207)

• Agent Desktop no longer generates duplicate SAML authentication requests, which led to a login failure.
(HTCC-23006)

• When another party hangs up on a consult, the RELEASED event is now triggered in the Service Client
API. (HTCC-23163)

• If overriding attached data is added while an interaction is active, the overrides are now correctly taken
into account. Previously in this scenario, the overriding options were taken into account only if the
overriding attached data was within the interaction when the interaction was received by the agent.
(HTCC-22678)

• Statistics of type Float are now rounded to two decimal places. (HTCC-23147)
• When a horizontal scrollbar is displayed in either My Statistics or Contact Center Statistics views, the

horizontal scrollbar now correctly scrolls the table contents and column headers. Previously, the
scrollbar only scrolled the table content, not the column headers. (HTCC-23096)

• When an agent sends an email to a customer using an email display name, the display name now

Agent Desktop (V.8)
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correctly displays any capital letters when the customer receives the email. Previously, capital letters
from the display name were replaced with small letters when the customer received the email.
(HTCC-23406)

• Contact Center Statistics are now correctly displayed if the name of the statistic object contains an '&'.
Previously, the use of special characters in the name of statistic objects prevented statistics from being
displayed. (HTCC-22908)

• If an agent double-clicks on the dial button in Team Communicator, Agent Desktop no longer sends a
second dial operation. Previously, this action resulted in a warning message. (HTCC-23587)

• In multi-switch environments, Agent Desktop no longer duplicates favorites that are related to routing
points if the routing points are configured in both switches and no switch is specified in the favorite.
(HTCC-23633)

• There is no longer a delay in the My Agents view when the user navigates to another page.
(HTCC-24043)

• Supervisors can now sort the interactions in the 'My Interactions Queues' view by clicking column
headers in the interaction list table. Previously, clicking on a column header in this view did not apply
sorting. (HTCC-24016)

• If incoming email doesn't have a proper 'From' address, when an agent replies, the reply is generated
with an empty 'To' address, requiring the agent to type it in. (HTCC-23142)

• The Case Data tab now displays the correct name of each disposition code. Previously, the Case Data
tab displayed a business attribute name instead of the display name of the disposition. (HTCC-23520)

• Previously, the Chat Pending indicator incorrectly restarted when the contact sent a new message. Now,
the Chat Pending indicator only restarts after an agent sends a new message. (HTCC-23637)

August 15, 2016 (8.5.201.37)

What's New
Resolved Issues

• When no thresholds are configured from Agent Setup, Agent Desktop no longer displays alarms in the
My Statistics and Contact Center Statistics tabs. (HTCC-22286)

• When an administrator sets a single queue for the list on login, this queue is now applied automatically.
Previously, the queue wasn't taken into account and it was not possible for the agent to fill it in
manually. (HTCC-22907)

• In the My Agents view, supervisors no longer see all agents when he or she isn't configured as the
supervisor for any Agent Group. (HTCC-22761)

• Interaction disposition is no longer reloaded every time an interaction is displayed as default behavior.
To view the disposition updates done during an agent session, the agent should refresh the browser or
wait for the next refresh to occur. ( HTCC-22792)

• Skills are no longer displayed in the My Statistics view as the related information isn't available from the
platform. (HTCC-22866)

Agent Desktop (V.8)
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July 18, 2016 (8.5.201.33)

What's New
Resolved Issues

• The list of standard responses in the Responses view is no longer empty or incomplete after server
startup. (HTCC-18168)

• Previously, if an agent refreshed the web browser while handling a call, an issue occurred with the
direction parameter in the Service Client API. Agent Desktop was not able to determine the direction of
the call. Now, Agent Desktop identifies direction as follows:

If the callType is Inbound, the direction as IN.

If the callType is Outbound, the direction as OUT.

However, after the call is transferred or some other operations, the direction might still be
incorrect. In scenarios where the callType is Consult or Internal, Agent Desktop does not know the
call direction; therefore, the direction is set to UNKNOWN. (HTCC-22463)

• Previously, when the Responses Explorer contained more than one sub-category or more than two
nodes in the expandable/collapsible list, an issue occurred where Agent Desktop did not properly
display these options. This problem is now resolved. (HTCC-22467)

June 28, 2016 (8.5.201.29 UPDATE)

What's New
Hot Seating

• Hot Seating is now supported with Genesys Interaction Recording (GIR) screen recording.

Resolved Issues

• Corporate Favorites based on Agent, Skill, Routing Point, Interaction Queue, Agent Group, and Virtual
Agent Group are now available in Team Communicator. Previously, only the first ten Corporate Favorites
configured for each object were used by Team Communicator. (HTCC-22591)

June 20, 2016 (8.5.201.29)

What's New
Interaction history enhancements
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• Display of custom interaction attribute(s) in the Interaction History. Previously, only standard interaction
attributes, such as status, subject, start date, and end date could be displayed in the Interaction
History table. It is now possible for system administrators to configure additional custom interaction
attributes to be displayed. This capability allows agents to have more detailed information prior to
selecting an interaction on which to focus, leading to improved efficiency.

• A note is automatically created in the Interaction History when a voice call is transferred to, or
conferenced with, another agent.

Case information enhancement

• Administrators can configure case information fields so that they are required to be filled in by the
agent when the agent marks an interaction as done. This capability allows your business to capture
critical business data for further analysis.

Outbound Campaign enhancement

• Support for Predictive and Progressive ASM (Active Switching Matrix) mode. ASM enhances the
capability of Outbound Campaign Predictive and Progressive modes by reserving the agent before the
call is connected. This mode allows the agent to be connected with the customer as soon as the
customer answers the call.

Miscellaneous enhancements

• User feedback. Agents now have the capability to provide feedback when they encounter a problem
with the application. The application automatically submits the browser log for further processing.

• Automated feedback. Occasionally the application might experience disconnection from the backend
servers. If this occurs, a browser log is automatically collected. Agents are asked if they want to submit
the collected information when the application re-establishes connection.

• Application rebranding support. You can now configure the application to display a custom company
logo instead of the default Genesys branding.

Resolved Issues

• Previously, when the Contact Center Statistics or My Statistics panels were displayed, memory used by
the browser where Agent Desktop was running grew quickly. After a certain period, the application
became unresponsive and the browser needed to be closed and restarted in order to proceed. This
issue no longer occurs. Memory no longer grows in such situations and the application is responsive
even after a long period of time. (HTCC-21970)

• My Team Workbin currently shows all supervised agents with their associated workbins. Previously, the
list of agents could be empty or limited to only 10 agents only. (HTCC-21688)

• When a supervisor switches from monitoring or coaching to barge-in mode, both the Note and
Disposition tabs are displayed and currently fully accessible. Previously, when the supervisor selected
the Note tab, it was no longer possible to show the Disposition tab. (HTCC-21984)

• An audible notification is now played on the Agent Desktop when a new Twitter interaction is directed to
the agent. (HTCC-21748)

• When a supervisor switches from monitoring to coaching on a chat interaction, the supervisor can see
the chat transcript in the coaching view. Previously, this chat transcript was empty. (HTCC-22029)
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May 16, 2016 (8.5.201.25)

What's New
Resolved Issues

• The Team Communicator now displays the expected result if a search matches agents using a certain
channel of interaction. Previously, if one of the matched agents was using this channel of interaction,
no result was returned. (HTCC-21226)

• For the Contact Directory in list mode, email addresses presented in the drop-down list are no longer
truncated by the right panel that provides details of a contact. (HTCC-21183)

• Agents are no longer logged out after their desktop session restarts. (HTCC-21140)
• Standard Response Root Categories are no longer duplicated. (HTCC-21195)
• The Reply button is no longer displayed for Direct Messages from Twitter and the agent is not able to

reply through a status update. (HTCC-21627)

April 18, 2016 (8.5.201.20)

What's New
Chat enhancement

• During a chat session, a customer is now able to request to receive content by email while continuing
with the chat session. This feature allows the agent to click on the customer-provided information to
start an outgoing email to the customer.

• During a chat session, a customer is now able to request to be called at a specific number while
continuing with the chat session. This feature allows the agent to click on the customer-provided
information to start an outgoing call to the customer.

Interaction history search

• Agents are now able to perform keyword searches of customer or contact interaction history, as well as
the agent's own interaction history.

• Agents are now able to use Quick Search to search for interactions using keywords within the content of
an interaction, such as the chat transcript, email body, email subject, interaction note, and other
interaction attributes.

Voice enhancement

• A conference call could involve multiple external parties during an interaction. System administrators
are now able to configure the system to automatically disconnect all remaining external parties when
the last agent departs the conference call.

Resolved Issues
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• When the Agent selects a voice interaction in My History, the Workspace title from the main bar is no
longer corrupted. Previously, some information from the selected interaction replaced the Workspace
title. (HTCC-20956)

• For Social media, Agent Desktop no longer erases the comment after disposition code is set.
(HTCC-20896)

• When the Agent Desktop is pinned in the task bar, disconnection no longer occurs when toast is
displayed for inbound interaction or Outbound campaign notification. (HTCC-21124)

• Updated case data is lost when the agent edits a Case Information field, and immediately clicks the
button to end up the interaction. To avoid this, click somewhere else within the Case Information
section, after editing the Case Information field. (HTCC-21152)

• When an agent fails to log into the voice channel, but successfully logs into multimedia channels, the
session is properly cleaned-up and the agents place is freed, allowing other agents to log in to the
same place. (HTCC-20618)

March 21, 2016 (8.5.201.17)

What's New
Agent state

• Target agent detail state. Starting with this release when an agent searches for another agent in the
Team Communicator, he or she can see the target agent’s detail state such as Ready, Busy, Not Ready,
Not ready <reason>, and Logged Off. The former display of ‘Available’ and ‘Unavailable’ states are now
obsolete.

Resolved Issues

• When an agent clicks a hyperlink from the inbound email, the related web page is displayed in another
Browser window. Previously, the related web page replaced the inbound email view or if the hyperlink
was HTTP, and not HTTPs, the view became blank. (HTCC-20583)

• Agent created unsolicited Facebook posts will now appear on Facebook. (HTCC-20739)
• When a call is monitored by a screen recording and a consultation occurs, the consultation is no longer

attached to the screen recording. (HTCC-20429)
• Previously, when Agent Desktop was configured to prevent the agent from being notified that the

current call is monitored by a supervisor, an issue occurred where the sound (a beep) was heard. This
issue no longer occurs. (HTCC-20361)

• Blended agents with voice calls that contain screen recording will no longer appear ready to take
interactions after they have logged off. (HTCC-20477)

• Agent Desktop no longer generates exceptions when reasons from the Global state menu contain
special characters. (HTCC-20603)
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February 22, 2016 (8.5.201.12)

What's New
Supervision

• Supervisors can view and update the status of their agents in real-time. Supervisors can change an
agent's readiness state and, if necessary, log off an agent from all media channels.

• Agent state supervision allows supervisors to prevent interactions from being routed to agents who
have left the workstation without properly exiting the application or changing their readiness state.

Voice supervision enhancement

• To assist agents that need immediate help with an in-progress customer interaction, supervisors can
begin silent monitoring or coaching of calls already in progress.

Routing

• Agent Desktop can be configured to record the last agent who communicated with the customer. Future
interactions can then be routed to the same agent to maintain the continuity of the conversation.

Security

• You can now configure Agent Desktop to automatically logout the agent after a period of inactivity.

Resolved Issues

• When an agent starts a chat consultation with an Agent Group or Skill, the "Invitation sent to Agent
Group 'xxxx'" message in the chat transcript now disappears after a configured period of time.
(HTCC-19284)

• Agent Desktop now identifies when a supervisor is coaching an agent by displaying the coaching status
for the related party. Previously, the status was just connected. (HTCC-18894)

• Agent Desktop no longer identifies coaching as a conference. Previously, Agent Desktop used the
conference icon in this use case. (HTCC-17837)
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Agent Desktop (V.9)

Important
Not all changes listed below may pertain to your deployment.

Important
Workspace Agent Desktop v9 documentation is available here:

• Workspace Web Edition Agent Help
• Workspace Web Edition Supervisor Help

• January 27, 2021 (9.0.000.77
UPDATE)

• October 29, 2020 (9.0.000.75
UPDATE)

• September 17, 2020
(9.0.000.73)

• August 11, 2020 (9.0.000.72)
• July 16, 2020 (9.0.000.70

UPDATE)
• May 14, 2020 (9.0.000.69)
• March 26, 2020 (9.0.000.65

UPDATE)
• February 20, 2020

(9.0.000.65)

• January 23, 2020 (9.0.000.63
UPDATE)

• November 7, 2019
(9.0.000.55)

• September 26, 2019
(9.0.000.49)

• August 29, 2019 (9.0.000.41
UPDATE)

• August 1, 2019 (9.0.000.41)
• June 27, 2019 (9.0.000.39)
• June 6, 2019 (9.0.000.37)
• May 23, 2019 (9.0.000.34)
• May 13, 2019 (9.0.000.33)

• May 2, 2019 (9.0.000.32)
• April 18, 2019 (9.0.000.31)
• April 4, 2019 (9.0.000.30)
• March 14, 2019 (9.0.000.26)
• February 28, 2019

(9.0.000.25)
• January 31, 2019 (9.0.000.23)
• January 17, 2019 (9.0.000.22)
• December 14, 2018

(9.0.000.19)
• Known Issues
• Limitations

Important
Social channels, such as Facebook, Twitter, WhatsApp, and SMS are delivered to
Workspace Agent Desktop through Genesys Digital Channels.
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January 27, 2021 (9.0.000.77 UPDATE)

What's New
Inbound phone number reformatting

• Agent Desktop can now reformat phone numbers before creating a new contact to avoid creating
duplicate contacts. Please contact Genesys to enable this feature.

Interaction History threaded view

• Agent Desktop can now display conversations (related interactions) in a threaded view in the interaction
history.Use the Allow Tree View for Threaded Interactions, Tree View - Contact History
Displayed Columns, Tree View - My History Displayed Columns, and Tree View - All
Interactions Displayed Columns options in the Contact tab of the Desktop Options section in Agent
Setup to enable this feature.

Opt-out support

• Agent Desktop now prevents supervisors from monitoring a call when a contact opts out of call
monitoring.

• Agent Desktop now prevents agents and supervisors from recording a call when a contact opts out of
call recording. To enable this feature, use the Allow Alert for Opt-out Recording option in Agent
Setup.

Outbound Campaign record editing support

• Agents can now view and update the fields of Outbound campaign records. Use the Allow Update on
Outbound Records option in the Desktop Options section of Agent Setup to enable these
features.

Not Ready Reason status enhancement

• Agent Desktop can now keep the Not Ready Reason after the After Call Work period ends if a Not Ready
Reason is applied during a call. Contact Genesys to configure this support.

Voice channel Out of Service support

• For deployments that do not include Genesys Softphone in Connector mode, and do not use WebRTC,
Agent Desktop allows agents to use the application when a voice channel is in the Out of Service state.
If the DN is registered later, the voice channel switches automatically to the Logout state.

Email hyperlink support

• Agent Desktop enables agents to insert and edit hyperlinks in Email interactions.

Resolved Issues

• Column size is now retained when an agent switches between the Quick Search and Advanced
Search or between tabs in the My History, Contact History, and Interaction Search views. Column
size is only reset when an agent switches between the flat view and the conversation view. Previously,
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the column size was reset each time an agent changed the view. (GAPI-25039)
• For supervisors monitoring a call in barge-in mode, the buttons for Consultation, Transfer and

Conference are no longer available. Previously, if a supervisor selected these operations, unexpected
side effects occurred as these features are not supported in this scenario. (GAPI-25025)

• For favorites in Team Communicator, the drop down list to create or edit a favorite is no longer
truncated when the list is too long. (GAPI-24804)

• For Chrome and Firefox users that implement the Background Tabs Throttling feature, Agent Desktop
now has improved defense against delayed interaction notification. Previously, when the tab running
Agent Desktop did not have the focus for a long time, agents might have experienced a delay receiving
incoming interaction notifications. (GAPI-24720)

• All voice interactions are now available in Designer Analytics. Previously, depending on the number of
agents, some calls might be missing from this application. (GAPI-24558)

• For agents handling multiple Chat interactions simultaneously, when an agent switches among the Chat
interactions, Agent Desktop remembers the scroll position in the transcript for each active Chat
interaction. Previously, the position of the scrollbar was always reset to the top. (GAPI-24532)

• The following message is no longer displayed continuously: "Could not execute operation for user
... Please wait for recovery to be completed." (GAPI-24420)

• Agents no longer have to clear the browser cache before running a custom Agent Desktop based on the
Workspace Toolkit after an upgrade of the platform. (GAPI-24125)

• Multiple agents are no longer assigned to the same Chat interaction. (GAPI-23571)
• The display of Agent Desktop no longer becomes corrupted after an active Chat interaction becomes

idle and the agent handling the Chat clicks the Insert button from the Standard Response tab.
(GAPI-23565)

October 29, 2020 (9.0.000.75 UPDATE)

What's New
Duplicate contact alert

• Agents now receive an alert when they try to save a contact that is a potential duplicate of an existing
contact. Use the Allow Check for Duplicate Contact, List of Contact Attributes for AND rule,
and List of Contact Attributes for OR rule option in Contact tab of the Desktop Options section in
Agent Setup to enable this feature.

Resolved Issues

• When Agent Desktop is set up to display the current state of an interaction in a workflow (routing
strategy), agents can now open interactions while they are being routed. (GAPI-24291)

• If there is a loss of connection between Agent Desktop and the backend Genesys services, agents are
no longer prevented from from logging in to the Chat and Email channels. (GAPI-24097)

• Agent Desktop now supports both commas ( , ) and semicolons ( ; ) as email address separators.
Previously, only the semicolon was supported as a separator. (GAPI-22919)
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• In environments with a large number of Genesys features and objects configured, the Feedback service
now correctly accepts submissions. The operation no longer fails. (GAPI-22532)

September 17, 2020 (9.0.000.73)

What's New
Outbound Campaigns

• You can now add an outbound treatment when a campaign record is rescheduled. Use the Allowing
Treatment On Reschedule option in Agent Setup Outbound section to configure the treatment.

Contact History

• When viewing digital interactions in the Contact History view, agents can see the exact status of an
interaction while it is being processed. Enable this feature by selecting the Allow Contact
Interactions Workflow State option in Agent Setup.

Restricting access to digital interactions

• You can now grant user privileges to specify which users may handle Digital interactions in the Contact
History or workbins. Enable this feature in Agent Setup selecting the Allow Contact Interactions to
be Open from Queue and Allow Contact Interactions to be Open from Personal Workbins
options.

Resolved Issues

• Starting from version 72 Firefox does not correctly handle the situation where a source for the remote
media container is assigned before the source for the local media container is assigned and the media
was not correctly played by the browser during an inbound call.

To manage this Firefox issue, Agent Desktop now always assigns the source for the local media
container before it assigns the source for the remote media container. (GAPI-22864)

• Workspace displays the columns defined for workbins. Previously, only the following default columns
were used: From, To, Subject, and Received. (GAPI-22733)

• Voice interactions are now correctly reported as Done in Contact History and My History after it has
been marked as Done by an agent. Previously, in some very specific situations (the agent refreshes the
browser page with an active voice interaction, or there is a cometd disconnection during an active
voice interaction), the voice interaction remained in the In Progress status after the call was marked
as Done by the agent. (GAPI-22544)
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August 11, 2020 (9.0.000.72 UPDATE)

What's New
Standard Responses

• Agents can select a Standard Response and add it as a favorite. Use the Enable favorite standard-
response option in Agent Setup to enable this feature.

• Agents can insert responses into a chat or email by using a short keyword.

Resend email

• From any History view, agents can resend a previously sent email. Use the Allow Email Resend from
History option in Agent Setup to enable this feature.

Resolved Issues

• The Reject button is now available for inbound Voice interactions for the next routed agent after the
previous agent rejects the interaction. (GAPI-22461)

• In the following scenario, a reply email is no longer considered a forwarded email:
1. An agent forwards the original inbound email inline to an external resource.
2. The external resource replies to the forwarded email.
3. The agent replies to the external resource's reply email.

Previously in this scenario, the reply email was considered a forwarded email resulting in a loop as
the inbound email was showing up on complete. (GAPI-22426)

• A single-step chat conference, with attached data, routed through an Interaction Queue that is selected
as a Favorite now correctly reaches the intended target. Previously, the interaction sometimes was not
directed to the correct target. (GAPI-22406)

• The Agent State menu is improved to provide the agent name and status to screen readers, such as
JAWS. Previously, an agent had to navigate to obtain this information when the focus was in this menu.
(GAPI-22021)

• Agents can now right-click to save embedded images in active inbound or outbound email interactions
and also from History and workbins. (GAPI-21738)

• Use of the Team Communicator favorite is improved in situations where an agent uses it immediately
after logging in. Previously, depending on the environment, Corporate Favorites might have
disappeared when the agent selected Favorites filtering and only Personal Favorites were displayed.
(GAPI-21612)

• You can now copy content from a Microsoft Word document and paste it into the editor of an outgoing
HTML-formatted email interaction. (GAPI-21554)
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July 16, 2020 (9.0.000.70 UPDATE)

What's New
SIP preview ringing bell

• If the DN was configured for preview interactions, you can use SIP preview ringing bell to notify
agents that they have a directly dialed interaction. Use the following Agent Setup Voice options to
enable this feature:
• Voice SIP Preview Ringtone Type
• Voice SIP Preview Ringtone Priority
• Voice SIP Preview Ringtone Duration
• SIP Preview Interactions

Interaction view tab order

• You can now re-order the tabs displayed in the right panel of an interaction view. Use the following
options in the Desktop Views Options in Agent Setup to configure the display of elements in the Agent
Desktop User Interface:

• Default view in Region NavigationBarRegion
• Views order in Region NavigationBarRegion
• Default view in Region ConnectRegion
• Views order in Region ConnectRegion
• Default view in Region MonitoringRegion
• Views order in Region MonitoringRegion
• Default View In Region ContactRegion
• Views order in Region ContactRegion
• Default view in Region HistoryInteractionDetailsRegion
• Views order in Region HistoryInteractionDetailsRegion
• Default view in Region CaseSideRegion
• Views order in Region CaseSideRegion

Resolved Issues

• Agents can now reply to email interactions containing embedded images that are not of types jpg, gif,
or png. (GAPI-21493)

• Personal favorites now load more quickly. Previously, in environments with large numbers of agent
groups, personal favorites loaded slowly or failed to load. (GAPI-21512)

• After a call has ended, Workspace no longer permits agents to remove from an interaction attached
data that was available before the call was ended. (GAPI-20912)

• When an agent marks a voice interaction as Done, Agent Desktop now sends only the user data that
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was update by the agent when the call was ended. Previously, Agent Desktop sent all the user data
which cause issues for some reporting situations. (GAPI-19693)

• Agent Desktop does not allow agents to delete a contact if there are in-progress interactions in the
contact's history. (GAPI-15922)

May 14, 2020 (9.0.000.69 UPDATE)

What's New
Email enhancement

• Support for embedded images within the body of inbound email interactions. Email interactions are
often sent with images inserted within the email body for illustration purposes. Agents receiving these
email interactions can now see the images at the position intended by the sender.

• Embedded images within the body of outgoing email interactions. Images can be inserted in the email
editor, either by drag and drop or by clicking Insert Image. The image viewing size can be adjusted if
needed.

• Email interaction history now displays embedded images.

Interaction history enhancement

• Ability to display unanswered outgoing calls in the My History, Contact History, and Interaction
History views. To enable this feature, use the Allow Unanswered Outbound Call option in Agent
Setup.

Contact Management enhancement

• Ability to display a list of possible matching contacts for incoming interactions when more than one
contact matches the assignment criteria and enable agents to manually assign the interaction to the
correct contact. Please contact Genesys Customer Care to enable this feature.

Auto-answer with timed interaction preview

• When Agent Desktop is configured to auto-answer inbound interactions, you can now specify that the
interaction preview is displayed to agents for a defined period before the interaction is automatically
answered by using the Voice Auto Answer and Voice Auto Answer On Active Call options.

Fail-over enhancement

• Agent state is now maintained during fail-over. For example, depending on the system settings, an
agent who was in the Ready state before the fail-over remains in the Ready state after the jump to the
recovery region. Previously, agent state could be lost.

Team Communicator enhancement

• Ability to display a statistic for Route Point. This feature provides greater visibility about the state of the
target destination when performing actions such as transfer, conference, and consultation.
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Outbound campaign enhancement

• Support Direct Push Preview mode. Direct Push Preview is a variation of pull-preview which does not
require the Agent to request the next Outbound record; instead the record is pushed to the Agent.
Please contact Genesys Customer Care to enable this feature.

Routing Point support enhancement

• If an agent dials an outgoing call to an external contact that first goes through a routing point, Agent
Desktop now identifies the contact based on the phone number entered by the agent rather than on
the routing point number. Contact Genesys to have this feature enabled.

Resolved Issues

• In the Statistics Gadget, duration statistics are now correctly displayed in a duration format:
HH:mm:ss. Previously, duration statistics were displayed in a numeric format. (GAPI-19651)

• If an agent switches to a different browser or a different workstation during a chat session, the agent's
nickname is correctly used on the new browser. Previously, the agent nickname changed to
"anonymous" on the new browser session. (GAPI-19635)

• When Contact Directory search is configured in Lucene mode in Agent Setup, Agent Desktop no
longer generates two emails or calls when one is started from the Contact Directory. (GAPI-19258)

• If there is a failure to register with Genesys Softphone during agent login or during the switching of
regions in a Smart Fail-over situation, Agent Desktop now displays an error message when redirecting
agents to login again. Previously, no error message was displayed to inform agents of why they must
login again. (GAPI-19073)

• Agents can now reply to inbound email interactions that contain a carriage return in the personal part of
the address. Previously in this scenario, Agent Desktop could not display the inbound email and did not
display a warning message to agents. (GAPI-19020)

• Agent Desktop no longer displays erroneous messages about Chat session expiration that prevented
agents from interacting with contacts. This issue was caused by the allowing of initiating multiple
connections for the same Chat and agent. Now only a single connection per agent per chat is permitted
and chat clean up is now triggered only after the single connection is closed. (GAPI-18326)

• Agents can now log in to Chat and Email after certain service outages. (GAPI-18031)

March 26, 2020 (9.0.000.65 UPDATE)

What's New
Chrome v80+ SameSite cookie support

• The Chrome v80+ SameSite cookie attribute processing changes are now supported by Workspace
Agent Desktop.
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Resolved Issues

• If, during a chat session, an agent closes the browser, the chat is rerouted to another agent who can
mark it as Done. Previously in this scenario, it was not possible to mark the chat as Done.
(GAPI-18908, GAPI-18384)

• The comma character is now supported in the personal identification part of email addresses for Cc and
Bcc; for example: "lastname, firstname" <name@domain.com>. Previously, the comma was
interpreted as a separator which generated invalid email addresses. (GAPI-17973)

• Agents enabled for handling non-voice channel interactions can now login successfully. Previously, in
some scenarios the persistence of an old session caused the login to fail. (GAPI-17962)

• When an agent marks a chat as Done, the operation is now taken into account after a smart fail over
situation. Previously, in some situations, the related chat remains active in the system and was
redistributed to an another agent after the first agent marks it as Done. (GAPI-17588)

• Creation of Personal Favorites now works correctly when a backslash character ("\") is used. Previously,
it was not possible to create a Personal Favorite if the name included a backslash. (GAPI-17417)

• Supervisors can now use the current Place of the agent when they start monitoring. Previously, only
monitoring of the default Place was possible. (GAPI-17367)

• Agents are no longer logged out in some circumstances after switching regions. Previously, after
switching regions agents might sometimes be logged out after 30 minutes. (GAPI-16061)

February 20, 2020 (9.0.000.65)

What's New
Resolved Issues

• Agent Desktop now remembers the position of the vertical divider in the interaction view layout set by
an agent for each interaction type so that when a new interaction of a given type is displayed the size
of each pane is the same as the last one viewed. (GAPI-16858)

• If agents are allowed to extend their After Call Work by checking the option in the Extend After Call
Work banner, the Global Status menu is now correctly displayed. Previously, the banner partially
covered the Global Status menu. (GAPI-18841)

• For Microsoft Edge users, Agent Desktop no longer sends empty messages to contacts if an agent
presses Enter when the message composition field is blank or contains only whitespace characters or a
line terminator. (GAPI-18799)

• Chat Typing notification now correctly takes into account the time an agent pauses in entering a
message but has not yet sent the message so that contacts know that the agent is still working on a
message. Previously, Chat Typing notification timed out if the agent took too long between keystrokes
and the notification was no longer displayed to the contact. (GAPI-18458)

• For Microsoft Internet Explorer 11 users, when the Dispositions view is fully expanded, the list of
dispositions now fills the available space. (GAPI-18366)

• Standard Responses can now contain the text "Responses". Previously, there might have been display
issues of the Responses and Contact tabs when an agent made an outgoing call by typing a number
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into Team Communicator when one of the Standard Responses contained this text. (GAPI-17294)

January 23, 2020 (9.0.000.63 UPDATE)

What's New
Chat enhancement

• If a period of inactivity is detected during a Chat interaction, Agent Desktop alerts the agent in the chat
transcript that the session will be closed due to inactivity.

Voice call enhancement

• Agents are now notified by a visual alert when a contact or other party disconnects from a call.
• Dial plan support for outgoing calls. Please contact your Genesys representative to enable this feature.

Email enhancement

• The Arial and Helvetica fonts are now available to select from the Fonts list in the HTML email editor.

Contact Management enhancement

• Agent Desktop can now be configured so that the identity of the incoming voice contact remains
anonymous until the contact voluntarily discloses their identity to the agent during the interaction.
Contact your Genesys Representative to configure this feature.

Interaction history enhancement

• Agent Desktop enables agents to call contacts from the interaction history by clicking the phone
number in the interaction details. Additionally, agents can now view the contact's information by
clicking on the contact name in the interaction history.

Usability improvement

• Agents can now collapse and expand the disposition and note region for more efficient usage of screen
real estate during interaction handling.

Resolved Issues

• Supervisors can now move email from one workbin to another in environments where agents have two
or more channels assigned. Previously, the Move to workbin button wasn't available in the Workbin
view. (GAPI-18005)

• For Internet Explorer 11 users, agents can now paste text at the position of the cursor in the Chat editor.
(GAPI-17911)

• Interaction Bar tooltips have been improved to provide more details about the interaction case to aid in
distinguishing them. Previously, in some cases, such as consultation, the content of tooltips could seem
to be duplicates. (GAPI-17892)
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• Supervisors configured to monitor both voice and chat interactions can now monitor chat-only agents.
Previously, only voice and chat and voice-only agents could be monitored. (GAPI-17888)

• Agent Desktop now sends the correct From Address information of outgoing email interactions to
Genesys Reporting. (GAPI-17875)

• The My Agents view no longer displays reasons that have not been configured to ensure that the
reasons displayed are aligned with the state seen by agents. Previously, for example, on unanswered
calls, the reason no-answer was displayed. (GAPI-17694)

• For Microsoft Internet Explorer users, performance has been improved when an agent clicks Show
more in My Team Workbins. (GAPI-17589)

• Embedded images, which cannot be displayed at this time, are now accessible as attachments.
(GAPI-17469, GAPI-17474)

• During an Outbound Campaign call, the Reschedule view now displays the default reschedule time to
the current time of the contact plus 30 minutes. Previously, it was set to the current time of the agent
plus 30 minutes. (GAPI-17449)

• Supervisors can now set a disposition for a call monitored in barge-in mode. (GAPI-17422)
• Columns in the Dashboard view are now resizable. (GAPI-17234)
• Disposition hierarchy tree view is now correctly supported. Previously, in some situations the display of

the disposition tree view was corrupted or was not available. (GAPI-17177)
• When Focus Time is enabled, Workspace no longer displays an error message when an interaction is

marked done. (GAPI-17136)
• Support of Internet Explorer 11 has been improved to avoid some page rendering issues. (GAPI-17018)

November 7, 2019 (9.0.000.55)

What's New
Resolved Issues

• The following features now support additional ASCII characters such as -, +, and @:
• Disposition Attribute Value names
• Voice caller ID Attribute Value names
• Case Data Attribute Value names
• Interaction notification Case Data Attribute Value names

Previously, only the following characters were supported: a-z, A-Z, 0-9, _, space. If characters other
than these were used, the default value was applied instead. (GAPI-17095)

• Routing Points Favorites are now correctly displayed in Team Communicator. Previously, in some
situations such as network slowdown during application initialization, some Favorites were not
displayed. (GAPI-16784, GAPI-15711)

• Localization is now correctly supported in the My Agents tab. Previously, when agents were set up in a
non-English locale, the contents of the tab displayed in English. (GAPI-16760)
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• The Transfer button in Team Communicator for email and chat interactions is not available if the
selected agent is logged out. (GAPI-16655)

• Agent Desktop now correctly identifies internal targets who are existing favorites during a consultation,
transfer, or conference, so that agents are not asked to add these internal targets as favorites.
(GAPI-16303)

• Slow networks no longer cause issues with smart fail-over to the backup site. Previously, Agent Desktop
aborted the fail-over process. (GAPI-16281)

• When the From Address column is configured to be displayed in the My History, Contact History,
and Interaction Search views, the email address is now displayed in the From Address field for
related interactions as well. Previously, the related interaction fields were empty. (GAPI-16171)

• An agent can now correctly download attachments from the history views. Previously, if the agent was
logged in only on the voice channel, the agent could not download attachments from the history views.
(GAPI-16100)

• When an agent is on an Outbound Campaign call in "with seizing" mode, their status is now displayed
as Busy in the My Agents tab and Team Communicator of other agents and supervisors. Previously,
the agent status was Available or Not Available. (GAPI-16098)

September 26, 2019 (9.0.000.49)

What's New
Outbound campaign enhancement

• Preview mode timed dialing. You can set up Agent Desktop to automatically dial a contact after a
specified preview interval.

WebRTC Enhancement

• Agents can now use the WebRTC capabilities of the Chrome and Firefox browsers, eliminating the need
of Genesys Softphone as an endpoint.

Resolved Issues

• The specified default value of mandatory integer type Case Data is now correctly added to the
interaction view Case Information area if the Case Data was not already part of the interaction user
data. Previously, the Case Data was added without a value or with the value NaN. (GAPI-15971)

• Supervisors, using the My Agents view, can now log out agents from non-Voice channels who are not
logged in on the Voice channel. Previously, supervisors could not log out agents from any other
channels unless the agent was logged in on the Voice channel. (GAPI-15717)

• Agents can now correctly end and mark as Done SMS Chat interactions. Previously in some cases,
Agent Desktop became stuck when an agent clicked End. (GAPI-15662)

• If an agent makes multiple consultation calls from a single voice interaction, the consultation calls are
now correctly displayed vertically stacked. Previously, the consultation calls were displayed overlapping
horizontally. (GAPI-15171)

• The Workspace Web Edition default sandbox property might prevent web applications from being
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embedded within IFrame for security reasons. Contact Genesys Customer Care to handle reprovisioning
to enable this integration. (GAPI-15131)

• The error message in the case of failure when an agent is trying to accept a chat has been improved.
Agent Desktop now displays the following message: This chat is no longer available. Previously, Agent
Desktop displayed the following message: Cannot accept this chat interaction. (GAPI-15034)

• When an agent scrolls an interaction view, the Case Information panel now remains in view.
Previously, the Case Information panel scrolled out of view. (GAPI-13947)

August 29, 2019 (9.0.000.41 UPDATE)

What's New
Resolved Issues

• Agent Desktop no longer displays errors to agents when they mark done an email interaction.
Previously, in some situations, an 'Unknown interaction identifier specified' error was displayed to the
agent. (GAPI-14192)

August 1, 2019 (9.0.000.41)

What's New
Resolved Issues

• With Genesys Softphone running in connector mode, if the the headset is unplugged, the agent's state
now switches automatically to Not Ready with a Reason if a Not Ready Reason is set up. (GAPI-14224)

• The behavior of drop-down menus and buttons in the Case Information view has been improved so that
they respond correctly to user input and edited values are now automatically saved before being
submitting. (GAPI-13657)

June 27, 2019 (9.0.000.39)

What's New
My Agent view filters

• The My Agent view allows supervisors to view and change the status of the agents they supervise and
filter the view for all agents in a specific state on one or more channels.
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Interaction queue and workbin search

• Agents can now search interaction queues and workbins.

Resolved Issues

• Agents using hot seating no longer see incorrect interactions in Agent Desktop on next login. Previously,
depending on how the agent ended the Agent Desktop session, released voice interactions might have
been directed to them that they did not handle. (GAPI-13972)

• During login, if an agent enters a user name that is not recognized as an agent, the Change login
account link is now correctly displayed. Previously, only the Try again link was displayed and the
agent was not able to enter a different user name. (GAPI-13598)

• When the agent applies a Not Ready with a reason state to the Voice channel during a call, this
reason is no longer also associated to the After Call Work state when the call is ended. Previously, the
voice channel was in After Call Work state with this reason on the Agent Desktop but not at the
Reporting level. (GAPI-14123)

June 6, 2019 (9.0.000.37)

What's New
Multiple interactions

• You can now choose to have new interactions open in the background when an agent is already actively
handling an interaction. For agents who have the ability to handle multiple simultaneous interactions,
this new capability reduces disruptions when a new interaction is directed to them.

WebRTC Softphones

• Disaster Recovery is now supported for WebRTC Softphones. Agent Desktop now releases stuck calls
during a disaster recovery scenario.

Outbound campaign

• To prevent abandoned calls, agents who are reserved to receive an outbound campaign record cannot
log off until they have handled the record.

Resolved Issues

• Agent Desktop has been improved so that when it is in a tab in the background on some browsers, the
Background Tabs Throttling feature does not cause background tasks such as Softphone Connector, to
timeout due to inactivity on the Agent Desktop tab. (GAPI-13750)

• Agent Desktop no longer displays disconnection notices to agents when a channel briefly goes out of
service and is immediately restored. Disconnection notices are now sent only when channels remain
out of service after a disconnection. (GAPI-13659)

• Agent Desktop handling of voice operation failures has been improved by using the Warning level
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instead of the Error level to avoid notifications being displayed to agents. (GAPI-13515)
• Agents can now delete parties from a conference when they perform a single-step conference through

an IVR or other routing point. (GAPI-13424)

May 23, 2019 (9.0.000.34)

What's New
Email enhancements

• Agents may attach file(s) up to a maximum size of 8MB to an external email interaction.
• Interim email reply allows agents to reply to an inbound email multiple times. Agents can choose

between Send and Interim Send when replying to an inbound email.

Outbound Campaign enhancement

• Active Switching Matrix (ASM) and Assured Connect enable agents for the Predictive and Progressive
mode in your Outbound campaign to reserve an agent before the connection with the contact is
established. This feature enables agents to connect to the contacts instantly.

Genesys Altocloud Agent UI support

• Genesys Altocloud is an AI-powered Journey Optimization solution for real-time engagements of visitors
browsing websites, by triggering a WebChat widget to engage visitor at the right moment. The Genesys
Altocloud Agent UI Journey tab enables agents to access the following Altocloud features:
• Journey content for a specific visit session
• Visitor details and activity status
• Visit details
• Real-time customer journey chart
• Real-time view of matched segments
• Real-time view of outcome scores

Resolved Issues

• Agent Desktop can now handle large emails (up to 2 MB) without causing the application to freeze for
several seconds. (GAPI-13413)
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May 13, 2019 (9.0.000.33)

What's New
Resolved Issues

• A third-party component is updated to improve security within the session-handling mechanism.
(GAPI-11984)

• Agents are no longer logged out of the voice channel in some cases involving multiple browsing
sessions. (GAPI-13254)

May 2, 2019 (9.0.000.32)

What's New
Resolved Issues

• Configured Bell sounds for an active chat are no longer played when a previous chat is selected in a
History view. (GAPI-13032)

• For personal favorites, a scrollbar is now available for the drop-down list of categories. Previously, a long
list was truncated, and the only way to see hidden items was to type characters to filter the search
results. (GAPI-12948)

April 18, 2019 (9.0.000.31)

What's New
Automatic failover

• To maintain business continuity, the application now automatically connects to a backup environment
when the connection to the primary environment is lost.

Agent state supervision

• Supervisors can view and update the status of their agents in real time. Supervisors can change an
agent's readiness state and, if necessary, log off an agent from all media channels. These capabilities
allow supervisors to prevent interactions from being routed to agents who have left the workstation
without properly exiting the application or changing their readiness state.
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Resolved Issues

• Agents can now search for internal targets in Team Communicator using the target's DN. (GAPI-2128)
• Agent Desktop no longer displays the content of two email interactions in the same interaction view

(GAPI-12298)
• You can now search for alternate names for Corporate Favorites in Team Communicator when the

alternate name is displayed in parentheses. Previously, the search worked only when there was a space
between the parentheses and the alternate name. (GAPI-12423)

• If the application disconnects from the server, agents are automatically logged out after 30 minutes if
the application does not reconnect. (GAPI-12720)

April 4, 2019 (9.0.000.30)

What's New
Feedback

• To help us serve you better, it is now possible for users to provide feedback when they observe minor
issue while using the application. In the event of a major issue, such as total application or browser
failure, the user is provided with the opportunity to submit feedback the next time they log in.

My Agents Workbin and Interaction Queue

• Ability to select and perform actions on multiple items.

SMS interactions

• Support for inbound and outgoing SMS interactions through Digital Channels.

WhatsApp

• Support for WhatsApp interactions including text, emoji, images, and Highly Structured Messages
through Digital Channels.

Resolved Issues

• Spaces are now supported for the names of custom attributes based on an enum for advanced searches
in the My History, Contact History, and Interaction Search views. (GAPI-12453)

• Corporate Favorites and search results in Team Communicator can now include routing points with
names that contain non-numeric characters. (GAPI-12297)

• The tooltip for the 'End Coaching' button for a current call or chat has been corrected from 'End
Monitoring' to 'End Coaching'. (GAPI-12319)
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March 14, 2019 (9.0.000.26)

What's New
Focus-time reporting support

• For scenarios where an agent is handling several simultaneous interactions on different channels, Agent
Desktop now tracks the duration for which each interaction is actively being worked on (in focus) to
better support accurate reporting of the agent’s time spent per interaction.

Support for Genesys Co-browse

• Agents can now assist contacts by jointly navigating web pages in a synchronized browsing session with
Genesys Co-browse.

• Contacts can grant agents control of the browsing session using the "write mode".
• For privacy and security, the service can be configured to mask sensitive data from the agent's view

and to prevent actions on specified controls.

Resolved Issues

• Agents can now correctly reply to email interactions. Previously, the reply operation sometimes failed
due to an issue between internal email system configurations and Agent Desktop. (GAPI-11878)

• Team Leads can now start Agent Desktop supervision in coaching mode in any deployment
environment. Previously, in certain environments, Agent Desktop supervision started in silent
monitoring mode instead. (GAPI-11871)

• Team Communicator now correctly displays the state of an agent who is in 'After Call Work' state.
Previously, the agent's state was shown as 'Not Ready'. (GAPI-11820)

• Transfer of email, chat, and other eServices interactions to an Interaction Queue is now working
correctly. Previously, attempting to transfer any eServices interactions to an Interaction Queue resulted
in an error. (GAPI-11678)

• You can now restrict the file type of email attachments. (GAPI-10820)

February 28, 2019 (9.0.000.25)

What's New
Interaction enhancements

• Interaction history, workbin, and interaction queue enhancements:
• Agents can open 'in-progress' emails and workitems. This capability allows agents to respond in

real-time to queued and outstanding customer inquiries.
• Agents can mark as Done interactions that do not require a response.
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Resolved Issues

• The chat toolbar now correctly blinks when a new chat message is added to the transcript of a collapsed
or non-active chat interaction. Blinking stops if the agent passes the mouse pointer over the collapsed
or non-active interaction. (GAPI-10856)

• If the Voice server goes down during an agent session, the Voice channel status is, correctly, out of
service, even after a refresh. Previously in this scenario, refreshing the browser displayed the voice
channel in the state it was in before the server went down, even if it was still out of service.
(GAPI-10812)

• Team Communicator now returns complete and consistent results when an agent searches for Agent
Groups. (GAPI-3830)

• Internal contacts that are designated as Corporate Favorites now correctly display as Corporate
Favorites in Team Communicator. (GAPI-3614)

• Agents can now complete voice conferences when the agent is allowed to make two-step conferences,
but not one-step conferences. (GAPI-11391)

• Session authentication now provides protection against login conflicts with an additional verification to
ensure users belong to the correct tenant. (GAPI-11593)

January 31, 2019 (9.0.000.23)

What's New
Chat enhancements

• Agents can now receive and send emojis by selecting from a list during chat interactions.
• Asynchronous chat enables agents to continue a chat session after the initial interaction is ended by

using the new Conversation tab in the interaction window or the new Communication tab in the
Connect group through Digital Channels.

Facebook support

• The Facebook channel enables agents to engage in private chat sessions with Facebook Messenger
users and public sessions with Facebook users. This enables you to monitor and respond to public posts
and replies to your organization's Facebook page in a timely manner through Digital Channels.

Twitter support

• The Twitter channel enables agents to engage in private chat sessions with Twitter Direct Message users
and public sessions with Twitter users. This enables you to monitor and respond to public Tweets and
replies to your organization's Twitter page in a timely manner through Digital Channels.

Resolved Issues

• Agent Desktop no longer displays a Bad Request error when agents mark voice interactions as Done.
(GAPI-11090)
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January 17, 2019 (9.0.000.22)

What's New
Last agent routing support

• Agent Desktop can be set up to remember the last agent who communicated with a contact. This
capability ensures that future interactions can be routed to the same agent to maintain the continuity
of the conversation.

December 14, 2018 (9.0.000.19)

What's New
Voice

• Support for voice interactions:
• Receiving calls
• Making calls
• Call recording
• Call transfer, conference, and consultation
• Call hold
• End call
• Mark done
• Call case information
• Call disposition
• Call notes

• Support for Genesys Softphone 9.0

Email

• Support for email interactions:
• Email media state control (including ready, not ready, and logon/logoff)
• Inbound email screen-pop
• Auto accept and interaction preview with manual accept and reject
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• Initiate new email from Team Communicator, contact directory, and interaction parties area
• Support for To, Cc, Bcc with ability to restrict Cc and Bcc
• Standard email interaction controls, including: Reply, Reply all, Save to Workbin, transfer, and Mark

Done
• Auto signature insert
• Support for text and HTML format with text editor
• Ability to configure default font size and type
• Retrieve and insert attachments
• Spelling check using browser's native spelling checker
• Retrieve email from workbin
• Capacity rule support
• Email in contact's interaction history
• Email disposition and note
• Email case information
• Enables agents to forward email to one or multiple external recipients who are not using Genesys

Email. Agents can add an additional comment prior to forwarding when needed.

Web Chat

• Support for Web Chat interactions:
• Web chat state control (including ready, not ready, and logon/logoff)
• Inbound web chat screen-pop
• Auto accept and interaction preview with manual accept and decline
• Web chat interaction control, including send, end, mark done, consultation, transfer, and conference
• Cancel chat consultation to queue
• Delete party from conference
• Customer/Agent "is typing" notification
• Agent nickname configuration
• Notification of a pending response to a contact
• Spelling check using browser's native spelling checker
• Capacity rule support
• Web chat in contact's interaction history
• Web chat disposition and note
• Web chat case information

Open Media Task Routing

• This generic UI framework allows custom media types such as faxes, scanned documents, and tasks to
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be routed to agents for processing. Included capabilities are:
• Media logon/logoff and readiness state control
• Interaction preview with manual or auto accept and decline
• Transfer, save to personal workbin, and mark done
• Enter disposition and note
• Contact’s interaction history tracking

Outbound Campaign

• View listing of call campaigns which are assigned to the agent
• Notification of campaign loaded, start, and stopped
• Support for Outbound Campaign pull preview mode:

• Retrieve call record from start notification, campaign listing, and at completion of a previous call
• Decline a preview record prior to placing the call with selection of how the record is to be treated
• Click to dial the provided phone number, with the ability to select an alternate number (if available)

during the preview phase
• Request next record, stop, and resume retrieval of a preview record

• Support for Outbound Campaign Predictive and Progress modes
• View list record attributes prior to and during a call
• Flag a record as 'Do Not Call'
• Call result and interaction disposition
• Standard voice call control when a call is successfully made
• Outbound Campaign case information

Contact profile and interaction history

• Contact directory search, contact creation, contact assignment, contact profile editing, contact deletion,
and contact interaction history.

• Ability for agents to mark done interactions that do not require a response.
• Open “In Progress” emails and workitems from the contact interaction history. This capability allows

agents to respond in real-time to queued, outstanding customer inquiries.

Interaction history search

• Quick search
• This new feature allows an agent to perform keyword searches of contact's and the agent’s own

interaction history. Quick search is a feature that appears in Contact History, Interaction Search, and
My History views.

• Agents can search for interactions using keywords within the details of an interaction, such as the
chat transcript, email body, email subject, interaction note, and other interaction attributes.

• Advanced search
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• A new module enabling agents to search for historical customer interactions within and outside the
context of the My History and Contact History views.

• Agents can specify multiple search attributes and conditions when searching. Search attributes
include:
• System interaction attributes such as 'processed by', 'dates', 'media types', 'status', and 'email

addresses'
• Business attributes stored as attached data key-value pairs
• Specific text within the email body, the web chat transcript, the subject, and the notepad
• Specific date range using the 'Between' operator

My Interaction History

• A new module enabling agents to view their historical customer interactions.

Statistics

• Performance Tracker for agent KPIs
• Contact center statistics viewer
• You can now configure Agent Desktop to allow agents to select one statistic to be visible at all times

while the application is in focus.

Standard Responses

• Standard responses are now supported for all media channels.

Workbins

• Agent's in-progress and draft personal workbins for email

Supervision

• Voice
• Supervisors can initiate monitor with possibility to barge-in interactions between an agent and

contact.
• Supervisors can whisper coach agent during an interaction with contact.

• Web Chat
• Supervisors can now monitor, coach, and barge-in interactions between agents and contacts.
• Supervisors can switch between various supervision modes (monitor, coach, and barge-in).

• Email
• To ensure outgoing emails are of consistent quality, certain emails from agents to customers are

selected by the system to be reviewed by a supervisor before being released by the system. These
emails can be routed to an available supervisor in real-time or to a supervisor’s workbin.

During the review, supervisors can approve or reject emails sent by agents to customers.
Supervisor can make minor edits when approving or provide comments to the sending agent
when rejecting an email.
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• Agent Workbin and Interaction Queue
• Capability for supervisors to view interactions within interaction queues and their agent’s personal

workbins
• Ability to select interaction from an agent’s personal workbin and move it to another agent’s

workbin or interaction queue
• Ability to select interaction from an interaction queue and move it to another agent’s workbin or

interaction queue
• Mark interaction as Done
• Delete agent’s draft email

Navigation

• A sidebar navigation toolbar offers quick access tools that can be used at any time, such as Team
Communicator, voicemail, and messages and other notifications.

• Introduction of the top-level navigation bar to include support switching between different agent task
and support views.

Customization

• It is now possible to customize the top navigation bar to include custom third-party party web content.
• It is now possible to customize the side bar to include custom icons which allow agents to view 3rd

party web content.

SSO

• Support for Single Sign-on through OAuth2, and two-step sign-on process.

Security

• Allows you to control enabling/disabling usage of geolocation, midi, encrypted media extension,
microphone, and camera within iframe.

Known Issues

• After an active Chat interaction becomes idle, if the agent handling the Chat clicks Insert from the
Standard Response tab the display of Agent Desktop might become corrupt. To resolve the display
issue, the agent must refresh their browser. (GAPI-23565)

• For Chrome and FireFox users, the tooltip feature in Team Communicator is not displaying content
correctly; however, most of the tooltip information can be read. (GAPI-20831)

• For Internet Explorer 11 with CKEditor 4.13.1, embedded images are not always resizable. Embedded
images can be resized only if they are placed on a separate line with no other content. (GAPI-19699)

• In environments using Smart Fail Over, if the primary site fails during agent log in, Agent Desktop does
not connect to backup site. Administrators must provide the agent with the URL for the backup site.
(GAPI-17174)
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• When a call is transferred, Agent Desktop incorrectly notifies the agent that the contact has left the call.
(GAPI-17799)

Limitations

• Google Chrome 57 introduced the Background Tabs Throttling feature that reduces the availability of
CPU cycles to 1% for Web applications in tabs that are not currently in focus or for minimized browsers.

This feature can cause an issue with incoming interactions. If the tab running Agent Desktop does
not have the focus for a long time, agents might experience a delay receiving incoming interaction
notifications.

Workarounds:

• Disable the feature in Chrome by adding --disable-background-timer-throttling to the
command line when launching Chrome: "C:\Program Files\Google\Chrome\Application\
chrome.exe",

• Or, agents must open Workspace in a separate browser window without any other tabs open and
never minimize the window. There is no issue if this browser window is in the background;

• Or, agents should use the Microsoft Internet Explorer 11 browser.

• Mozilla Firefox 58 introduced the Background Tabs Throttling feature that reduces the availability of CPU
cycles to 1% for web applications in tabs that are not currently in focus or if the browser is minimized.

This feature can cause an issue with incoming interactions. If the tab running Agent Desktop does
not have the focus for a long time, agents might experience a delay receiving incoming interaction
notifications.

Workarounds:

• Disable the feature in Firefox using the following procedure:
1. Enter about:config in the address bar and press Enter to open the Firefox application

preferences page.
2. Click I accept the risk! to dismiss the warning message.
3. Enter min_background_timeout_value in the search field to find this timer throttling option.
4. Edit the Value column to change the preference setting to 0.
5. Enter min_background_timeout_value_without_budget_throttling in the search field to find

this timer throttling option.
6. Edit the Value column to change the preference setting to 0.
7. Restart the browser and log back in to Agent Desktop.

• Or, agents must open Agent Desktop in a separate browser window without any other tabs open and
never minimize the window. There is no issue if this browser window is in the background;

• Or, agents should use the Microsoft Internet Explorer 11 browser.

• Mozilla Firefox 58 introduced the Background Tabs Throttling feature that reduces the availability of CPU
cycles to 1% for web applications in tabs that are not currently in focus or if the browser is minimized.

This feature can cause an issue with WebRTC. If the tab running WebRTC does not have the focus
for a long time, Agent Desktop might drop the call and move the agent to the out of service state.
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Workarounds:

• Disable the feature in Firefox using the following procedure:
1. Enter about:config in the address bar and press Enter to open the Firefox application

preferences page.
2. Click I accept the risk! to dismiss the warning message.
3. Enter min_background_timeout_value in the search field to find this timer throttling option.
4. Edit the Value column to change the preference setting to 0.
5. Enter min_background_timeout_value_without_budget_throttling in the search field to find

this timer throttling option.
6. Edit the Value column to change the preference setting to 0.
7. Restart the browser and log back in to Agent Desktop.

• Or, agents must open Agent Desktop in a separate browser window without any other tabs open and
never minimize the window. There is no issue if this browser window is in the background;

• Or, agents should use the Chrome browser with the settings described above.

• Agent Desktop does not support Incognito Mode for Chrome version 83 and higher due to a security
feature introduced by Google.

• The contact search results for a given search criterion currently differ between Team Communicator and
Contact Directory.

• Workspace Agent Desktop does not support multiple simultaneous logins from the same agent account
in different browsers or browser tabs in a Production context.

• Agents cannot search on email address domains in the Contact Directory. Agents can only search on
whole email addresses.

• In Team Communicator, the tooltip for the Call button for internal calls displays the target agent ID
rather than the target DN.

• Agents cannot place calls to other agents who are not logged in, except by directly calling the
extension.
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Agent Setup
For information on later releases of Agent Setup, click here: Agent Setup

Note: The updates listed below might not apply to all environments.

• March 25, 2021 (9.0.000.82 UPDATE)
• March 4, 2021 (9.0.000.81)
• September 17, 2020 (9.0.000.78)
• August 11, 2020 (9.0.000.77)
• July 16, 2020 (9.0.000.75)
• May 14, 2020 (9.0.000.74)
• March 26, 2020 (9.0.000.73)
• November 7, 2019 (9.0.000.63)
• October 24, 2019 (9.0.000.62)
• September 26, 2019 (9.0.000.60)
• August 29, 2019 (9.0.000.56)
• August 1, 2019 (9.0.000.55)
• June 6, 2019 (9.0.000.51)
• May 23, 2019 (9.0.000.49)
• May 13, 2019 (9.0.000.48)
• May 2, 2019 (9.0.000.47)
• April 18, 2019 (9.0.000.46)
• April 4, 2019 (9.0.000.45)
• March 14, 2019 (9.0.000.41)
• February 28, 2019 (9.0.000.40)
• January 31, 2019 (9.0.000.38)
• January 17, 2019 (9.0.000.37)
• November 8, 2018 (9.0.000.31)
• October 25, 2018 (9.0.000.30)
• October 11, 2018 (9.0.000.28)
• September 27, 2018 (9.0.000.27)
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• September 13, 2018 (9.0.000.26)
• Archive

March 25, 2021 (9.0.000.82 UPDATE)

What's New

• Bulk Import now supports updating a username by using dbid as the primary key. This new support
enhances the user download feature with the ability to also download dbid when exporting all users.
(GAPI-26698)

• Introduced the following new option in the Email tab of the Desktop Options section:
• Allow Email Resend from History — Enables agents to re-send an email from the interaction

history. This option is dependent on the Contact option also being set in Desktop Options.
(GAPI-26278)

• Introduced the following new option in the Voice tab of the Desktop Options section:
• Allow Alert for Opt-out Recording — Alerts the agent that the current call is not being recorded

by a supervisor. (GAPI-26276)

• Introduced the following new option in the Interaction History Advanced Search tab of the Desktop
Options section:
• Allow Unanswered Outbound Call — When this option is true, an interaction is created in the

Universal Contact Server database, even if the outbound call is unanswered by the customer. This
option can be overridden by a routing strategy, as described in the Configuration Guide.
(GAPI-26274)

• It is now possible to create a statistic definition without mainMask by choosing the statistic category
ServiceFactor1. (GAPI-26152)

• The following improvements have been made to the Agent Setup UI for Favorites:
• A new Favorites Pool tab has been added to the Agent Desktop section. Through this new tab, you

can add, delete, and edit (change the name, type, and category) the global favorites available in
your Contact Center.

• The Global Favorites tab has been updated so that you can manage linked Favorites per level
(Contact Center, Agent Group, Agent, and Transaction).

• Other general enhancements:
• Improved the way the Favorite's "Attached Data" values are managed.
• Improved the way duplicate Favorites are detected.
• Improved the global checkbox logic after the data has been filtered.

(GAPI-23054)

• If using the latest version of Genesys Engage cloud Email powered by our Intelligent Workload
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Distribution (IWD) solution, you can find new instructions for setting up your email mailboxes in
Workload Manager in the IWD Administrator's Guide. If you are still using Email classic, setting up
your Email Server in Engage cloud is still done through the Email tab of the Desktop Options section.
No changes are required. (GAPI-28753)

March 4, 2021 (9.0.000.81)

What's New

• Agent Setup now allows migration of statistics without mainMask.
• Introduced the following new options in the Screen Pop tab of the Gplus Salesforce section:

• Screen Pop For Outbound Calls — Specifies whether the Adapter initiates screen pop in
Salesforce for outbound calls.

• Create New Salesforce Record on Screenpop — Specifies whether Gplus Adapter creates a new
Salesforce record on screenpop. Values include:
• None: No new Salesforce record is created
• No Matching Record: A new Salesforce record is created when a Salesforce search returns no

matching record
• Always: A new Salesforce record is created for every screenpop

• Salesforce Object API Name — Specifies the Salesforce custom object API name. To find the API
name, go to Salesforce Setup > Object Manager > Custom Object > Details > API Name.

• New Salesforce Record Field Mapping — Specifies the name of the configuration section where
the mapping is defined. In the section, each key must correspond to an interaction UserData key,
and each value must correspond to the name of the Salesforce standard or custom object field.

• Introduced the following new options for the Agent's WebRTC configuration in the Voice tab of the
Desktop Options section:
• WebRTC Polling Timeout — Specifies, in seconds, a period of time during which WebRTC library

waits for the response for a polling request.
• Expression to capture groups in GWS url — Specifies that Workspace should extract some part

of its url to capture some groups containing shared information among services, like the tenant or
the region.

• WebRTC Server URN — Specifies the URN that should be based on the following pattern:
WEBRTCGATEWAY_SERVER:WEBRTCGATEWAY_PORT?sip-proxy-address=
SIPPROXY_SERVER:SIPPROXY_PORT.

• Introduced the following new option in the General tab of the Gplus Salesforce section:
• Prevent Gplus in Browser Multitab — Specifies that Gplus Adapter will not work in multiple tabs.
• Notifications — Specifies whether Gplus Adapter displays notifications.

• All users (Agents, Administrators, and Supervisors) can now access Agent Setup however, read and
write access depends on the user's role.

• Agent Setup now provides the ability to configure external URLs at the workspace level and the
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interaction level in the External URLs tab of the Agent Desktop section.
• Introduced the following new options in the Activity Log tab of the Gplus Salesforce section:

• Auto Activity Log Association — Specifies the Salesforce criterion to use to associate the Activity
Log Task when the interaction is completed.

• UI Activity Log Association — Specifies whether Gplus Adapter displays the Object Association
table when the interaction is completed.

• Introduced the following new options in the Outbound tab in the Desktop Options section:
• Allow View for Fields on Outbound Records — Specifies if the agent can view the fields of the

outbound record in the interaction.
• Allow Update on Outbound Records — Specifies if the agent can update the fields of an

Outbound Record that are configured as editable.

• Introduced the following new options in the Contact tab of the Desktop Options section:
• Allow Check for Duplicate Contact — Enables workspace to alert agents when creating a

duplicate contact. This option can be overridden by a routing strategy as described in the
Configuration Guide.

• List of Contact Attributes for AND rule — Specifies the list of contact attributes, each of which
are added as an AND clause in the search query to retrieve potential duplicate contacts from UCS
during contact creation in Workspace.

• List of Contact Attributes for OR rule — Specifies the list of contact attributes, each of which
are added as an OR clause in the search query to retrieve potential duplicate contacts from UCS
during contact creation in Workspace.

• Allow Tree View for Threaded Interactions — Enables agents to swap the interaction display
format from grid view to tree view and inversely.

• Tree View - Contact History Displayed Columns — Specifies the list of interaction fields that are
displayed in the Contact History screen for tree view.

• Tree View - My History Displayed Columns — Specifies the list of interaction fields that are
displayed in the My History screen for tree view.

• Tree View - All Interactions Displayed Columns — Specifies the list of interaction fields that are
displayed in the Interaction Search screen for tree view.

• A new Desktop Views tab has been added under the Desktop Options section, providing sixteen new
options:
• Default view in Region NavigationBarRegion — Specifies, in precedence order, the view

selected by default in the Navigation Bar Region.
• Views order in Region NavigationBarRegion — Specifies the order (left to right, top to bottom)

in which the views are displayed in the Navigation Bar Region.
• Default view in Region ConnectRegion — Specifies, in precedence order, the view selected by

default in the Connect Region.
• Views order in Region ConnectRegion — Specifies the order (left to right, top to bottom) in

which the views are displayed in the Connect Region.
• Default view in Region MonitoringRegion — Specifies, in precedence order, the view selected

by default in the Monitoring Region.
• Views order in Region MonitoringRegion — Specifies the order (left to right, top to bottom) in

which the views are displayed in the Monitoring Region.
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• Default View In Region ContactRegion — Specifies, in precedence order, the view selected by
default in the Contact region.

• Views order in Region ContactRegion — Specifies the order (left to right, top to bottom) in
which the views are displayed in the Contact Region.

• Default view in Region HistoryInteractionDetailsRegion — Specifies, in precedence order, the
view selected by default in the History Interaction Details Region.

• Views order in Region HistoryInteractionDetailsRegion — Specifies the order (left to right, top
to bottom) in which the views are displayed in the History Interaction Details Region.

• Default view in Region CaseSideRegion — Specifies, in precedence order , the view selected by
default in the Case Side Region.

• Views order in Region CaseSideRegion — Specifies the order (left to right, top to bottom) in
which the views are displayed in the Case Side Region.

• Default view in Region InteractionDetailsRegion — Specifies, in precedence order, the view
selected by default in the Interaction Details Region.

• Views order in Region InteractionDetailsRegion — Specifies the order (left to right, top to
bottom) in which the views are displayed in the Interaction Details Region.

• Default view in Region WorkbinInteractionDetailsRegion — Specifies, in precedence order,
the view selected by default in the Workbin Interaction Details Region.

• Views order in Region WorkbinInteractionDetailsRegion — Specifies the order (left to right,
top to bottom) in which the views are displayed in the Workbin Interaction Details Region.

Resolved Issues

• Reconfigured the list of SIP Phone types available in the Users tab. SIP Phone types are now listed as:
• Disable CTI
• Genesys Softphone / Genesys 420HT / AudioCodes 4xxHD / Polycom
• Obsolete Genesys Softphone with embedded DTMF support
• Generic phone
• Genesys SoftPhone with WebRTC

For details on when to use each type, see SIP Phone Types.

(GAPI-26534)

• Introduced a new sorting functionality for Toast Data. (GAPI-25487)
• Fixed an issue with Bulk Import hanging during validation when an error in the data file is

encountered. Now Agent Setup automatically clears the data file and requires the user to re-select and
re-validate the data file once it's been corrected. (GAPI-25192)

• Changed the default Agent Setup mode in the backwardCompatibility option from v2(8.5) to v3(9.0).
(GAPI-25134)

• Fixed an issue in the Case Data where long Business Attribute names would not display in full in the
Select Business Attribute list. (GAPI-24073)
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• Added the ability to sort the names of all Dispositions alphabetically, in ascending or descending
order. (GAPI-15440)

• The User Role names are now renamed as the following:
• The "Agent" role is now called "Agent Desktop Agent"
• The "Supervisor" role is now called "Agent Desktop Supervisor"
• The "Admin" role is now called "Agent Setup Admin"

(GAPI-25927)

• The following functionalities are now accessible to all Users who have the required roles and
permissions set in Access Groups:
• Audit action
• Export action
• Delete User and Delete multiple Users actions
• Edit multiple Users action

(GAPI-25241)

• The .csv structure for an empty Annex field has now been changed to "Annex: <>". (GAPI-25193)
• Fixed an issue where, in certain instances, the Recording Hierarchy user interface was inadvertently

disabled. (GAPI-24489)
• The Enable Standard Response Library option's default value is changed to false in the v3(9.0)

version. (GAPI-23896)
• The Skills user interface is updated to now properly reflect the latest changes made by the user.

(GAPI-23638)
• Fixed an issue where the Business Attribute (BA) folder displayed incorrectly. Previously, if a child

folder and a BA had the same ID in the parent folder, the folder's BA list would generate incorrectly in
the UI. (GAPI-23419)

• Fixed an issue where Corporate Favorites could not be added to Agent Groups unless one corporate
favorite had first been added through the Platform Administration. (GAPI-23243)

September 17, 2020 (9.0.000.78)

What's New

• Introduced the following new option in the Outbound tab of the Desktop Options section:
• Outbound Treatment on Reschedule — Specifies the list of disposition codes that can be set for

an outbound interaction, enabling the Outbound Contact Server to receive outbound treatment for
campaign records marked as Done, after a reschedule.

• Introduced the following new options in the Contact tab of the Desktop Options section:

Agent Setup

Genesys Engage cloud Release Note 57



• Allow Contact Interactions to be Open from Queue — Enables agents to open in-progress
interactions from their workbin history.

• Allow Contact Interactions to be Open from Personal Workbins — Enables agents to open in-
progress interactions that are in another agent's workbin history.

• Allow Contact Interactions Workflow State — Enables the use of the interaction workflow state
in an interaction's details.

• Introduced the following new options in the Voice tab of the Desktop Options section:
• Voice SIP Preview Ringtone Type — Allows the selection of a ringtone type from the default tone

types.
• Voice SIP Preview Ringtone Priority — Specifies Voice SIP ringing priority between different

channels.
• Voice SIP Preview Ringtone Duration — Specifies the Voice SIP preview duration.
• SIP Preview Interactions — Specifies the path of the sound file that plays when the SIP Preview is

ringing.

• Introduced the following new option in the Standard Response Library tab of the Desktop Options
section:
• Enable favorite standard response — Enables agents to use favorites for standard responses.

These changes take effect after the next platform configuration refresh interval.

• Introduced the following new option in the Activity Log tab of the Gplus Salesforce section:
• Activity Log Field Mapping — Specifies the name of the configuration section where the mapping

is defined.

Resolved Issues

• Only users with sufficient view permissions (administrator or supervisor) are able to login into the Agent
Setup UI. (GAPI-22834)

• Fixed an issue where the Edit Transaction page did not display the required configuration information
when opened in a new tab. (GAPI-22530)

• Fixed an issue where the Category field was incorrectly made mandatory when creating a Global
Favorite. (GAPI-20619)

August 11, 2020 (9.0.000.77)

What's New

• The user browser cache is automatically refreshed when Agent Setup is upgraded
• Introduced the following new option in the Screen Pop tab of the Gplus Adapter for Salesforce

section:
• Screen Pop on Outbound Email Create — Specifies whether the adapter initiates a screen pop in

Salesforce immediately after creating an email.
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• You can now disable and enable agent groups and virtual agent groups with the State setting in the
Agent Group view.

• The UI for the Users > User > Access Groups page was redesigned to make it easier to use.
• Agent Setup has improved the Users > User view with the following enhancements:

• Search based on skill and agent groups from the user sidebar.
• A tool-tip for the sidebar sections was added.
• Switch information was removed.

• Edit User improvements:
• Added a new Save button that saves the changes and stays on the Edit User screen.
• Renamed the Update button to Save and Close. Click this button to save your changes and return

to the agent list.

• Agent Setup now supports inserting standard responses using a short keyword. Use the following
options on the Desktop Options > Standard Responses page to configure this feature:
• Standard Response Shortcuts.<keyword> - The template option you can clone to specify the

association between a keyword and a standard response defined in Knowledge.
• Shortcuts Prefix - Specifies a prefix to identify a keyword associated with a standard response.
• Use Shortcuts filter - Enables an agent to filter Standard Responses in the Standard Responses

tree view to show only those with shortcuts.

Resolved Issues

• The Add Statistic window for Agent Statistics now includes all statistics objects in the list of available
statistics. (GAPI-22048)

• Agent Setup no longer deletes the interaction-workpace section configuration when you delete all
External URLs for an Agent Group. (GAPI-22018)

• The Mailbox Name field now supports the "@", "_", and "." special characters. (GAPI-21772)
• The From Addresses option now uses the emailAddress Business Attribute as a value.(GAPI-21506)

July 16, 2020 (9.0.000.75)

What's New
Desktop Options

• Improved the Standard Response options view by adding new field labels.

Gplus Salesforce Options

• Introduced the following new options in the General tab of the Gplus Salesforce section:
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• Run Salesforce Apex on Interaction Events — Specifies the interaction event which triggers
Salesforce Apex to run.

• Apex Class Name — Configures the name for a Salesforce custom apex class.
• Salesforce Message Channel Name for Service Client API — Specifies the name of the

message channel in Salesforce for Service Client API.

• Introduced the following new options in the Activity Log tab of the Gplus Salesforce section:
• Chat Include Transcript in Description — Specifies whether the adapter saves the chat

transcript, as part of the activity description in Salesforce.
• Chat Transcript Custom Field Name — Specifies the name of a custom activity field in

Salesforce.

Audit Trail

• Introduced a new Download Audit Data button, enabling Agent Setup to support the ability to export
audit logs.

May 14, 2020 (9.0.000.74)

What's New
SAML Configuration

• Agent Setup now supports configuration for SAML HTTP Redirect.

Resolved Issues

• The following Bulk Import issues are now fixed:
• The CSV file import now supports a place name in the “Default place" field. (GAPI-20165)
• Bulk Import now permits the "+" symbol in the extension number field. (GAPI-19996)
• Bulk Import now permits the "'@" symbol in the "Places" field, and the "?" symbol in the "Annex"

field. (GAPI-20229)

• Now SAML can be enabled without first uploading any IdP-metadata into the "Region Name" field.
(GAPI-19510)

• The "Export" functionality has been optimized to take less time and resources for data collection.
(GAPI-19092)
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March 26, 2020 (9.0.000.73)

What's New
CRM Adapter

• The following Salesforce options have been added for the CRM Adapter:
• Salesforce Object Type
• Salesforce Object Name
• Salesforce Object Key
• Keep Alive Sync
• Salesforce Activity Log Status
• Open Media Activity Log

• The following Screen Pop options have been added for the CRM Adapter:
• Screen Pop on Open Media Invite

Desktop Options

• The following options have been added to the Global Login section in the Desktop Options:
• Invalidate Auth SSO session on Workspace logout—When this option is selected, the Auth SSO

session along with the Agent Desktop session is invalidated when an agent logs out of the
Workspace Agent Desktop. When this option is cleared, only the Agent Desktop session is removed
and the GWS Auth SSO session is kept alive.

• Show Change Account Link—Specifies whether or not to display the "Change login account" link
on the login error page and the second step login page. This option is not used when the "Invalidate
Auth SSO session on Workspace logout" option is selected.

• The following option has been added to the Voice Options section in the Desktop Options:
• Two-Step Voice Conference—Enables two-step voice conferencing.

Renamed Menu Items

• Menu items have been renamed from "CRM Adapter" to "Gplus Salesforce" for better alignment of
functionality. A new "General" tab under the "Gplus Salesforce" section includes Salesforce Click-to-Dial
Preprocessing Rules, Salesforce Object Type, Salesforce Object Name, Salesforce Object Key, and Keep
Alive Sync. A new "Activity Log" tab includes all items from the current Salesforce tab except as listed
above.

Contact Center Settings

• The following option has been added to the Screen Pop tab in the Gplus Salesforce section:
• Use DNIS in Screen Pop Search—Specifies whether the screen pop search uses the DNIS.

• The following option has been added to the Activity Log tab in the Gplus Salesforce section:
• Activity Log on Screen Pop—When a screen pop occurs on inbound or external calls, specifies
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whether the adapter creates an activity in Salesforce and modifies the logged activity when the
interaction is marked done.

Chrome v80+ SameSite Cookie Support

• The Chrome v80+ SameSite cookie attribute processing changes are now supported by Agent Setup.

New Screen Pop Object Types

• Gplus Adapter for Salesforce now supports the following object types for screen pop:
• SOBJECT
• URL
• OBJECTHOME
• LIST
• SEARCH
• NEW_RECORD_MODAL
• FLOW

Resolved Issues

• The "Action Search" filter on the Audit Trail page now functions as expected. Previously, the search
result also included the records that contained the action keyword in the message text. (GAPI-18200).

• The value of the "Interaction ID" attribute has been changed from "Id" to "id" for the All Interactions
Displayed Columns option. (GAPI-18570)

• Before applying new SAML settings, Agent Setup now cleans up the corresponding old ones. Previously,
outdated settings could cause outages. (GAPI-18399)

• Agent Setup now delays refreshing SAML settings until all data is fully replicated to secondary regions.
(GAPI-18361)

• On the Agent Groups > Custom Agent States tab, you can now set an empty value for the After
Call Work and Not Ready options. (GAPI-16946)

• Agent Setup now lets you:
• Create a custom business attribute of type "Email Address" and manage its values.
• Select any previously created custom business attribute as the Root Business Attribute.
• Set the email.from-addresses option to the values present in the custom business attribute of

type "Email Address" that is selected as the Root Business Attribute.

(GAPI-17552)
• The default value for the following options has changed to None.

• Chat Message Ringtone Type
• Chat Message Sound Priority
• Chat Message Sound Duration
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• Chat Interaction Ringtone Duration
• Chat Interaction Ringtone Priority
• Chat Interaction Ringtone Type

(GAPI-17812)
• Import of the Time for Statistics Reset option now functions as expected. Previously, a bulk import of

this option resulted in an incompatibility error. (GAPI-17809)
• Statistics creation for Agent Desktop V.9 now behaves as follows:

• The notificationFrequency option default value is equal to 60.
• The notificationMode option with the Periodical value is created.
• The empty parameters and extensions options are not created.

(GAPI-17681)
• When creating a new agent, you can now enable the Multimedia Agent option. Previously, this option

was disabled until after the agent account was created and saved. (GAPI-17463)
• When defining Favorites, you can now use spaces in attached data keys. (GAPI-17383)
• The User Search by Skills filter now functions as expected. Previously, the filter would not work when

using an Internet Explorer browser. (GAPI-17321)
• Field labels on the SAML Single-Sign-On (SSO) configuration page in Agent Setup have been updated.

Refer to the Enable Single-Sign On page for more information. (GAPI-17299)
• The Agent Group Supervisor dropdown list is now correctly updated after a change is made. Previously,

an Agent Setup caching issue resulted in unsaved changes. (GAPI-17262)
• A user no longer receives a misconfiguration error when the Genesys Softphone with WebRTC option is

enabled. Previously, when this option was enabled, Agent Setup incorrectly enabled two conflicting
options, resulting in the misconfiguration error. (GAPI-17206)

• Users can no longer switch between tabs when Agent Setup is disconnected from the server.
(GAPI-16964)

• Agent Setup now displays an error message when a user lacks the necessary permissions to perform a
specific bulk import operation, such as a directory update. Previously, the import would begin and then
freeze, without indicating an error. (GAPI-15395)

• The "Transactions" page now supports pagination. (GAPI-4649)
• Audit logs now record SAML settings changes. (GAPI-11119).
• Agent Setup now removes workspace.web-content and interaction.web-content options when all

corresponding External URLs are deleted. (GAPI-18822)
• Agent Setup now properly displays only the last search request result when utilizing the search field

from the User tab. (GAPI-19186)
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November 7, 2019 (9.0.000.63)

What's New
Resolved Issues

• Agent Setup now supports pagination for the Single Sign-on -> SAML -> Access Groups drop-down
menu. This eliminates the need to scroll through a long list of Access Groups when configuring SAML.
(GAPI-16247)

• On the Audit screen, the To Date Search field in the Search section now defaults to Now, meaning the
current date and time. (GAPI-16851)

• On the Agent Groups -> Agents tab, when you search for an agent, the agent's username now appears
next to the agent's first and last name in the search results. Previously, only the agent's first and last
name appeared in the search results.(GAPI-16852)

October 24, 2019 (9.0.000.62)

What's New
Capacity Rules

• Agent Setup now supports Capacity Rules. Capacity Rules allow you to define an agent’s ability to
handle multiple interactions concurrently for different channels. When those limits are reached, the
agent stops receiving calls/interactions. Refer to the Capacity Rules page in the Agent Setup Help
manual for more information.

External URL templates

• The following option has been added to the External URLs configuration templates to enable the use of
attached data values in labels or URLs:
• $AttachData.KVPName$

WebRTC options

• The following options have been added to the Genesys Softphone section of Agent Setup:
• Can Use WebRTC - Enables WebRTC in Workspace. Depends on 'Voice - Can Use Voice Channel'.
• Can change speaker volume - Allows an agent to change speaker volume. Depends on 'Voice - Can

Use Voice Channel' and 'WebRTC - Can Use WebRTC'.
• Can mute microphone - Allows an agent to mute and unmute the microphone. Depends on 'Voice -

Can Use Voice Channel' and 'WebRTC - Can Use WebRTC'.
• Can mute speaker - Specifies if DTMF is available for WebRTC calls. Depends on 'Voice - Can Use

Voice Channel' and 'WebRTC - Can Use WebRTC'.
• Can send DTMF- Specifies if DTMF is available for WebRTC calls. Depends on 'Voice - Can Use Voice
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Channel' and 'WebRTC - Can Use WebRTC'.
• Quality request interval - Specifies the voice channel ringing sound-configuration string. It consist of

three options:
• WebRTC Ringtone Type - Set WebRTC call ringing sound. Depends on 'Voice - Can Use Voice

Channel' and 'WebRTC - Can Use WebRTC'.
• WebRTC Ringtone Priority - Set WebRTC call ringing priority between different channels. Depends

on 'Voice - Can Use Voice Channel' and 'WebRTC - Can Use WebRTC'.
• WebRTC Ringtone Duration - Set WebRTC call ringing duration. Depends on 'Voice - Can Use

Voice Channel' and 'WebRTC - Can Use WebRTC'.

Resolved Issues

• You can no longer define a Skill level while creating or editing a Person template if you don't select that
particular Skill. Previously, you could define a level for a Skill that wasn't selected for the template.
(GAPI-16395)

• The Audit Trail screen in Agent Setup now includes a Refresh Logs option. (GAPI-16374)
• For Corporate Favorites, the attached data key now supports the <","> characters. (GAPI-16370)
• The option to assign a supervisor to a virtual agent group has been removed from the Agent Setup

application because this option is not supported. (GAPI-16191)
• Agent Setup no longer throws an error when a supervisor is added to an agent group. (GAPI-16165)
• Agent Setup now correctly applies changes made to the Agent Page Limit and Agent Page Refresh

settings. Previously, Agent Setup did not honor any updates made to these settings. (GAPI-16101)
• On the Users tab > Advanced Search, the State field no longer contains the Valid and Not Valid options

because Agent Setup has disabled client side caching. (GAPI-15868)
• Agent Setup users can now set an empty value in the Business Attributes option for Agent Desktop.

Previously, Agent Setup did not support this behavior. (GAPI-15823)
• The following issues with Bulk Import have been resolved:

• Bulk Import now supports the @ symbol in a user's name.
• Errors now contain more descriptive error messages. (GAPI-14580)

• On the Users tab, the Advanced Search filters are now presented as dropdown menus, allowing for
multiple selections. (GAPI-13462)

• The following issues with External URLs have been resolved:
• Agent Setup no longer throws an error when you try to create multiple External URLs using the same

URL yet different labels.
• Agent Setup now correctly identifies the mode being used for the External URL – INTERNAL,

EXTERNAL, BACKGROUND, or HIDDEN. (GAPI-11806)

• A new Add button has been added to the Agent Groups -> Agents tab to allow you to manually assign
one or more agents to the agent group. (GAPI-11664)

• Improvements have been made to the Audit Trail information collection process. (GAPI-15133)
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September 26, 2019 (9.0.000.60)

What's New
Agent Desktop V.9 support

• The Timed Preview Auto Dial option for Agent Desktop is now available in the Outbound section of
Agent Setup. This option specifies the method in which calls are dialed for agents in Preview, Push
Preview, or Reschedule campaigns.The options are as follows:
• The agent can manually dial a record.
• The record is auto-dialed as soon as the record is accepted.
• The record is auto-dialed after a specified number of seconds.

This option can be set at the Contact Center, Agent Group, and User level.

Resolved Issues

• Agent Desktop options can now contain a blank Value field. Previously, the Value field could not be
blank if a default value was defined.(GAPI-15920)

• Mailbox sorting and pagination issues have been resolved. Previously, mailbox entries did not display in
alphabetical order, and the scroll bar was out of view. (GAPI-15754)

• Updates have been made to confirmation windows for operations related to deleting and unassigning
Favorites. (GAPI-15715)

• A bulk import CSV file can now contain both an Agent account and an Admin account. (GAPI-15625)
• Stability improvements have been made to the agent export functionality. (GAPI-15436)
• Agent Setup no longer deletes Agent Desktop options that contain blank Value fields. (GAPI-15384)
• TheMy Team Workbins and Access to Interaction Management options no longer depend on

theWorkitem channel. Previously, the Workitem channel had to be enabled in order to access the My
Team Workbins and Access to Interaction Management options. (GAPI-15349)

• Display and navigation issues on the Skills tab have been corrected (GAPI-14884)
• The following option has been deprecated:

• Voice Forward (GAPI-14420)

• The Email Address Regular Expression option has been added to the Email section of Agent Setup.
This option can be set at the Contact Center, Agent Group, and User level. (GAPI-14189)

• SAML can no longer be enabled in Agent Setup if SAML configuration is incomplete. (GAPI-13897)
• When you modify a Standard Response' option for Agent Desktop, the confirmation window now

includes the standard response prefix with the name of the option being modified (GAPI-13039)
• Agent Setup no longer requires a minimum browser width of 1280 pixels to view all onscreen elements

in a single view (GAPI-12837)
• For bulk exports, you can now view the number of users being exported. (GAPI-12448)
• The Team Communicator Exclude from Groups option has been added to the Global Login section
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of Agent Setup. When you enable this option, the agents from excluded groups are not visible in Team
Communicator, Favorites, or Statistics. (GAPI-11772)

• When you modify an agent group (for example, add or remove agents; create, modify, or delete
business attributes; update desktop options), a new confirmation dialog window appears with a
summary of the changes. (GAPI-11663)

• Agent Setup no longer throws an error when you use bulk import to create a virtual agent group for a
chat virtual queue. (GAPI-7056)

• Agent Setup now returns an error if a user attempts to perform a bulk import without the required
permissions. (GAPI-5847)

• In the Audit Trail, the UPDATED action now reports on the following activity related to agent groups:
• The name of the user added to an agent group.
• The name of the user who made the update. (GAPI-15546)

August 29, 2019 (9.0.000.56)

What's New
Resolved Issues

• Scripts are no longer removed when a Group Favorite is added to a Virtual Agent Group. (GAPI-14725)
• The Chat timer tracking the response time to a customer comment now works correctly. (GAPI-15053)

August 1, 2019 (9.0.000.55)

What's New
Resolved Issues

• You can now include spaces in the First Name or Last Name fields when importing. Previously, spaces in
these fields caused an error during imports. (GAPI-14815)

• Audit events now display in the local time zone. (GAPI-14166)
• You can now save more than one URL on the Screen Recording Server. (GAPI-13977)
• Voicemail numbers are now updating correctly. (GAPI-13839)
• Using the "'Export All"' option in the Users tab no longer duplicates users in the exported XML file.

(GAPI-12318)
• You can now unassign skills using the /d option in the skill field during an import. Previously, skills were

not removed when using the /d option. (GAPI-13870)
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• You can now include spaces in the folder name during an import. Previously, spaces in the folder name
caused an error during imports. (GAPI-14448)

• The reset time for statistic definition now saves correctly. (GAPI-14203)

June 6, 2019 (9.0.000.51)

What's New
Agent Desktop V.9 support

• Auto-focus options on inbound interactions for the new Agent Desktop are now available among the
Global Login options in the Contact Center Settings, Agent Groups and Users sections.

• Agent Setup now supports the configuration of Voicemail options for the new Agent Desktop.

Resolved Issues

• The "Time for Statistics Reset" option has been moved from the Global Login section to the Statistics
section in Desktop Options. (GAPI-13587)

• The Bulk Import page now times out when the page is inactive, except during an active import session.
(GAPI-12800)

• Audit messages are improved for better readability. (GAPI-12765)
• Audit now displays changes made to Agent Groups and the affected users. (GAPI-11919)

May 23, 2019 (9.0.000.49)

What's New
Agent Desktop V.9 support

• A Voice option allowing calls to be released while they are on hold is now available for the new Agent
Desktop in the Contact Center Settings, Agent Groups and Users sections.

Genesys Altocloud support

• Altocloud can now be enabled as a Channel and its options can be set in the Contact Center Settings,
Agent Groups and Users sections.

• The Altocloud user privilege is now available as an export and import column.
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Resolved Issues

• When removing an extension from an agent's profile, you now have the option to keep the extension for
other users or delete the extension from the system. (GAPI-12240)

May 13, 2019 (9.0.000.48)

What's New
Resolved Issues

• A third-party component is updated to improve security within the session-handling mechanism.
(GAPI-11984)

May 2, 2019 (9.0.000.47)

What's New
Single Sign-On

• Single Sign-On configuration for SAML is now available.

Agent Desktop V.9 support

• Outbound options for the new Agent Desktop are now available in the Contact Center Settings, Agent
Groups and Users sections.

• Email options for the new Agent Desktop are now available in the Contact Center Settings, Agent
Groups and Users sections. These options include:
• Click to Dial from email
• Delete email
• Move to Workbin
• Reply and Reply All to email
• Save and send email
• Add attachments to email
• Enable and toggle HTML formatting

• The following new options for Supervisors are now available for the new Agent Desktop in Contact
Center Settings, Agent Groups and Users section:
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• Allow Supervisor access to interaction management
• Allow Supervisor to move interactions to workbin
• Allow Supervisor to move interactions to queue
• Allow Supervisor to see workbins for their agents

Resolved Issues

• The Allow Reject Call option is deprecated, because Reject Call is no longer supported. (GAPI-13015)
• When deleting shared favorites, a confirmation is now displayed. (GAPI-12490)
• Attached data for Favorites exceeding column widths are no longer cut off. (GAPI-12487)

April 18, 2019 (9.0.000.46)

What's New
Agent Desktop V.9 support

• Chat options for the new Agent Desktop are now available in the Contact Center Settings, Agent Groups
and Users sections. These options include:
• One-step transfer
• Auto-disconnect
• On-hold Queue
• Warning time
• Decline
• URL push
• Interaction disposition

• Facebook can now be enabled as a Channel and its options can be set in the Contact Center Settings,
Agent Groups and Users sections.

• Twitter can now be enabled as a Channel and its options can be set in the Contact Center Settings,
Agent Groups and Users sections.

• Workitems can now be enabled as a Channel and its options can be set in the Contact Center Settings,
Agent Groups and Users sections.

• Options to handle Workitems for Genesys Task Routing are now available in the Contact Center Settings,
Agent Groups and Users sections.

• Options to enable Performance Tracker and Dashboard, as well as manage the Sidebar Region, for the
new Agent Desktop are now available through Global Login in the Contact Center Settings, Agent
Groups and Users sections.
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Resolved Issues

• Audit Trail now tracks changes to the Desktop Options, CRM Adapter, and Recording sections.
(GAPI-11065)

April 4, 2019 (9.0.000.45)

What's New
Export enhancement

• Export files now only list skills with values equal to zero or greater.

Resolved Issues

• A cache update message is now displayed in the application bar when updating a User's skills.
(GAPI-12083)

• Skill names no longer cut off when exceeding 38 characters. (GAPI-11972)
• The application screen now resizes correctly with all browsers. (GAPI-11963)
• Usernames containing (') now display correctly. (GAPI-11962)
• The Audit section is now correctly updating. (GAPI-11869)
• Agent Setup no longer redirects to Contact Center Settings after saving edited User profiles.

(GAPI-11494)

March 14, 2019 (9.0.000.41)

What's New
Skill levels

• A skill level can now be entered when adding a new skill to an Agent.

Agent Groups

• An Agent Group with one or more agents assigned to it can no longer be deleted. You must unassign all
agents from the Agent Group before deletion.

Resolved Issues

• When the Service Client option for "Auto Login" is selected, the agent is placed in their earlier login
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state if they are unexpectedly logged out. (GAPI-11748)
• A Digital Management menu is now available for Email Server Mailbox configurations. Mailbox options

now allow predefined values for mailbox servers and security protocols. (GAPI-10730)
• Passwords for mailboxes now update correctly when saved. (GAPI-9813)

February 28, 2019 (9.0.000.40)

What's New
Audit Trail

• The Audit Trail allows you to track user changes made in the application, such as logins, logouts,
created accounts, deletions, updates, and imports.

For more information, see the Audit Trail documentation.

Resolved Issues

• When using the Advanced filter while searching for users, the correct results are now displayed.
(GAPI-11211, GAPI-11283, GAPI-11304, GAPI-11190)

• The table in the Users section now resizes properly when the web browser is reduced. (GAPI-9895)
• The login page now shows "Agent Setup" as the application name. (GAPI-11201)
• Session authentication now provides protection against login conflicts with an additional verification to

ensure users belong to the correct tenant. (GAPI-11593, GAPI-11558)

January 31, 2019 (9.0.000.38)

What's New
Resolved Issues

• Assigned skills are now visible when editing a user. (GAPI-11017 )
• An error message is now presented to unauthorized users when they attempt to access Agent Setup.

(GAPI-10131)
• Agent Setup is once again compatible with Internet Explorer 11. (GAPI- 11002)
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January 17, 2019 (9.0.000.37)

What's New
Remove objects during import

• Use the new /r option to unassign phone numbers, places, and default places from user accounts during
a bulk import. These objects are not deleted from the environment.

From email addresses

• You can now configure additional From email addresses for agents to use in Agent Desktop.

DN Groups

• You can now create DN Groups for Virtual Queues and Route Points through the Routing Manager menu.

November 8, 2018 (9.0.000.31)

What's New
Application timeout

• Application timeout has been introduced to log off users after 15 minutes of inactivity.

Menu condensed

• You can now expand and collapse the left-side option menu in the Contact Center Settings, Agent
Groups, and Users sections.

Resolved Issues

• Issues causing Agent Setup to be unresponsive have been resolved. (GAPI-9464)

October 25, 2018 (9.0.000.30)

What's New
Team Communicator

• The include and exclude drop-down lists of Agent Groups for Team Communicator now include Virtual

Agent Setup

Genesys Engage cloud Release Note 73



Agent Groups.

Resolved Issues

• Agent Groups are now displayed in the quick-view panel in the Users section. (GAPI-8585)
• The Genesys Softphone options Use Headset and URI are now available at the Contact Center Settings,

Agent Groups, and Users levels. (GAPI-8581)

October 11, 2018 (9.0.000.28)

What's New

• External URLs can now be configured at the Agent Group and User levels.
• Service Client API options for Agent Desktop can now be set at the Contact Center Settings, Agent

Group, and User levels.
• Genesys Softphone with Web-RTC can now be provisioned for users.

Resolved Issues

• Agent Setup's performance is now improved when exporting a large amount of user records.
(GAPI-8626)

• Agent Setup no longer truncates External URLs when you paste them into the entry field. (GAPI-8731)

September 27, 2018 (9.0.000.27)

What's New
Genesys Email

• You can now configure email mailboxes using Genesys Email.

Resolved Issues

• Supervisors can now log in to Agent Setup. (GAPI-8518)
• Setting the Reset Password flag now properly prompts the user to change the password the next time

the user logs in. (GAPI-7620)
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September 13, 2018 (9.0.000.26)

What's New
User interface

• The user interface has changed to reflect Genesys Corporate UX standards, including the following:
• The login page has been changed to the new corporate application page.
• The navigation bar logo has been changed from white to Genesys red.
• The navigation bar active item color has been changed from blue to Genesys red.
• The fonts and color palette has changed for buttons, tables and alerts.

Voice options

• The following options are now available at the Contact Center Settings, Agent Groups and Users levels:
• Allow Reject Call
• Show Post Call Duration
• Show Hold Indication Timer
• Allow Pending State in My Channel

CRM Adapter

• The following options have been deprecated from the CRM Adapter section:
• CRM Adapter Provisioning
• CRM Adapter Interaction
• Voice and Chat Track Agent's Navigation

Resolved Issues

• When removing an Agent Group from a user's profile, the warning message has been improved to say
remove instead of delete. (GAPI-7182)

Archive
[+] Click to show archived release notes
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August 30, 2018 (9.0.000.25)

What's New
Salesforce templates

• If you use templates for Salesforce activity, you can now set template options in the CRM Adapter
section, under Salesforce Options.

Resolved Issues

• Agent Setup only supports external URLs with HTTPS. Previously, the example URL in the External URLs
field displayed HTTP. (GAPI-8060)

• Agent details now correctly display in the Users section. (GAPI-7619)
• Attached Data no longer disappears when being added with Favorites. (GAPI-7030)
• If you incorrectly set an option in Contact Center Settings, the error message now identifies which

option is not properly set. (GAPI-4348)
• When importing an existing password fails, the error message now displays the actual error shown in

the logs. Previously, the error message did not explain why the import failed. (GAPI-3831)

August 2, 2018 (9.0.000.23)

What's New
Resolved Issues

• When changing data on an Edit User page, the Revert button performs as expected. Previously, the
Revert button did not reverse the changes. (GAPI-7275)

• The informational modal shown in External URLs now correctly identifies your operations when creating
a new entry. Previously, the modal displayed an extra delete operation. (GAPI-7192)

• Skills now display correctly with their folders. Previously, Skills for different folders displayed as single
records. (GAPI-6889)

• When creating a folder on the Dispositions page of Contact Center Settings, Agent Setup no longer
stops working. (GAPI-6834)

• The application loading progress now displays in the Main Navigation Bar. (GAPI-6178)
• Agent Setup no longer stops working when saving edits to Users with Skills from the Special Access

folder. (GAPI-7246)
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July 19, 2018 (9.0.000.22)

What's New
Bulk Import contacts

• You can now import contact records using the Bulk Import page under Data Tools. Imported records are
now accessible in the Contact Directory section of Agent Desktop.

Resolved Issues

• The load time for Agent Setup as been significantly improved. (GAPI-7064)
• An error message is no longer displayed when Capacity Rule is set to an empty value. (GAPI-7217)
• When creating Statistical Types, the Display Name field now shows the correct value. Previously, the

Statistical Type was created without the Display Name. (GAPI-7212)
• The Add URLs button now shows properly in the External URLs section. (GAPI-7137)
• The Agent Channels field menu in the Supervisor section now shows values. (GAPI-7127)
• The editing of skill level fields no longer results in an error message. (GAPI-7096)
• Required Statistical Type fields now show as mandatory. (GAPI-6995)
• You can now set the Wrap Up Time for hot desk agents. (GAPI-6952)
• Attached Data is now correctly formatted in the Templates menu for External URLs. (GAPI-6936)
• When creating a Standard Response, lengthy values no longer overflow on the screen. (GAPI-6851)
• The Skills section for Users now displays in a table view, and includes the Skill level. (GAPI-6842)
• The Capacity Rule field on the Users page has been moved down on the page and properly aligned.

Previously, it was shown at the top of the right column of the add or edit user view. (GAPI-6668)

July 5, 2018 (9.0.000.21)

What's New
Resolved Issues

• Toast alerts were corrected and updated. (GAPI-4163, GAPI-4525, GAPI-4563, GAPI-4565)
• Changes made in Case Data under Contact Center Settings now save correctly. (GAPI-6483)
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June 21, 2018 (9.0.000.19)

What's New
Capacity Rules

• Capacity Rule can now be chosen as an import value when using Bulk Import.
• Capacity Rule can now be chosen as an export value when using bulk export on the Users tab.
• Capacity Rules can now be assigned to individual users.

Skills

• The list of skills assigned to an agent now display in a tree structure flowing from their assigned folders.

Resolved Issues

• Validation during a Bulk Import now correctly identifies if an Employee ID is linked to another user.
Previously, the validation error stated the "person already exists" instead of the "EmployeeId exists."
(GAPI-6088)

June 7, 2018 (9.0.000.18)

What's New
Resolved Issues

• The progress bar for bulk uploads now tracks each step of an import and provides the overall progress
as a percentage. The number of completed records also displays on screen when the import is finished.
(GAPI-4441)

• Changes made in Case Data under Contact Center Settings now save correctly. (GAPI-6483)

May 24, 2018 (9.0.000.17)

What's New
Resolved Issues

• The Application Menu has been reordered to show Contact Center Settings as the first menu item. This
change was made to shorten the application load time. (GAPI-5572)
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• You can now create a default Agent's role during an import. (GAPI-5677)
• You can now create Global Favorites with @ characters for Route Points. Previously, the application did

not accept anything after the @ character. (GAPI-5167)
• The Save button now functions as expected on all pages. Previously, it was missing on some pages and

any changes made on those pages were saved automatically. (GAPI-2525)

May 10, 2018 (9.0.000.16)

What's New
Routing Manager

• You can now view and filter a list of your Routing Points and Virtual Queues with the Routing Manager
menu in Contact Center Settings. The Alias name for each line can also be changed as needed.

Resolved Issues

• Bulk Import is now working correctly. Previously, the import process stalled prior to completion.
(GAPI-4376, GAPI-4870)

April 26, 2018 (9.0.000.15)

What's New
One Step Transfer for Chat

• The option to enable One Step Transfer for Chat in Agent Desktop is now available at the Contact Center
Settings, Agent Groups or Agent levels.

Statistics

• You can now configure options for Display Statistics on the Agent Desktop Menu Bar at the Contact
Center Settings or Agent Groups levels. The following fields are available for this feature: Default
Statistics displayed, Refresh Time, and Maximum quantity of Gadget Statistics displayed.

After Call Work

• You can now extend After Call Work time to an indefinite value for Agent Desktop at the Contact Center
Settings, Agent Groups or Agent levels.
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Resolved Issues

• Bulk Export is now working properly. Previously, the export didn't include all records. (GAPI-4530)

April 12, 2018 (9.0.000.14)

What's New
Contact History notepad

• You can now enable Contact History notepad for Agent Desktop at the Contact Center Settings, Agent
Groups or Agent levels.

Resolved Issues

• Agent Setup now loads properly. Previously, the application continually spun without loading.
(GAPI-4950)

March 29, 2018 (9.0.000.12)

What's New
Voice Quality Alarm

• You can now enable Voice Quality Alarm for Genesys Softphone.

Resolved Issues

• You can now set a Routing Point for Skill Based Transfer. (GAPI-3880)

March 8, 2018 (9.0.000.09)

What's New
Screenpops

• Screenpops for chat or email invites can now be configured at the Contact Center Settings, Agent
Group, or Agent levels.
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• You can now enable screenpops for consults through CRM Adapter's Screenpop section at the Contact
Center Settings, Agent Groups or Agent levels.

Standard Response quick search

• The option to enable Can Do Quick Search for the Standard Response Library is now available at the
Contact Center Settings and Agent Group levels.

Agent groups

• The option to include agent groups in Team Communicator can be configured at the Contact Center
Settings, Agent Group, or Agent levels.

Resolved Issues

• Agent Setup is now supported through Internet Explorer. (GAPI-4313)
• Bulk Imports no longer cause an error when uploading files. (GAPI-4438)
• Updating an agent no longer removes the agent's loginID. (GAPI-4381)
• Desktop Options now load correctly. (GAPI-4449)

February 8, 2018 (9.0.000.07)

What's New
Field Code option

• The Field Code option for Standard Response is now available for configuration at the Contact Center,
Agent Group or Agent levels.

Interaction search

• The Interaction search option for Agent Desktop can now be turned on or off at the Contact Center,
Agent Group, and Agent levels.

Email options

• Email management options for Agent Desktop can now be turned on or off at the Contact Center, Agent
Group, or Agent levels. The options are:
• A list of Cc addresses on forwarding email
• Instructions for forwarding email
• A list of multiple To addresses for forwarding email
• The max size of each attachment with a value range from minimum of 1MB to a maximum of 20MB

Recording controls
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• Recording controls for pause, resume, start, and stop recording can now be enabled or disabled at the
Contact Center, Agent Group, or Agent levels.

Pending state

• The Pending Agent State option is now available to turn on or off at the Contact Center, Agent Group, or
Agent levels.

Channel Transfers

• The option to enable or disable one-step email transfer is now available at the Contact Center, Agent
Group, or Agent levels.

• The options to enable or disable voice one-step or two-step transfers are now available at the Contact
Center, Agent Group, or Agent levels.

• The options to enable or disable two-step chat transfer or conference are now available at the Contact
Center, Agent Group, or Agent levels.

Resolved Issues

• User updates no longer fail due to an incompatible JavaScript code stored in the browser's cache.
(GAPI-4177, GAPI-4178, GAPI-4162)

• An issue of unwanted settings blocking agents from viewing Corporate Favorites has been fixed.
(GAPI-4176)

• Templates are now correctly displayed. (GAPI-3697)
• Agent Group settings now display correctly in Internet Explorer 11. (GAPI-3485)
• Contact Center Statistics are now available at the Agent Groups and Agent levels. (GAPI-3156)
• A new 'Place' line is no longer added to Agent Options. (GAPI-3625)
• Sorting by agent groups now works correctly. (GAPI-3629)
• Passwords can now be entered correctly using Internet Explorer. (GAPI-3546)
• Import validation no longer freezes at five per cent. (GAPI-3547)
• Supervisors can now be added correctly to Agent Groups when using Bulk Import. (GAPI-3696)

December 7, 2017 (9.0.000.05)

What's New
Genesys Softphone

• Agent-level and headset-name options now allow Agent Desktop to sign on to Genesys Softphone.
• You can now turn on or off the mute and volume widget in Agent Desktop for use with Genesys

Softphone at the Contact Center, Agent Group, or Agent levels.
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Custom Agent States

• Action codes for Custom Agent States can be added as additional values, allowing Agent Desktop to
send action codes to a telephony server.

• Custom Agent States (reason codes) can now be sorted alphabetically in the Display Name column.

CRM Adapter

• The CRM Adapter option for the Click-to-Dial processing rule has been improved with pre-configured
rules.

Resolved Issues

• The Statistics Reset time can now be set correctly. (GAPI-3378)
• External URLs now display correctly. (GAPI-3136)
• External ID is now present in the Add/Edit User window. (GAPI-3163)
• A default place now correctly appears in Agent Setup if the default place was created and assigned in

Platform Administration. (GAPI-2549)
• All menus now correctly display in Internet Explorer 11. (GAPI-3308)

November 1, 2017 (9.0.000.04)

What's New
Enhanced user interface

Tip: Review the following video to see the enhanced user interface in action: Agent Setup New UI.

• Application menu: Agent Groups and Transactions are now available in the Application Menu for easier
access.

• Users view:
• Click the Add User button on the main User view to quickly create new user accounts.
• Desktop Options for individual users are available for quick configuration.
• You can now edit user information in multiple places, such as in the detail view, in the drill down on

each record, or from the pull-down menu.

• The Agent Groups view provides detailed records of group members and options currently configured.
• In the Contact Center Settings view, options are grouped based on category and displayed on the side

menu for easy access.

Forward emails inline

• The option to configure email inline forward is now available for contact center, agent group, or agent
configurations.
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• You can now configure an option to send email to an external party as inline directly from the
interaction history.

Resolved Issues

• You can now use default values when configuring Case Data of type enum. (GAPI-812)
• The Users tab now correctly displays the user information. Previously, the Users tab failed to load the

user data and eventually timed out. (GAPI-2724)

October 5, 2017 (9.0.000.03)

What's New

• Setting Feedback Options from Desktop Options now works for both CRM Adapter and Agent Desktop.
The Feedback section of CRM Adapter settings has been removed.

• Microsoft Edge is now a supported browser.

Resolved Issues

• Extension DNs for Polycom phones can be configured. (GAPI-1400)

September 21, 2017 (9.0.000.02)

What's New
Resolved Issues

• The Contact Center Settings > Agent Groups folder is now displayed correctly. (GAPI-2030)
• The application Login screen has been updated to reflect Genesys branding and login cache.

(GAPI-1557)
• External URLs are validated to ensure only HTTPS is supported. (GAPI-1903)

August 24, 2017 (9.0.000.01)

What's New
Browser support
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• Google Chrome browser version 54+ for Windows 10 and Mac OS X 10, 11
• Firefox browser version 45+ for Windows 10 and Mac OS X 10, 11

Cancel After Call Work

• You can set Cancel After Call Work (ACW) to allow agents to cancel ACW when they change their status
to Ready or Not Ready.

Auto Answer

• In Desktop Options, you can turn on or off the ability to disable Auto Answer when an Agent is on an
existing call.

Resolved Issues

• You can now turn on or off Voice Forward in the Voice section of Desktop Options. (GAPI-753)
• The Reject feature for Voice is no longer available for turning on or off. To set this option, please log a

case with Genesys Care. (GAPI-826)
• CRM Adapter now uses the same option to control recording buttons as Agent Desktop. (GAPI-865)
• You can now set the values for agent status, Agent Status Global Status, to be displayed in the My

Channel tab of Agent Desktop. The actions are displayed in the order in which they appear in the list.
(GAPI-886)

• You can now set the values for agent status, Agent Status Global Status, to be displayed in the Agent
Status button of Agent Desktop. The actions are displayed in the order in which they appear in the list.
(GAPI-986)

• Agent Login can now be correctly assigned to supervising agents. (GAPI-1808)
• Display Name for Favorites can now be correctly updated. (GAPI-785)
• The format of the option intercommunication.voice.routing-points has been corrected. (GAPI-1766)
• You can turn on or off the ability to look up and create contacts for each channel. You can find the

Lookup Contact and Create Contact options in Desktop Option for the Voice, Chat, and Email sections.
(GAPI-1054)

• You can turn on or off the ability to store the most recent place an agent used when logging into Agent
Desktop. This option is applicable when the Prompt Place option is set to true. (GAPI-995)

• When using Bulk Import, Supervisors are now added to their Agent Group as Supervisors. (GAPI-828)
• You can turn on or off the ability to save a contact in Agent Desktop using the Save Contact checkbox in

the Contact section of Desktop Option. This feature is available for Contact Center, Agent Group and
User levels. (GAPI-1082)

• The Active Recording option in the CRM Adapter section is no longer available. CRM Adapter now uses
the recording option set in Desktop Option. (GAPI-700)

• When make case data editable, Agent Setup now recognizes your update and no longer treats the case
data as read only. (GAPI-1166)

• Case Data of an enumerated type is correctly configured as editable. (GAPI-786)
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July 17, 2017 (9.0.000.00)

What's New
Re-branding

• Agent Setup is rebranded to reflect the new Genesys logo

Resolved Issues

• Exporting using the filter "Enabled" no longer results in all users being exported. (GAPI-997)
• The Desktop Options page now loads correctly. (GAPI-1525)

March 30, 2017 (8.5.201.60)

What's New
Resolved Issues

• Previously, when importing bulk user accounts on the Bulk Import tab, the import stopped at 7 percent
in certain cases. This no longer occurs. (HTCC-26786)

• Previously, if you deleted a user by clicking Delete User on the Manage User page, the user’s assigned
DN was not deleted. This no longer occurs. (HTCC-26578)

• Previously, when adding or modifying an agent group, the Agent Group Supervisor dropdown list box
displayed only supervisors with names that start with “a”. The list box now shows all valid supervisors.
(HTCC-26674)

• Previously, new custom disposition codes did not display in list on the Manage Disposition page. This no
longer occurs. (HTCC-26779)

February 23, 2017 (8.5.201.59)

What's New
Resolved Issues

• When adding users using bulk import, the Password field is no longer allowed. Instead, a system default
password is generated for each user account in the imported file. The format of the default password is:
‘<username>@<companyname>.com-<month>-<year>’, where <month> is the three-letter
abbreviation for the month. For example, ‘hjackson@demo.com-Feb-2017’. The Reset Password option
is automatically enabled and all users added through bulk import will be required to reset their
password the first time that they log in. (HTCC-26398)
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• The Open From History option, which allows agents to open in-progress emails from contact interaction
history, now works correctly. (HTCC-26433)

• Correct error messaging is now displayed to users when the Prompt Place option is disabled on the
Contact Center Settings > Desktop Options page and enabled for Agent Groups. (HTCC-26285)

• Statistics can now be configured once and then shared between Agent Groups (Contact Center Settings
> Agents Groups and the global contact center under the Desktop Settings tab. (HTCC-23350)

February 9, 2017 (8.5.201.58)

What's New
Resolved Issues

• You can now configure the Desktop option to allow a specific type of target (for example, Agent or Agent
Group) to appear in Agent Desktop Team Communicator. (HTCC-26154)

• The Agent Login code is now only visible when the correct rights are applied to the user. (HTCC-25738)
• Corporate Favorites can now be set up to be visible only to certain Agent Groups. (HTCC-23309)
• A bulk import of statistics no longer hangs the system. Previously, when the import reached 59%, it

would cause the system to hang. (HTCC-26223)
• The bulk import feature no longer fails to add skills to agents. Previously when the skill level was set to

0 (zero), agent skills were not added after the import was finished. (HTCC-26224)
• Previously, when choosing a statistic name for one type of stat (such as Agent Stat), the same statistic

would no longer be available in other stat types (such as Call Center Stat). This issue has been
resolved. (HTCC-25750)

January 26, 2017 (8.5.201.57)

What's New
Invalid user accounts

• The list of users on the Users page now displays a red check box for user accounts that are considered
invalid due to missing account information. You can hover your mouse over the check box to learn what
information is missing. You can also filter the list to show only Valid or Not Valid user accounts.

Resolved Issues

• All Agent Setup users are now required to reset their password when they log in to Agent Setup for the
first time. (HTCC-25783)

• When importing or adding new agent records, the Reset Password option is now selected automatically.
When Reset Password is enabled, agents must provide new password when they log in to Agent
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Desktop. (HTCC-25696)
• In the Voice section of the Desktop Options page, you can now specify sequences of numbers to exclude

from the Team Communicator in Agent Desktop. This modification introduces the following options:
Single Step Conference Exclude Number, Single Step Transfer Exclude Number, and Consultations
Exclude Number. (HTCC-25674)

• On the Transactions page, you can now add corporate favorites as a business attribute in the
Transaction list. (HTCC-25663)

• You can now use the Delete Contact option on the Desktop Options page to allow Agent Desktop users
to delete contacts. (HTCC-25585)

• You can now use the Email Forward option on the Desktop Options page to allow Agent Desktop users to
forward emails to another user. (HTCC-25557)

• You can now use the Contact Notepad option on the Desktop Options page to enable or disable the
notepad feature in Agent Desktop. This can be set at a global, agent group or agent level.
(HTCC-25503)

• The Manage Skill page now provides the list of skills in a nested folder tree structure. (HTCC-25482)
• On the Case Data and Toast Data tabs of the Desktop Settings page, you can configure toast and case

data to be shared across different agents and agent groups. (HTCC-25156)
• On the Dispositions tab of the Desktop Settings page, you can configure disposition codes to be shared

across different agents and agent groups. (HTCC-25155)
• On the Caller ID tab of the Desktop Settings page, you can now configure Caller IDs to be shared across

different agents and agent groups. (HTCC-23623)
• You can now create Virtual Queue aliases in Agent Setup. (HTCC-25823)
• When you export user accounts (Users > Export All), the export process no longer fails at 21 percent of

the export. (HTCC-25647)

December 15, 2016 (8.5.201.56)

What's New
Resolved Issues

• When updating disposition codes, existing Disposition Codes now display correctly on the Agent Groups
> Dispositions window. (HTCC-25642)

• When updating the Caller ID list, the existing Caller ID list now displays correctly on the Manage Caller
IDs window. (HTCC-25643)

• When exporting user accounts, Agent Setup no longer intermittently hangs. (HTCC-25647; HTCC-25641)
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December 8, 2016 (8.5.201.55)

What's New
Resolved Issues

• You can now set the Open from History option, which allows agents to open in-progress emails from the
Interaction History view in Agent Desktop. (HTCC-25261)

• You can now include the SIP Phone Type field when you export agent records to a .CSV file. The SIP
Phone Type field can also be processed when you import the external file back in. (HTCC-25165)

• You can now set the Mandatory Disposition option in the Global Login section of the Desktop Options
page. The Mandatory Disposition option specifies whether it is mandatory for the agent to select a
disposition before marking an interaction as done. (HTCC-24970)

• You can enable the Conference option in the Voice section of the Desktop Options page enables one-
step voice conferencing. When this option is disabled, the Conference button does not appear in Agent
Desktop. (HTCC-24947)

• The supervisor settings have been moved from the Add User and Manage User windows to the
Supervisor of the Desktop Options page. (HTCC-24783)

• You can now set all options for Virtual Agent Groups as you can for regular Agent Groups. (HTCC-24718)
• The Desktop Options page is restructured. The configuration options are now better organized into the

following sections: Channel, Global Login, Supervisor, Voice, Chat, Email, Recording, Contact, Standard
Response Library, and Feedback. (HTCC-24611)

• You can now reset the Statistics option for any time of the day. Previously, the following error message
was displayed: The value is invalid. (HTCC-25272)

November 10, 2016 (8.5.201.53)

What's New
Export Agent Login field

• When performing a bulk export of user accounts, you can now export the Agent Login field.

Resolved Issues

• The Team Communication Filter option has been moved to the Desktop Options page to make the option
configurable for agents, agent groups, and the contact center. Previously, the option was only available
to be configured for agent groups on Agent Groups page. (HTCC-24891)

• You can now add, enable, and edit the following options for the Agent Desktop on the Desktop Settings
page:

DTMF (HTCC-24736)

Transfers based on specific action in routing (HTCC-24669)
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Audible tone for new inbound voice or chat (HTCC-23651)

• For options that allow you to organize objects into folders, such as Custom Agent States and Disposition,
you can now create new folders when using folder selection dialog. (HTCC-22828)

• The global favorites configured in Agent Setup now display correctly in the Team Communicator on the
Agent Desktop. Previously, an issue occurred where global favorites were not displayed. (HTCC- 24775)

• When using the Microsoft Internet Explorer 11 web browser, bulk imports no longer fail. (HTCC-24911)

October 27, 2016 (8.5.201.49)

What's New
Enable / disable user accounts

• You can now enable or disable user accounts when adding, editing, importing, or exporting user
accounts. You can also filter the Users list to view only enabled or disabled user accounts.

Agent Login editing

• You can now edit the Agent Login name when editing user details.

Configure CRM adapter

• You can now configure CRM adapter options for agents that use the Gplus Adapter for Salesforce.

Resolved Issues

• The Cancel ACW status when voice interaction is marked Done option is now available to be set for all
users, specific agent groups, or individual agents. (HTCC-24595)

• The allow reject of inbound interaction option is now available to be set for all users, specific agent
groups, or individual agents. This option is available for both the voice and chat channels.
(HTCC-24563)

• The History Quick Search option is now available to be set for all users, specific agent groups, or
individual agents. (HTCC-19879)

October 6, 2016 (8.5.201.44)

What's New
Agent Desktop Options

• In addition to being able to configure WWE options for Agent Desktop at the Contact Center and Agent
Group levels, you can now add or update Agent Desktop (WWE) Options to an individual agent record.
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Resolved Issues

• You can now enable the following features for the Team Communicator in Agent Desktop (HTCC-24008):
Click to dial from transcript

Feedback for Disconnect

User Feedback

Detail Agent state

• You can now assign multiple supervisors to an Agent Group. Previously only a single supervisor could be
assigned to an Agent Group. (HTCC-23970)

• Filters that use a Skill name that contains “_” or space now returns all matching records. Previously, not
all matching records were returned. (HTCC-23883)

• After you add Contact Center Statistics to Agent Desktop, the proper view for Contact Center Statistics
is now displayed in Agent Desktop. (HTCC-24171)

September 22, 2016 (8.5.201.42)

What's New
Standard Response Library

• You can now configure Agent Desktop to allow agents to access the Genesys Standard Response Library.

Time parameter reset

• You can now edit the reset time parameter for contact center statistics.

Resolved Issues

• When adding or updating a Caller ID entry, users can specify a display name for each Caller ID.
(HTCC-23211)

September 8, 2016 (8.5.201.41)

What's New
Agent Desktop configuration

• As new features are made available to Agent Desktop, you can now configure the options and
parameters for the features in Agent Setup. These options can be configured at the Agent, Agent
Group, or Global levels.
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Resolved Issues

• Previously, when the UPDATE operation completed for a bulk import, an issue occurred if the Is Agent or
Is Supervisor fields were missing. This issue caused the associated record to be unusable. This no
longer occurs. (HTCC-23572)

August 25, 2016 (8.5.201.40)

What's New
Resolved Issues

• When you configure a Login template, you can now use patterns to create the Agent Login Name.
(HTCC-23055)

• You can now include the Voice Mail Box and Recording Hierarchy fields when you export users to an
external file. (HTCC-23025)

• Previously, when exporting agents, the export might have stalled or failed to complete. This no longer
occurs. (HTCC-23300)

August 11, 2016 (8.5.201.37)

What's New

• This upgrade is targeted to improve performance and stability of the service, and does not provide new
features or corrections.

July 28, 2016 (8.5.201.35 UPDATE)

What's New
Resolved Issues

• The Contact Center Settings view now functions correctly. Previously, when the view was accessed,
incorrect objects were created and displayed. (HTCC-23062)

• Statistics threshold options are no longer created with empty values. Previously, these options caused
alarms to be displayed in the Workspace Agent Desktop Contact Center Statistics tab. (HTCC-23064)
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July 25, 2016 (8.5.201.35)

What's New
Resolved Issues

• You can now update the Display Name field of an existing global favorite. (HTCC-22775)
• When you export an Agent Group list, the export no longer stops at 10 percent. The export now

completes successfully. (HTCC-22836)

July 14, 2016 (8.5.201.34)

What's New

• You can now assign an origination DN, such as a DN, virtual queue, or routing point, to an agent group.

July 7, 2016 (8.5.201.33)

What's New
Resolved Issues

• You can now create new or add existing favorites to an agent group. (HTCC-22616)

June 30, 2016 (8.5.201.32)

What's New
Resolved Issues

• When creating agent accounts in Agent Setup, you can now specify the type of the SIP phone for the
agents. (HTCC-21876)
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June 22, 2016 (8.5.201.31)

What's New
Resolved Issues

• You can now configure mandatory fields for case information. (HTCC-20965)
• You can now configure custom attributes so it will be displayed in the My History tab of Agent Desktop.

(HTCC-20856)

June 16, 2016 (8.5.201.30)

What's New

• You can now edit Annex for Agent Group options such as:
Auto Answer (Voice)

Agent Desktop Timeout

Number of seconds to alert an agent that Agent Desktop is going to time out

• You can now add personal voicemail box access for each agent.

June 9, 2016 (8.5.201.29)

What's New

• You can now assign a user with supervisor privileges to an Agent Group.

May 26, 2016 (8.5.201.27)

What's New

• You can now configure the option to override the routing by assigning a list object name to the override
option.

• You can now configure Transaction List for the following objects: disposition code, case and toast data,
and caller id.
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May 12, 2016 (8.5.201.26)

What's New

• You can now configure agents to use the screen recording client with Agent Desktop.
• You can now configure the Supervisor option as part of the Agent Desktop Team Lead features, such as

agent monitoring and controlling agent real-time status.
• You can now enable or disable an agent’s contact management features, such as Assign Contact,

Search Contact History, and Quick Search attributes.
• You can enable and disable an agent’s Caller ID feature.
• You can now configure the following values of the Agent Desktop Team Communicator filter list: Agent,

Agent Group, Interaction Queue, and Custom Contact.
• You can now configure Agent Desktop statistics to be exported in either YAML or CSV format.

Resolved Issues

• There is a new option to improve the bulk update update process. Empty fields are ignored by default,
and you can configure a pattern to delete any unwanted fields. (HTCC-21614)

April 28, 2016 (8.5.201.23)

What's New

• Global Favorites can now be assigned to an individual agent.
• When creating an extension, the user has the option to choose a specific switch to assign to that

extension.

April 14, 2016 (8.5.201.21)

What's New

• In Agent Group, the following options can be set:
Agent Inactivity Timeout – the amount of time before a message is sent to an agent stating their
desktop will be disconnected
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Calls can be answered automatically with “Auto Answer”

March 11, 2016 (8.5.201.19)

What's New

• Ability to create and edit users (agents, supervisors)
• Ability to create and edit templates
• Ability to create and assign skills
• Ability to create agent groups and virtual agent groups
• Ability to manage contact center desktop settings for entire contact center

Case and Toast Data – Add/Update/Delete

Disposition codes – Add/Update/Delete

Custom Agent States – Add/Update/Delete of reason codes: Not Ready; After Call Work

Assignment of global favorites to agent, agent group

Manage and assign external URL to show in desktop

Manage and assign outbound caller id list for desktop

Manage and assign agents and call center statistics for desktop

• Bulk Export of agent’s record to csv file
• Bulk Import of agent’s record (from csv) - Allow for Add/Update/Delete
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Genesys Engage cloud APIs
Note: Not all changes listed below may pertain to your deployment.

• For information about the latest releases of Genesys Engage cloud APIs, refer to Genesys Engage cloud
APIs Release Notes.

• March 25, 2021
• March 4, 2021
• August 11, 2020
• July 16, 2020
• May 14, 2020
• March 26, 2020
• May 23, 2019
• April 4, 2019
• September 27, 2018
• August 30, 2018
• Known Issues

March 25, 2021

What's New
Workspace API

• The Workspace API now updates the callState property on the call resource when a voice call is
released due to no answer or redirection. The callState property can be either Redirected or
NoAnswer to indicate those scenarios; otherwise, the property is not present. The call resource is
updated with this property when CallStateChanged is sent for the release event.
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March 4, 2021

What's New
Resolved Issues

Provisioning API

• The Provisioning API now populates SIP Softphone details and place data when creating a new user.
(GAPI-25825)

August 11, 2020

What's New

Resolved Issues
Service Client API for Agent Desktop

• In Service Client API, you can now distinguish the Ready State Reason of an agent. (GAPI-22168)

July 16, 2020

What's New
Service Client API for Agent Desktop

• The Service Client API can now accept or reject a SIP Preview when ringing in Agent Desktop.

May 14, 2020

What's New
Resolved Issues

Provisioning API
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• The Provisioning API now returns an error message when you make a GET /objects/users request with
a valid filterName and don't include a value for filterParameters. (GAPI-19949)

Service Client API for Agent Desktop

• The Service Client API now correctly handles attached data for interactions that contain values "0" or
blank. Previously, key-value pairs containing these values were not included in the attached data.
(GAPI-19419)

• The Service Client API now returns only one ACCEPTED event for an interaction and all following events
are of type PROPERTY_CHANGED. Note: The PROPERTY_CHANGED events are hidden in the API iframe.
(GAPI-19815)

• The Service Client API now initializes correctly. Previously, on a slow network, it could appear that
initialization failed. (GAPI-19912)

March 26, 2020

What's New
Cloud intelligent Workload Distribution API

• The Cloud iWD API lets you create, update, delete or find workitems that come from existing enterprise
software applications (such as ERP, BPM, DCM, Salesforce) as well as homegrown legacy systems. The
API also supports two-way REST API messaging between Cloud iWD and multiple source systems. See
Cloud intelligent Workload Distribution in the Administrator's Guide for details about implementing this
solution.

Resolved Issues

Provisioning API

• The /users endpoint is deprecated and the Provisioning API now supports a new /objects/users
endpoint you can use to create, read, update, and delete users.

• The GET /objects/users request now returns a maximum of 100 users.

June 6, 2019

What's New
Service Client API for Agent Desktop

• The Service Client API can now retrieve provisioning data for Agent Desktop through the new
Configuration namespace.
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Resolved Issues

Workspace API

• The delete from conference operation is now available when using a single-step conference through a
route point. (GAPI-13424)

May 23, 2019

What's New
Provisioning API

• The Provisioning API's /provisioning/v3/objects/{object_type} endpoint can now return Access
Groups and Skills.

• The Provisioning API now enables you to set the recording hierarchy when creating or updating a user.

Resolved Issues

Service Client API for Agent Desktop

• The Service Client API now populates the CALL_RECORDING_STATE_CHANGED event. Previously, the API
triggered the ATTACHED_DATA_CHANGED event when the call recording state changed. (GAPI-13256)

April 4, 2019

What's New
CX Contact Service API

• The CX Contact Service API enables users to create, manage, and execute outbound events. Specific
capabilities include the following:
• Create and manage outbound campaigns
• Create contact lists and manage the records within them
• Create and manage compliance rules
• Manage contact suppression lists and record exclusion rules
• Create administration tasks

Consumer Messaging API
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• The Consumer Messaging API provides support for custom applications to create chat sessions, send
and fetch messages, manage participants, send mobile push notifications and update userdata.

Genesys Task Routing API

• The Genesys Task Routing API lets you submit workitems to Genesys from third-party applications. You
can use other Genesys applications to route submitted workitems to agents, get interactions that were
processed by agents, and view reports about those interactions. See Genesys Task Routing in the
Administrator's Guide for details about implementing this solution.

Engagement Service API

• Support for Web or mobile callback — Public API-driven from mobile apps, Web sites, or the Genesys
Widgets for Callback.

• Support for Click-To-Call-In — A mobile app requests call-in details provided immediately or when an
agent becomes available.

• Support for Queue Estimated Wait Time (EWT) and office hours availability.

Cloud Data Download Service API

• The Cloud Data Download Service API enables secure export and download of contact center data. The
exported data files are encrypted and stored for a maximum of 30 days, during which time they are
available for download. After 30 days, the files are deleted from storage. The initial release supports
contacts and interaction-based data sourced from Universal Contact Server (UCS).

September 27, 2018

What's New
Workspace API

• The Agent (Workspace) API now supports Chat.

Service Client API for Agent Desktop

• The Service Client API now supports email and chat.

August 30, 2018

What's New
Workspace API
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• The Workspace API (also referred to as Agent API) supports development of custom agent applications
that integrate with Genesys. These applications can include features such as:

Inbound voice

• Manage agent state
• Perform basic call control
• Perform conferences and transfers
• Enable supervisor monitoring
• Create, read, update, and delete user data
• Enable call recording

Statistics API

• The Statistics API supports access to contact center statistics. The API provides two models of access:
• Subscribe/Notify model - Create a subscription and receive notifications
• One-time retrieval - Retrieve the current values of statistics

Provisioning API

• The Provisioning API supports creating users, modifying configuration data, and retrieving configuration
data. Specific supported actions include:
• Create, read, update, and delete users
• Get skills for a user
• Import and export users
• Get DNs or agent groups
• Create, read, update, and delete application options

Authentication API

• The Authentication API provides authentication and authorization for client endpoints using OAuth 2:
• Authenticate users, generate access tokens from grants, validate access tokens for resource

services
• The Authentication API is required as a prerequisite for accessing other APIs

Service Client API for Agent Desktop

• It is possible to configure Agent Desktop to embed other web client business applications to improve
overall user experience by removing the need for users to manage multiple application windows.
Developers can extend the UI integration by using Service Client API to customize how your web
application or website integrates with Agent Desktop. Genesys provides this window.postMessage
based API so that your application can communicate cross domain with Agent Desktop while
maintaining secured isolation. By monitoring various events provided by Agent Desktop, you can use
the Service Client API to perform the following actions from third-party applications:
• Get and set agent and media state
• Enable click-to-dial
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• Control call recording such as start, pause, resume, and stop
• Answer, hold, resume, and hang up voice calls
• Mute/unmute Genesys Softphone microphone and speaker
• Create, update, and delete attached data
• Invoke a toast in Agent Desktop
• Control case selection
• Block and unblock the agent Mark Done operation

Known Issues

• The Service Client API does not support the EXTERNAL mode with Microsoft Internet Explorer.

Reference Material

• Genesys Engage cloud Developer Center: Organized, up-to-date information on the APIs, built from
OpenAPI (Swagger) definitions

• Github: A set of client library examples
• Service Client API: Customize how your web application or website integrates with Agent Desktop

Genesys Engage cloud APIs

Genesys Engage cloud Release Note 103

https://docs.genesys.com/Documentation/PSAAS/Public/Administrator/ServiceClientAPI


Authentication Service
Authentication Service provides single sign-on (SSO) for applications in Genesys Engage cloud.

Note: Not all changes listed below may pertain to your deployment.

• November 2, 2020 (9.0.000.68)
• Known Issues
• Limitations

November 2, 2020 (9.0.000.68)

What's New
Localization support

• Authentication Service now supports the following languages: Brazilian, French, French Canadian,
German, Japanese, Spanish, Korean, Italian, and Dutch.

SAML

• Authentication Service now supports SAML certificate rollover without service interruption.

Resolved Issues

• The "Remember Me" functionality on the login screen now preserves the agent's username and tenant
when SameSite settings are enabled in agent browsers. (AUTH-274)

Known Issues

• There are currently no known issues.

Authentication Service
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Limitations

• There are currently no limitations.

Authentication Service
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Callback
Note: Not all changes listed below may pertain to your deployment.

• For information about the latest releases of Genesys Callback, see Callback Release Notes.
• March 11, 2021 (9.0.043.00)
• January 28, 2021 (9.0.040.00)
• November 25, 2020 (9.0.039.57)
• November 12, 2020 (9.0.038.92)
• November 5, 2020 (9.0.038.91)
• June 18, 2020 (9.0.036.01)
• May 28, 2020 (9.0.035.55)
• April 9, 2020 (9.0.034.43)
• April 2, 2020
• February 20, 2020 (9.0.033.56)
• January 7, 2020 (9.0.032.04)
• November 7, 2019 (9.0.030.40)
• October 10, 2019 (9.0.029.90)
• September 26, 2019 (9.0.028.35)
• September 5, 2019 (9.0.027.59)
• August 8, 2019 (9.0.026.60)
• July 18, 2019 (9.0.025.55)
• June 27, 2019 (9.0.000.23)
• June 6, 2019 (9.0.000.22)
• May 16, 2019 (9.0.000.21)
• April 18, 2019 (9.0.000.19)
• April 4, 2019 (9.0.000.18)
• March 21, 2019 (9.0.000.17)
• March 7, 2019 (9.0.000.16)
• February 27, 2019 (9.0.000.15)
• February 7, 2019 (9.0.000.14)
• December 28, 2018 (9.0.000.06)
• Known Issues
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March 11, 2021 (9.0.043.00)

What's New
Resolved Issues

• The accuracy of Estimated Wait Time (EWT) values, used in the processing of scheduled callbacks, has
been improved. When calculating EWT, the system now excludes all calls that are not ready to be
routed. Previously, all calls in the queue – regardless of status – were being used to calculate the EWT.
(GES-2383)

• Call-in match requests now treat numbers in the DNIS pools with leading '+' characters as equivalent to
numbers without them. Previously, numbers in the DNIS pool with a leading '+' were unmatchable.
(GES-2194)

January 28, 2021 (9.0.040.00)

What's New
Resolved Issues

• Click-To-Call-In Group configuration no longer expires after 2 weeks of inactivity. (GES-2314)
• Scheduled callbacks that are booked without the inclusion of the userData parameter now correctly

start processing at the Estimated Wait Time (EWT) number of minutes before the desired callback time.
Previously, Scheduled callbacks that did not include the userData parameter didn't start processing
until after the desired callback time had passed. (GES-2290)

• An issue has been fixed that sometimes interfered with the operation of rescheduled callbacks.
Previously, when the desired time of an already-scheduled callback was rescheduled to an earlier
desired time, the new desired time was updated in the callback record and displayed in the UI, but the
system continued to use the original desired time as the time at which to fetch the callback for
processing. As a result, the exclamation mark warning icon – an indicator that a callback is past due –
displayed for these rescheduled callbacks. (GES-2249)

• Creating a new rule on the Permitted & Blocked Numbers page in the UI using the Select All
Countries check box now saves correctly. Previously a rule of this type provided no error message
when saving, but the new rule failed to display in the drop-down list of saved rules on the Permitted &
Blocked Numbers page and it wasn't available for selection on the Callback Queues page.
(GES-2149)

Callback
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November 25, 2020 (9.0.039.57)

What's New
Resolved Issues

• Precise Estimated Wait Time (EWT) values are now used in callback processing for scheduled callbacks.
Previously, EWT for scheduled callbacks was capped at 90 minutes. In cases where the EWT was longer
than 90 minutes, callback processing did not begin until 90 minutes before the desired time.
(GES-2285)

November 12, 2020 (9.0.038.92)

What's New
General maintenance

• The Genesys team made a few minor updates to improve your experience.

November 5, 2020 (9.0.038.91)

What's New
UI improvement

• To improve accuracy in the UI, the Desired Callback Time now includes a grace period, which must
elapse before a scheduled callback displays a warning.

Changes associated with Firebase credential testing

• The Test Firebase Credentials section of the Credential Management > Push Notification page
has been updated to accommodate changes associated with version 7.0 of the Firebase API/SDK. This
change should not impact any apps already leveraging GES/Callback Push functionality other than the
testing of provisioned credentials. In addition, the changes to testing your credentials in the Callback UI
will not interfere with or otherwise break any existing Firebase/Push integrations. Regardless, Genesys
recommends that you conduct your own testing to verify the correct operation of all apps that use
callback-related Push Notifications.

When upgrading the Firebase client to version 7.0, you require the following information for each
Firebase web app when testing the credentials in the Callback UI:

• App ID
• Public API Key
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• Sender ID

• The Project Name entry is no longer redacted on the Credential Management > Push Notification
page.

Updates to the phone number validation process

• The phone number validation process has been updated to accommodate recent changes in some
countries, such as the addition of new area codes.

Resolved Issues

• You can again test your Firebase Cloud Messaging (FCM) Push Notification credentials using the Callback
UI. Previously, an issue with the Push Notification service sometimes interfered with the credential
testing capabilities on the Credential Management > Push Notification page in the UI. In addition,
there were changes in FCM that might impact your configuration. More specifically, you might have to
update your Firebase projects in order to successfully test credentials in the Callback UI. For more
information, see the entry for FCM in the Firebase JavaScript SDK Release Notes, under Version 7.0.0 -
September 26, 2019.

June 18, 2020 (9.0.036.01)

What's New
Resolved Issues

• An issue has been fixed that sometimes caused a scheduled callback to be missing the original call
data.

May 28, 2020 (9.0.035.55)

What's New
General maintenance

• Genesys continuously reviews and monitors product functionality; this release includes minor updates
and improvements in the UI.

Resolved Issues

• On the Region Affinity Rules page in the UI, the buttons for creating a new rule, deleting an existing
rule, and saving a rule no longer display for users with read-only access. Clicking and dragging a region
name is also disabled for those users.
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• An issue has been fixed in the Callback UI that previously let users see callbacks for queues that were
restricted to them based on line-of-business filtering.

April 9, 2020 (9.0.034.43)

What's New
Region Affinity

• The Callback UI has a new page under the Tools tab: Region Affinity Rules. A Region Affinity rule
specifies the region or regions that you want to use to manage interactions for a given callback
queue.This is an advanced feature. You must consult with your Genesys representative before you use
it. The Region Affinity Rules page is described in the Configuring Region Affinity rules.

Resolved Issues

• You can now log in to the Callback UI over MPLS.
• An issue has been fixed that sometimes caused a delay in fetching stats from the Statistics API.

April 2, 2020

What's New
Routine maintenance

• Genesys is performing routine maintenance on the operating system. There are no other changes.

February 20, 2020 (9.0.033.56)

What's New
Changes to auto-cancel of longstanding PROCESSING-state callbacks

• Callback includes a feature that automatically cancels callbacks that are in the PROCESSING state for
more than 30 minutes. The feature is now disabled by default. Contact Customer Care to have the
feature enabled in your environment.

Performance and stability enhancements
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• As part of our continuous effort to make things better, this release includes performance improvements,
which in turn improve callback resiliency.

Resolved Issues

• When creating a custom date range in the Advanced Options dialog on the Callback tab, you can
now include spaces in the name. Previously, if you included at least one space in the name of a custom
date range, Callback failed to recognize the offset values (the number of days before and after) and no
results were displayed on the tab for that date range.

January 07, 2020 (9.0.032.04)

What's New
Auto-cancel of longstanding PROCESSING-state callbacks

• Callback now automatically cancels callbacks that are in the PROCESSING state for more than 30
minutes. All callbacks cancelled as a result of this condition will appear in the Callback UI as
COMPLETED (CANCELLED_BY_SYSTEM).

Performance and stability enhancements

• As part of our ongoing commitment to improve customer experience, this release has functional and
performance improvements that include updates to the Callback tab in the UI.

November 7, 2019 (9.0.030.40)

What's New
Support for Edge browsers

• Callback is now supported on EdgeHTML version 16.0 and up and on the new Chromium-based Edge.

Performance and stability enhancements

• Genesys is always looking for ways to improve customer experience. In this release, we're rolling out
the following performance and stability enhancements to improve both your user experience and your
consumers' experience:
• Ongoing styling and performance improvements to the UI, including enhanced diagnostic data for

callbacks.
• More precise handling of Scheduled callbacks to ensure that they are never purged from the queue

before the Desired Callback Time.
• Improved accuracy for starting scheduled callbacks.
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• Improved monitoring and handling of large volumes of concurrent callbacks.
• Improved performance and stability to better handle environmental changes or failures.

Resolved Issues

• In the UI, filtering the list of callbacks based on a specific callback state now works correctly. Previously,
callbacks in a state other than the one on which you were filtering could sometimes be included in the
list, although this rarely happened.

October 10, 2019 (9.0.029.90)

What's New
Partial support for Edge browsers

• Microsoft Edge and Chromium-based Edge support is now in the beta phase. Although most
functionality is supported, you might experience some display issues. Ensure that you are running the
latest version of Edge.

Access to GWS statistics

• You can now access GWS statistics through the Genesys Engagement Services (GES) Statistics API. To
use the Statistics API, you must first register your GWS credentials with Callback using the new GWS
Credentials tab under Developer > Credential Management in the Callback UI.

Callback-type indicator on queues

• On the Tools > Queues page in the Callback UI, icons beside each queue name indicate if the queue
supports Immediate callbacks ( ), Scheduled callbacks ( ), or both.

Performance and stability enhancements

• Genesys is always looking for ways to improve customer experience. In this release, we're rolling out
the following performance and stability enhancements to improve both your user experience and your
consumers' experience:
• Improved response times in the Callback UI.
• Improvements to Scheduled callbacks, ensuring that they start at the correct (desired) time.
• Internal improvements that maximize service availability and minimize time spent troubleshooting.
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September 26, 2019 (9.0.028.35)

What's New
Callback UI Enhancements

• This release includes the following UI enhancements:
• On the Tools > Queues page, you can now open a Filter Displayed Queues dialog in which you

select the specific queues that you want to display on the Callback Queues page.
• On the Callback tab, in the State column, a calendar icon displays beside callbacks that are

scheduled. If there is no icon associated with a callback's state, then the callback is immediate.

September 5, 2019 (9.0.027.59)

What's New
Upload JSON-format capacity data

• To make it easier to add data to your new or existing capacity rule, you can now copy JSON-format
capacity data from a file and paste it directly into an open and focused capacity rule. The rule is
updated with the pasted data; this overwrites all existing data in the rule. For more information, see
Using JSON-format capacity statements to configure a capacity rule.

Updates to diagnostic data associated with callback records

• On the Callback tab in the UI, the following updates have been made to the diagnostic data that is
available for callbacks:
• There is now diagnostic data, including error messages, available for a callback that is in the

SCHEDULED state.
• When a callback in the SCHEDULED state remains in that state past the Desired Callback Time, a

Warning icon displays to alert you. Hovering over the icon displays a message.

August 8, 2019 (9.0.026.60)

What's New
UI styling enhancements

• The following Callback UI pages have been re-designed for an improved user experience:
• Call-In
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• Tools > Queues
• Tools > Callback Search
• Tools > Permitted & Blocked Numbers

Resolved Issues

• Unchecking Canada or Unites States at the top of the Permitted & Blocked Numbers page now
correctly removes the country from the Currently Selected Countries list. (GES-1732)

• An issue has been fixed that, in rare scenarios, caused changes to a Permitted & Blocked Numbers
rule to be saved automatically instead of being discarded when the user navigated away from the rule
without clicking Save. (GES-1729)

• Custom date ranges now work correctly for users who set their browser language to Australian English.
Previously, depending on the date range that was specified, the Callback UI might generate an error
and fail to save the custom date range setting. (GES-1709)

• Previously, an error was posted on the Errors page if someone tried to cancel a callback that was in the
PROCESSING state. That error is no longer tracked on the Errors page. (GES-1700)

July 18, 2019 (9.0.025.55)

What's New
UI styling enhancements

• The following Callback UI pages have been re-designed for an improved user experience:
• Tools > Capacity
• Tools > Click-To-Call-In Config
• Callback
• Developer > Errors
• Developer > Credential Management

Resolved Issues

• When UTC mode is selected as a display option for the Callback UI tab, the server now correctly uses
UTC time for date ranges instead of the local time zone. (GES-1681)

• An issue has been fixed that could cause localized date formatting (based on your browser's language
setting) to display incorrectly in the Callback UI. (GES-1685)

• An issue has been fixed that occasionally caused an unexpected server error (1001). (GES-1688)
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June 27, 2019 (9.0.000.23)

What's New
Updates to Callback metrics

• Callback metrics on the Callback tab in the UI now include the name of the user who created,
cancelled, rescheduled, or recreated the callback. The username is captured for these actions only
when they are performed in the Callback UI.

Changes to callback record storage

• Callback records are now stored for 14 days; the 14 days start at the Desired Callback Time. The
Callback TTL (seconds) setting in the CALLBACK_SETTINGS data table no longer has any effect on
how long a callback record is stored.

UI enhancements

• Genesys continues to improve text, styling, and performance in the Callback UI.

Resolved Issues

• The callback ID now displays correctly when you search for a callback record using Tools > Callback
Search. Previously, when using a customer's number to search for a scheduled callback, the UI found
the information for the record but failed to display the callback ID.

• The occasional failure to fetch callback details while a callback was in the PROCESSING state has been
fixed. Previously when this happened, no metrics were available in the UI for the callback record once
the state reached COMPLETED.

• Using a complete and valid URL to search for an error on the Developer tab now works correctly.
Previously in this scenario, the Developer tab sometimes failed to return any results.

June 6, 2019 (9.0.000.22)

What's New
Click-To-Call-In

• Callback now supports the Click-To-Call-In (Immediate) scenario. Consumers tap a ClickToCall button in
your mobile app to initiate a call to your contact center. For more information, see Callback Scenarios.

• To implement the Click-To-Call-In scenario for Callback, you must configure at least one Click-To-Call-In
group. You provision the Click-To-Call-In Groups on the new Tools > Click-To-Call-In Config page. For
more information, see Configuring Click-To-Call-In Groups.

Updates to the Patterns page
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In the Callback UI, improvements have been made to the Tools > Patterns page, including the
following:

• The Patterns page has been re-named to Permitted & Blocked Numbers.
• It is no longer possible to delete a rule when it is assigned to a queue.
• When you select a rule, the names of the queues to which the rule is assigned are now listed on the

page.
• The page now includes a Save button. Previously, rule settings were saved automatically.

Updates to the Capacity page

In the Callback UI, improvements have been made to the Tools > Capacity page, including the
following:

• A message displays at the top of the Capacity page that indicates the number of queues to which the
selected capacity rule is assigned.

• You can now delete a capacity rule as long as it is not assigned to any queue.
• You can enter up to 1000 callbacks per time slot.

Updates to the CAPTCHA tab

• Minor text fixes and styling updates have been made to the Developer > Credential Management >
CAPTCHA tab.

May 16, 2019 (9.0.000.21)

What's New
Capacity rules

• You can now configure capacity rules on the Tools > Capacity tab to specify the maximum number of
scheduled callbacks that are allowed within each time slot for a week. After rules are configured, assign
them to queues. For more information, see the Configuring Capacity Rules article.

Updates to the Callback tab

• Advanced Options improvements:
• Styling updates have been made to the Advanced Options window to enhance clarity.
• A Select All checkbox is now available for filtering the grid based on the different callback states.

• Custom Date Range improvements:
• Minor text fixes and styling updates have been made to the Configure Custom Date Range

section of the Advanced Options window.
• Custom date entries in the time range drop-down menu on the Callback tab are now prefixed with

Callback

Genesys Engage cloud Release Note 116

https://docs.genesys.com/Documentation/PSAAS/Public/Administrator/CallbackCapacity


Custom.

RBAC and Line of Business filtering

• The Role-Based Access Control and Line of Business filtering that was described as an upcoming feature
in an earlier Release Note is now fully implemented. For more information, including a note about the
migration of roles, see the Controlling User Access article.

Developer resources

• Users with the Developer role may now access the following areas under the Developer tab:
• Allowed CORS Domains for troubleshooting Web integration with Callback services. For more

information, see the Using the Developer Tab article.
• Credential Management > CAPTCHA for provisioning reCAPTCHA to protect against bot-based

attacks for a customer's Callback Services integration.

Resolved Issues

• Previously, users might have encountered an error message that indicated that the system Failed to
Fetch All Callbacks for Queue <queue-name>. The issue that caused the error message has been
fixed. The error message sometimes displayed during start up of the Callback UI or when users
refreshed the list of callbacks using the F5 key when there was a large number of callbacks in the
system (for example, 10,000 or more). (GES-1354, GES-1350)

• Name recordings that are made when a customer initially requests a callback are now working correctly.
Previously, name recordings were not played back to the customer during the callback attempt.
(GES-1477)

April 18, 2019 (9.0.000.19)

What's New
Number validation

• To avoid initiating callbacks to numbers that you know to be fraudulent, you can now configure number
validation rules on the Tools > Patterns tab. In addition, you can create rules that specify a list of
countries to which you allow callbacks. After the rules are configured, apply them to queues.

April 4, 2019 (9.0.000.18)

What's New
Developer tab
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• The Callback UI now includes a Developer tab that provides access to a set of tools to facilitate or
troubleshoot developer integration efforts. A user must be a member of the Callback Developer or
Administrator Role to access the Developer tab. For more information, see Using the Developer Tab in
the Callback documentation.

Support for Push Notification

• The Callback UI now includes a Push Notification page on which you enable push notification
configuration for features that can leverage this capability. A user must be a member of the Callback
Developer or Administrator Role to access the Push Notification configuration page. For more
information, see Provisioning Push Notifications in the Callback documentation.

Tools tab

• The Callback UI now includes a Tools tab, which offers additional views and tools to assist with callback
management, configuration, and troubleshooting. A user must be a member of the Administrator,
Supervisor, or Developer Role to access the Tools tab. For more information, see Using Callback Tools
in the Callback documentation.

Security improvements

• Security improvements have been made to the Callback application.

March 21, 2019 (9.0.000.17)

What's New
URL changes

• The URLs for all of the Callback UI web pages now include /ges/app/*, rather than /ges/ui/* or /ges/
react/* .

Resolved Issues

• You can now successfully recreate a callback using the automatically-generated Desired Date value
without any manual intervention. Previously, when you tried to recreate a completed callback using the
Desired Date that the application selected, you received a Please select a valid callback time
error. In this scenario, the only way to recreate the callback using the auto-generated date was to open
the calendar and select that date. (GES-1160)

• Callbacks no longer return error messages when in the PROCESSING state. Previously, the interface
generated an error message about a failure to get diagnostic data when a call was being processed.
(GES-1300)
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March 7, 2019 (9.0.000.16)

What's New
Updated UI

• Colors and styling have been updated on the Callback login screen and throughout the UI.

Resolved Issue

• Styling issues have been fixed in the Callback Advanced Options window. Previously, long queue
names did not display properly in the Advanced Options window and users could sometimes
experience issues when scrolling through the list. (GES-1148)

February 27, 2019 (9.0.000.15)

What's New
MPLS

• Support for environments that use MPLS. (GES-1121)

Resolved Issue

• The Callback tab now displays all pages of results when you filter the list and more than 250 callbacks
are returned. Previously, Callback would sometimes display only one page of callbacks in this scenario
(subsequent pages failed to display). (GES-1149)

February 7, 2019 (9.0.000.14)

Features Coming Soon
Role-Based Access Control

• Role-Based Access Control (RBAC) gives you customized control over user activities within the interface.
Using RBAC, you can define Roles such as Administrator, Developer, Monitor, and Supervisor, and then
configure access control that is appropriate for each Role. Users can then perform only the tasks
allowed for the Role to which they are assigned. For example, a user with a “Monitor” role can log in to
the Callback interface and view the list of callbacks, but cannot make any changes. RBAC will be
available for use with the Callback application when Platform Administration has been updated to
support this feature for Callback. Watch this Callback Release Note for future updates.
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Restricting user access based on lines of business

• You can limit the scope of what logged-in users can see and access based on your lines of business.
Currently, any user who is logged in to the Callback application can see all callback requests as long as
the user has access to that tab in the user interface. Using the line-of-business filtering feature,
administrators have the option to limit which callback requests a specific group or user can view. For
example, if you have a Sales group, then you can allow that group to view only callback requests for
Sales. The ability to limit user access based on lines of business will be available for use with the
Callback application when Platform Administration has been updated to support this feature for
Callback. Watch this Callback Release Note for future updates.

December 28, 2018 (9.0.000.06)

What's New
Initial release

Genesys Callback enables you to provide a deferred option to connect consumers and agents at a
mutually beneficial time, and provides support for Call-In behavior.

Callback is a generic product name that includes support for many scenarios and triggering sources
including:

• Immediate (as soon as an agent is available) or Scheduled Callback offers
• IVR in-queue callback.
• Web or mobile callback — Public API-driven from mobile apps, Web sites, or the Genesys Widgets for

Callback.
• Click-To-Call-In — A mobile app requests call-in details provided immediately or when an agent becomes

available.
• Additional public APIs for queue Estimated Wait Time (EWT) and office hours availability
• Web administration UI for general management (list, create, cancel, reschedule callbacks)

Genesys Callback is enabled through Genesys Engagement Services (GES), the successor to Genesys
Mobile Services (GMS) in the cloud. Designer is used to configure Callback.

Known Issues

• When the desired time of an already-scheduled callback is updated or rescheduled to an earlier desired
time, the new desired time is updated in the callback record and displays in the UI. However, the
system continues to use the original desired time as the time at which to fetch the callback for
processing. As a result, the exclamation mark warning icon – an indicator that a callback is past due –
displays for these rescheduled callbacks. (GES-2249)
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Cloud Data Download Service
• January 16, 2020 (9.0.003.00)
• September 27, 2019 (9.0.002.01)
• June 04, 2019 (9.0.001.02)
• August 31, 2018 (9.0.000.03)
• Known Issues

January 16, 2020 (9.0.003.00)

What's New
Resolved issues

• CDDS now correctly runs jobs that are scheduled to run simultaneously. Previously, a job could become
stuck if another job that was running at the same time failed. (CDD-1378)

September 27, 2019 (9.0.002.01)

What's New
Security and stability

• This release contains several security and stability improvements to Cloud Data Download Service.

June 04, 2019 (9.0.001.02)

What's New
Job scheduling

• You can now schedule a data export job to start at a certain date and time, and specify how often it

Cloud Data Download Service
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should run.

Progress indicator

• The Latest Status column now features a status bar to indicate the progress of active data export jobs.
If you hover your mouse over the bar, it displays the estimated time remaining until the job completes.

August 31, 2018 (9.0.000.03)

What's New
Initial release

This is the initial release of Cloud Data Download Service (CDDS).

Cloud Data Download Service enables you to securely export and download your contact center data.
The exported data files are encrypted and stored for a maximum of 30 days, during which time they
are available for download. After 30 days, the files are deleted from storage.

As of this release, CDDS only supports the export and download of contacts and interaction-based
data sourced from Universal Contact Server (UCS).

Known Issues

• CDDS uses Coordinated Universal Time (UTC) to calculate the start time for scheduled jobs and not the
local timezone. As a result, job start times are not automatically adjusted to align with changes to the
local timezone, such as for Daylight Savings Time.

Workaround: After a local timezone change, review the start times for your scheduled jobs and
adjust accordingly.
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Intelligent Workload Distribution

Important
Not all changes listed below may pertain to your deployment.

• For information about the latest releases of IWD, click here: Intelligent Workload Distribution
• For more information on IWD, see the documentation here.

• March 4, 2021 (9.0.000.64)
• February 11, 2021

(9.0.000.63)
• November 05, 2020

(9.0.000.60)
• October 22, 2020

(9.0.000.59)
• October 8, 2020 (9.0.000.58)
• September 24, 2020

(9.0.000.57)
• September 03, 2020

(9.0.000.56)

• August 20, 2020 (9.0.000.55)
• July 23, 2020 (9.0.000.54)
• July 09, 2020 (9.0.000.53)
• June 25, 2020 (9.0.000.52)
• June 09, 2020 (9.0.000.50)
• May 28, 2020 (9.0.000.49)
• May 14, 2020 (9.0.000.48)
• April 30, 2020 (9.0.000.47)
• April 20, 2020 (9.0.000.46)
• April 2, 2020 (9.0.000.45)

• March 19, 2020 (9.0.000.44)
• March 05, 2020 (9.0.000.43)
• February 20, 2020

(9.0.000.42)
• February 6, 2020 (9.0.000.41)
• January 23, 2020 (9.0.000.40)
• January 9, 2020 (9.0.000.39)
• December 9, 2019

(9.0.000.35)
• October 3, 2019 (9.0.000.27)
• June 28, 2019 (9.0.000.18)

March 4, 2021 (9.0.000.64)

Resolved issues

• iWD Manager now correctly prohibits saving empty rules in Rules Builder. (CIWD-1370)
• When an Endpoint is either unassigned from the Designer application or deleted, in a previously related

workitem's details the default Endpoint now displays. (CIWD-1105)
• When the source system submits a workitem with empty non-custom attribute values, these attributes

can now be edited in iWD Manager. (CIWD-533)
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February 11, 2021 (9.0.000.63)

What's new?
Auto-suggest in search

• iWD now auto-suggests possible values for:
• Existing attributes names and logical operators.
• Values for key-value pairs and multi-values, along with the ability to search among them using an

already entered value.

(CIWD-772)

WFM Activity to Category mapping

• Genesys WFM Activity can now be mapped to the level1/* category path in iWD in addition to level1/
level2, Default/unclassified, and level1/unclassified. Setup is the same as before but instead of
specifying leve1/level2 in the activity, specify level1/* to select all subcategories of the level1
category. (CIWD-985)

Reporting enhancements

• The reporting model has been extended with new elements:
• The Media Type attribute distinguishes different types of media (such as workitem or email). It is

added to the following reports:
• Capture Point Business Value
• Capture Point Task Duration
• Customer Segment Service Level
• Intraday Process
• Resource Performance
• Task Age
• Task Detail
• Task Work Detail Report

• The Media Type prompt enables filtering by different types of media. It is added to reports
containing the Media Type attribute listed above, and to the following dashboards:
• Capture Point
• Customer Segment Service Level
• Intraday Process
• Resource Performance
• Task Age Dashboard

• The Interaction Type and Interaction Subtype attributes enable data to be organized by
interaction type and interaction subtype. They are added to the following reports:
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• Task Detail
• Task Work Detail Resource Performance Report

• The Interaction Type prompt allows the Task Detail, Task Work Detail and Resource Performance
Reports to be filtered by interaction type.

(CIWD-784)

Inactivity logout

• iWD Manager now logs users out automatically after 15 minutes of inactivity. (CIWD-1071)

Filter and sort attributes

• It is now possible to filter and sort workitem attributes in the Workitem Details panel. (CIWD-1006)

Resolved issues

• iWD now correctly updates the state of a workitem that is returned to the universal queue after a
routing timeout in Designer. Previously in such a scenario, iWD might have put workitems into a
Completed state, which might have resulted in their being marked as Expired while still awaiting
completion. (CIWD-1409)

• iWD now uses the same interaction ID for both Contact Server and Interaction Server when a workitem
is submitted. (CIWD-1399)

• iWD now takes into account the priority attribute provided by the source system. This initial priority
value is now always added to the priority calculated by the prioritization schema. (CIWD-1397)

• iWD now correctly handles rules defined in categories, when the type of categorization rule is changed
from Lucene Query to Rules Builder or vice versa. Previously, iWD might have incorrectly updated the
changed rule. (CIWD-1196)

• iWD now correctly calculates the next scheduled reprioritization time. Previously this time was
calculated based on the last time the workitem was queued. (CIWD-1157)

• iWD now correctly processes transfers for workitems when the assigned agent changes. (CIWD-1092)
• iWD Manager now displays user-friendly names for Designer applications. (CIWD-422)

November 05, 2020 (9.0.000.60)

Resolved issues

• This update includes improvements for stability and scalability.

Intelligent Workload Distribution

Genesys Engage cloud Release Note 125



October 22, 2020 (9.0.000.59)

Resolved issues

• This update includes improvements for stability and scalability.

October 8, 2020 (9.0.000.58)

What's new?
Search for Endpoints

• Search within the Endpoints list is now available. (CIWD-824)

Summary table improvements

• User data in the Summary table is now trimmed and tooltip help is displayed on mouseover.
(CIWD-829)

Resolved issues

• This update includes improvements for stability and scalability.

September 24, 2020 (9.0.000.57)

What's new?
Support for query validation in iWD Manager

• iWD Manager now validates Lucene queries in the search field, highlights the position of any search
field input errors and shows error messages. (CIWD-556)

Improved handling of duplicate workitems

• IWD now returns a 200 OK HTTP response when a request to create workitems contains one or more
workitems that have already been created. The body of the HTTP response now contains a list with
details of all workitems, and an additional list of external IDs of the duplicates. Client applications that
process this content in an HTTP response need to be adjusted to accommodate the change in format.
Please refer to the API documentation for details. (CIWD-719)

Auto-addition of Endpoint prefixes
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• When an endpoint of type openmedia is created, a prefix is now automatically added. Previously this
prefix had to be added manually. (CIWD-609)

Resolved issues

• iWD now correctly classifies items that use Lucene queries involving fields with multiline text. Previously
such fields were ignored during classification. (CIWD-753)

September 03, 2020 (9.0.000.56)

Resolved issues

• This update includes improvements for stability and scalability.

August 20, 2020 (9.0.000.55)

What's new?
Automatic index cleanup

• iWD now performs automatic cleanup of workitem indexes created more than 90 days ago. Contact
Genesys if you need workitems to exist for longer than 90 days. (CIWD-586)

July 23, 2020 (9.0.000.54)

Resolved issues

• This update includes improvements for stability and scalability.
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July 09, 2020 (9.0.000.53)

What's new?
Service reliability

• Handling of internal connections between components has been improved. (CIWD-578)

June 25, 2020 (9.0.000.52)

What's new?
Saving of search filters

iWD Manager users can now save search filters in the Workitems and Summary tabs of iWD
Manager.

• Supervisors can now configure and save search queries along with their preferred Workitem or
Summary tab views—such as specific selected columns, sorting direction, fields, categories and so on.

• Other users can now access and use the queries stored by the Supervisor in order to make work easier.
• Other users can now add queries to their Favorites list.

Please contact Genesys to have this feature enabled. (CIWD-338)

Integration with WFM

• You can now integrate iWD with Genesys Workforce Management (WFM) to enable WFM capabilities to
improve management of your contact center workforce. There is more information in the Genesys
Engage Administrator's Guide. (CIWD-9)

Service reliability

• Service reliability has been improved by adding end-to-end health checks, logging and monitoring
improvements. (CIWD-337)

Reporting

• GCXI reports for Cloud IWD have been improved. (CIWD-511, CIWD-283)
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June 09, 2020 (9.0.000.50)

Resolved issues
After restoring its connection with underlying Genesys Engage cloud components, iWD now:

• No longer makes any additional attempts to reconnect.
• Issues only a single client registration request per queue. This also improves performance.
• Registers the client immediately and subscribes to notifications (unsolicited events). This ensures that

workitems' states are updated precisely.

(CIWD-527)

May 28, 2020 (9.0.000.49)

What's New

• You can now delete an Endpoint's user data keys. (CIWD-496)

Resolved issues

• This update includes improvements for stability and scalability.

May 14, 2020 (9.0.000.48)

What's New
UI enhancements to exhibiting workitems & better sorting

• You can now:
• Sort columns in the Workitem display panel in multiple ways.
• Drag and drop columns.
• Expand and collapse the contents of fields with more than 200 characters.
• Scroll down through long field displays.

(CIWD-468, CIWD-445, CIWD-340)
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April 30, 2020 (9.0.000.47)

Resolved Issues

• This update includes improvements for stability and scalability.

April 20, 2020 (9.0.000.46)

Resolved issues

• This update includes improvements for stability and scalability.

April 2, 2020 (9.0.000.45)

What's New
Internationalization support

• Cloud iWD now lets you select a localized UI from the User Preferences menu in the iWD Manager
interface. (CIWD-29)
• French and German languages are now supported. (CIWD-28)

• A quick 'filter by Category' button has been added to the Workitem Details view. (CIWD-246)

Resolved issues

• This update includes improvements for stability and scalability.

March 19, 2020 (9.0.000.44)

What's New
Two-way API messaging support

• Cloud iWD now supports two-way REST API messaging between Cloud iWD and multiple source systems.
For more information, see the Cloud iWD API Reference documentation. Consult with your Genesys
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representative to enable this feature.

Stability and scalability

• This update includes improvements for stability and scalability.

March 05, 2020 (9.0.000.43)

What's New
UI Enhancements in iWD Manager

• A new Summary View panel is added to the Settings tab of iWD Manager. This displays details of all
categories, prioritization schemas and endpoints. You can also search the displayed items and export
displayed items to .CSV format.

• You can now search the lists of categories and prioritization schemas by entering search text above the
navigation tree in the respective panels.

• You can now use the names of categories in the Segment by option of the endpoint configuration. This
is useful when multiple categories are configured to use the same endpoint. Using the category for
segmentation along with other item attributes can help to ensure that items from all categories are
pushed to routing.

• The iWD Manager Settings drop-down menu now allows you to select a further colorized display of
workitem states.

February 20, 2020 (9.0.000.42)

What's New
UI Enhancements in iWD Manager

• A Restore defaults button has been added to the iWD Manager Settings drop-down menu. This
feature enables you to restore default columns and sorting views after customizations have been made.

• You can now see workitems' Prioritization schema and Endpoint displayed both in tooltips in the iWD
Manager global workitem list and at the top of the Workitem Details panel.

• The workitem's state is now displayed in a new State column in iWD Manager.
• The following predefined queries have also been added to iWD Manager's global workitem list:

• Was/Is assigned to an agent

• Completed but never been assigned

These enable you to easily identify whether workitems have been processed by an agent.
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Resolved issues

• Bulk actions to workitems in specific Categories are now applied only to the selected Category.
(CIWD-155)

• New attributes that are added to a workitem in the Workitem Details panel are now saved correctly.
(CIWD-148)

• Customized filter criteria in iWD Manager are now preserved across user sessions and page refreshes.
(CIWD-94)

• Empty Due Date values in iWD Manager are now left empty, rather than being updated with the local
time. (CIWD-71)

• Where a workitem field is longer than 30 symbols, you can now see its full content in a tooltip.
Previously, the content was truncated. (CIWD-67)

February 6, 2020 (9.0.000.41)

What's New
Update to Cloud iWD Data Mart

• Cloud iWD 9.0.000.41 is released in tandem with Cloud iWD Data Mart release 9.0.000.47.

For more information on Cloud iWD, see the documentation here.

January 23, 2020 (9.0.000.40)

Resolved issues

• Customized user views in iWD Manager are now preserved across user sessions and page refreshes.
(CIWD-130)

• Users can now export selections of workitems. Previously, export was available only for all workitems.
(CIWD-98)

For more information on Cloud iWD, see the documentation here.

Intelligent Workload Distribution

Genesys Engage cloud Release Note 132

https://docs.genesys.com/Documentation/PSAAS/Public/Administrator/IWD
https://docs.genesys.com/Documentation/PSAAS/Public/Administrator/IWD


January 9, 2020 (9.0.000.39)

What's New
Language support

• iWD Manager now supports the German date format.

For more information on Cloud iWD, see the documentation here.

December 9, 2019 (9.0.000.35)

What's New
Outbound REST Webhook updates

• Support for outbound REST webhook updates of workitem status back to the source system. This
feature enables source systems to follow the progress of the workitem through Cloud iWD and to know
the status of the workitem within Genesys. Genesys Professional Services will configure this feature.

Role-based Access Control

• You can now assign sets of permissions to iWD Manager users to restrict access to different features and
functions. Available roles are:
• iWD Manager User (read-only)
• iWD Manager Supervisor
• iWD Manager Business User
• iWD Manager Administrator

Users without one of these roles assigned cannot log in to iWD Manager.

Enhancements to iWD Manager

• You can now export selected workitems to a CSV format file by clicking the export button at the top
right of the screen.

• Dashboards in the Summary tab now display meaningful labels and descriptions.
• The Help button now opens the iWD Manager topics in the Genesys Engage cloud Administrator's Guide

in a browser window.
• You can now navigate directly from the Genesys brand icon at the top left of the screen to the

genesys.com Business Automation Solutions portal.

Enhancements to Historical Reporting
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• See the Genesys CX Insights release notes.

Support for Gplus Adapter for Salesforce Lightning

• See the Gplus Adapter (V.9) for Salesforce Lightning release notes.

For more information on Cloud iWD, see the documentation here.

October 3, 2019 (9.0.000.27)

What's New
Dashboards

• This release delivers dashboards for real-time monitoring of workitems in iWD Manager. Use these to:
• Identify bottlenecks in arrival and completion patterns.
• View volumes.
• Monitor service level adherence, categories and timing.

You can drill down at any time to the data underlying these dashboards by clicking on the
Workitems tab.

Source system updates

• Source systems can now receive updates as workitems progress through the iWD solution. This feature
connects the iWD solution to the source system by means of a webhook integration configured by
Genesys Professional Services. Outgoing messages do not require a confirmation of receipt from the
source system, so you should consider them as informational only and therefore delivered on a best-
efforts basis.

Sample integration

• This release includes a one-way sample integration of Salesforce.com cases to the intelligent Workload
Distribution API.

For more information on Cloud iWD, see the documentation here.

June 28, 2019 (9.0.000.18)

What's New
Cloud intelligent Workload Distribution (iWD)
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Cloud intelligent Workload Distribution (iWD) captures pre-classified work items (tasks) from any
source system, then continuously re-prioritizes the tasks according to business requirements to
ensure they are pushed to the best available agent at the right time.

• Business Context Configuration—The source system classifies tasks and passes them to Cloud iWD
to match with the appropriate departments and business processes. Tasks can then be viewed and
managed in the Global Task List in iWD Manager, and subsequently reported on. Business users can
easily add new departments or business processes.

• Service Level Agreement-based Rules—Service Level Agreement (SLA) rules prioritize the tasks
from most to least important, based on business value. Cloud iWD automatically re-prioritizes tasks
throughout their lifecycle, ensuring the most important are at the top of the Global Task List.

• Task Management—Operations Managers and Team Leads can:
• View captured tasks in the Global Task List
• Hold, resume, and cancel tasks
• Modify task attributes (modifications take effect immediately)
• Manage flexible and business-friendly prioritization schemes

• Business Insights—Cloud iWD generates task-based statistics that provide insight into business
performance. Business insights are available for the current day, and intraday historically.

For more information on Cloud iWD, see the documentation here.

Intelligent Workload Distribution

Genesys Engage cloud Release Note 135

https://docs.genesys.com/Documentation/PSAAS/Public/Administrator/IWD


Co-browse
Note: Not all changes listed below may pertain to your deployment.

• December 09, 2022 (9.0.016.05)
• June 06, 2022 (9.0.015.02)
• January 28, 2022 (9.0.014.12)
• January 19, 2022
• January 07, 2022 (9.0.014.09)
• July 14, 2021 (9.0.013.00)
• November 2, 2020 (9.0.012.00)
• September 29, 2020 (9.0.011.00)
• June 4, 2020 (9.0.010.00)
• February 3, 2020 (9.0.009.01)
• November 15, 2019 (9.0.008.00)
• September 5, 2019 (9.0.007.00)
• August 12, 2019 (9.0.006.01)
• May 15, 2019 (9.0.004.00)
• November 6, 2018 (9.0.003.02)
• March 2, 2018 (9.0.000.07)
• Known Issues

December 09, 2022 (9.0.016.05)

What's New

• Slots and templates synchronization support is now available for the Web Components feature.
(CB-7864)

• Starting with this release, Co-browse supports constructed CSS objects on web pages. (CB-7863)
• All vulnerable or outdated third-party libraries part of the Co-browse bundle are replaced with their

updated stable versions. (CB-7839)
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Resolved Issues

• The Jetty application server is now updated to version 9.4.49, which is a stabler version without known
vulnerabilities. (CB-7883)

• The Spring libraries set was updated to its most recent stable version, 5.3.20. (CB-7808)

June 06, 2022 (9.0.015.02)

What's New

• Co-browse now supports Microsoft Edge Chromium browser. (CB-7806)
• Co-browse session synchronization now includes HTML web components browser feature support. It is

now possible to synchronize various types of web components with few limitations. For more
information on limitations, see Limitations. (CB-7680)

January 28, 2022 (9.0.014.12)

What's New
This release includes important security fixes related to the Apache Log4j 2 vulnerability
(CVE-2021-44832). In particular, the Log4j version included with Genesys Co-browse has been
upgraded to 2.17.1. (CB-7755)

Resolved Issues

Static resources behind the authentication feature now handle more CSS internal resources to
synchronize agents properly. It is recommended to perform CSS validation before using this feature.
(CB-7648)

January 19, 2022

Deprecations

• Genesys Co-browse — On January 31, 2024, Genesys will deprecate the product called Genesys Co-
browse.

Genesys Co-browse allows an agent and a customer to navigate (browse) the same web page at

Co-browse

Genesys Engage cloud Release Note 137



the same time. With Genesys Co-browse, the agent and the customer share the same instance of
the web page (or browser window), unlike a conventional screen sharing application, where one of
the parties sees the image of the other party's browser instance or the whole desktop.

Genesys recommends customers using Genesys Co-browse to migrate to one of the partners’
offers before Genesys ends support on January 31, 2024, available via the Genesys AppFoundry
and PS Expert Applications. For more information, see Deprecation: Genesys Co-browse.

January 07, 2022 (9.0.014.09)

What's New
This release includes important security fixes related to the Apache Log4j 2 vulnerability
(CVE-2021-44228 and CVE-2021-45105). In particular, the Log4j version included with Genesys Co-
browse has been upgraded to 2.17.0.

Important
Starting from 9.0.014.09, support for Internet Explorer 11 is deprecated and will be
dropped in the future releases.

Resolved Issues

• Static resources behind the authentication feature are now improved for working with CSS. (CB-7642)
• Potentially vulnerable eval() core JavaScript functions are now removed from the frontend code to

improve Co-browse security. (CB-7713)

July 14, 2021 (9.0.013.00)

What's New
This release includes OpenJDK 11 support.
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November 2, 2020 (9.0.012.00)

What's New
This release includes security improvements.

September 29, 2020 (9.0.011.00)

What's New

• A warning message now appears in the agent-side debug log if a web page in the co-browse session
does not contain a correct <!DOCTYPE html> tag. (CB-7457)

• Co-browse no longer encounters an issue with the cbUrl parameter in the customer website
instrumentation. Previously, extra URL parameters were being added after the question sign (?),
causing a malformed URL. (CB-7449)

• Co-browse now correctly passes a co-browse session through pages with multiple redirects. Previously,
the co-browse session could have been lost if the page redirected to another page within a very short
period of time. (CB-7238)

• The modern static resource passing mechanism for the agent-side (called Static Resource Behind
Authentication) is completed and enabled by default. With this mechanism, white-listing web domains
is not needed. (CB-7400)

June 4, 2020 (9.0.010.00)

What's New
JSON related libraries are now updated to address potential security vulnerabilities in the
deserialization mechanism. (CB-6790)

February 03, 2020 (9.0.009.01)

What's New

• Co-browse Server now sets the SameSite=None attribute for the BAYEUX_BROWSER cookie if long-polling
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CometD transport is used. This enhancement addresses the new, stricter browser policies being
implemented (starting 2/4/20 for Chrome, and starting at later dates for other browsers). Without this
flag, the Co-browse session will not work due to Co-browse being on a different domain than the Co-
browsed web page. (CB-7310)

Important
We highly recommend using web sockets instead of long-polling to improve Co-browse session
performance.

• Co-browse now has a new mechanism for scrolling synchronization. To enable, set
cobrowse.useByElementScrolling to true in the instrumentation. For example:

let _genesys = {
cobrowse: {

useByElementScrolling: true
}

}

This feature is considered experimental. See Known Issues for additional information. (CB-7230)

• Co-browse now uses an additional layer of security for agents, Content Security Policy (CSP), in
browsers that support it. To benefit from this, we recommend that your agents use modern browsers to
run Agent Desktop and not use Internet Explorer 11. (CB-7036)

November 15, 2019 (9.0.008.00)

What's New
Co-browse can now proxy files that have a space symbol in their names. (CB-6915)

Resolved Issues

Co-browse now works properly with <iframe> tags that are added to the page during a co-browse
session. (CB-7034, CB-6984)

September 5, 2019 (9.0.007.00)

What's New
Resolved Issues

• This release includes behavior and stability improvements. (CB-6906, CB-6811)
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• Improvements have been made to the German and French localizations. (CB-6808)
• Co-browse now better supports pages that use "fr" CSS units. (CB-6737)
• The following improvements have been made to the DOM Restrictions Editor:

• The Back and Forward buttons now work correctly. (CB-6395)
• The URL of the previewed page is now updated if the user navigates from one page to another by

using links. (CB-6868)
• Intermittent issues no longer occur with certain types of restrictions that contain attribute selectors,

for example; [class="a_class"]. (CB-6900)
• Restrictions no longer intermittently display improperly when a regular expression is used to

configure on which pages the restrictions should be applied ("Apply to all regexp matches"
setting). Note: This issue only affected the representation of the restrictions in the DOM
Restrictions Editor UI; it did not affect the actual Co-browse sessions. (CB-6850)

• The DOM Restrictions Editor now works properly if Write Mode for Co-browse is disabled in the
tenant configuration. Previously in this scenario, some features didn't work correctly. (CB-6202)

August 12, 2019 (9.0.006.01)

What's New

• Co-browse can now be localized in German and French. (CB-6437)

Resolved Issues

• This release includes behavior and stability improvements. (CB-6726, CB-6789, CB-6787, CB-6733,
CB-6656, CB-5874)

May 15, 2019 (9.0.004.00)

What's New

• Co-browse is now available with the new Genesys Agent Desktop.

Resolved Issues

• Co-browse no longer occasionally hides all of the page content from the agent if the style attribute of
<body> was dynamically changed during a co-browse session. (CB-6017)

• Co-browse no longer synchronizes most of the <meta> tags. Previously, their synchronization could
negatively affect the experience in certain scenarios. (CB-5847)
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• Co-browse now sends the correct notification when signaling the end of a session. Previously, Co-browse
was not sending the proper reason, which affected the JavaScript APIs (onSessionEnded callback), and
the agent UI where a wrong notification was shown when the session ended. (CB-5638)

• Co-browse now correctly synchronizes pages that use <link rel="import"> tags. (CB-5671)
• Co-browse now loads without browser console warnings on pages containing iframes. (CB-5709)
• The Co-browse JavaScript API events onSessionStarted and onSessionEnded are now available from

both the main page context and from nested iframes contexts. Handlers for these signals will be
executed in all existing contexts where handlers are present. To call handlers only in top context, as in
earlier Co-browse releases, use the isTopContext JavaScript API method to distinguish top and child
co-browse contexts. (CB-5709)

• The customer-facing tooltip indicating masked content from the agent is now removed from inside the
iframe when the co-browse session ends. (CB-5709)

• Co-browse now correctly synchronizes the display of body elements. Previously, Co-browse always set a
value of display: block in document.body in the agent's browser, even if the co-browsed page
contained a different value, for example flex. This sometimes led to problems with the synchronization
of layout and scrolling. (CB-5951)

• Co-browse now better synchronizes the agent's typing in Write Mode, in cases outside of normal
operating parameters. (CB-5674)

November 6, 2018 (9.0.003.02)

What's New
Configure DOM restrictions

• Co-browse now has a new, intuitive UI for easily configuring DOM restrictions in a WYSIWYG fashion,
requiring little to no technical knowledge. You can configure the elements that you need to mask from
your agents and the elements that should be visible to agents, but non-interactive. You don't need to
modify your website to set up the restrictions, and you no longer need Genesys Professional Services to
assist.

Image masking

• Co-browse now masks images when Data Masking is used for them. Previously, only textual content was
masked, leaving images intact. Note: only <img/> tags are masked. If an image is rendered using CSS
(for example, as a background-image) it won't be masked. The <picture> and <source> elements are
not yet supported. If your web page uses them for an image, this image may not be masked for the
agents.

Size control

• Agents now have a zoom-to-fit/actual size control allowing them to avoid unnecessary scrolling and to
get a better overall picture of the co-browsed content. Previously, the Co-browse area of Agent Desktop
had a fixed zoom level that was tied to the size of the customer's browser. In some situations, this
forced the agent to use the scroll bars (including horizontal) to see different areas of the shared web
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page.

Historical reports

• Co-browse now has two historical reports available in Genesys CX Insights: The Details report, which
enables you to see details on any co-browse session, such as when it started and finished, the related
interaction, pages visited, and so on. The Summary report, which enables you to find answers to
questions such as "What percent of interactions had Co-browse sessions?" or "How long did a Co-
browse session last on average?" More reports will be available in future releases.

Resolved Issues

• The Agent Desktop inactivity timeout now resets for different types of an agent's activity in the web
page during co-browsing, such as keyboard typing, scrolling, navigation, and so. Previously, the timeout
reset only when the agent moved his or her mouse. (CB-4750)

• The co-browse session now ends when the customer ends a voice call with the agent. Previously, the
co-browse session did not end until the agent clicked Mark Done in Agent Desktop. (CB-4677)

• The co-browse run-time voice statistics are now updated when the co-browse session ends. (CB-4710)
• The customer-facing tooltip indicating masked content from the agent is now removed when the co-

browse session ends. (CB-5419)
• The agent can no longer join a co-browse session after the chat or voice call has ended. (CB-4571)
• A mousedown or mouseup event no longer replays on restricted elements. (CB-5816)

March 2, 2018 (9.0.000.07)

What's New
Initial release

• End-users can now request a Co-browsing session, associated with either a Voice or a Chat interaction.
The Co-browsing session can be requested from either the Channel selector Widget (Voice interaction)
or from the Chat Widget (Chat interaction).

• Supported browsers:
• End-user: Internet Explorer 11, Edge, Firefox ESR, Chrome (Desktop and Android)
• Agent, as part of Agent Desktop: Internet Explorer 11, Edge, Firefox ESR, Chrome (Desktop only)

• This first Cloud version inherits from almost all Premise version features: data masking and DOM
control, domains whitelisting, Read/Pointer mode and Write mode.
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Known Issues

Revealed DOM-restriction elements in the Agent UI

• Restricted DOM element frames might be visible in the Agent UI even when the base element is covered
by another layer or element if the display="none" attribute is not set. Genesys recommends setting
the display="none" attribute for these elements.
(CB-7630)

Possible suppressed cookie tracking in browsers

• A Co-browse session cannot be established when all the following conditions are true:
• The Co-browse URL domain differs from the client's website domain.
• Third-party cookie-tracking privacy settings is suppressed in the client browser.
• Headers Access-Control-Expose-Headers and Access-Control-Allow-Headers are not set in the

website response.

To fix this issue, set the headers Access-Control-Expose-Headers and Access-Control-Allow-
Headers with the same domain as the Co-browse URL domain. (CB-7629)

Scrolling issue

• The following are known issues for the scrolling synchronization mechanism
(cobrowse.useByElementScrolling = true):
• Only vertical scrolling is supported (horizontal scrolling is not supported).
• The scrolling synchronization might not behave properly on multi-column layouts or layouts that

have sticky (fixed position) menus.
(CB-7230)

Limitations

• Web components with shadowDom can be synchronized with an agent only if shadowDom was created as
{mode:open}. For components {mode:closed}, it is only possible to fill a component space with the
same size mock.

• Input synchronization inside web components works only from the master page to an agent. Input will
not be synchronized from an agent’s component reflection to the master page.

• Though DOM-restrictions with jQuery syntax work for web components, it could be an issue that a
component is restricted on master or agent side. A restricted image space might have a different
background color or frame inside the web component on agent side.
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CRM Gplus Adapters
Note: Not all changes listed below may pertain to your deployment.

• May 18, 2020 (8.5.202.76)
• March 12, 2018 (8.5.202.23)
• January 29, 2018 (8.5.202.15)
• November 13, 2017 (8.5.201.99)
• October 16, 2017 (8.5.201.95)
• September 18, 2017 (8.5.201.91)
• August 21, 2017 (8.5.201.87)
• July 17, 2017 (8.5.201.84)
• June 19, 2017 (8.5.201.80)
• May 15, 2017 (8.5.201.74)
• April 17, 2017 (8.5.201.71)
• March 20, 2017 (8.5.201.66)
• Known Issues
• Archive

May 18, 2020 (8.5.202.76)

What's New
Chrome v80+ SameSite cookie support

• The Chrome v80+ SameSite cookie attribute processing changes are now supported by Gplus Adapter.

March 12, 2018 (8.5.202.23)

What's New
Agent Desktop deployed as an embedded application in Salesforce Console
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• Screen pop on Event Invite for Genesys Chat and Genesys Email events
• The current Salesforce object attached to the voice transfer event is available on the screen pop on the

receiving Agent's desktop although the screen pop for internal call is disabled

Agent Desktop deployed as an embedded application in Salesforce Lightning Experience

• Genesys Outbound Campaign
• Screen pop for Pull Preview
• Activity tracking for Outbound calls established through the Pull Preview mode

Resolved Issues

• When voice interactions are automatically marked done on release, performing a two-step transfer no
longer produces duplicate activity logs in Salesforce. (HTCC-28856)

• When transferring a call created using the Participant call back action, the user data is now transferred
correctly. (HTCC-28858)

• When mandatory disposition is enabled, the call back feature is no longer available under the
Participants section, which resolves the issue of call back interactions not getting closed. (HTCC-28632)

January 29, 2018 (8.5.202.15)

What's New
Agent Desktop deployed as an embedded application in Salesforce Lightning Experience

• Genesys Email
• Associating email interactions with Genesys Universal Contact Server (UCS) and creating entries in

the interaction history with disposition and notes
• Screen Pop:

On email acceptance

Passing data field as a search expression

Passing transfer object key for screen pop on transfers

• Activity Tracking:
Logging the Salesforce Activity for each email upon mark done

Storing the email body as part of Activity description

CRM Gplus Adapters

Genesys Engage cloud Release Note 146



November 13, 2017 (8.5.201.99)

What's New
Browser support

• Microsoft Edge on Windows 10 operating system:
Agent Desktop deployed as an embedded application in Salesforce Console.

Agent Desktop deployed as an embedded application in Salesforce Lightning Experience.

Resolved Issues

• Participants drop down in an active call allows the agent to redial the party that has hung up the call.
(HTCC-28298)

October 16, 2017 (8.5.201.95)

What's New
Agent Desktop deployed as an embedded application in Salesforce Lightning Experience

• Associating Voice interactions with Genesys Universal Contact Server (UCS) contacts with the ability to
turn on/off in Agent Setup with UCS for Voice is now supported.

• Genesys Web Chat
• Associating Web Chat interactions with Genesys Universal Contact Server (UCS) where the

interaction history is provided with disposition and notes is now supported.
• Screen Pops:

For chat acceptance.

Passing data field as a search expression.

Passing transfer object key for screen pop on transfers.

• Activity Tracking:

Logging the Salesforce Activity for each chat upon mark done.
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September 18, 2017 (8.5.201.91)

What's New
Resolved Issues

Gplus Adapter for Salesforce

• Genesys Screen Recording now correctly records the call when there is a change of agent login in the
adapter regardless of the first agent’s logout from Salesforce. (HTCC-27917)

• Adapter no longer displays the Consultation section without call controls, when an agent completes
consultation in a call in the advanced case data view. (HTCC-28144)

• Intermittent failure to load the Adapter no longer occurs after a user logged in. (HTCC-23474)

August 21, 2017 (8.5.201.87)

What's New
Agent Desktop deployed as an embedded application in Salesforce Lightning Experience

• Agent Desktop deployed as an embedded application in Salesforce Lightning Experience (currently
available for Voice only) and supports the following:

Setting up the adapter with Salesforce Lightning Experience (Enabling Lightning Experience)

Outbound click-to-dial on any Salesforce Phone field

Screen pop:

— Screen pop for Ringing and Established Event

— Ability to turn on/off ANI as a search key

— Ability to pass data field as a search expression

— Passing transfer object key for screen pop on transfers

Activity Tracking: Logging the Salesforce Activity History for each voice call upon mark done

Free Seating: Prompt Place is set to True in Desktop Options -> Global Login using Agent Desktop

Resolved Issues

Gplus Adapter for Salesforce

• Agent and Agent Group presence can now be disabled in Team Communicator. (HTCC-27819)
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July 17, 2017 (8.5.201.84)

What's New

• Gplus Adapter for Salesforce introduces the new Genesys branding in the user interface.

June 19, 2017 (8.5.201.80)

What's New
Screen Recording

• Genesys Interaction Recording Screen Recording is now supported when agents use the voice channel.

May 15, 2017 (8.5.201.74)

What's New
Statistic View

• When enabled, the Contact Center Statistic View in the Report menu now opens showing all statistics as
a full expanded list.

Resolved Issues

• The Adapter now uses Agent Setup Recording option in Desktop Options to enable the buttons used for
start/stop/resume recording. (HTCC-26668)

April 17, 2017 (8.5.201.71)

What's New
Browser support

• Google Chrome browser version 54+
• Firefox browser version 45+
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Agent passwords

• The Adapter now allows agents to change their password.

Agent Desktop deployed as an embedded application in Salesforce Console

• Genesys Interaction Recording Screen Recording is now supported when agents use the voice channel.
• When sending a new outbound email, the embedded Agent Desktop creates a Salesforce contact

activity history after the agent clicks Send.

March 20, 2017 (8.5.201.66)

What's New
Gplus Adapter for Salesforce

• When a voice call is put on hold, the Adapter starts counting the hold duration in the timer located in
upper-right corner, and resets the timer when the call is retrieved from hold.

Resolved Issues

Gplus Adapter for Salesforce

• When an outbound call is establishing or in a call queue, agents are now able to access the dialpad.
Previously, the dialpad option was hidden in these circumstances. (HTCC-26407)

• When selecting a voicemail in the Adapter main menu, the main menu now collapses. Previously, the
main menu stayed open (HTCC-24922)

Known Issues

• While the Adapter is open in multiple tabs in Salesforce Classic mode, dialing the hung up participant
using the call back feature displays an error. (HTCC-28682)

• Agent Desktop deployed as an embedded application in Salesforce Lightning Experience may get
minimized on screen pop as a result of a chat transfer or consultation, or during any operation that
refreshes the browser. (HTCC-28681)

Workaround

Click the Workspace button to display the Adapter again.

• Agent Desktop deployed as an embedded application in Salesforce Lightning Experience fails to update
the interaction user data when sending a reply email. (HTCC-28619)

• If Security Assertion Markup Language (SAML) is enabled, the adapter’s login dialog doesn’t fit into its
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display area in Salesforce.

• If a user drags the adapter to change its location in the Salesforce console, input controls such as on the
dial pad or in Team Communicator don’t respond. (HTCC-18459)

Workaround

Click outside of the adapter frame and then click inside the adapter to allow the input controls to
function normally.

• If the user does not click within the Salesforce UI or the adapter after refreshing the page and before
receiving a new call, screen pop might not occur if the adapter is configured to perform screen pop
when ringing. (HTCC-15740)

Note

This issue can’t be fixed given the current capabilities provided by Salesforce.

Archive
[+] Click to show archived release notes

January 30, 2017 (8.5.201.61)

What's New
Resolved Issues

Gplus Adapter for Salesforce

• Salesforce activities are now created correctly when the Adapter is open in multiple tabs. Previously, in
rare circumstances, Salesforce activity creation failed if an agent had Salesforce open in multiple
browser tabs. (HTCC-25179)

• In a Salesforce activity task, the Adapter sets the Call Type field to "Inbound" for all completed chat
interactions. (HTCC-24711)

• When marking a call or a chat done without selecting a disposition while dispositions are mandatory,
the warning message displayed is now in the format: "You must select a '<Business Attribute Display
Name>' before closing", where '<Business Attribute Display Name>' is the configured business
attribute display name. (HTCC-25735)

• Agent Desktop deployed as an embedded application in Salesforce Console
In a Salesforce activity task, the embedded Agent Desktop sets "Call Type" field to "Inbound" for
incoming email interactions, and to "Outbound" for outgoing emails including replies.
(HTCC-24149)

In a Salesforce activity task, the embedded Agent Desktop sets the Call Type field to "Inbound" for
all completed chat interaction (HTCC-24148)
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November 14, 2016 (8.5.201.50)

What's New
Resolved Issues

Gplus Adapter for Salesforce

• Agent Desktop deployed as an embedded application in Salesforce Console
The Call icon is now correctly displayed in an interaction popup. Previously, no Agent Desktop call
icon was displayed. (HTCC-24449)

October 17, 2016 (8.5.201.45)

What's New
Gplus Adapter for Salesforce

• In Salesforce console mode the Adapter now provides a drop-down menu in the Interaction Details
screen to link to Salesforce open tabs or sub-tabs.

• Agent Desktop deployed as an embedded application in Salesforce Console
For email interactions, Salesforce object name, object type and object id can be saved to Genesys
User Data.

Resolved Issues

Gplus Adapter for Salesforce

• Previously, when agents received a call and marked the call done in the Advanced Case Data view, then
received a second call, the Voice channel went blank. This no longer occurs. (HTCC-23002)

• Previously during a chat, even if selecting a disposition was mandatory, agents were able to mark the
interaction done without selecting a disposition. This no longer occurs. (HTCC-23498)

• In Salesforce classic mode, the Object Association drop-down list box is no longer visible in the Adapter
voice details screen. This feature is not available for classic mode. (HTCC-23861)

• Agent Desktop deployed as an embedded application in Salesforce Console
If a failure occurred in the Salesforce console, agents were unable to mark done their interactions.
This no longer occurs (HTCC-21987)

The Last Month, Last Week, and Last Day labels on the Contact Directory History tab filter control
now display correctly. Previously, these labels were not displayed. (HTCC-23547)
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October 6, 2016 (8.5.201.37 UPDATE)

What's New
Resolved Issues

Gplus Adapter for Salesforce

• Agent Desktop deployed as an embedded application in Salesforce Console
During a chat, even if selecting a disposition was mandatory, agents were able to mark the
interaction done without selecting a disposition. This no longer occurs. (HTCC-24471)

August 15, 2016 (8.5.201.37)

What's New

• Agent Desktop deployed as an embedded application in Salesforce Console
For emails, the adapter now adds the email body to the activity history comments field.

July 18, 2016 (8.5.201.33)

What's New
Resolved Issues

• Agent Desktop deployed as an embedded application in Salesforce Console
The Adapter now correctly allows agents to close Outbound voice interactions after selecting a
disposition. Previously, a message was sometimes displayed that asked agents to set a disposition
code before closing an interaction even though a disposition was already selected. (HTCC-22582)

June 20, 2016 (8.5.201.29)

What's New
Gplus Adapter for Salesforce

• The Adapter can now be configured to create a new contact in the Genesys database.
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• The Adapter can now be configured to associate voice interactions with contacts created in the Genesys
database, and add entries in the contact history with a disposition and notes.

• In Salesforce console mode, the Adapter can be popped out to open in a separate browser window.
• In Salesforce console mode, when the Adapter window is minimized and there is a Genesys server

disconnect, the Adapter attempts to reconnect within 90 seconds. If the connection is not restored, the
window is maximized and a message is displayed to ask users to refresh their browser windows.

• The Adapter now shows agent name instead of extension in the call detail view.
• For chat interactions, the Salesforce object type can be saved in Genesys attached data when a chat is

marked as done.

• Agent Desktop deployed as an embedded application in Salesforce Console
In Agent Desktop mode, when the Adapter window is minimized and there is a Genesys server
disconnect, the Adapter attempts to reconnect within 90 seconds. If the connection is not restored,
the window is maximized and a message is displayed to ask users to refresh their browser
windows.

Resolved Issues

• Agent Desktop deployed as an embedded application in Salesforce Console
The Adapter will now carry over the notes to the Salesforce activity once the call is marked done.
(HTCC-21945)

May 16, 2016 (8.5.201.25)

What's New
Resolved Issues

Gplus Adapter for Salesforce

• When using the adapter in Salesforce and using multiple tabs, the Mark Done synchronization in
inactive tabs no longer fails when dispositions are mandatory. (HTCC-21203)

Gplus Adapter for Zendesk

• Custom phone fields on tickets are no longer incorrectly updated with the caller’s phone number when
the ticket is marked as done. (HTCC-21435)

• Resizing the adapter window has been improved. Previously, if the window was resized too quickly,
resizing stopped and the agent needed to click the window again to start over. (HTCC-21278)
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April 18, 2016 (8.5.201.20)

What's New
Gplus Adapter for Salesforce

• Administrators are able to specify what the adapter saves for the subject field in the Salesforce activity
by using custom templates.

• For Salesforce account, case, or contact objects, agents are able to attach additional information (object
type, id or name) to Genesys user data in voice interactions

• The adapter is able to be configured to automatically submit feedback logs after being disconnected.

• Agent Desktop deployed as an embedded application in Salesforce Console
Administrators are able to specify what the adapter saves for the subject field in the Salesforce
activity by using custom templates.

For Salesforce account, case, or contact objects, agents are able to now attach additional
information (object type, id or name) to Genesys user data in voice interactions

Resolved Issues

Gplus Adapter for Salesforce

• The adapter no longer fails to render properly after logging out and subsequently logging in with
voicemail enabled. (HTCC-21020)

• The disposition code chosen for voice calls within the adapter is now visible in the interaction history in
Agent Desktop. (HTCC-20459)

March 21, 2016 (8.5.201.17)

What's New
Gplus Adapter for Zendesk

• Adapter UI integration with Zendesk
Screen pop

Outbound Click-to-Dial

Activity Tracking, where comments are inserted to Zendesk Tickets

• Inbound Voice
Call controls – Accept, Reject, Hold, End Call, Transfer, Conference

Inbound toast alert

Case Data View
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Recording controls – Pause, Start, Stop

• Agent Status Management

• Free Seating based on Place or Extension (Genesys SIP only)

Resolved Issues

Gplus Adapter for Salesforce

• Results in the Favorites view are no longer cleared after you add or edit a favorite. (HTCC-20052)

• Agent Desktop deployed as an embedded application in Salesforce Console
When you click the desktop notification for new interactions, the Agent Desktop will now correctly
display. (HTCC-19751)

February 22, 2016 (8.5.201.12)

What's New
Voicemail

• The adapter now provides access to personal and group/shared voicemail boxes.
• The number of unread voicemail messages is displayed as a red number.
• The total number of voicemail messages is displayed in parentheses.
• Agents can call their voicemail boxes directly.

Gplus Adapter for Salesforce

• Agent Desktop deployed as an embedded application in Salesforce Console
Ability to turn activity tracking off

Supervisor monitoring, coaching, and barge-in

Resolved Issues

• The adapter now makes fewer API calls when it’s refreshed, which improves the refresh time.
(HTCC-19378)

• Team Communicator menu for adding favorites is no longer blocked when agent try to add items to
personal favorites (HTCC-19935)

• An agent can now pop the Agent Desktop window out of Salesforce before marking the transaction as
complete (Mark Done) or while handling an outbound preview record. Previously, Agent Desktop did not
refresh properly in this scenario. (HTCC-16538, HTCC-16484, HTCC-16450)
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Gplus Adapter (V.9) for Salesforce
For information about the latest releases of Gplus Adapter (V.9) for Salesforce, refer to Agent Desktop
and Gplus Adapter Release Notes.

Important
Not all changes listed below may pertain to your deployment.

Warning
When migrating to Gplus Adapter 9.0 for Salesforce, you must use the following
procedure.

Important
Gplus Adapter v9 documentation is available here:

• Gplus Adapter 9 for Salesforce Administrator's Guide
• Gplus Adapter 9 for Salesforce Agent's Help

• March 25, 2021 (9.0.000.59)
• March 4, 2021 (9.0.000.58)
• January 27, 2021 (9.0.000.57 UPDATE)
• October 29, 2020 (9.0.000.55 UPDATE)
• September 17, 2020 (9.0.000.53)
• August 11, 2020 (9.0.000.52)
• July 16, 2020 (9.0.000.51)
• May 14, 2020 (9.0.000.48)
• March 26, 2020 (9.0.000.47)
• January 23, 2020 (9.0.000.43 UPDATE)
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• October 24, 2019 (9.0.000.33)
• September 26, 2019 (9.0.000.30)
• Known Issues
• Limitations

March 25, 2021 (9.0.000.59)

What's New
Genesys Smart Failover Support

• Gplus Adapter supports Genesys Smart Failover for disaster recovery scenarios. This feature enables
you to switch agents automatically to a backup URL configured in Salesforce in the event that the
primary URL is inaccessible.

Resolved Issues

• Gplus Adapter now loads correctly in Internet Explorer 11. Previously, agents using this browser could
not progress beyond the login view. (GAPI-26787)

March 4, 2021 (9.0.000.58)

What's New
Screen pop for Outbound

• Gplus Adapter can now be configured to screen pop Salesforce Records on the Dialing and
Established Genesys Interaction events. To enable this feature, configure the Screen Pop for
Outbound Calls option in Agent Setup.

Supervisor support updated

• When a supervisor starts monitoring, coaching, and barging-in calls, Gplus Adapter features only occur
on the supervised agent's Gplus Adapter.

Salesforce High Velocity Sales support

• Gplus Adapter now supports Salesforce High Velocity Sales.

Salesforce Classic support enhancement

• Chat, email, and workitem channels are now supported for Salesforce Classic.
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Resolved Issues

• The Service Client API sample now contains automatic subscription to Agent Desktop events.
(GAPI-25901)

January 27, 2021 (9.0.000.57 UPDATE)

What's New
Create new record on screen pop

• Gplus Adapter can create and screen pop (display) a new Salesforce record during an interaction. To
configure this feature specify Create New Salesforce Record on Screenpop, Salesforce Object
API Name, and New Salesforce Record Field Mapping options in Agent Setup.

Gplus notifications in UI

• Gplus Adapter can display notifications when Salesforce Activity Tasks are created, related to a
Salesforce record, or updated. This feature is configured by the Notifications setting in Agent Setup.

Gplus in one Browser tab

• Gplus Adapter can prevent loading in more than one browser tab when an agent opens Salesforce in
multiple browser tabs. This feature is configured by the Prevent Gplus in Browser Multitab option in
Agent Setup.

Resolved Issues

• Agents no longer have to clear the browser cache after an upgrade of the Genesys Web Services
platform. (GAPI-24125, GAPI-24985).

October 29, 2020 (9.0.000.55 UPDATED)

What's New
Salesforce Activity Task association

• Gplus Adapter now supports Salesforce Activity Task association workflow based on an open Salesforce
record. Contact Genesys to enable this feature and specify whether Gplus Adapter associates Activity
Tasks to Salesforce objects based on search (default behavior) or based on the open Salesforce record
at the time the interaction is completed. Use the Auto Activity Log Association option in Agent
Setup to specify whether Gplus Adapter associates Activity Tasks based on Salesforce Search or on
the Salesforce Open Record.
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• Gplus Adapter introduces the Object Association table into the Gplus Adapter UI for Salesforce
Lightning. Gplus Adapter stores opened Salesforce records in the Object Association table. To
associate an Activity Task, agents can select a record in the Gplus Adapter UI before the interaction is
completed. Use the UI Activity Log Association option in Agent Setup to specify whether Gplus
Adapter displays the Object Association table.

September 17, 2020 (9.0.000.53)

What's New
Salesforce Classic support

• Support for Gplus Adapter in Salesforce Classic for voice, and migration from Gplus Adapter 8.5 to 9.0 in
Salesforce Classic.

Salesforce Multiple Search Match support

• When a Salesforce screen pop returns multiple matching records, Gplus now associates the activity log
with the active Salesforce object opened by the agent at the time the agent marks the interaction as
done.

Resolved Issues

• Gplus Adapter now associates the Salesforce activity log to the Salesforce object from where the click-
to-dial Internal call was initiated. Previously, Gplus associated Outbound calls only. (GAPI-23046)

August 11, 2020 (9.0.000.52)

What's New
Browser cache update

• The agent browser cache is automatically refreshed when Adapter is upgraded.

Screen pop on outbound email creation

• Adapter initiates a screen pop based on whether the Screen Pop on Outbound Email Create setting
is selected.

Resolved Issues

• Enabling the SameSite setting in agent browsers no longer results in a disconnection to the server and
a loss of interaction channels when an agent logs in to Gplus Adapter. (GAPI-22744)
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July 16, 2020 (9.0.000.51)

What's New
Browser-based WebRTC

• Gplus Adapter supports now WebRTC capabilities of the Chrome and Firefox browsers.

Run Salesforce Apex

• Gplus Adapter can execute Salesforce Apex initiated by the Genesys interaction events. Configure this
feature by using the Run Salesforce Apex on Interaction Events option in Agent Setup.

Service Client API support

• Gplus Adapter supports the Service Client API for custom integrations between Salesforce and Genesys.
Configure this feature by using the Salesforce Message Channel Name for Service Client API
option in Agent Setup.

Activity log record from Click-To-Dial

• Gplus Adapter obtains the Salesforce Object ID from a Click-To-Dial outbound call and then creates and
associates an activity log record with the object from which the call was dialed.

May 14, 2020 (9.0.000.48)

What's New
Status display

• The Gplus Adapter button in the Salesforce Lightning Utility Bar now displays the current status of an
agent obtained from Workspace Agent Desktop. If Gplus Adapter is minimized, it still reflects changes
to the current status.

March 26, 2020 (9.0.000.47)

What's New
Salesforce object search by DNIS
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• Gplus Adapter passes DNIS (the number that the caller dialed) from the voice interaction to search the
Salesforce objects and screen pop matching record. This feature is configured by Use DNIS in Screen
Pop Search in Agent Setup.

DNIS pre-processing and screen pop

• Gplus Adapter pre-processes DNIS (the number that the caller dialed) before searching the Salesforce
objects This feature is configured by Use DNIS in Screen Pop Search and Screen Pop
Preprocessing Rule in Agent Setup.

Activity log on screen pop

• Gplus Adapter creates an activity log on screen pop in the matching Salesforce record. This feature is
configured by Activity Log on Screen Pop in Agent Setup.

Chrome v80 SameSite cookie support

• Gplus Adapter now supports the Chrome v80 SameSite cookie attribute processing changes.

Custom status when creating task

• Gplus Adapter can now save a custom value in the Salesforce activity log status field. This feature is
configured by Salesforce Activity Log Status in Agent Setup.

Screen pop by Object Type

• Gplus Adapter can now screen pop different object types for voice interactions. This feature is
configured by Screen Pop object type in Agent Setup. Available object types are:
• FLOW: Specify Screen Pop Flow.
• URL: Specify Screen Pop URL.
• OBJECTHOME: Specify Screen Pop Object Home section name.
• LIST: Specify Screen Pop List section name.
• SEARCH: Specify Screen Pop Search section name.
• NEW_RECORD_MODAL: Specify Screen Pop New Record section name.

January 23, 2020 (9.0.000.43 UPDATE)

What's New
Search for Salesforce objects

• The search for Salesforce objects to link a new activity log to has been improved.
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October 24, 2019 (9.0.000.33)

What's New
Open Media activity history

• Adapter allows you to specify Open Media (Workitem) interaction type to enable or disable activity
history entries creation in Salesforce.

Gplus Adapter with Salesforce Single sign-on (SSO) identity provider

• Simplify your agent login process by using Salesforce as your single sign-on (SSO) identity provider
(IDP). Now your agent only has to provide their Username to log in to Gplus Adapter after they have
logged into Salesforce.

September 26, 2019 (9.0.000.30)

What's New
Initial Release

• Gplus Adapter now integrates the new Agent Desktop.
• Gplus Adapter is compliant with Salesforce Lightning Open CTI.
• Gplus Adapter agents can now handle voice interactions through the Genesys Softphone in Connector

Mode.
• Gplus Adapter keeps the session established between Genesys Server and Salesforce by verifying the

session at regular intervals.

Voice

• The following features are supported for voice interactions:
• Screen pop for making and receiving calls, consultations, transfers and conferences.
• Screen pop on ringing and established event.
• Creating activity history in Salesforce record for voice interactions on Mark Done.
• Saving Salesforce Object attributes to Genesys key-value pairs (KVP) on Mark Done.
• Click-to-Dial from Salesforce Phone fields.
• Associating voice interactions with Genesys Contacts Server.
• Supports custom Subject field for voice activity history with templates.

Chat
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• The following features are supported for chat interactions:
• Screen pop on chat event invite and chat acceptance.
• Creating activity history in Salesforce record for chat interactions on Mark Done.
• Associating chat interactions with Genesys Contacts Server.
• Supports populating chat transcript in a custom activity field.
• Supports custom Subject field for chat activity history with templates.

• Integration with Genesys Digital Channels Asynchronous chat.
• Screen pop on chat event invite and chat acceptance.
• Creating activity history in Salesforce record for chat interactions on Mark Done.
• Associating chat interactions with Genesys Contacts Server.
• Supports populating chat transcript in a custom activity field.
• Supports custom Subject field for chat activity history with templates.

Email

• The following features are supported for email interactions:
• Screen pop on email event invite and email acceptance.
• Creating activity history in Salesforce record for email interactions on Mark Done.
• Storing the email body as part of activity description.
• Associating email interactions with Genesys Contacts Server.

Outbound Campaign

• The following features are supported for Outbound campaign interactions
• Screen pop for Push and Pull Previews.
• Creating activity history in Salesforce record for Outbound calls established through the Push and

Pull Preview modes.

Open Media

• The following features are supported for open media interactions:
• Screen pop on workitem event invite and workitem acceptance.
• Creating activity history in Salesforce record for workitem interactions on Mark Done.
• Genesys iWD workitems are saved to workbins, activity history, and so on.

Genesys Interaction Recording

• Gplus Adapter features are supported for Genesys Interaction Recording for voice.

If you're looking to migrate to Gplus Adapter 9.0, follow the steps explained in the migration
procedure.
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Known Issues

• Agents cannot download attachments from email interactions. Attachments must be view in the Agent
Desktop view. (GAPI-26537)

Limitations

• Due to a Salesforce limitation, Task Association cannot be created for consultation calls because the
"Call type" (Salesforce pick list) Task field does not support the Consult value.
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Gplus Adapter for Microsoft Dynamics 365
Note: The updates listed below might not apply to all environments.

• August 02, 2022
• August 02, 2021
• June 02, 2021
• April 02, 2021
• June 26, 2020
• April 02, 2020
• January 17, 2020
• Known Issues

August 02, 2022

What's New
Gplus Adapter now supports:

• WorkItem as a new channel for agents.
• Multiplatform InstanceURL configuration.

Resolved Issues
There are currently no resolved issues.

Known Issues
There are currently no known issues.

August 02, 2021

What's New

• Gplus Adapter now supports WebRTC.
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• Gplus Adapter is now available for Dynamics Customer Service Workspace that will allow agents to work
on multiple sessions at a time in a single workspace experience.

Resolved Issues
There are currently no resolved issues.

Known Issues
There are currently no known issues.

June 02, 2021 (9.0.004.01)

What's New
This release includes only resolved issues.

Resolved Issues
Agents can log in successfully without any errors. Previously, there were issues when agents tried to
log in.

Known Issues
There are currently no known issues.

April 02, 2021 (9.0.004.00)

What's New

• Gplus Adapter now supports the Workflow Designer. This tool allows administrators to customize how
the screenpop and records can be created in Dynamics 365.

Resolved Issues

• Recording handling buttons (start, stop, pause recording) are no longer hidden when active recording is
set for an agent’s management.

• The Adapter no longer hangs if the agent was configured with non-voice channels.
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Known Issues
There are currently no known issues.

June 26, 2020 (9.0.003.00)

What's New

• Gplus Adapter now supports Microsoft Channel Integration Framework (CIF) V2.0.

April 02, 2020 (9.0.002.00)

What's New

• Gplus Adapter now supports Microsoft Unified Service Desk (USD).

January 17, 2020 (9.0.0.0)

What's New

• Gplus Adapter is embedded in Microsoft Dynamics 365
• Single pane desktop user experience
• Support Channel Integration Framework (CIF) V1.0
• Customer Engagement Applications for Sales and Customer Service
• Activity history tracking (type = Phone Call)
• Customizable screen pop

• Agent Status Management - Ready, Not Ready (with Reasons), Logoff, and so on
• Agent Performance Tracker
• Inbound/Outbound Voice

• Call controls – Make call, Accept, Hold, End Call, Transfer, Conference
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• Inbound toast alert
• Case Data view
• Free Seating based on Place (Genesys SIP only)
• Click-to-call from Dynamics Phone field

Known Issues

There are currently no known issues.

For documentation, see Gplus Adapter for Microsoft Dyanamics 365.
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Gplus Adapter for Service Now

Important
Not all changes listed below may pertain to your deployment.

• July 05, 2022
• August 02, 2021
• June 12, 2020

July 05, 2022 (9.1.002.00)

What's New
GPlus Adapter now supports the following:

• Configurable Interaction, Incidents and Cases screen pop.
• Search through ANI or Customer_Contact/Sys_user table custom fields.
• WorkItem as a new channel for Agents.
• Multiplatform InstanceURL configuration.
• A new Contact Us module under the Application Menu.

Resolved Issues
Other miscellaneous enhancements and fixes related to ServiceNow certification were made.

Known Issues
There are currently no known issues.
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August 02, 2021

What's New

• Gplus Adapter now supports WebRTC.

Resolved Issues

• Recording handling buttons (Start, Stop, Pause recording) are no longer hidden when active recording is
set for an agent’s management.

• The Adapter no longer hangs if the agent was configured with non-voice channels.

Known Issues
There are currently no known issues.

June 12, 2020 (9.0.002.00)

What's New

• Configurable Screen pop
• Allows to screen pop on any ServiceNow entity

• ClickToDial from ServiceNow:
• Start outbound call from phone fields (example: start call from Contact business number)
• Start outbound call from reference fields (example: start call from “caller” field or Incident)
• Customizable screen pop

• Single pane desktop user experience
• Agent Status Management
• Agent Performance Tracker
• Inbound Voice

• Inbound toast alert
• Supports ServiceNow Agent Workspace View
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Prerequisite

• ServiceNow “Openframe” plugin installed

CRM Gplus Adapters Gplus Adapter for Service Now

Genesys Engage cloud Release Note 172



CX Contact
For information about the latest releases of CX Contact, refer to CX Contact Release Notes.

Note: Not all changes listed below may pertain to your deployment.

• February 22, 2021 (9.0.024.04)
• January 25, 2021 (9.0.024.03)
• January 11, 2021 (9.0.023.04)
• November 19, 2020 (9.0.023.03)
• September 14, 2020 (9.0.022.04)
• August 25, 2020 (9.0.022.03)
• July 9, 2020 (9.0.021.05)
• June 15, 2020 (9.0.021.04)
• April 6, 2020 (9.0.020.05)
• March 16, 2020 (9.0.020.03)
• February 24, 2020 (9.0.020.01)
• January 17, 2020 (9.0.019.01)
• December 12, 2019 (9.0.018.01)
• November 1, 2019 (9.0.000.17)
• September 20, 2019 (9.0.000.16)
• August 23, 2019 (9.0.000.15)
• June 19, 2019 (9.0.000.14)
• May 8, 2019 (9.0.000.12)
• April 2, 2019 (9.0.000.11)
• February 28, 2019 (9.0.000.10)
• January 15, 2019 (9.0.000.09)
• December 6, 2018 (9.0.000.08)
• November 2, 2018 (9.0.000.07)
• October 2, 2018 (9.0.000.06)
• Known Issues
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February 22, 2021 (9.0.024.04)

What's New

• CX Contact now supports Enterprise Redis 6 over TLS. (CLOUDCON-12202)
• CX Contact now supports PostgreSQL 12.x, Redis 6.x, and Elasticsearch 7.6. (CLOUDCON-9616)
• CX Contact now supports PostgreSQL 11. (CLOUDCON-12281)
• It is now possible to optionally utilize basic authentication on CX Contact HTTP or HTTPS connections to

Elasticsearch. (CLOUDCON-10589)

Resolved Issues
This release does not contain resolved issues.

UI Modifications

• Starting with release 9.0.024.04, CX Contact stores filtering rules in Filter type objects. Older Filtering
Rules, created with CX Contact releases prior to 9.0.024.04 are displayed in the List Rules Table View as
obsolete, with an exclamation mark (!) icon. CX Contact release 9.0.024.04 is fully backwards
compatible with prior releases and fully honors older filtering rules. New filtering rules created with CX
Contact 9.0.024.04 are created with the new format. (CLOUDCON-11876)

January 25, 2021 (9.0.024.03)

What's New

• The new Disposition Code field has been added to the mandatory Contact Lists fields.
(CLOUDCON-4416)

• You can now apply a Dialing Filter to a specific Calling List. A Dialing Filter can be applied to lists in
unloaded or in active or running Campaign Groups. (CLOUDCON-7659)

• It is now possible to use a SSH Private Key (or combined SSH Private Key and Password) authentication
methods to access the remote SFTP Server. (CLOUDCON-11590)

• For SMS outbound campaigns, the list of keywords for help and stop signals has been expanded with the
following additional keywords (in any letter case):(CLOUDCON-10410)
• help: 'aide'
• stop: 'arret' and 'unsub'
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Resolved Issues

• You can now import a contact list after upgrading from 9.0.022.03 to 9.0.023.04 when NFS4 shared file
system is used. Previously, after the upgrade was complete List Builder could have reported an error
when importing a contact list. (CLOUDCON-12131)

• A Caller ID number in the Campaign Group create/edit UI dialog can now start with a 0. Previously, a
validation error occurred when the Caller ID number started with 0. (CLOUDCON-11809)

January 11, 2021 (9.0.023.04)

What's New

• The Campaign Group Event Record Dashboard now contains data that indicates when pre-loading was
started and completed for each Campaign Group. (CLOUDCON-11680)

• Device Mask is now supported for the Selection (Contacts) rule. It is now possible to define a Selection
(Contacts) rule that operates over a Device Mask field. (CLOUDCON-11515)

Resolved Issues

• When creating or editing a schedule you can now select the Time in state (Advanced) condition. This
new condition enables you to configure the Set Time interval and state for a specific campaign group.
(CLOUDCON-11737)

• The table headers in the aggstable analytics dashboard panel are now lined up correctly. Previously, the
table headers appeared in the wrong location. (CLOUDCON-11748)

• The Call Result Record Dashboard now contains Call Duration data. Previously, the Call Duration data
did not appear. (CLOUDCON-11582)

• When working with Email Campaign Groups the email unsubscribe link is now correctly adding records
that opt-out to the Email Opt Out suppression list. Previously, the record was not automatically added
to a contact suppression list. (CLOUDCON-7480)

November 19, 2020 (9.0.023.03)

What's New

• CX Contact is now capable to decrypt PGP files encrypted with older PGP encryption standards.
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(CLOUDCON-11583)
• CX Contact analytics Call Result Records index now contain ChainID, ChainN, and ClientID data fields.

(CLOUDCON-11455)
• The end user can now create a filter using only mobile phone numbers from the input list.

(CLOUDCON-11514)
• The Attempt Rule can now be configured to govern attempts at specific time periods during the day. For

example, an Attempt Rule can be configured to run 2 attempts in the morning (9am - 2pm), 1 in the
afternoon (2pm - 4pm), and 2 in the evening (4pm - 9pm). (CLOUDCON-11174)

• Compliance Tools Improvements
• All Compliance Tools have been significantly extended to include the ability to define the scope of

each compliance rule for a particular country and for subdivisions by regions, states, and provinces
within a defined country.

• The Contact Times rule can now work in strict Contact Times mode (applied during pre-loading by
the Campaign Manager), and apply a Disposition Code.

• The Contact Times rule can now support device position and device type configuration options.
• Attempt Rules can now work in a Today time interval and apply a Disposition Code.
• Attempt Rules now support device position and device type configuration options.
• Location Rules now support device position and device type configuration options.
• The Custom Timezones Table has been extended to include the ability to optionally define the

exchange code for each Timezone mapping.
• Custom Compliance rules can now apply a Disposition Code. (CLOUDCON-10959)

Resolved Issues

• You can now set the time format using the time diff mode in the Custom table Panel.
(CLOUDCON-11616)

• List Automation no longer attempts to import an input file that was not encrypted by the CXC Public Key.
(CLOUDCON-11472)

• An issue with List/ Campaign statistics not updating when one of lists did not have a DB table created
has now been resolved. (CLOUDCON-11470)

• List Automation jobs no longer fail when a custom time interval is configured. (CLOUDCON-11424)
• When a new Campaign Group is created using List Automation with action type Send Campaign Group,

it is now configured according to the selected template. (CLOUDCON-11369)
• CX Contact analytics Call Details index now shows the correct scheduledTime value. Previously, the

scheduledTime value appeared as the current time. (CLOUDCON-11320)
• The Last Run and the Status columns are now populated in the Schedules tab. (CLOUDCON-11275)
• Expired Suppression Lists are now removed from the configuration. Previously, an error occurred

because expired Suppression Lists were not removed. (CLOUDCON-11180)
• CX Contact analytics, Contact History Dashboard, and the ScheduleTime value now appear in the date-

time format instead of minutes. (CLOUDCON-11153)
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September 14, 2020 (9.0.022.04)

What's New

• From the Settings > Security page you can now view information about the uploaded public key
algorithm and the public key expiration date. (CLOUDCON-10850)

Resolved Issues

• Now, when a filter is applied to the List Details View, the records count and the number of pages are
updated to reflect the filter results. (CLOUDCON-11053)

• Campaign statistics are now aligned correctly in the UI and appear on the correct line. Previously,
Campaign statistics overlapped in the UI. (CLOUDCON-11037)

• You can now view a logged in user's information (that is, last name, first name, and username) in the CX
Contact UI. Previously, CX Contact UI may have displayed information for the incorrect user account.
(CLOUDCON-10924)

• Now, the number of entries for a given sessionuuid is equal to the List Size. (CLOUDCON-11054)

August 25, 2020 (9.0.022.03)

What's New

• The DB field name of every Contact List field is now located under its respective column header when
using List Details Viewer. When working with SQL use the DB field name to query the correct DB fields.
For additional information, see Contact List Import. (CLOUDCON-10513)

• You can now filter the List Details View according to the following free-form SQL entries. For additional
information, see the SQL row in the List Details View table. (CLOUDCON-10503)
• Where - An SQL filtering expression applied to the selected contact list.
• Order By - An SQL ordering expression applied to the selected contact list.

• You can now hide/show columns in the List Detail View. For more information, see the Important note in
the Contact List Import section. (CLOUDCON-10458)

• A summary of the number of contacts and devices in the entire contact list and in the selected filtered
view is now provided above the List Details View you. For additional information, see List Details View
(CLOUDCON-10412)

• All List Details View filtering rules, and selection rules (contact and advanced) are accessible from the
*Rule* drop-down list. As a result, you can now apply previously created filtering and selection rules to
view previous results. For additional information, see the Rule row in the List Details View table.
(CLOUDCON-10396)
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• The records in the List Details View are now automatically color grouped. Each color represents a
different customer. Since each customer can have more than one device, the colors enable you to view
which records belong to the same customer. For additional information, see the Important note under
the List Details View table.(CLOUDCON-10372)

• The Copy Contact option now includes a Copy as Callback option that enables you to maintain the
callback information (that is, agent name, the date and time the callback occurred, and the type of
callback) when a contact is copied to a new contact list. For more information, see Apply to Record
Options Defined (CLOUDCON-10363)

• Custom Compliance rules created using custom expressions can now be validated before they are
saved and applied to campaign groups. (CLOUDCON-10066)

• You can now create a filtering rule from the List Details View. Using this option, you can now test and
validate SQL queries against uploaded contact lists and save the active query as a filtering rule for
future use. For additional information, see the SQL row in the List Details View table.
(CLOUDCON-10928)

• CX Contact Analytics now supports HTTPS connection to Elasticsearch. (CLOUDCON-10952)
• You can now view the import history of lists imported when working with List Automation. The new

Activity Type field will show the List Automation value if imported by SFTP automation.
(CLOUDCON-10900)

• Campaign dashboard statistics now include the number of successful contact attempts during an active
session and the total number of successful contact attempts for the selected campaign group. Note:
The Aggregation of Delivered, Not Delivered and Not attempted will always match the total contact list
size. (CLOUDCON-10647)

Resolved Issues

• When working with the Advanced view option in the List Details View, the descriptions in the Device
Mask column are now fully displayed.(CLOUDCON-10591)

• When an SMS is sent to a Virgin Mobile number, the call result is no longer unknown.
(CLOUDCON-10522)

• 401 and 501 US area codes are no longer incorrectly classified as non-geographic numbers in the
Device Mask field. (CLOUDCON-10517)

• SMS STOP request automatically adds the device to the default SMS suppression list.
(CLOUDCON-10507)

• The List Automation schedule now functions as expected. Previously, the List Automation schedule did
not run automatically at a predefined date and time. (CLOUDCON-10430)

• The List Details View no longer displays data from a deleted contact list and error messages.
(CLOUDCON-10425)

• The default strict sign out time is now set to a maximum of 15 minutes to to ensure PCI compliance.
Previously, the maximum was more than 15 minutes. (CLOUDCON-10787)

• The size of the configuration modal window has been increased to avoid user interface problems.
(CLOUDCON-10734)

• An unexpected behavior that occurred when there were white spaces in the values in the custom table
has now been resolved. (CLOUDCON-10733)
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July 9, 2020 (9.0.021.05)

Resolved Issues

• The Search option in the List Details View now functions as expected. Previously, the Search field
was not emptied after a search was performed. (CLOUDCON-10576)

• The List Automation schedule now functions as expected. Previously, the List Automation schedule
did not run automatically at a predefined date and time. (CLOUDCON-10430)

• The List Import option now functions as expected. Previously, when using the List Import option an
error would appear indicating that imported data was rejected. (CLOUDCON-10398)

• All of the options available when creating or editing a Campaign Group appear and function as
expected. Previously, some of these options were grayed out. (CLOUDCON-10306)

June 15, 2020 (9.0.021.04)

What's New

• When a Contact list encoded with PGP-encryption (that is, secured encryption) is selected, a closed
padlock icon is displayed and all of the list options are disabled. Previously, the encoded Contact list
details were visible and the list options were enabled. For more information, see: List Details View.
(CLOUDCON-10089)

• The local timezone is now displayed in the CX Contact user interface at all times. The local timezone is
configured in the CX Contact Settings page. For more information, see: General settings.
(CLOUDCON-10046)

• When working with List Automation you can now export analytics data to a .csv file via SFTP. For more
information, see: Create and Manage List Automation Tasks. (CLOUDCON-9993)

• You can now incorporate special characters (white-space, @, -, and so on) in the List Automation SFTP
directory. Form more information, see: Create and Manage List Automation Tasks. (CLOUDCON-9963)

• The Agent Callback Error call result now includes a new action type: AssignToGroup. AssignToGroup
redistributes the callback to another agent in the agent group if the original agent is unable to initiate
the scheduled callback. This option is only available when the call result is: agent callback error. For
more information, see: Apply to Record Options Defined. (CLOUDCON-9846, CLOUDCON-9788)

• Interactions that are cancelled during pre-loading and pre-dial validation are stored in Outbound
Analytics with Blocking rule and Blocking Suppression list information. For more information, see:
Preloading Record Dashboard. and the Call Result Record Dashboard. (CLOUDCON-9812)

• The Settings > Security tab now includes a new Use strict sign out option. When this new option is
enabled, users will be forced to sign out of the CX Contact UI every time the browser page is closed. For
more information, see: Security settings. (CLOUDCON-9726)

• You can now select to show/hide individual columns in the Outbound Analytics Custom Table panel.
(CLOUDCON-10076)

• It is now possible to calculate the duration between two different date timestamps in the Outbound
Analytics Custom Table panel. (CLOUDCON-10074)
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Resolved Issues

• Switzerland phone numbers are no longer identified as invalid devices. (CLOUDCON-10272)
• The Link field mode in the Outbound Analytics Custom table panel is now working as expected.

(CLOUDCON-10072)
• It is no longer necessary to restart a Campaign group after the Campaign has started in order to process

records inserted into a list via API . (CLOUDCON-10026)
• When a Selection rule is imported as a .json file after it was exported from CX Contact, the Selection

rule name is no longer ignored. (CLOUDCON-9945)
• When the CX Contact default country code is set as United Kingdom, the system no longer adds a

cd_mask with an invalid DM_INVALID_AREA_CODE bit set. (CLOUDCON-9745)
• Measures have been taken to improve the prevention of potential security threats. (CLOUDCON-9700)
• The Call Attempts value in the Campaigns/Groups list no longer includes negative values.

(CLOUDCON-9549)
• The Summary tab in the Device Escalation > Treatment tab now contains the correct information.

(CLOUDCON-9958)

April 6, 2020 (9.0.020.05)

What's New
Settings

• The Settings tab now includes a strict-logout option. When enabled this option forces the user to be
logged out of the CX Contact UI as soon as the browser is closed. (CLOUDCON-9727)

Analytics

• The Analytics Histogram panel now supports X-Axis labels to show date and time ranges.
(CLOUDCON-9607)

Security

• The CX Contact UI now supports a Secure with encryption option when creating or editing a List
Automation Job. (CLOUDCON-8944)

Resolved Issues

• Searching for an Agent Group name from within the Agent group list, using only part of the name, is
now working as expected. (CLOUDCON-9807)

• The CX Contact logo is now displayed correctly in the Login page when you log out of the CX Contact UI.
(CLOUDCON-9806)
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• Outbound schedules now store the correct configuration values when you create a schedule with a
start at and start after duration. (CLOUDCON-9801)

• Users can now apply Campaign Group updates as expected. (CLOUDCON-9790)
• When uploading contacts using an Excel .xlsx file the calling list is no longer rejected.

(CLOUDCON-9760)
• Importing contacts into a Calling list or a Suppression list using a .zip file is now functioning as

expected. (CLOUDCON-9748)
• The dialingMode field is now stored in the Call Results and Contact History analytics index's.

(CLOUDCON-9737)
• The List Automation update button no longer appears enabled when changes have not been made to

the list. (CLOUDCON-9716)

March 16, 2020 (9.0.020.01)

What's New
Schedules

• A new CX Contact Dashboard (Outbound Analytics) has been added for the new Schedules index.
(CLOUDCON-9416)

• The Schedules menu was added to CX Contact. With Schedules you can now configure instant and
sequential events by determining when dialing is active. This new option enables you to:
• Schedule when a campaign group starts/finishes.
• Schedule a campaign group to run for a specified period of time or until a specific statistic is

achieved.
• Sequence campaign groups. For example, starting one campaign group when another campaign

group closes at a defined time. (CLOUDCON-3657)

Attempt Rule

• An Attempt rule can now be defined using the Agent Disposition code. As a result, when an attempt
is made to initiate an interaction, the attempt can be counted according to its Disposition value. This
allows for greater granular control over agent and customer interactions. (CLOUDCON-9232)

Resolved Issues

• The Outbound Analytics User Actions tab is no longer missing data. Previously, when a search query
was deleted some rows did not appear in the tab. (CLOUDCON-9389)

• When creating/editing a Dialing Profile, Campaign Template and/or a Campaign Group, selecting Device
Escalation in the Treatment tab no longer causes the window layout to change. (CLOUDCON-9383)

• When a Caller ID Set is imported with an Import file, the Caller ID set cannot have more than 5000
Caller IDs. (CLOUDCON-9472)
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• When the drop-down menu associated with an empty field is opened, the drop-down menu is now a
normal size displayed correctly. Previously, when opened, the drop-down menu was larger than normal.
(CLOUDCON-9381)

• Records no longer fail to upload when using the XLSX file for input. (CLOUDCON-9380)
• When you configure the Contact List table to include the Secured column, the Secured column

appears in the table. Previously, even when selected, the Secured column did not always appear in the
Contact List table. (CLOUDCON-9374)

• Measures have been taken to improve the prevention of potential security threats to List-builder.
(CLOUDCON-9320)

• The List Source column in the List Automation tab now contains an SFTP Server name for each list.
Previously, the List Source column contained an IP address. (CLOUDCON-9265)

• When configuring Advanced selection rules, the original data is no longer deleted when Visual
Editor is turned on/off. (CLOUDCON-9207)

• When configuring an Upload rule with the Quantity type option, you are no longer limited to 250
records. (CLOUDCON-9089)

• CX Contact automatic sign-out now functions correctly after the sign-out modal window is displayed.
Previously, it was possible to reload the page and remain logged in after the automatic sign-out modal
window was displayed. (CLOUDCON-9040)

• When exporting an Outbound Analytics table and audit panel to PDF, the exported PDF now includes
page numbers. (CLOUDCON-8854)

• The Contact Suppression Search and the Contact Search drop-down menus are now positioned
correctly in the UI. Previously, these menus appeared above the top menu bar. (CLOUDCON-8676)

• When working with CX Contact, mandatory options can no longer be unselected. (CLOUDCON-8515)

February 24, 2020 (9.0.020.01)

Resolved Issues

• Measures have been taken to improve the prevention of potential security threats to List-builder.
(CLOUDCON-9320)

• The List Source column in the List Automation tab now contains an SFTP Server name for each list.
Previously, the List Source column contained an IP address. (CLOUDCON-9265)

• When configuring Advanced selection rules the original data is no longer deleted when Visual Editor is
turned on/off. (CLOUDCON-9207)

• When configuring an Upload rule with the Quantity type option you are no longer limited to 250 records.
(CLOUDCON-9089)

• CX Contact automatic sign-out now functions correctly after the sign out modal window is displayed.
Previously, it was possible reload the page and remain logged in after the automatic sign-out modal
window was displayed (CLOUDCON-9040)

• The Contact Suppression Search and the Contact Search drop down menus are now positioned correctly
in the UI. Previously, these menus appeared about the top menu bar. (CLOUDCON-8676)
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January 17, 2020 (9.0.019.01)

What's New
Contact List

• When editing a campaign group the Contact list drop-down menu is now listed in alphabetical order.
(CLOUDCON-9144)

• Improvements have been made to the List Automation user interface to support SFTP over MPLS with
new file server, directory and public key fingerprint options. (CLOUDCON-9092)

• All drop down menu options are now listed alphabetically. This includes all menus found in Campaign
Group, Upload rule, Label, Contact attempt, Suppression and Session Profiles. (CLOUDCON-9036)

• To enable detailed event logging a new Trace connection attempt option was added to List
Automation. (CLOUDCON-8842)

• An exported List Rule can now be imported into CX Contact. (CLOUDCON-8817)

Analytics

• Analytics now provides a format configuration option for managing Time conversion for the time and
duration fields. For example, milliseconds can be rounded seconds, or seconds with a decimal place to
1 or 2 or 3 positions. (CLOUDCON-8870)

Selection Rules

• Advanced Selection rules that are built using Visual Editor are now converted in SQL when a user
disables the visual editor to access free-form SQL advanced options. (CLOUDCON-8848)

User Interface

• Table panel has been enhanced to support custom column options. (CLOUDCON-8374)

Resolved Issues

• Updating a Campaign Group when a Disposition code matches the call result is now working as
expected. (CLOUDCON-9118)

• When logging into CX Contact with inadequate credentials, an error message appears informing the
user that they do not have the correct credentials. Previously, logging into CX Contact with inadequate
credentials caused the screen to go blank. (CLOUDCON-9113)

• Page reloading now works as expected after an automatic sign out from the user interface occurs.
(CLOUDCON-9040)

• Errors no longer occur when creating advanced Selection Rules and malformed SQL is no longer created
when using Visual Editor. (CLOUDCON-8843)
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December 12, 2019 (9.0.018.01)

What's New
Contact List

• Users can now select to view the Label column in the Create/Edit contact list preview screen.
(CLOUDCON-8925)

• When a Selection rule is selected in the List Rules table, the right side of the view now includes field
names. Previously, the view only included Other values. (CLOUDCON-8805)

• Importing Contact Lists with Splitting rules now takes less time. The process was optimized in the List
Builder. (CLOUDCON-8802)

Filtering Rules

• When configuring a filtering rule, users can now select an ascending or descending order using a slider
widget instead of a drop down list. (CLOUDCON-8880)

Caller ID Set

• Users can now configure the Caller ID Set modal window using a slider widget instead of a checkbox.
(CLOUDCON-8879)

• Caller ID sets can now be imported via a text file. (CLOUDCON-8546)
• When configuring a Dialing Profile you can now select a Caller ID set (includes multiple CLI's), instead of

the single CLI assigned to the Campaign Group level. (CLOUDCON-8545)

Selection Rules

• You can now download and export Selection Rules as a .JSON file. (CLOUDCON-8786)
• A new Non-Geographic option has been added to the drop-down list for Device Mask field option while

create/edit advanced selection rule. (CLOUDCON-8775)
• CX Contact now checks for Non-Geographical numbers during the pre-loading phase of a campaign

group. (CLOUDCON-8622)
• A Non-Geographical numbers filter option was added to the Dialing Profile filter options.

(CLOUDCON-8621)
• Selection Rules can now identify if all Devices are valid or invalid. (CLOUDCON-8524)

Answer Machine Delivery

• Device Escalation check boxes for Answer Machine Delivery have been replaced with drop/connect
switches. (CLOUDCON-8749)

• The Advanced button in the Delivery Option section of the Treatment tab has been replaced with a
more prominent button. (CLOUDCON-8738)

PDF Export

• The CX Contact Analytics PDF Export document option now includes additional details. The PDF now
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includes a Report title, Dashboard name, Index name, and the report's time frame. (CLOUDCON-8709)

Device Import Detail Records Dashboard

• User-defined Other1-OtherN fields of type string can be added to the CX Contact Analytics Device
Import Detail Records Dashboard. (CLOUDCON-8657)

SMS/EMail Records Dashboard

• CX Contact Analytics SMS/EMail Records Dashboard now supports storing the final state of the SMS
Aggregator in the providerReceipt field. This field enables users to review the final SMS delivery
state as it was received from the SMS Aggregator. (CLOUDCON-8509)

Target Contact List

• For auditing purposes an invalid device can now be imported into a Target Contact list. As a result,
records are not rejected during the import process. (CLOUDCON-8441)

Resolved Issues

• The Duplicate options in the Dialing profile, Campaign Group, Campaign Template filter options have
been renamed to Duplicate device in... instead of only Duplicate. For example, Duplicate Position is
now Duplicate device in Position, Duplicate List is now Duplicated device in List and Duplicate Contact
is now Duplicated device in Contact. (CLOUDCON-8840)

• CX Contact no longer fails to delete a file after List Automation is downloaded. (CLOUDCON-8809)
• Australian mobile numbers +614 and +615 are now dialed. Previously, these numbers were not dialed

due to an invalid Exchange flag. (CLOUDCON-8799)
• When manually importing a Contact list, the preview is no longer empty. (CLOUDCON-8798)
• Columns in the Import Activity table are now sorted correctly. Previously, the sorting option did not work

as expected. (CLOUDCON-8796)
• When uploading a large list using splitting the process no longer times out. (CLOUDCON-8766)
• The Toll Free filter option in the Dialing Profile, Campaign Group and Campaign Template pages has

been replaced with the Non-Geographic option. (CLOUDCON-8753)
• Additional Security enhancements and updates have been included. (CLOUDCON-8702)
• The Help widget now includes documentation about the Analytics tab. (CLOUDCON-8680)
• The Outbound Analytics PDF can now be exported as expected. Previously, the PDF was not

downloaded. (CLOUDCON-8649)
• A new message was added to the Export all dashboards option when there are no saved dashboards.

Previously, there was no indication that 0 dashboards were saved. (CLOUDCON-8648)
• Elasticsearch field are now assigned with the correct field types. Previously, some Elasticsearch field

types were assigned a long type instead of the date type. (CLOUDCON-8577)
• When working with the Audit table in Outbound Analytics, you can now search for a partial match

instead of only capital letter sensitive matches. (CLOUDCON-8462)
• When working with Outbound Analytics you can now show/hide the Fields section. (CLOUDCON-8427)
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November 1, 2019 (9.0.000.17)

What's New
Last In First Out (LIFO)

• Campaign Groups / Dialing Profiles now support LIFO (Last In First Out) Dialing modes. For a complete
description of this feature, refer to the Dialing Modes and IVR Modes > LIFO Mode section in the the CX
Contact Help manual. (CLOUDCON-8434)

• Due to the nature of LIFO (Last in First Out) campaigns, Time Remaining statistics are not displayed in
the UI. (CLOUDCON-8557)

Campaign Group

• During the editing of an active/running Campaign Group, all Dialing Profile options that only take effect
after a campaign group restart are now either disabled or show a “campaign is running” prompt when
trying to edit. (CLOUDCON-8536)

Labels

• Labels can now be exported and imported. (CLOUDCON-8470)

Outbound Analytics

• Outbound Analytics now displays a yellow warning ribbon and a red error ribbon. (CLOUDCON-8412)
• Outbound Analytics—It is now possible to export panels to a .csv file. (CLOUDCON-8343)
• Outbound Analytics—It is now possible to export panels and dashboards to a .pdf file.

(CLOUDCON-8385)

Suppression List Table

• A new Found In column has been added to the Suppression List Table view. That is, when you search
for a suppression record the target Suppression List in which the match was found is now shown in the
results. (CLOUDCON-8362)

Search

• A new Search option is now available for all drop-down menus. (CLOUDCON-8361)

Resolved Issues

• A Campaign Template now inherits the Copy Contact settings from the Dialing Profile.
(CLOUDCON-8586)

• When you edit a Campaign Template, and select Copy Contact from the Apply to Record list in the
Treatment tab, the Copy as Rescheduled option is now working as expected. (CLOUDCON-8566)
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• The List Builder now accurately detects US time zones. Previously, List Builder failed to detect some
US time zones. (CLOUDCON-8561)

• When importing an exported .json dashboard file, the file is now saved to the correct index.
(CLOUDCON-8538)

• When duplicating a Data Mapping Schema, the labels from the original schema are now duplicated as
expected. (CLOUDCON-8534)

• The default label configured for the New Contact List dialog now appears as selected. Previously, the
default label was not selected. (CLOUDCON-8522)

• When viewing the Contact List table the Last Modified Date sort option now functions as expected.
(CLOUDCON-8513)

• When Dialing Profiles and Campaigns are loaded a loading icon appears on the screen. Previously, a No
record(s) found message was displayed on the screen. (CLOUDCON-8467)

• The Target Abandon rate and Abandon call definition fields have been removed from the Pacing
Settings window. (CLOUDCON-8465)

• Record_Id values will now be reset to start at 0 each time a contact list is modified by the Flush and
append upload type. (CLOUDCON-8367)

• Outbound Analytics will now provide a notification alert for an unset default dashboard.
(CLOUDCON-8352)

• Outbound Analytics— You can now perform an Audit table search with multiple criteria using a comma
to separate the criteria. (CLOUDCON-8349)

• Outbound Analytics—The Audit Table now shows all search results in the current table view (controlled
by row view). Previously, results appeared among the table tabs. (CLOUDCON-8347)

• Outbound Analytics—The Ddfilter panel now displays the correct values for the selected time frame.
Previously, it panel displayed incorrect values. (CLOUDCON-8346)

• Outbound Analytics - When exporting dashboards the exported file contains a valid file extension.
Previously, the file was downloaded without an extension. (CLOUDCON-8345)

• Outbound Analytics— Dashboard tool tips are now displayed correctly. Previously, some of the
Dashboard tool tips were either not displayed or were displayed cropped. (CLOUDCON-8305)

• The CX Contact Login screen is no longer bypassed. (CLOUDCON-7871)
• When editing the Data Mapping table you can now edit a field by double-clicking the specific table cell.

Previously, it was not possible to edit a field directly from the table. (CLOUDCON-5805)

September 20, 2019 (9.0.000.16)

What's New
Suppression List

• Searching for records in suppression lists now supports multiple list search options. Previously, only one
suppression list was available to search against. (CLOUDCON-8248)
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Treatments View

• The Treatments view no longer appears as a modal window. A new Summary tab has also been added to
the sub-menu. (CLOUDCON-8172)

Analytics

• In Analytics, a new sum table panel is now available. (CLOUDCON-7022)

Retry Options

• A new treatment Copy Contact has been added to the list of available Retry Options. The Copy
Contact treatment can be applied to the call result or disposition code and allows to copy an active
contact into a different contact list either as General or as Rescheduled.

Resolved Issues

• In Analytics, it is now possible to remove a dashboard as the default dashboard. (CLOUDCON-8304)
• The Show spinner now appears on all panels while loading in Analytics. (CLOUDCON-8265)
• There is now a Mobile option and a Landline option in the Value dropdown menu in Campaign

templates. Previously, the Mobile option was named Wireless and no Landline option existed.
(CLOUDCON-8255)

• The OtherX fields and ClientID in selection rules when numeric type is used now work properly.
(CLOUDCON-8155)

• The filtering rules with CONTAINS and IS [NOT] EMPTY clauses now work properly. (CLOUDCON-8154)
• In Analytics, a notification has been included for fields where a numeric value is required.

(CLOUDCON-8112)

August 23, 2019 (9.0.000.15)

What's New
Phone number filters

• In the Campaign Template > Dialing Profile and Campaign Group > General tabs the Wireless filter has
been renamed Mobile and a new Landline filter option has been added.

Compliance tools

• Location rules now support an asterisk wildcard as part of the postal code.

Contact list
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• The Contact List table now includes a Caller ID column.
• When importing a Contact List you can now search for the correct Upload Rule > Custom Splitting

option.

Analytics

• Horizontal scrolling is now supported for the User Actions Dashboard > Audit Panel.
• The Analytics Dashboard > Terms Panel now supports more than one field.
• When working with CX Contact Analytics you can now apply Time Picker settings to each field.
• The Control Panel has been removed from the Dashboard Configuration options.

Data mapping

• An exported Data Mapping schema can now be imported into CX Contact.

Resolved Issues

• When uploading a file that contains duplicate records, the duplicates are now rejected.
(CLOUDCON-7857)

• Contact List files that have fields containing single quotes no longer cause syntax errors during upload.
(CLOUDCON-7826)

• Compliance Contact Dates now includes an Edit option. (CLOUDCON-7814)
• When a new list is imported using the Upload Rule, data for Last Modified Date now appears in the Last

Modified Date column as expected. (CLOUDCON-7813)
• A Caller ID is now displayed for each list associated with an uploaded file that was split into multiple

Contact Lists. (CLOUDCON-7767)
• Area Code type selection rules are no longer limited to 10 digits. You can now create an Area Code type

selection rule with up to 2,000 characters. (CLOUDCON-7727)
• The Field drop-down menu in the Analytics tab now appears in the correct location. Previously, this

menu remained hidden until a user entered text in the text box. (CLOUDCON-7605)
• Filters applied to the Analytics Dashboard > Goal Panel now function as expected. (CLOUDCON-7604)
• Hard-coded values no longer appear in the Analytics > Number Panel. (CLOUDCON-7603)
• When you edit a campaign, the selected General > Contact Lists are now highlighted in the drop-down

menu. Previously, the selections were not highlighted and you were not able to know which contact list
was selected. (CLOUDCON-7494)

• When creating or editing a Dialing Profile, selecting call wait connected timeout in the Advanced tab
now operates as expected. Previously, this option was not added to the Campaign Group options and
could not be selected. (CLOUDCON-7399)

• An empty Contact List will now remain active and linked to its original Campaign Group.
(CLOUDCON-7344)
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June 19, 2019 (9.0.000.14)

What's New
Contact list

• When editing a contact list, the Caller ID is now displayed and can be modified.
• When importing a contact list, you now see a progress bar in the Size column. The progress bar displays

the current status of the import process.

List Rules

• Contact Time rules are no longer limited to 15-minute increments. You can now specify a value (in
Minutes) in the Minutes option.

Suppression lists

• It is now possible to manually delete contact information records from a suppression list.

List Builder

• List Builder now nullifies binary characters during ingestion.

User defined field labels

• When creating a List Automation job for exporting contact lists, it is now possible to select a Use label
option. This option replaces the Other1-OherN fields with the field names from the associated list
labeling schema.

• When downloading a contact list from the User Interface, CX Contact now replaces the other1-OtherN
user-defined fields with the field labels assigned to the contact list.

Analytics dashboard

• It is now possible to configure the Time format on an Analytics dashboard.
• CX Contact Analytics now includes a new User Actions index to audit user events. The system

administrator can now track who did what and exactly when.
• The CX Contact Analytics SanKey panel can now support additional parameters. Previously, this panel

only supported three parameters.
• You can now edit a CX Contact Analytics dashboard label. This new option enables you to define each

system field value name.

User Interface

• A yellow warning icon was added next to problematic services in the About Help > Current Version
section of the User Interface.

• The User Interface now supports a tabular layout, meaning that pages now open in new tabs, allowing
you to easily switch back and forth between tasks. Previously, the current page closed when you
navigated to a new page within the User Interface.
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Resolved Issues

• A delivery confirmation message is now sent when an email is sent from an email dialing profile.
(CLOUDCON-7293)

• You can now write an email using an email address that contains both upper and lowercase letters.
(CLOUDCON-7292)

• The default Email Opt Out Suppression list appears as a required suppression for Email dialing profiles
alone. (CLOUDCON-7264)

• You can now send an SMS with more than 160 characters. Sending an sms with more than 160
characters is enabled with SMS Concatenation. That is, delivering content with more than 160
characters requires the system to send multiple sms's that can lead to a cost implication.
(CLOUDCON-7262)

• The Max Queue Size value and the Minimum and Optimal Buffer size values on the Advanced tab are
now transferred to the CME Campaign Object settings successfully. (CLOUDCON-7253)

• When previewing imported HTML in an Email profile, all of the preview content is contained within the
preview frame. (CLOUDCON-7251)

• Records are no longer flushed from a contact list that is created using an Upload rule whose target
contact list does not have new records. (CLOUDCON-7214)

• Data associated with the Last Modified Date on the Lists tab is now updated when the Flush and Append
option is selected. (CLOUDCON-7213)

• A delivery confirmation message is now sent when an SMS is sent from an SMS dialing profile.
(CLOUDCON-7165)

• CX Contact performs as expected when you configure splitting criteria for a Selection rule within an
Upload rule. (CLOUDCON-7137)

• The At (@) symbol cannot be included in a Campaign Group name. (CLOUDCON-7104)
• In Power (Email & SMS), Power IVR, Progressive IVR, and Push Preview modes the minimum and optimal

buffer values are now displayed as percentages on the Dialing Profile > Advanced tab.
(CLOUDCON-6924)

• When creating a Voice Dialing Profile using a Campaign Template, a loading animation is now displayed
after you click Create or Create and Run. (CLOUDCON-6696)

May 8, 2019 (9.0.000.12)

What's New
Analytics Tab

• The following enhancements have been made to the Analytics tab in the CX Contact user interface:
• The navigation bar now continually floats at the top of the Analytics tab. This allows the user to

access the navigation bar without scrolling to the top of the page.
• You can now save multiple dashboard views per Elasticsearch index.
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• You can now resize each Analytics tab panel when editing the panel.
• You can now rename a panel after it is created.

Dialing Profile

• The Call wait connected timeout option is now a permanent option in the Dailing Profile > Advanced
tab. Users can now easily and quickly set a maximum value for the timeout by seconds option. This
option specifies the timeout, in seconds, between dialing (or first ring) and the determination that the
called party is not answering.

Selection Rules

• The following changes and enhancements have been made to Selection Rules:
• When you create or edit a Selection rule with Field set to Device1 - Device10, two new operators

are available:
is valid

is not valid

These operators provide device validation during ingestion against the Genesys Integrated
Global Numbering plan.

• The not in operator is now available where Field is set to Device1 - Device10 and Type is set to
any of the following:

Area Code

Exchange

Timezone

State Code

Country Code

• CX Contact now supports decimal values for the Type->Numeric filtering criteria. Previously, CX
Contact supported full integers only.

• CX Contact now supports the is not empty operator.

Custom Time Zone map

• Custom Time Zone is now stored as a script object within the configuration server. As a result, you can
now control permissions and access to the Custom Time Zone objects.

Suppression List Record Retention

• When configuring a suppression list it is now possible to specify the duration of the record retention.
This means that records added to the suppression list will be retained within that suppression list for
the period of time they are configured and automatically purged at the end of that duration.

Resolved Issues

• When using a fixed position within a data mapping scheme, an error that restricted users from
overlapping fields no longer occurs. Additionally, the overlapping fields are now highlighted yellow.
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(CLOUDCON-6832)

April 2, 2019 (9.0.000.11)

What's New
SMS Channel

• CX Contact now includes support for the SMS channel. More specifically, you can use the CX Contact
user interface to do any of the following:
• Create SMS outbound alert templates for one-way text messaging campaigns.
• Create and modify message content for initial outbound messages, opt-out/stop responses, and help

responses.
• Personalize message content (for example, greet the customer by name).

Refer to the Create an SMS Template page in the CX Contact Help manual for more information.

Email Channel

• CX Contact now includes support for the Email channel. More specifically, you can use the CX Contact
user interface to do any of the following:
• Create outbound email alert templates.
• Use a built-in visual editor to create message content (text and images) or upload an HTML file that

contains the message content.
• Personalize message content (for example, greet the customer by name).
• Add an Unsubscribe option.

Refer to the Create an Email Template page in the CX Contact Help manual for more information.

Suppression

• When a contact uses the Opt-out or Unsubscribe option within a text message or email, the record is
automatically added to a contact suppression list, called CXContactSMSOptOut and
CXContactEmailOptOut, respectively. These suppression lists have the following characteristics:
• The type is set to Device.
• The suppression list is set to Required.
• The suppression list Never expires.
• The suppression list cannot be deleted.

Analytics

• You can now use the Analytics tab in the user interface to create custom dashboard views of the
following Elasticsearch data:
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• Device imports
• Pre-loading events
• Campaign Group events
• Call results
• Contact history
• SMS/Email events

February 28, 2019 (9.0.000.10)

Resolved Issues

• CX Contact has discontinued support for FTP protocols for list automation jobs and now only supports
SFTP protocols. (CLOUDCON-6051)

• The Contact Search functionality now functions as expected. Previously, if you attempted to delete a
contact using the Contact Search page, CX Contact returned an error. (CLOUDCON-6274)

• CX Contact no longer returns an error after an update to a campaign group. Previously, in this scenario,
CX Contact returned a Disposition Code Not Found error, even when the Use Disposition Codes switch
on the Treatments tab was set to the Off position. (CLOUDCON-6216)

• Formatting issues with values populated in the Attempts > Remain column on the campaigns dashboard
have been resolved. (CLOUDCON-5640)

• You can now flush all records from a contact list and then manually remove the empty contact list from
a campaign group. Previously, once a contact list was flushed of its records, you couldn’t manually
remove it from a campaign group. (CLOUDCON-6415)

• Statistics on the campaigns dashboard now populate as expected. Previously, some fields displayed
zero (0) values. (CLOUDCON-5639)

January 15, 2019 (9.0.000.09)

What's New
Historical reporting

• CX contact now supports historical reporting of unattempted (suppressed) records through Elasticsearch
and Genesys Info Mart. Once CX Contact writes the data to an Elasticsearch index, Genesys Info Mart
extracts the data and transforms it into Genesys Info Mart LDR_* tables.

Treatments

• CX Contact now supports call treatments based on disposition codes. In the event a treatment is
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defined for both a call result and a disposition code, CX Contact gives priority to the disposition code
when applying the call treatment.

• For call treatments (Retry Options), the Apply to Record menu now includes a Suppress option that
allows you to suppress a record (by client ID or by phone number) that meets the treatment criteria.
When you select this option, you must specify a suppression list for the suppressed record from the
new Suppression List menu, which contains all suppression lists set to Never expire.

Refer to the Delivery and Retry Options page in the CX Contact Help manual for more information.

Filtering Rule

• On the General tab of a dialing profile, campaign template, and campaign group, a new Filtering Rule
menu replaces the following menus:
• Labels
• Contact Order
• Ascending/Descending

A filtering rule encompasses all of these options.

Campaigns dashboard

• The List Size field has been renamed List Size/Devices, and the Filtered field has been renamed
Contacts Filtered/Devices Filtered. The previous release (9.0.000.08) introduced the new Devices
and Devices Filtered statistics but excluded updates to the field names.

Resolved Issues
Campaigns dashboard

• If you expand a campaign template to reveal its campaign groups and contact lists, and then you
navigate away from the page, CX Contact now retains the expanded layout. Previously, in this scenario,
all campaign objects collapsed when you navigated away from the page. (CLOUDCON-5949)

• Cells now scale automatically to fit the contents of the cell. Previously, values exceeding 10,000 in the
List Size/Devices and Contacts Filtered/Devices Filtered fields spilled outside of the cell.
(CLOUDCON-5916)

• Abandoned statistics now display as expected. Previously, the Abandoned % column displayed 0
values. (CLOUDCON-5863)

December 6, 2018 (9.0.000.08)

What's New
List Rules

• A new Filtering rule allows you to sort and order contact data within a contact list. This rule can be
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applied and updated while a campaign group is running. The Filtering rule replaces the Contact Order
option on the General tab of a dialing profile, campaign template, and campaign group.

• There are now two types of Upload rules:
• Contacts - The selection rule applies to a contact list.
• Suppression - The selection rule applies to a suppression list.

• There are now three types of Selection rules:
• Contacts - The selection rule applies to a contact list.
• Suppression - The selection rule applies to a suppression list.
• Advanced - The selection rule applies to a contact list export and filtering rules. When defining the

filtering criteria for this type of rule, you can now define an SQL WHERE clause in place of the
standard visual editor.

• You can now duplicate a condition set being applied to a selection rule.

Related documentation: Create and Manage List Rules

Campaigns dashboard

• On the Campaigns dashboard, the Filtered cell now includes the total number of filtered devices from
the contact list, in addition to the total number of filtered records. The count is displayed as Records
Filtered/Devices Filtered.

• On the Campaigns dashboard, the List Size cell now includes the total number of devices contained in
the contact list, in addition to the total number of unique records. The count is displayed as Record
Count/Device Count.

• On the campaigns dashboard, the Expand All option, which is used to view campaign groups and
contact lists associated with each campaign template, now functions as follows:
• Click Expand All once to view all campaign groups associated with each campaign template.
• Click Expand All again to view all contact lists associated with each campaign group.
• The Collapse All functionality remains unchanged.

Related documentation: View Campaign Statistics

Contact lists

• Contact lists exported from CX Contact now include compliance classification data for each device
(record in chain), including:

Wireless

Duplicate Position

Duplicate List

International

Ends in 00

Ends in 000
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TPS/DNC

Toll Free

Duplicate Contact

Contains Extension

VoIP

• Contact lists exported from CX Contact now store all devices associated with each record in a chain.

Campaign group

• You can now create a campaign group against an individual campaign template using the More
Actions menu (displayed as an ellipsis) on the Campaigns dashboard. When you do this, the campaign
template and associated parameters will automatically populate on the New Campaign Group page.

Related documentation: Create and Manage a Campaign Group

Compliance tools

• You can now duplicate Attempt rules and Location rules. The duplicated rule will inherit all settings from
the original rule, but you can change any or all of them. If you do not change the name of the rule, it
will inherit the name of the original rule, with _duplicate# appended to it.

Related documentation: Compliance Tools

Context-sensitive help

• The user interface now contains a context-sensitive help tool that enables you to view help content
relative to the page you're viewing in the user interface. To access the tool, click the question mark icon
in the top right-hand corner of the user interface.

UI improvement

• The width of each menu on the General tab for a dialing profile, campaign template, and campaign
group has increased by 50 percent.

November 2, 2018 (9.0.000.07)

What's New
Data mapping

• The new data mapping feature is an alternative to using an input specification file to map contact data
to fields in a CX Contact contact list. You can create a data mapping schema for either a fixed-position
file or a delimited file and then apply the schema to a list being imported into CX Contact via manual
import or via List Automation. For detailed instructions, visit the Create a Data Mapping Schema page
in the CX Contact Help manual.
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Increment retry option

• For call treatments, the Increment retry option is no longer a mandatory option. Previously, if you
selected Retry in from the Apply to Record menu, you had to define an increment value.

Campaigns dashboard

• The media control icons have increased in size and now use the following color scheme:
• Play - Green
• Pause - Blue
• Stop - Red

• A new status bulb displays next to the media controls to indicate the status of a campaign group. It uses
the following color scheme:
• A green status bulb indicates that the campaign group is running
• A blue status bulb indicates that the campaign group is paused
• A grey status bulb indicates that the campaign group is inactive

Campaign group

• An icon now displays next to the name of a campaign group to indicate the type of dialing mode the
campaign group uses. When you hover over the icon, the name of the dialing mode and associated
optimization parameters display in a text box. Refer to the View Campaign Statistics page in the CX
Contact Help manual for more information.

October 2, 2018 (9.0.000.06)

What's New
Initial release

• This is the first release of CX Contact to Genesys Engage cloud. CX Contact is a web-based application
that enables you to set up and manage outbound campaigns. Key capabilities include the following:
• Campaigns - Set up and manage outbound campaigns and monitor the status of active campaigns

in real-time.
• Lists - Import contact lists, apply upload rules to a list, create list automation jobs, and define user

field labels.
• Compliance - Restrict contact attempts to records within a contact list and import or manage

contact suppression lists.
• Settings - Define or edit CX Contact settings.

The supported features and functionality are documented in the CX Contact help.

CX Contact Gplus Adapter for Service Now

Genesys Engage cloud Release Note 198

https://docs.genesys.com/Documentation/CXC/latest/CXCHelp/CampaignsPage


Known Issues

There are currently no known issues.
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Designer (v8.5)

Important
These release notes are for Designer version 8.5. If you are looking for Designer
(version 9.x) release notes, go here.

Note: Not all changes listed below may pertain to your deployment.

• Aug 8, 2018 (8.5.202.99)
• June 01, 2018 (8.5.202.96)
• August 09, 2017 (8.5.202.75)
• July 18, 2017 (8.5.202.67)
• June 12, 2017 (8.5.202.63)
• April 4, 2017 (8.5.202.58)
• March 8, 2017 (8.5.202.53)
• February 20, 2017 (8.5.102.48)
• November 11, 2016 (8.5.102.35)
• September 13, 2016 (8.5.102.21)
• July 18, 2016 (8.5.101.97)
• June 3, 2016 (8.5.101.77)
• March 17, 2016 (8.5.101.68)
• Known Issues

August 8, 2018 (8.5.202.99)

What's New

• Historical reporting for callbacks is now improved.
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June 01, 2018 (8.5.202.96)

What's New
Blocks

• The new Debug block (Reporting palette) enables you to set checkpoints in the application and review
the results in Analytics. Debug blocks are not reported once the application goes live and can remain in
the application.

• The new Get Chat Transcript block (User Interaction palette) allows you to retrieve the contents of the
latest chat transcript at any point in the application.

• On the Advanced tab of the Route Call, Route Agent, and Route blocks, the Threshold Expression option
is added to enable you to use a script expression to further refine a routing threshold for the specified
targets.

• On the Results tab of the User Input block, two optional input options, interpretation and confidence
score, are added to streamline the process of parsing the interpretation and confidence score from the
speech/DTMF recognizer.

• The HTTP REST block has a new option, Disable DTMF buffering. When enabled, it prevents any DTMF
inputs entered while fetch audio is being played from being buffered and carried forward into
subsequent User Input or Menu blocks.

• The Start Treatment block has a new option, Is Synched, that makes the block wait until the specified
Self Service Shared Module completes execution.

• When a Menu or User Input block is used in the Self Service phase, you can now select a target
destination after the maximum number of retries for No Input or No Match is reached. You can have the
application go to another block in the Self Service phase, or to the Assisted Service or Finalize phase.

• The Route Call and Route blocks now allow you to specify a variable for the Skill Expansion Interval
setting.

Callback V2

• You can now use separate hours for immediate and scheduled callbacks.
• Session IDs are now attached to user data.
• For predictive calls, callback service IDs are immediately attached to user data.
• Callback applications can no longer be deleted if they are referenced in the CALLBACK_SETTINGS data

table.

Built-in Grammars

• Designer now supports the following new built-in grammar types: boolean, currency, date, digits,
number, phone, and time. The built-in grammars are available for both speech and DTMF for any
language that is available to the application.

Audio Collections

• When you publish an audio collection, Designer now lets you review the changes made to the audio
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resources since the collection was last published.

Quick Filters

• Quick Filters are now sticky. If you navigate to a new resource page (such as going from Data Tables to
Business Hours), any selected quick filters are now automatically applied to the new page.

System Variables

• Two new system variables are added: AgentsTotalSize tracks the total number of agents that could
possibly be logged on. AgentsLoginSize tracks the number of agents that are actually logged on.

Business Controls

• The default trace level for Business Controls is increased to ensure that these details are included as
part of Analytics reporting. Note: This change only applies to applications published in this and later
releases. It does not apply to applications or snapshots published in previous releases that used the
previous trace level defaults.

• When viewing data tables, you can now select and remove announcements from the menu options
column.

Call handling

• For consult calls, the session continues to run the application even if the parent interaction cannot be
associated with that session.

Audit logs

• Audit logs now capture when live code is activated and when applications are reverted back to the last
good snapshot.

Last Application Snapshot

• Designer now takes a "snapshot" of each application's active code during a Designer upgrade and
keeps this code active after the upgrade is complete. Newly generated code will be active when you
publish the application manually. You can also revert an application back to this "last application
snapshot", if required.

Analytics

• Designer Analytics now displays details about specific revisions to a Shared Module that is in use.

Treatments

• Route Call and Route Agent blocks are now exited, and asynchronous treatments completed, when a
busy treatment has executed at least ten times and the average duration of the treatment is less than
1000 ms. A new system variable, TreatmentIterationCount, is introduced to track the number of times
that a treatment has executed.

• Designer now plays the default on_hold audio file for callers if the audio file for a busy treatment cannot
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be played (for example, the fetch request fails or the file is missing).

User interface

• The Designer interface is updated with the new Genesys corporate logo.
• On the Applications page, the buttons to disconnect phone numbers and delete the application are now

moved to a drop-down menu (More Options) to reduce the chances of an accidental click.

Resolved Issues

• The Route Call block is now exited correctly if Force Route is enabled and the block timeout is equal to
30 seconds. (DES-5064)

• For Callback V2, default music is now played until the call is answered, even when an agent is in ready
status. (DES-5485)

• The delay when fetching Quick filters is now reduced. Users of Chrome, Safari, and Firefox, will also see
performance improvements when activating or deactivating quick filters in environments with 500 or
more applications. Note: Internet Explorer users might continue to experience delays when activating
quick filters. (DES-5663, DES-5664)

• Designer now displays an error if you try to save an undefined (deleted) special days or business hours
in Applications and Shared Modules. (DES-4375)

• The EstimatedWaitTime and PositionInQueue system variables are now updated correctly when
treatments are looping. (DES-5524)

• When Show Block ID is selected, the block IDs are now displayed correctly in the flow. (DES-5419)

• Treatments are now executed correctly in the Assisted Service phase after a consult call transfer is
completed. (DES-5831)

• Designer now correctly indicates that the business is closed at the specified closing time, not one
minute past the specified closing time. (DES-5751)

• For blocks that allow you to select a virtual queue, Designer now displays all available virtual queues in
the selection list. (DES-5497, DES-5171)

• Designer now correctly runs an application if Global Commands are enabled in conjunction with the use
of treatments in Assisted Service modules. (DES-5834)

• For environments using Genesys Interaction Recording (GIR), the EnableRouteCallRecording system
variable now toggles recording on or off correctly. (DES-5842)

• Designer now correctly handles Chat Message or Chat Custom Message blocks that contain chat
message text with special characters (such as "'" or "&"). (DES-5312)

• Designer applications now detect and flag the mixed usage of cloned Callback and Callback V2
templates that are referenced as shared modules. Previously, this invalid scenario was not detected.
(DES-5297)

• Designer now correctly handles calls when global DTMF commands are enabled in cloned Callback and
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Callback V2 templates. Previously, in this scenario, calls were disconnected. (DES-5252)

• The Voice Mail block is now displayed correctly in the palette. Previously, in certain scenarios, the block
was not appearing in the palette. (DES-5244)

• In the user interface, clicking the Designer logo now opens the Genesys home page in a new browser
tab. (DES-5239)

• Designer now correctly updates the session detail record to indicate that the caller ended the call when
a call is routed successfully but the caller hangs up. Previously, in this scenario, Designer reported that
the call was ended by the application. (DES-5198)

• The exit_time value is now correctly reported in the SDR. Previously, this was not correctly captured for
some blocks during certain scenarios, such as when HTTP requests were still active during call
termination. (DES-5218)

August 09, 2017 (8.5.202.75)

What's New
Partition-Based Access Control (PBAC)

• Partition-Based Access Control (PBAC) is introduced to enable users with Designer Administrator
privileges to control individual user access to Designer resources. The Administrator can create
partitions for other users and assign those partitions to certain resources. Users then have access to
only those resources that match their assigned partitions or are not assigned to any partitions (non-
assigned resources are available to all users).

Quick Filters toolbar

• The new Quick Filters toolbar enables users to better organize their Designer resources by enabling
1-click filtering of resources based on the tags associated with the selected filters. This toolbar appears
on the Special Days, Business Hours, Data Tables, Applications, Shared Modules, Emergency Flags,
Audio Collections, and Message Resources pages.

Callback V2

• For web-invoked callbacks, all outbound attempts now have custom key-value pairs (KVP) attached to
the interaction as soon as the call is initiated. (Custom KVPs are those that are passed into the web
request and do not have names starting with an underscore character.)

System Variables

• A new system variable, ChatEntryPoint, is added to hold the value of the point of entry for a chat
interaction in digital applications and shared modules. This can be used in the application logic at
runtime to provide alternative processing (according to user requirements) or to facilitate the use of a
parallel testing environment (PTE).

Blocks
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• On the Call Data block, a new option is added to the Edit Data tab that enables users to add multiple
key-value pairs by selecting a variable that will be a JavaScript object at runtime. Each of the object's
properties is added as a separate key-value pair.

• The new Callback VQ Watermark block enables you to check the number of active callbacks that are
currently queued for a specific virtual queue (VQ). The result is returned as a "watermark" value that
represents the number of queued and executing callbacks.

Resolved Issues

• The import option is now disabled for Data Tables that contain the menu data type. (DES-4984)

• The Callback V2 Audio collection now contains the correct audio file for the cb_country_generic prompt.
(DES-5029)

• When viewing the properties for an audio resource, filenames are now displayed correctly. Previously, in
certain scenarios, TTS text was displayed as the filename. (DES-4600)

July 18, 2017 (8.5.202.67)

What's New
Blocks

• A new block, Validate Phone Number, provides phone number validation and international phone
number support for Callback V2. A new system data table, NUMBER_VALIDATION_CONFIGURATIONS, is
introduced to support this feature.

• A new routing type option, Force route, is added to the Route Call block. When selected, it forces the
call to be routed to a direct number.

Analytics

• A new report, Performance by Activities, is added to the Application Details dashboard. This report
shows a breakdown of performance data for each activity over a given time period.

Business Controls

• When you select Display Business Object Diffs in Data Tables, changes made to specific properties of
local Business Hours and Special Days are now indicated.

• On the Data Tables page, the buttons have been rearranged to maintain consistency with other
Designer pages.

Callback V2

• When a call reaches the Callback V2 block, Designer now fetches live data for any referenced Data
Tables and Business Hours. Previously, cached data was sometimes used.
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• For callback type applications, the Routing Priority tab on the Callback V2 block now includes a
clarification that the routing priority settings are only applicable to web-invoked callbacks and that
routing priorities for scheduled callbacks accepted from an inbound call must be configured in the
Designer application handling the inbound call.

Resolved Issues

• Designer now displays a warning message when you try to navigate away from a page that has
unsaved changes to local Business Hours or Special Days data tables. (DES-4978)

• Designer now correctly handles Route Point type routing when the Route Call block is exited before
routing is complete. (DES-4976)

• When using Display Business Object Diffs, the option for All is now removed, so you must now select a
specific business object type to view. (DES-4936)

• When an asynchronous treatment is started by the Start Treatment block, Designer now correctly
evaluates the treatment navigation expressions. (DES-4889)

• On the Business Control dashboard, the Close% column in the Shared Business Hours Check
Performance panel now displays the correct value. Previously, it displayed the value for Open%.
(DES-4877)

• When viewing a Call Trace using the Application Summary view, the Reset button now correctly resets
the Overview diagram. (DES-4868)

• On the Data Tables page, the Publish button is now re-enabled when the Show Modified Rows Only
checkbox is deselected. (DES-4835)

• As of release 8.5.102.48, Designer correctly handles consult call transfers to another application that is
executing shared modules. (DES-4636)

• Designer now correctly updates the session detail records for calls that are disconnected while the Self
Service phase is being finalized. (DES-4573)

• Designer now correctly marks a data table as modified when you edit a local Business Hours or Special
Days definition in that data table. (DES-4551)

• The Statistics block now returns the correct value for the PositionInQueue variable. (DES-4391)

• Designer now correctly handles non-English characters when importing/exporting data from a data
table. (DES-4762)

June 12, 2017 (8.5.202.63)

What's New
Analytics
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• The new Business Controls dashboard provides near real-time metrics on the runtime usage of
Emergency Flags, Business Hours, Special Days, and Data Tables.

• A new panel, Top 10 Milestones, is added to the Application Details dashboard.

• The Inputs dashboard has a new panel, Blocks By NoMatch/NoInput Count, that lets you view the total
counts of No Input and No Match by block.

Business Controls

• On the Data Tables page, the new Display Business Object Diffs button lets you review the changes
made to local Business Hours and Special Days before publishing the data table.

Blocks

• The Route Call block now provides an option to force skills-based routing to use skills defined for the
Voice channel only if both Voice and Chat in Designer are being used.

Other improvements

• Designer now supports the bulk uploading of audio prompts (this feature currently requires the
assistance of Genesys Operations).

• Designer now implicitly converts the value of certain block properties from string to numeric if the value
allows for this conversion. Previously, this conversion caused a runtime error.

Resolved Issues

• In the Application Summary view, the Reset button now correctly clears the currently displayed call
trace. Also, the links in the side navigation menu now work correctly. (DES-4698, DES-4692)

• Designer now only generates validation warnings (not errors) when the outputs of a Data Table block
have changed due to modifications made to a data table schema. Changes to key columns that affect
the inputs of a Data Table block will continue to generate validation errors. (DES-4511)

• Designer no longer generates an error message when you delete an imported Data Table before it is
published. (DES-4433)

• Designer now displays the General tab in the settings for Callback type applications. (DES-4284)

• When displaying the changes made to Special Days business objects, Designer now includes changes
made to the Occurs Every Year property. (DES-4837)

• After a data table has been published, Designer no longer allows you to change the data types of the
existing columns. (DES-4827, DES-4084)

• Calls that were successfully routed to a Route Point are now correctly reported in Designer Analytics.
Previously, some calls were not being reported correctly. (DES-4788)

• The value of the FlowEntryCount system variable now holds the total number of times that the current
application has been started for the current interaction. Previously, it held the total number of times
that any application started for the current interaction. (DES-4756)
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• Designer no longer skips a prompt when the Always play prompt and disable buffering option is enabled
and Global DTMF commands are active. (DES-4728)

• Designer Analytics now correctly displays the results for the No input count panel. (DES-4703,
DES-4690)

• When validating an application with a Data Table block, Designer now validates the latest published
version of the associated data table. Previously, Designer validated the unpublished version of the data
table. (DES-4593)

April 4, 2017 (8.5.202.58)

What's New
Application Summary View

• Designer can now generate an application summary view that shows a graphical representation of the
application flow, similar to a flowchart. This view displays all possible paths that an interaction can take
through the application. It also lets you trace the path that was taken by a selected session, as well as
the values of variables in various blocks.

Block options

• The Advanced tab of the Route Call block has a new option, Route only to local agent, that is available
when using Skill based routing with relaxing criteria or Skill expression based routing. When enabled,
the call is routed to a local agent who matches the target skill.

• The option for Play the prompt immediately is now changed to Always play prompt and disable
buffering. If selected, the prompt will always be played, even if there was a barge-in on the prompt
preceding it. In addition, the option for Not Interruptible is now changed to Disable barge-in.

Analytics

• The Inputs dashboard has a new panel, Report by Block, that lets you select and view input reports for
Blocks and Utterances and Blocks and Interpretations.

Other improvements

• Callers are now able to barge-in on the last message that is played before the application proceeds to a
shared module.

Resolved Issues

• When updating data for callback components, the Business Hours and Special Days user interfaces now
correctly indicate if failures were encountered. (DES-4598)

• In the voice prompts for scheduled callbacks, Designer now offers the correct next available timeslot.
Previously, Designer could offer the same timeslot twice, even if that timeslot was not available.
(DES-4626)
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• Designer now plays an Intelligent Prompt in American English (en-US) if it cannot play the prompt in the
caller's preferred language. (DES-4614)

• If you are using Callback, Designer no longer allows you to delete the original Callback or Callback V2
Audio collections. The only exception to this is if you have cloned the original collection and are making
changes to the cloned resource. (DES-4604)

• Changes made to features and settings from the Workspace Settings interface no longer require that
Designer be restarted before they take effect. (DES-4371)

• It is now possible to control the barge-in setting at the block level (for Play Message, Menu, and User
Input blocks), irrespective of whether Global Commands are enabled for the application. Previously,
prompts could be interruptible if Global Commands were used. (DES-4601)

March 8, 2017 (8.5.202.53)

What's New
Support for Digital application types

• With this release, Designer introduces support for Digital application types. This type enables you to
build applications that can handle chat interaction messaging and routing.

• The new Message Resource Collection (similar to the existing Audio Collection) contains standard
responses and user-defined messages that can be used with digital application types.

• Autostop logic for chat interactions prevents interactions from being re-queued indefinitely when they
are not routed and the application does not terminate them after a certain number of routing attempts.
As a result, the interaction is automatically terminated, either when it exceeds 20 application runs or
when it exceeds the configured Expiration time.

Blocks

• The Route Call block now has a routing option added for Campaign Group routing.

Restricted mode

• During upgrades, Designer now goes into a restricted mode that prevents users from making changes
to applications, modules, and workspace settings, but still allows them to make changes to business
controls, audio resources, and grammars.

System Variables

• A new system variable, FlowEntryCount, can be used when segmenting an application to implement
logic based on how many times a Designer application has been executed for a specific interaction.

Resolved Issues

• ECMAscript expressions are no longer required to evaluate Boolean values in the Segmentation block.
(DES-4582)
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February 20, 2017 (8.5.102.48)

What's New
DTMF Typeahead

• This feature lets callers provide additional input entries that are buffered and then applied to
subsequent menu prompts. For example, to navigate a series of menus and submenus, the caller might
enter a series of digits while one menu is played to bypass subsequent menus.

Data Tables

• Data tables must now be published before any saved changes to the data tables take effect. Saving a
data table will save changes, but they will not take effect for calls until the table is published. (In
previous releases of Designer, changes took effect immediately after a data table was saved.)

Blocks

• A new option called Not Interruptible is added to the Play Message, Menu, and Menu Option blocks. If
selected, it disables barge-in and DTMF typeahead capabilities.

• A new property called Play the prompt immediately is added to the Play Message and Menu Option
blocks. When disabled, it allows DTMF inputs to be buffered into subsequent blocks. (Genesys
recommends that this option be disabled only when DTMF typeahead functionality is required.)

• The HTTP REST block now allows a fetch request to be specified as an Internal Genesys Service. If
selected, the request is made without using an HTTP proxy, which is typically used for any external
requests.

Shared Modules

• An exported shared module now includes all versions of that module in the resulting archive file,
including the unpublished version. When such an archive file is imported, all versions of the module are
imported, and any versions that require an upgrade are upgraded during the import process to ensure
they are compatible with the current version of Designer.

Analytics

• Analytics data for IVR type applications is now appended with -hhmmssSSS to ensure that session IDs
do not repeat across sessions. (The unmodified session ID is available in the OrigSessionID key).

• The number of milestones reported in analytics data is now limited to the first 20 milestones in a
session. Existing applications are not impacted by this change, but new applications should be
designed so that any execution path through the application does not encounter more than 20
milestones during the call.

Other Improvements

• In the application settings, the DTMF Options tab now has an option to enable or disable Global DTMF
Commands.
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• The Data Tables interface now displays an error if the update of the callback_transaction list fails while
the Callback_Settings data table is being published.

• Under Workspace Settings > Features, Enabled Implicit module milestones is now renamed to Implicit
module milestones.

• When viewing the Application Flow, users can now use the Action menu to toggle the visibility of Block
Types and Block IDs. They can also search by numeric Block ID.

Resolved Issues

• The External Services dashboard now displays the correct total counts in the Count of Request By Host
and Count of Request By Service Name reporting panels. (DES-4373)

• The Route Call block now correctly handles scenarios when the Clear targets from queue if this block
times out option is selected and the timeout value is specified by a variable. (DES-4372)

• When an application is unable to query a statistic, it now continues to the next block without exiting to
the Finalize phase. (DES-4317)

• In business object dialogs for data tables, locally-defined business objects that can only be referenced
from one data table now display (Local) beside their name, to better distinguish them from global
objects that can be referenced from multiple data tables. (DES-4307)

• For Callback, Designer now correctly replays the existing or detected phone number on the retry prompt
when no-input or no-match is found. (DES-4294)

• On the Routing dashboard, the Routed to LCA field count is now correctly incremented when a call is
routed to the last called agent and the final disposition is Routed to Agent. However, this change only
applies to new sessions. (DES-4237)

• In validation error messages, data table integer columns are now correctly identified as integer
columns. Previously, these columns were incorrectly identified as numeric. (DES-4230)

• On the Routing dashboard, the Block Time Count panel now displays the correct value. (DES-4228)

• On the Menu block, Voice Option is renamed to Speech Inputs. (DES-4183)

• The Row Count field (used to jump directly to a specific row number when viewing a data table) now
works correctly with Firefox browsers. (DES-4180)

• Under Workspace Settings, a description is now added for the Implicit Module Milestones feature:
"Controls if modules report a milestone when they start executing." (DES-4179)

• Callbacks are now correctly processed if platform components experience a failover, avoiding duplicate
calls. (DES-4170)

• The description of the survey_sOffer system variable is updated as follows: "Determines if a survey is
offered, setup or rejected. This is set by the Setup Survey block." (DES-4165)

• During the Finalize phase, Designer now generates block labels for disposition option blocks without
using hyphens. (This change only applies to new applications.) (DES-4124)
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• For Data Tables, the Column Settings screen now suppresses messages that are not relevant to the
changes made by the user (for example, not displaying a message about providing values in all
mandatory columns when this setting was not changed). (DES-3924)

• Data Table validation warnings now always show the correct row number, even if a data table row was
deleted. (DES-3823)

November 11, 2016 (8.5.102.35)

What's New
Designer Analytics

• The new External Services dashboard lets you analyze the external requests being made by your
applications.

• The new Routing Analysis dashboard lets you analyze how calls are being handled during the Assisted
Service phase of the applications.

Single Sign-On (SSO)

• Designer now supports single sign-on (SSO) access when logging in from the Genesys Portal.

System Variables

• ApplicationPath — contains a URL pointing to the root of the current application at runtime.
• DefaultPartition — sets the default GIR partition for the application (this setting can be overridden by a

new Partition setting in the Record block).

Data Tables

• Data tables are now locked while they are being saved to prevent accidental changes.
• Clicking Cancel while modifying a data table now cancels any changes made to cell values, in addition

to any changes made to embedded global Business Hours or Special Days.
• Data tables will now timeout and close after a fixed period of time, to prevent users from accidentally

locking a data table indefinitely.

Blocks

• You can now use the Business Controls blocks with Callback type applications.
• You can now use Data Table blocks from the Finalize phase.
• On the Call Routing tab of the Route Call block, the DN Routing routing type is renamed to Route Point

Routing.
• The Record block has a new Partition option that lets you override the default GIR partition (as set by

the new DefaultPartition system variable) for that block.
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• The HTTP REST and Custom Service blocks now support the use of an error-handling child block. (You
must select an error handling method under the Results tab.)

Other Improvements

• Designer applications now transition to the Finalize phase if the call is default routed. In Analytics, such
calls are indicated by a new disposition called Default Routed.

• You can now set Special Days to recur annually.
• When defining Business Hours, you can now select a No End Time checkbox to specify that there is no

set end time for the given day. (This option only appears if the business is not closed for that day and
Open All Day is not enabled.)

Resolved Issues

• Callback V2 now supports Web Callbacks. (DES-4064)

• Imported modules now appear as modules with no versions. Previously, imported modules displayed the
latest version of the source module next to the module name. (DES-4097)

• Assisted Service Shared Modules no longer terminate prematurely due to non-significant error events.
(DES-4096)

• Applications no longer terminate prematurely when assigning output variables to routing blocks that do
not belong to the active Shared Module. (DES-4095)

• Business Hours are now correctly handled when the Follow Overrides box is checked, but no exceptions
are added. (DES-4024)

• When a Special Day with a disabled date range is used as an exception in Business Hours, the date
ranges now correctly remain disabled. (DES-4018)

• Using the Callback V2 - Offer Callback callback module template in a Shared Module block outside of the
callback context no longer generates a validation error. (DES-4005)

• When importing applications that were exported from a patched version of Designer into a newer
version of Designer, the version check now compares the versions correctly. (DES-3980)

• When saving or publishing an application or module, Designer now arranges the Validation Issues list by
severity, with error messages appearing at the top. (DES-3973)

• Designer now correctly discards any unsaved changes made to Special Days or Business Hours from
within a data table if the user navigates away from the page. (DES-3969)

• In a numeric or an integer datatable key column, a value of "0" (zero) is no longer accepted. (This was
accepted in earlier versions, but was not returned while querying.) (DES-3929)

• When editing a data table, you can now use the backspace key without it triggering the browser's Back
button behavior. (DES-3920)

• When you go to the Business Hours page, you are now prompted to select a Business Hours item from
the list or create new Business Hours, with no initial selection already made. (DES-3821, DES-3636)
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• After a Designer upgrade, IVR type applications now use a regular timestamp and reference the correct
versions of modules. (DES-3730)

• The System Resources audio collection is updated to use a more consistent format that allows the files
to be played in a wider variety of browsers. (DES-2507)

September 13, 2016 (8.5.102.21)

What's New

• Designer now supports Callback V2 (in addition to the previous Callback implementation, version 1,
which remains unchanged). Several new blocks are introduced to the Callback palette to support this
feature:
• Callback V2
• Check Availability V2
• Check for Existing Callback V2
• Book ASAP Callback V2
• Book Scheduled Callback V2
• Cancel Callback V2

• Designer introduces a new disposition, Routed to Voicemail, for Final Disposition codes.

• Designer now supports the use of system variables as the default value expression of user variables for
both Self Service modules and IVR applications.

• Business Hours now support Time Zone configuration. (This setting is only supported for the Callback
feature.)

• The Route Call and Callback V2 blocks now let you define a Maximum Priority when Priority Increment is
enabled.

• The Record block now supports Self Service application recording in Genesys Interaction Recording (GIR)
environments, and also provides new controls to Start, Stop, Pause, and Resume the recording.

• Note: This feature requires a version of Genesys Voice Platform (GVP) that supports Interactive
Voice Response (IVR) recording. Check the GVP Release Note to confirm if this is supported by your
version.

• Designer now supports the use of integer extension values in the Route Call, Route Agent, and Call Data
blocks.

• When using the test functionality in the HTTP REST block, Designer now clearly indicates if any errors
are associated with internal Genesys components.

• Fetch audio is now supported in the HTTP REST and Custom Service blocks in the Initialize and Assisted
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Service phases. (This was previously only supported in the Self Service phase.)

• You can now create and edit Business Hours and Special Days directly from within a data table

Resolved Issues

• If an existing data table contains columns with Business Hours or Special Days columns, new validation
errors can occur the first time the data table is saved. Genesys recommends opening such data tables
and saving them once to reveal any potential errors. The validation errors should then be fixed so that
the data table saves properly. (DES-3987)

• Record blocks are now ignored if the EnableSSRecording option is enabled and GIR recording is used.
(DES-3902)

• If no global Business Hours are defined, the first new business hours created within the pop-up dialog in
a data table now display as if they were created globally. If the data table is not saved, the new
Business Hours are discarded. (DES-3789)

• You can now create new Special Days or Business Hours from within Data Tables, even if no Special
Days or Business Hours entries currently exist. (DES-3786)

• The scrollbar on the Special Days page now displays correctly when there are several entries in the
Special Days list. (DES-3762)

• In the Finalize phase, disposition codes are now disabled when their corresponding phase blocks are
deleted from the flow. (DES-3669)

• When a RTP (Real-time Transport Protocol) timeout is encountered during the Self Service phase, the
application now transitions directly to the Finalize phase. Previously, the application would enter the
Assisted Service phase for a brief period of time before transitioning to the Finalize phase. (DES-3657)

• American Spanish (es-US) intelligent prompt bundling is now converted to Mexican Spanish (es-MX).
(DES-3796)

• Designer now detaches the parent interaction along with the current interaction when routing a call to
voicemail. (DES-3783)

• Designer data tables now support Callback application types. (DES-3612)

• Designer now displays a validation error when blocks are placed as direct child blocks below blocks that
should not be parent blocks. Previously, in certain scenarios, an Assign Variables block could incorrectly
become a parent block. (DES-3727)

July 18, 2016 (8.5.101.97)

What's New

• The HTTP REST block now consolidates and sends external requests from a single Designer service
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rather than from multiple platform components. In previous releases, you could switch to this mode of
operation if certain features were enabled in the block, but now it works this way by default.

Note: This change won't affect existing blocks, but any new HTTP REST blocks added to existing
flows will work this way.

• The following data types are now supported by data tables: Special Days, Business Hours, Skills
Expressions, and Timezones.

• You can now create multiple date ranges for a single Special Day. If a call comes in on a date that
overlaps or coincides with at least one of the date ranges, the Special Day settings take effect.

• You can now enable or disable individual exceptions for business hours.

• The Setup Survey block now includes an option to let callers take the survey from within one application
in the Self-Service phase (these are different from surveys taken after customers have finished their
call with an agent).

• A new Start Treatment block lets you use a shared module as an "asynchronous busy treatment" during
the Assisted Service phase. This means you can have a Start Treatment block followed by multiple
Route Call blocks and the selected treatment (for example, you might play some music to the caller
while their call is being processed) will not be interrupted as the application transitions from one Route
Call block to another.

• The default unit of time for displaying statistics on the dashboard panels is changed from milliseconds
(ms) to seconds (s).

• During the audio upload process, Designer now converts valid audio files to PCM mono 8KHz (WAV
container) and rejects files that are not in a valid audio format.

• Intelligent audio prompts now support Spanish and user-recorded system audio files.

• The Segmentation block now lets you move conditions (and their associated flow segments) up or down
in the application flow.

• An application that is handling a consult call interaction no longer stops when the parent call interaction
is released.

• A new Test tab is added to the HTTP REST block, which lets you test the specified HTTP fetch directly
from the browser.

• The Route Agent block now supports routing to the agent that the customer last spoke with.

Resolved Issues

• Designer now routes calls using the correct routing priority. Previously, calls were sometimes routed
with the Initial Priority instead of an increased priority as specified by the Increment Priority every
settings. (DES-3737)

• Designer now has improved safeguards to protect against data table corruption. (DES-3755)

• Designer now correctly handles consult calls. Previously, an application would fail to process a consult
call if it came from another application that had a Route Call block configured with a DN Routing route
type. (DES-3634)
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• Analytics now correctly reports the type of failed attempts in a User Input block when the output of the
block was stored in a variable marked as secure. In previous releases, the failed attempts for both no
input and no match were reported as 0 (zero). (DES-3629)

• The caching of speech grammars and audio files now works correctly for modules. (DES-3460)

• The description for Cache Settings on the user interface now clearly indicates that Business Controls
cannot be cached. (DES-3424)

• Designer now correctly handles ASAP callback requests. Previously, if an ASAP callback was accepted
late in the day (for example, past midnight UTC), the requesting caller was being called in the middle of
the night. (DES-3376)

• Designer now fully supports the use of a variable set to an integer value as a key to add or remove user
data in the Call Data block. (DES-3317)

• The milestone name is now converted to a string value (invalid_<variable name>) and the call's session
is reported in Analytics. In previous releases, if the application specified a milestone name using a
variable, and if the variable contained an object instead of a string, that call's session would not be
reported in Analytics. (DES-3564)

• Designer now supports dynamic language switching for agent and customer greeting audio prompts in
routing blocks. (DES-3519)

• The sunburst panel in the Survey dashboard no longer throws an exception when you try to drill down
by double-clicking the outer circle of the panel, which is the end of the path. (DES-3433)

• Very short calls (of less than a second) now show up in Analytics with the correct system attributes.
(DES-3428)

• In user variables, the Private attribute is renamed to Secure to better communicate the security related
behavior of these variables. Secure variables are not written to log files or reported in Analytics.
(DES-3427)

• Survey responses of value 0 (zero) are now correctly reported in Analytics. (DES-3395)

• In the Caching tab of the Application Setting screen, when you uncheck the Use workspace cache
settings box, the values from the workspace cache will remain and become editable. You can then use
them as a reference and tweak as needed. Previously, the values in those fields would be blanked out.
(DES-3422)

June 3, 2016 (8.5.101.77)

What's New

• You can now configure caching defaults for the workspace that apply to all applications, unless you
choose to override them in the individual application settings.

• In a Business Hours block, you can now check business hours using a timezone that is different from the
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application's timezone.

• You can now schedule Business Hours that differ from the normal schedule on Special Open Days.

• When you try to open an application, module, or data table that someone else has opened, you can now
see who has the resource locked.

• A new block (Record) is added to the User Interaction section that lets you start or stop call recording in
the Self Service phase of an application.

• You can now add shared module blocks in the Initialize phase of an application.
Note: You can't use the following blocks in Assisted Service modules that are called from the
Initialize phase: Route Agent, Route Call, Voice Mail, and Callback.

• Designer now displays validation errors if the Retry prompts in Menu and User Input blocks are not set
and "Play original prompt" isn't selected.

Resolved Issues

• You don't have to initialize application variables with a valid value when declaring them (leaving them
blank no longer causes errors). (DES-3384)

• You can now view an application's settings when opening it in read-only mode. (DES-3136)

• On the Surveys dashboard, you can now modify the width of the columns in the Survey Answer
Distribution panel. (DES-3326)

• The same Self Service module can now be used from both Self Service and Assisted Service. (DES-3306)

• You'll now get validation errors when:
• you select "use variable" without choosing a variable in a Milestone block. (DES-3294)
• you use the same variable to store the Output Parameters and Results tab variables in a HTTP REST

block. (DES-3276)
• you don't specify a "stop" Activity block for a "start" Activity block in an Activity block. (DES-1609)

• You'll no longer get validation errors when you don't specify the input parameters in a Custom Service
block. (DES-3293)

March 17, 2016 (8.5.101.68)

What's New

• Note: The first time you open an application after upgrading to a new version of Designer, you must
review and confirm its settings. After the application is saved, this dialog no longer appears.

• Designer now provides the ability to import and export applications and shared modules from one
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Designer environment to another.

• The Data Tables block now has an option to select the data table as a variable. This option is useful in
scenarios where the data table to be referenced is decided at runtime based on the application logic
(for example, when the same application is being used in multiple locations and each location needs to
reference a data table that is specific to that location).

• Data tables now support datetime and datetimerange data types, which enable users to specify a time
and date or a specific date range.

• Data tables now allow you to specify Optional Restrictions for certain data types, such as a maximum
string length for string data types or to enforce non-overlapping dates for datetimerange data types.

• The Business Hours block now includes an Open All Day option, which lets you indicate that the
business is open for the entire day.

• The Special Day block now includes a Results tab to store the results of special day lookups.

• The Data Tables block now includes a Results tab to store the results of data table lookups.

• Designer no longer displays warnings or validation errors for menu option blocks that require prompts to
be specified for each option.

• Data tables now support multiple keys by allowing more than one column to be marked as a key
column. Lookups can be performed by specifying values for all of these keys (composite key) or a
subset of keys.

Resolved Issues

• The default level of session data reported by Designer applications now includes block details.
Previously, certain block details were not included. (DES-3277)

• In data tables, the custom filter functionality for the Date and Range columns is now disabled.
Previously, the custom filter functionality for these columns did not work correctly if the data types for
the columns were changed. (DES-3223)

• If the Assign Variables block uses Advanced Scripting, Designer no longer displays a validation error if a
script is executed but no assignment is added. (DES-2869)

• Designer now displays an error message if Extension Data is added to a Call Data, Route Call, or Route
Agent block, but the Key and Value settings are not defined. (DES-2551)

• The Amazon Web Services PHP library is now restored to the source repository. This resource was
missing from the previous release, which caused Designer to report analytics data incorrectly.
(DES-3188)
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Known Issues

• Templates and shared modules cannot be mixed when using Callback. Either templates should be used
exclusively, or shared modules. (DES-5303)

• After disconnecting a Digital application from an endpoint and later associating that endpoint to the
same or to another application, Designer displays an error. However, this does not prevent that
application from being successfully associated with that endpoint. (DES-5489)

• For Callback V1, if a caller hangs up before callback has fully initialized, this can cause issues with
reporting. (DES-5571)

• In Digital applications, Special Days evaluations will not work if Special Days are defined in Data Tables
and a default message is empty. (DES-5551)

Workaround:

Define a default message.

• Users assigned to the Business User role should not be permitted to create or delete data tables, but
are currently able to do so. (DES-5555)

• When a caller rejects an offered callback, user data is not updated on the inbound call. (DES-5561)

• The final result of a callback is not always reported correctly when Designer fails to create the outbound
call. (DES-5568)

• If you import an application package (DAR file) that includes audio resources belonging to one or more
audio collections, the import overwrites all unpublished audio resources in those collections.
(DES-5179)

Workaround:

Publish the audio collection(s) before importing the application package.

• In the Manage Quick Filters dialog, searching for the term filter always returns all results. (DES-5155)

• The Quick Filters toolbar does not work correctly for tags that contain special characters (such as a
backslash or single-quote). (DES-5139)

• When assigning a new end point to a Digital application, Designer may display an error message that
there are insufficient permissions to assign or create an endpoint. If you receive this message, contact
Genesys Care for Cloud Customers. (DES-4226)

• When exporting an application, any Special Days referenced by Business Hours (where the Business
Hours are used by the application) are not included in the export. (DES-5021)

Workaround:

Use the export dialog for the application to manually select the referenced Special Days.

• Designer might not export an application that contains validation errors. (DES-4993)
Workaround:

Publish the application and fix any validation errors. Then try to export the application again.
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• Normally, the Delete option is not available for applications that have assigned phone numbers (these
applications only display the option to Disconnect). However, when Designer initially loads the
Applications page, the Delete option is temporarily available for all applications. During this time, a
user might accidentally delete an application that has assigned phone numbers. (DES-4661)

Workaround:

Contact Genesys Customer Care to have the deleted application restored.

• When exporting a digital application, messages in Chat Transcript and Send Email blocks are not
detected as dependencies. Only messages in Chat Message blocks are detected as dependencies.
(DES-4572)

• Importing applications that were exported from Designer 8.5.102.35 (or earlier) with the
globalCommands feature enabled into later versions of Designer does not preserve this setting, as the
global commands setting at the application level remains disabled. (DES-4476)

Workaround

After import, go to Application Settings > DTMF Options and select Enable Global Commands.

• If you re-import an application file (*.dar) containing data tables that reference local business hours and
special days, duplicate objects are created. (DES-4432)

Workaround

Don't re-import such a file. If it must be imported, delete the existing objects that will be replaced
by the new import.

• True or false columns in data tables cannot be edited using Firefox or Safari on OS X. The user interface
shows a checkbox that cannot be changed. (DES-4036)

Workaround

Use Chrome or Opera to set such columns on OS X. (Windows browers do not exhibit this issue.)

• Callback dispositions might not be reported correctly if a callback booking fails (for example, due to a
system error). (DES-4022)

• If you use the backspace key when a popup window is open (but the cursor is not active on it), the
background page goes to the previous screen, but the buttons on the popup window no longer function
(for example, to close or cancel). (DES-3874)

Workaround

Refresh the page, or close and restart Designer.

• When using Special Days as exceptions to Business Hours, the date ranges in the Special Days object
cannot be disabled using the checkbox. If you want to disable a date range, you will have to delete it
from the Special Days object. (DES-4018)

• Designer cannot be used with Google Chrome version 52. Genesys recommends using a different
browser until Google has addressed this issue. (DES-3970)

Workaround

You can disable the Chrome cache, but this will have a negative impact on performance.

• If no global Business Hours are defined, the first new business hours created within the pop-up dialog in
data tables shows an error message. (DES-3789)

Workaround
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Create one business hours definition on the main Business Hours page.

• You cannot use single or double quotation marks when specifying the payload key field in the Milestone
block. (DES-3432)

• Column definitions are not migrated if a data table is exported and then imported into a different table.
This is not supported. (DES-3449)

• When a data table is exported with a Key column that is not the first column is imported into a new data
table, the import completes correctly, but the first column is set as the Key column. (DES-3448)

• If you make changes to the column settings of a data table, it disables the ability to edit the row values,
which can prevent you from fixing row validation errors. (DES-3222)

Workaround

To correct row validation errors after changing column settings, cancel the changes to the column
settings, edit the row values to satisfy the validation errors, then edit and save the column
settings.

• If a HTTP REST block is configured to use a variable that is later deleted or renamed, the block will notify
the user about a missing variable even if the variable is no longer used. (DES-3055)

Workaround

Add the variable again, or recreate the HTTP REST block, or select the variable box for the URL,
point to any existing variable, and then deselect the variable box.

• While editing data table rows, a column of data type announcement might show the ID of the
announcement instead of the name. (DES-3067)

Workaround

None required. Functionality is not affected. To confirm the correct audio is selected, use the audio
picker.

• To use customer or agent greetings in an Assisted Service module, the module must be bound to the
same Audio Collection as the main application. (DES-2967)

• Deleting a Menu block option from the block properties page can result in the option prompt still being
played. (DES-2906)

Workaround

Do not delete Menu block options. Instead, Genesys recommends that you disable the options by
deselecting them. However, you can also recreate the Menu block (adding only the options you
want), or add the deleted menu option back, specify a short silence file for the audio, and then
delete the option again.

• For IVR-only applications, ICM variables are not returned if:
A system error occurs during the call.

The application ends with something other than a Terminate block or Transfer block. (DES-2549)

• Route Call blocks in shared modules might not correctly display the skill(s) used with the Skill based
routing with relaxing criteria > Specify Skills in this block option. This is a display issue only and all
skills that you specified are used for routing. (DES-1913)

Workaround

To fix this display issue, select all selected skills to see the specified skills.
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• Users might experience a slight delay when they log in if Role-Based Access Control is enabled.
(DES-1886)

• The process for importing a CSV file into a Data Table sometimes fails in certain browsers, even though
Genesys Designer displays an Imported message to indicate the process was successful. (DES-1810)

Workaround

Retry the import process using the latest version of Firefox.

• It is possible to add an Announcement prompt in the Special Day block without choosing an
announcement, and Designer does not flag the issue when you click Publish to save and verify your
application. (DES-1316)

Workaround

Always choose an announcement when you add an Announcement prompt in the Special Day
block.

• The validation check does not return invalid variable names defined in the Initialize block, such as
variable names starting with a number that create a runtime errors when a call is made. (DES-334)

Workaround

Specify variable names that start only with characters and contain no spaces. Genesys
recommends you use valid ECMAScript or JavaScript variable names.

• If non-numeric input is given to block properties that expect numeric input, the value is removed
automatically and not saved in the application. The validation process also does not catch these
mismatches. (DES-307)

Workaround

Provide valid numeric values for block properties that require numeric input to function correctly.

• You can play multiple audio files simultaneously from the announcements page. Playing an audio file
does not stop the previous file from playing. (DES-249)

Workaround

Stop the previous file before playing a second one.

• In Internet Explorer 11, newly added applications are not listed, which prevents access to the new
application while editing. (DES-86)

Workaround

Use Chrome or Firefox to add the application or restart Internet Explorer.

Designer (v8.5) Gplus Adapter for Service Now

Genesys Engage cloud Release Note 223



Designer
For information about the latest releases of Designer, see Designer Release Notes.

Note: Not all releases or changes listed below may pertain to your deployment.

• March 26, 2021 (9.0.116.09)
• March 11, 2021 (9.0.116.08)
• January 12, 2021 (9.0.114.03)
• November 5, 2020 (9.0.113.06)
• October 14, 2020 (9.0.113.05)
• August 26, 2020 (9.0.112.13)
• July 21, 2020 (9.0.112.11)
• July 8, 2020 (9.0.111.23)
• June 11 (9.0.111.19)
• May 14, 2020 (9.0.111.16)
• March 5, 2020 (9.0.111.09)
• January 23, 2020 (9.0.110.07)
• December 17, 2019 (9.0.109.08)
• October 22, 2019 (9.0.108.03)
• September 26, 2019 (9.0.107.06)
• September 23, 2019 (9.0.107.05)
• August 19, 2019 (9.0.105.14)
• March 12, 2019 (9.0.102.03)
• February 21, 2019 (9.0.100.31)
• January 18, 2019 (9.0.100.21)
• Known Issues

March 26, 2021 (9.0.116.09)

What's New
Resolved issues
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• Designer now correctly preserves customizations made to callback audio resources. The previous
release of Designer (9.0.116.08) reverted these resources to the original audio, which could impact the
caller experience if the Callback audio collection was published after upgrading to that version.
(DES-11143)

The Known Issues section is not updated for this release. However, make sure to review these items
so you are aware of them.

March 11, 2021 (9.0.116.08)

What's New

• Designer has improved the way it handles partial failures to initialize applications or run ECMAScript
when these are caused by resource limits being reached on the system platform. Designer Analytics
now reports these as a minimal SDR with a disposition of System Error and a milestone that provides
a more precise error (when available). Prior to this release, Analytics did not report these types of
sessions. (DES-10799)

• In the settings for chat applications (Digital tab), you can now specify a participant name to use for chat
sessions. If a participant name is not specified, the Application Reporting Title is now used as the
default name instead of the name of the application (which was the default used in previous releases of
Designer). (DES-10426)

• Designer Help now contains a list of valid characters that can be used when naming resources.
(DES-10957)

• Designer Analytics now displays enhanced details about third-party bot errors in the SDR properties of
the reporting bot object. (DES-10413)

Resolved issues

• The Menu block no longer suppresses an entire batch of user chat messages that resulted in No Match.
It now uses the first input for the No Match and the remaining messages are utilized by retries or other
blocks. Previously, it would consume the entire batch of messages. (DES-10604)

The Known Issues section is not updated for this release. However, make sure to review these items
so you are aware of them.

January 12, 2021 (9.0.114.03)

What's New

• Designer has a new optimized method for deleting large numbers (i.e. 30 or more) of userdata or Call
Data key/value pairs (KVP). Applications can use the Assign Variables block to build a JSON object
that lists all of the keys to be deleted, with each key assigned a 'null' value. This object can then be
specified in a new property in the Call Data block to initiate a more optimal removal of these KVPs.
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Important: This change has no impact to existing Designer applications or functionality. However,
Genesys recommends that you use this preferred method in all applications that require the
deletion of large numbers of KVPs. (DES-10265)

• Designer now supports the use of Speech Synthesis Markup Language (SSML) tags in TTS (Text-to-
Speech) prompts. This capability is enabled by default in new applications, but can be enabled for
existing applications by setting the new enableSSML system variable to true. (DES-10410)

• For DialogFlow bots, Designer now has the capability to stream audio directly to the bot services
provider, which significantly improves the performance of these bots. (DES-10077)

Resolved issues

• When adding a new bot to the Bot Registry, the list of provider types is now displayed correctly in the
Select Type drop-down. Previously, the list appeared to be empty due to a backend processing error.
(DES-10731)

• Designer now correctly recognizes and processes consult chat interactions, including chat messaging.
Previously, Designer interpreted such interactions as terminated, and would skip subsequent blocks in
the application by jumping directly to the Finalize phase for final processing. (DES-10705)

The Known Issues section is not updated for this release. However, make sure to review these items
so you are aware of them.

November 5, 2020 (9.0.113.06)

What's New
Resolved Issues

• When validating data tables, Designer no longer displays data type mismatch warnings if a cell in a
string-type column contains data that is not stored as a string. (DES-10449)

The Known Issues section is not updated for this release. However, make sure to review these items
so you are aware of them.

October 14, 2020 (9.0.113.05)

What's New

• In Designer deployments that are using the latest version of chat services (i.e. Chat Version 9), Designer
now supports messaging during chat consult transfers. (DES-10286)

• In Analytics, a new Bots dashboard is added to help you analyze and evaluate the performance of
your voice and chat bots. (DES-7169)

• Intelligent Prompts now support the following languages:
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• en-GB (English-Great Britain)
• it-IT (Italian-Italy)

(DES-10189)

• Designer now permits only one user at a time to open a media or message collection for editing. Other
users can view the resource, but they will not be able to make any changes until the resource is
released from editing mode. Designer automatically releases the lock after 15 minutes of inactivity.
(DES-9807)

• For Dialogflow bots, a new Wait Conversation End option is added to the bot registry. When enabled,
it changes the Bot block’s behavior to recognize intents that are marked as end-of-conversation intents
in the bot. This option is not enabled by default, but can be enabled when adding a new Dialogflow bot
to the Bot Registry or by editing an existing one in the registry. (DES-10115)

• Designer now performs stricter validations for data table imports. Schemas can no longer be changed
during imports and Designer now displays a warning if it detects that certain characters were removed
from the CSV file during the editing process. Designer also ensures that the correct default values for
the column data type are applied if no value is present during import. (DES-10360)

• Designer can now preserve user data across interactions for asynchronous chat scenarios. (DES-10346)

Resolved issues

• If the Wait for Answering Machine option is enabled in the application settings, Designer now
correctly informs platform components to wait for an answering machine tone to be detected before
continuing to process an outbound call (for example, waiting for the beep to sound before playing a
message). Previously, this setting was not properly taking effect. (DES-10235)

• In an HTTP REST block, Designer now correctly handles an HTTP 204 response from an external API
endpoint. (DES-10145)

• Designer now correctly generates only one Error Handler block for each Bot block. Previously, in
certain cases, Designer was creating two Error Handler blocks. (DES-9633)

• In the Bot block, Designer now populates the slot values for intents correctly. Previously, in certain
cases, Designer was not assigning variables to the slots correctly if the expected order of intents had
changed (for example, if an intent was disabled and later re-enabled). (DES-9511)

• Designer now filters out problematic characters in TTS text that can cause playback issues. (DES-10163)
• For Callbacks, Designer now correctly updates the blockpath details of the Session Detail Record (SDR)

if a customer disconnects before accepting or rejecting the callback offer. (DES-9977)

The Known Issues section is updated for this release. Make sure to review these items so you are
aware of them.

August 26, 2020 (9.0.112.13)

What's New
Resolved issues

• In certain cases, Designer applications continued to send chat messages to the user's chat widget even
though Designer had routed the chat to an agent. This behavior is now corrected and will take effect
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once the application is republished. No other changes to the application are required. (DES-10135)
• When opening a data table, Designer no longer blocks the UI with a "loading" spinner for a long period

of time. Previously, the spinner could take up to one minute to dismiss. Note: If you are using Google
Chrome, this issue is resolved only for version 76 and later. (DES-10197)

There are no new Known Issues added for this release. However, make sure to review these items so
you are aware of them.

July 21, 2020 (9.0.112.11)

What's New

• For Callbacks, Designer now provides an option to apply dynamic routing allocations to the routing
targets of a Virtual Queue. (DES-9437)

• The Debug block now lets you select secure variables, which enables the DEV, UAT, and QA streams of
an application to capture these variables in their logs.

Important: Secure variables are never captured in the logs for LIVE streams of applications.
(DES-9440)

• The Route Call and Route Digital blocks now allow you to specify a routing algorithm with a variable.
(DES-9515)

• Designer now displays a validation error if you try to upload a grammar file that contains a space in the
file name (spaces are not permitted). (DES-9788)

• When new interaction queues are created, Designer now adds friendly display names that can be
consumed by Workspace Web Edition. (DES-9700)

• Data Tables will now always load and display all known information in the UI, even if there are network
issues or the user has insufficient permissions to view certain resource types. (DES-7754)

Resolved issues

• For Designer users with roles that provide read-only permissions for Media Resources, Designer now
disables all buttons used for editing audio and languages. (DES-9692)

• For Build 0 (and only Build 0) of applications originally created in Designer 8 and migrated to Designer
9, Special Day exceptions in Business Hours are now handled correctly when the Special Day date
range is defined as a single day. (DES-9862)

• Designer is now more resilient when maintenance work is being performed on the platform
authentication services. (DES-8842)

• The PositionInQueue option in the Statistic block now includes details for non-voice interactions.
(DES-9384)

• When the cumulative size of all JSON captured by a Debug block exceeds 25 KB, the block now adds an
error message to the session detail record (SDR). (DES-9418)

There are no new Known Issues added for this release. However, make sure to review these items so
you are aware of them.
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July 8, 2020 (9.0.111.23)

What's New

• Designer has optimized how it communicates with digital services, especially for very long-running
application sessions (2 weeks or longer). The rate of communication between Designer and digital
services has been changed, so that Designer no longer constantly retries when there are
communication failures. Previously, this could cause a high load on these services, which would
manifest in Analytics as sessions with a disposition of Application Timeout and, in general, delays in
messaging. No specific changes are required in your applications. This improvement will take effect the
next time an application is re-published. (DES-10009)

There are no new Known Issues added for this release. However, make sure to review these items so
you are aware of them.

June 11, 2020 (9.0.111.19)

What's New

• In the application settings, the Digital tab has a new option to Terminate interaction when the
customer disconnects. When enabled, Designer terminates the interaction immediately if the
customer leaves the chat. This option is only applicable to Digital-type applications or Default-type
applications that are enabled for omni-channel support. Note that this option is enabled by default for
both new and existing applications.

• The Terminate Call (Default) and Terminate (Digital) blocks have a new option to Stop the
interaction immediately that can be enabled for digital interactions. When enabled, Designer
immediately stops the interaction and jumps to the Finalize phase. Previously, the Terminate block
did not immediately stop a digital interaction; instead, Designer skipped any remaining blocks and
jumped to the Finalize phase, and only terminated the interaction after the blocks in the Finalize
phase had been processed.

There are no new Known Issues added for this release. However, make sure to review the items in
this section so you are aware of them.

May 14, 2020 (9.0.111.16)

What's New

• In the application settings, the Digital tab has a new option that enables Designer to continue
processing the application after the customer leaves the chat session (this option does not apply to
voice interactions). For Default type applications, this option is available when omni-channel support is
enabled. When this option is unchecked (OFF), Designer terminates the chat interaction when the
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customer leaves the chat session and processing jumps to Finalize. This can interrupt any ongoing
processing, including routing.

• For Digital applications that are being used for Genesys Task Routing, Designer now requires that
endpoints created in Cloud iWD include an openmedia prefix (for example, openmedia.banking).
Otherwise, Designer won't recognize the endpoint and it won't appear in the list of endpoints in
Designer.

• Variables defined in the Initialize block are correctly initialized even if the chat customer participant
leaves while the block is executing. This allows reliable use of application variables in the Finalize
phase for post processing. Previously, in certain cases, variables did not initialize in this scenario.

The Known Issues section is updated for this release. Make sure to review these items so you are
aware of them.

March 5, 2020 (9.0.111.09)

What's New
Persona selection

• Designer now includes a variety of personas that you can use to control the Text-to-Speech (TTS) engine
(Nuance, Google) in your applications. You can select a persona to apply throughout the entire
application (in any block that uses a TTS service, including the Bot block). You can also switch to a
different persona midway in the application by using a Change Persona block.

Internet Explorer deprecated

• Microsoft Internet Explorer (IE) is now deprecated. For a list of browsers supported by Designer, see
Supported browsers.

Resolved issues

• The latest version displayed in the What's New pop-up now matches your actual version of Designer.
Previously, the version shown was based on the latest version being rolled out, and thus did not always
correctly indicate the version being used by your site. (DES-9197)

• When accessing Designer through a private Multiprotocol Label Switching (MPLS) tile, the Logout
button now correctly redirects users back to the Single Sign-on (SSO) login page. (DES-8397)

• In addition, an issue that prevented certain users from being able to log into Designer from a private
MPLS tile is now corrected. (DES-9256)

• If there are no SDR fields specified when performing a search on the SDR dashboard, Designer now only
matches the search terms against a few select fields (ANI, DNIS, SessionID, InteractionID,
ConnectionID, and childIxns.id). Previously, in this type of scenario, Designer searched all SDR field
values for a match, which sometimes had a negative impact on performance and led to service issues.
This update also introduces some changes to the syntax for SDR search query statements, which are
described in Searching the Session Detail Records. (DES-9010)

• The resource history view functionality is now extended to include history views for Users and
Partitions. (DES-9064)
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• The Get Chat Transcript block now uses a new digital channels API to fetch the chat transcript.
(DES-9169)

• Session Detail Records for outbound Callback applications now correctly contain the ConnectionID and
MCP fields. (DES-9224)

• When using Dialog Engine voice or chat bots, the "goal reached" confirmation message can now be
optionally suppressed. (DES-9257)

The Known Issues section is updated for this release. Make sure to review these items so you are
aware of them.

January 23, 2020 (9.0.110.07)

What's New
Resolved issues

• When publishing an application, Designer now validates the parseInt(string, radix) function used by
the Advanced Scripting tab of the Assign Variables block and displays a warning if the value of the
radix parameter is missing or invalid. (DES-8876)

Note: If you are using cloned Callback modules in the application, this validation returns an error
that prevents the application from being published. See Known Issues for more details and
workaround information.

• Designer now correctly calculates the amount of time an interaction has spent in the parking queue
when the interaction is routed to an agent after business hours are resumed and the agent misses or
rejects it. (DES-9067)

• The Bot block now stores the value of the Store latest response from bot variable for voice and chat
responses in the same format. (DES-9124)

• Designer now correctly retains the settings for a partition when you add multiple users to it from the
Partitions tab. (DES-9100)

• In Designer Analytics, percentages are now displayed correctly on dashboard panels that use the
number value type. (DES-8878)

• Designer no longer prevents additional changes from being made to a business controls resource if
multiple changes are made to the resource within a short period of time. (DES-8700)

December 17, 2019 (9.0.109.08)

What's New
Chat-based surveys

• Designer's survey capabilities are expanded to include the ability to offer chat-based surveys to your
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customers. If a customer who is engaged in a chat session opts to participate in a survey, they are
presented with the survey questions in the chat window after their chat with the agent is complete.
(DES-8953)

Other improvements and changes

• Intelligent prompts now include French, Cantonese, and Punjabi language packs. (DES-8973)
• Microsoft LUIS (Microsoft Language Understanding Service) bots can now be registered in Designer and

used for Self Service via the Bot block. (DES-8866)
• The routing priority of OpenMedia interactions is now auto-managed in Digital applications instead of

being configured manually in the Route Digital block. Cloud intelligent Workload Distribution (iWD)
provides the initial priority and any priority updates to Designer, and then Designer updates the priority
accordingly in all applicable queues. (DES-8861)

Resolved issues

• When exiting a Route Call block that has the Clear targets from queue when this block
terminates option enabled, Designer now correctly clears a call from the virtual queue. (DES-8736)

• When Manage Builds is selected for an application that has builds available, Designer no longer
displays a message that no builds have been generated for that application. (DES-8798)

• Dialog Engine V2 bots can now be registered in Designer and used for Self Service via the Bot block.
(DES-8740)

• Designer now uses Coordinated Universal Time (UTC) to adjust for local time zones when determining
when a data table was last modified or published. (DES-8622)

• An issue that caused Analytics to sometimes report duplicate details about busy treatments is now
resolved. (DES-8126)

• For scheduled callbacks, they will now be correctly purged after the desired time of their callback, or at
the end of the business day (whichever comes first). (DES-8020)

October 22, 2019 (9.0.108.03)

What's New
Optional LIVE B stream

• Designer now provides an optional LIVE B stream in addition to the existing LIVE stream. This enables
you to run a second application in LIVE production mode, which gives you greater flexibility in how you
can introduce new application builds into your production environment. For example, each LIVE stream
can have different contact points assigned to it, so you could allocate interactions coming from a
certain region to a particular stream, or use the streams to balance (or gradually introduce) the number
of interactions being handled by a new production build. (DES-8488)
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Resource history view

• Designer now provides a history view for most resources, such as applications, shared modules, media
files, audio collections, and business controls. This view allows you to see the historical details for a
selected resource, such as the date of each change, who made the change, and the previous value. In
some cases, you can drill down further into the results to view additional details for a specific edit. You
can also sort, filter (for example, view the history for a certain time period), search, and export the
results to a file. (DES-8450, DES-8451, DES-8452)

Other improvements and changes

• If a digital interaction is transferred to another application (such as when an application is selected as a
destination target in a Route Digital block), the interaction is transferred to the same type of stream
for the target application. For example, if the transferring application is running in the LIVE stream, the
interaction goes to the LIVE stream of the target application. (DES-8490)

• Support for several new languages is added. You can see a full list of supported languages in the
Language menu under System Variables (or whenever there is an option to select a language, such as
when managing languages for media resources). (DES-8667)

• When you create a new Bot, Designer now checks to make sure that the name you enter does not
contain any invalid characters. Note that Bot names can only contain alphanumeric and the following
special characters: plus (+) and minus (-). (DES-8739)

• Several improvements have been made to Designer Analytics, to support better reliability and stability
in displaying search and reporting data. (DES-8252), (DES-8261), (DES-8281)

• A new Input timeout value for chat interactions is added to the Input Settings tab of the User
Input, Menu, and Bot blocks. (DES-8449)

Resolved issues

• An issue that caused some users to experience intermittent disconnections from Designer is now
corrected. (DES-6680)

• An issue that caused Designer to stop processing an application if a specified built-in grammar couldn't
be found is now corrected. (DES-8676)

• Designer now checks if the variable containing the URL for an external grammar contains a null,
undefined, or empty value. If so, Designer logs the result and continues processing the application.
(DES-8630)

• During bulk audio uploads, Designer no longer permits media resources that contain non-supported
special characters to be uploaded. Note that the only special characters supported in media resource
filenames are dots (.), underscores ( _ ) and hyphens ( - ). (DES-8316)

September 26, 2019 (9.0.107.06)

What's New
This release includes only resolved issues.
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Resolved issues

• An issue that prevented Internet Explorer users from logging into Designer is now fixed. (DES-8702)
• For blocks that allow you to specify a navigational target destination when certain conditions are met

(such as User Input, Menu, and Bot blocks), Designer now displays an error message during
validation if the specified target block destination is missing. You can correct the error by going to the
indicated block and re-selecting the target destination. (DES-8153)

September 23, 2019 (9.0.107.05)

What's New
Externally-Hosted Grammars

• You can now use speech grammars that are stored outside of Designer in your applications. This
provides greater flexibility in selecting grammars, as an application can reference both externally-
hosted speech grammars and the ones that are included with Designer.

Other improvements and changes

• The Record Utterance block now allows you to select an audio format for your recording files.
• Designer now displays a validation error message if an external speech grammar does not have at least

one input Mode selected.
• Also, when viewing the properties of a speech grammar from a User Input block, the display of the

interface is improved so that all details are fully visible.
• When you clone an application and generate the first build for it, the build versioning now starts at 1.

Resolved issues

• Users with DesignerAdmin and DesignerBusiness roles are now able to successfully assign builds to
streams, and also to enable or disable them. (DES-8232)

• In Designer Analytics, the filtering tools now correctly apply all of the specified conditions. (DES-8068)
• Designer now correctly imports files exported from other Designer 9 releases. In some cases, Designer

would display a message that the files being imported were not compatible with that particular version
of Designer. (DES-7553)

• The value for the Bot invocation result code is now correctly captured by Designer Analytics.
Previously, this value was not appearing in analytics reports even though a variable was assigned to it.
(DES-7852)

• Designer now correctly ignores Debug blocks when application builds are running in the Live stream.
(DES-8655)

• For variable-driven priority routing, Designer now applies a default priority value if the variable specified
contains a value that isn't valid (i.e. undefined or not able to be converted to a number). (DES-8495,
DES-5590)
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• When you select one of the options provided on the Navigation tab of certain blocks (such as Start
Treatment, Click-to-Call-In Match, or Segmentation), Designer now retains your selection if you go
back to the tab after clicking on another tab. (DES-8418)

• For blocks that have a text box for specifying target destinations (such as the Go To or Start
Treatment blocks), Designer now retains the associated target if you unintentionally clear it by clicking
inside of the text box. (DES-8407)

• An issue that caused Designer Analytics to sometimes not display all session details for a call even
when the call completed without any errors is now corrected. (DES-8258)

• Designer now allows you to update an existing media resource file with a new file that has the same
name. (DES-8059)

• An issue that caused certain users to see an intermittent message that Designer had disconnected is
now corrected. (DES-8048)

• The Bot block is improved to correctly handle "no match" and "no input" scenarios for chats.
(DES-7465)

• Designer now correctly by-passes Route Call blocks when the variable for the timeout value is defined
as 0 (zero). (DES-7246)

• For callback applications, Designer now disconnects all dialed calls automatically when the call session
ends. (DES-8478)

• Immediate callbacks are now processed correctly if the connection is interrupted while a caller is
receiving their callback booking confirmation. (DES-8003)

• Callback handling has been improved in multi-switch environments. (DES-6631)

August 19, 2019 (9.0.105.14)

What's New
Facebook, WhatsApp, Twitter, and SMS

• Designer is now capable of handling messages coming from Facebook (Public and Private),
WhatsApp, Twitter (Public and Private), and SMS. If a customer contacts you from one of these social
media platforms or services, Designer detects which channel the message is coming from and launches
the appropriate application for managing and routing that type of interaction. If applicable, Designer
can also send or post messages back to the incoming channel.

Single Sign-On (SSO)

• Designer now supports single sign-on (SSO), which lets you access supported Genesys Engage cloud
applications with one login. Once you've signed-in and been authenticated by a third-party identity
provider (such as Okta), you can then go to any SSO-enabled application and be automatically logged
in without needing to enter your credentials.

Send SMS

• The new Send SMS block lets you send an SMS (Short Message Service) message to a customer from
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any application type or channel. Important: This functionality is not supported for Callback
applications.

Parking Queue Routing

• The Route Call and Route Digital blocks have a new option, Parking Queue, added to the list of
available routing types. When selected, Designer sends digital interactions to a parking queue when
the contact center is closed and retrieves them again when the contact center is open (as per the
regular business hours specified in the Business Hours block).

N-best setting for speech recognition

• You can now configure an N-best threshold setting for Automatic Speech Recognition (ASR). If a
customer's response isn't clear or is difficult to understand (for example, perhaps there is a lot of
background noise), the N-best setting enables Designer to formulate a "best guess" as to what it thinks
the customer intended to say, and then confirm if that was their intended response. You can configure
this option globally by going to the Speech Recognition tab in the Application Settings and using the
slider to adjust the Max N-best setting. Or, you can set it locally from the ASR Settings tab on the
User Input block.

Other improvements and changes

• For bulk audio imports, when importing new media resources to a collection, Designer now displays the
progress of the import.

• The Upload Record Utterance option in the HTTP REST block now supports custom headers.
• You can now view the flows of application builds and shared module versions in read-only mode.
• On the Applications page, you can now search by entering a specific phone number in the Search bar.
• When managing contact points for an application, you can now select phone numbers to be assigned in

bulk or transferred to another application, without any interruption to service. Two new buttons are
introduced to provide this functionality: Batch Assign lets you assign multiple phone numbers to the
application, and Transfer from Others lets you transfer multiple phone numbers to other
applications, or to other streams of the current application.

Resolved issues

• An issue that caused certain users to intermittently see a message that Designer had disconnected (i.e.
"Oops! Designer cannot reach the HTCC server") is now corrected. (DES-7678)

• If a Designer Role is modified in Platform Administrator, Designer now correctly interprets and applies
the privileges of that role. (DES-7664)

• On the Shared Module block, if the user navigates away from the Signature tab, the Input
Parameters radio button remains selected (as the default) if the user goes back to that tab.
(DES-7579)

• Designer Analytics no longer incorrectly applies a final disposition of Terminated - Auto Stop to
sessions when digital interactions were already routed. (DES-8007)

• Designer now displays assigned chat endpoints correctly when the name contains an underscore ("_").
(DES-7909)

• When the Specify Skills in this block option in the Route Call block is enabled, the radio button now
correctly indicates that the option is selected. (DES-7813)
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• For applications enabled for chats, the Treatments tab of the Route Call block now lets you specify
the number of seconds that should elapse between each treatment iteration. This setting prevents chat
customers from receiving too many update notifications while waiting for an agent, and is ignored for
voice interactions. (DES-7751)

• Bulk audio imports have been enhanced:
• Designer now lets you know if a media resource specified in the CSV file doesn't exist in the package

being imported. You can correct this by adding the missing file or removing the resource from the
CSV file. (DES-7749)

• If numbers are used to specify Text-to-Speech values in a CSV file, Designer no longer incorrectly
flags this as a validation error. (DES-7738)

• In the Application Settings, the Speech Recognition values are now updated accordingly when
adjusted by the sliders. (DES-7729)

• Designer now applies the correct disposition code ("Abandoned in Queue") if the Clear on Timeout
option is enabled in the Route Call block and a caller in the queue disconnects. Previously, Designer
was applying the "System Error" disposition code in this type of scenario. (DES-7723)

• Designer now correctly handles Special Day exceptions for Business Hours when the specified date
range is only one day. (DES-7639)

• If you generate a new build, Designer no longer assigns it a build number that was already used.
Previously, Designer would re-use numbers of deleted builds.(DES-7484)

• An issue that caused some of the panels on the default home dashboard to display average (mean)
values as invalid text is now corrected. (DES-7478)

• During application exports, media resource files that are specified as manual dependencies are now
included in the exported DAR file. (DES-7458)

• In the Statistic block, the width of the Objects drop-down menu is increased so that items with longer
names are displayed in full. (DES-4708)

• The Send Test Request option on the Test tab of the HTTP REST block is now working correctly for
requests that use a proxy. (DES-7634)

March 12, 2019 (9.0.102.03)

What's New
Google Automated Speech Recognition

• Designer applications can now tap into the powerful machine learning capabilities of Google's
Automated Speech Recognition (ASR) engine to transcribe speech inputs provided by customers. This
option is added to the Input tab of the User Input block, where you can enable it by selecting
Transcribe (Google ASR). Google ASR is also enabled by default on the Input Settings tab of the Bot
block.

Bulk audio upload

• You can now add multiple media resources to a collection using the Import Bulk Audio option. This
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enables you to upload a zip file that contains the media resources you want to import into the
collection.

Quick replies

• During a chat session, option prompts configured in the Menu block now appear in the chat window as
"quick reply" buttons. These are buttons that correspond to the options presented to the customer and
allows them to quickly reply to the prompt by clicking a button rather than typing their response.

Other improvements and changes

• The streams and builds workflow capability is expanded to include callback type applications.
• Designer now supports Punjabi (pa-IN).

Resolved Issues

• When using the Route to another Application option in the Route Digital block, the current
application is no longer listed as one of the available target selections. (DES-7297)

• When an application processes a block that collects customer data (for example, a User Input, Menu,
or Bot block), Designer now only considers customer messages received after that block is processed.
(DES-7324)

• When publishing a media collection, languages that were previously deleted no longer appear in the list
as added languages. (DES-7233)

• For digital applications, the option to assign or manage endpoints is now enabled only after the
application is published. (DES-7324)

• When an outbound call fails to be created, Designer no longer disconnects the call and generates an
error message. (DES-5839)

• When a callback is accepted, Designer now waits until all reporting processing is completed before
making the outbound call. (DES-5804)

February 21, 2019 (9.0.100.31)

What's New
Rich media enhancements

• The Play Message block now lets you display an image to a customer during a chat session. You can
enable this option on the Message Settings tab, where you can then specify the variable that contains
the URL path to the image you want to display.

Designer Analytics

• Reports for Predictive Routing are added to the Routing Analysis dashboard.
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Other improvements and changes

• Several of the user-interface elements have been standardized (i.e. color, style, formatting) to ensure a
more consistent user experience across Designer and other Genesys products.

Resolved Issues

• Designer now checks to make sure that data table names are unique. Previously, a new data table could
be saved with the same name as an existing one. (DES-7342)

January 18, 2019 (9.0.100.21)

What's New
Microservices platform

• Designer is now built as a microservice, which means you'll get faster access to new features and zero
downtime during upgrades.

Omnichannel capability

• You can now "build once, and deploy anywhere"; a single call flow can handle both voice and chat
interactions.

• Email handling — the new Send Email block lets an agent send an email to a customer, and the new
Automated Message block sends an automated confirmation to a customer that their email was
received.

Chatbots

• You can use the Bot block in the Self Service phase of your application to add a chatbot to your
application. Chatbots are software applications that apply automatic speech recognition and natural
language understanding to listen and respond to customers in a way that resembles a conversation
with a live agent. You can define and manage your bot resources in the new Bot Registry.

Predictive Routing

• If your site is enabled for Genesys Predictive Routing, you can use the Predictive Routing block in your
applications to take advantage of this powerful routing capability. This feature allows Designer to
retrieve a list of agents that are best equipped to handle a specific type of call and then route the call
to the agent with the highest likelihood of a successful outcome.

Streams and Builds Workflow

• Designer now features a streams-based workflow, where you can generate multiple builds of an
application and assign them to different streams. For example, you can have one build of an application
assigned to QA, and another build of the same application assigned to your Live operations. You can
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manage these builds from the application properties.
• You can now designate certain resources for use in testing, so that non-production builds do not

reference resources that are being used in your live operations.

Other improvements and changes

• The new Manage OpenMedia Endpoints setting under Application settings lets you select and assign
an OpenMedia endpoint to the application (to support Genesys Task Routing).

• The new Record Utterance block lets you capture a voice recording of a caller that can then be sent to
an external API (using an HTTP Rest block) or played back using a Play Message block.

• The new Click-to-Call-In- Match block lets you compare and match a caller's information with details
they provided earlier and then route the interaction accordingly.

• The Input tab of the User Input block has two new options (Service and Arg), that are added to
support dynamic speech grammars.

• The User Input block has two additional tabs, Confirmation and Confirmation Retry, that let you ask
customers to confirm their responses.

• A new option, Set Agent Reservation Priority to current priority option, is added to the Routing
Priority tab of the Callback block to apply the current priority of the call at the time an agent was
found for the callback to the agent reservation request (when using the Use Priority during Routing
option).

• The Routing tab of the Route Digital block has a new option, Route to another Application, that lets
you route the interaction to the interaction queue of the selected destination application.

• Speech Grammars is now called Grammars & Bots.
• Audio Resources is now called Media Resources.
• Message Resources is now called Digital Resources.

Known Issues

The latest known issues are at the top of the list.

• When importing Bulk Audio into a Media Collection, TTS text values that contain special characters are
not displayed on the Media Resources details page or the Manage Languages dialog. (DES-10389)

• For long-running background tasks that take longer than 2 minutes, Designer will sometimes display an
error message in the UI, even as the task continues to process successfully. This issue most often
occurs when publishing large applications, or publishing entire media collections. As a workaround,
refresh the page, and check the Last Published timestamp. If the publish operation was successful,
this is reflected in the Last Published timestamp. (DES-10294)

• Custom query expressions are only working on the Session Detail Records dashboard. (DES-10156)
Workaround: Instead of using a custom query, you can use filters and drill-downs on all other
dashboards to target and locate specific details.

• When a Route Call block is configured to run a post-processing application, the main application might
restart after the post-processing application has completed. (DES-9758)

Workaround: In the main application, use a Call Data block to set the sys_des_postprocessing
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value as true.

• When publishing an application, Designer now validates the parseInt(string, radix) function used by
the Advanced Scripting tab of the Assign Variables block and displays a warning if the value of the
radix parameter is missing or invalid. However, if you are using cloned Callback modules in the
application, the validation returns an error that prevents the application from being published.
(DES-8876)

Workaround: Click the error to jump to the affected block. Find the expression that uses
parseInt(parameter1) and add a second parameter for the radix value (e.g.
parseInt(parameter1, 10)). Save the application flow and try publishing again.

• In Designer Analytics, the aggstable panel type is removed from the list of available panel types. The
functionality of this panel is now migrated to the agg panel type. (DES-7489)

• When using the WhatsApp social media channel, “Unsupported message type” might appear in the chat
window if the application flow contains an Intelligent Prompt type message. (DES-9060)

• In chat-based survey applications, the chat transcript is missing from the email sent by the Send Chat
Transcript block. (DES-8957)

• The new LIVE B stream is not yet supported for social media interactions (Facebook, WhatsApp, Twitter,
etc.). (DES-8805)

• Designer might unexpectedly freeze if you are using a Google Chrome or Microsoft Edge browser
powered by Chromium v.77. (DES-8637)

Workaround: This issue is resolved in the latest versions of these browsers. To avoid this issue,
update your Chrome and Edge browsers to the latest versions.

• Designer does not support Microsoft Internet Explorer (all versions). Using non-supported browsers with
Designer can produce unexpected results. (DES-8654)

• WhatsApp: If a customer responds to a chat prompt by uploading an image from their local machine,
Designer accepts the image as a valid response even though it doesn't match the expected input (such
as a menu option number). (DES-7887)

• In Designer 9.0, you can only import applications that were created using a 9.0 version. Applications
exported from non-9.0 releases are not compatible. (DES-7283)

Designer Gplus Adapter for Service Now

Genesys Engage cloud Release Note 241



Digital Channels
For information about the latest releases of Digital Channels, refer to Digital Channels Release Notes.

Digital Channels is a common service (collectively known as Nexus) that enables Chat, SMS, Social,
and Messaging channels, as well as various APIs for mobile chat, secure mail, webhooks, and third-
party integrations. It provides functionality to several Genesys products, including Agent Desktop. For
more information about Digital Channels, refer to the documentation here.

Note: Not all changes listed below may pertain to your deployment.

• March 19, 2021 (9.0.000.83)
• March 4, 2021 (9.0.000.82)
• February 18, 2021

(9.0.000.79)
• February 4, 2021 (9.0.000.77)
• January 14, 2021 (9.0.000.75)
• December 9, 2020

(9.0.000.72)
• November 12, 2020

(9.0.000.69)
• November 4, 2020

(9.0.000.68)
• October 13, 2020

(9.0.000.67)
• October 1, 2020 (9.0.000.65)
• September 22, 2020
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• September 3, 2020

(9.0.000.63)
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• August 11, 2020 (9.0.000.61)

• July 23, 2020 (9.0.000.60)
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• May 14, 2020 (9.0.000.55)
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• March 5, 2020 (9.0.000.45)
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• Known Issues
• Limitations
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March 19, 2021 (9.0.000.83)

What's New
SMS channel enhancement

• The SMS channel can now be marked as CX Only if the SMS channel is used in CX Campaigns and no
routing of incoming messages is planned.

Bot-managed conversations

• Support of initial context for bot-managed conversations.

Resolved Issues

• Agents can now establish a new WhatsApp session with a new contact and send a message to the
contact immediately. Previously, if a contact had not been communicated with before on WhatsApp, it
was not possible to send a notification to the contact. Note: WhatsApp does not allow standard
messages to be sent to a user after 24 hours have elapsed from when the last message sent by the
user. (NEXUS-5617)

March 4, 2021 (9.0.000.82)

What's New
Chat reporting

• The time a contact left a Chat session is now reported in the Chat interaction, enabling further
processing by reporting components.

• For Chat interaction transfer, the handling of statistics for Chat interaction closure date/time and
number of agents in the session has been improved.

Messaging API improvement

• A message sent as a webhook to a third-party messaging API now contains the type field.

Security improvement

• Digital Channels security has been improved.

Secure Email API

• The Secure Email API now enables primary contact attribute lookup, create, and update, and enables
this contact information to be used in other Secure Email API requests.

CX Contact outbound email campaign support
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• CX Contact outbound email campaign support is added to the integration with third-party email
providers through a Third-party messaging API.

February 18, 2021 (9.0.000.79)

What's New
Security improvements

• Security has been improved for integration with Workspace Web Edition.
IMPORTANT: Agents that started their session before the production upgrade to this version must
login again to Workspace Web Edition to continue using the Communication and Conversation
tabs.

Secure Email API

• The Secure Email API now enables you to get either a list of email interactions or a count of emails by
type, such as inbound, outbound, and so on.

• The Secure Email API now enables you to get the content of an outbound Secure Email interaction
without marking it as Read.

February 4, 2021 (9.0.000.77)

What's New
SMS channel Communication and error handling improvements

• Agent are notified when MMS messages sent by a contact have problematic attachments.
• Handling of CX Contact campaign stop signals.
• Agents are notified if they attempt to send a message from a non-existing number due to platform

misconfiguration.

Outbound SMS campaign improvement

• Outbound SMS campaigns executed by CX Contact can now be enabled through integration with a third-
party SMS service.

Resolved Issues

• Agents can now send single or multiple Secure Email attachments where the maximum size of each
attachment is less than 7MB. Previously, if an email contained attachments totaling more than 7MB, all
together, the email could not be sent. (NEXUS-5634)
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January 14, 2021 (9.0.000.75)

What's New
WhatsApp Validation

• Agents can now check whether the contact number used for SMS or voice can also be used for
WhatsApp. The agent needs to click the Validate button next to the contact's number and then, if
successful, the agent can communicate with the contact on WhatsApp over that number.

Expanded SMS keyword support

• For SMS outbound campaigns, the list of keywords for help and stop signals has been expanded with
the following additional keywords (in any letter case):
• help: 'aide'
• stop: 'arret' and 'unsub'

Secure Email

• The getEmail service now enables you to specify start and end dates as criteria when requesting a list
of email interactions, including earlier-than and later-than specific dates.

Attached Data support

• API endpoints for retrieving attached user data from chat and secure mail interactions are now
provided. Note: some internal keys are omitted.

December 9, 2020 (9.0.000.72)

What's New
Secure Email

• Support for multiple corporate mailboxes.
• Support for image (jpeg, png, gif, tiff, and bmp) and document (text, docx, xlsx, and pdf) attachments.
• Support for thread/parent relationships for inbound Email interactions.

WhatsApp Highly Structured Messages/Notifications support

• Support of the WhatsApp Highly Structured Messages/Notifications has been enhanced to support the
new format introduced by WhatsApp, including notification header, footer, and buttons.
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Delivery receipt support

• Delivery receipts showing successful and failed delivery are now displayed to agents for sent messages.
Message receipt behavior varies depending on the behavior and capabilities of each media.

Resolved Issues

• The Chat interaction transcript is now correctly stored in UCS when the interaction is closed. Previously,
in some scenarios, the chat communication transcript was not exported to UCS when the interaction
was closed. (NEXUS-5289)

• For SMS sessions, the SMS number of the contact and organization is now displayed in the
Communication tab. (NEXUS-5145)

November 12, 2020 (9.0.000.69)

What's New
Resolved Issues

• The Consumer Messaging API now returns new messages in a single response. Previously, if a client
resumed polling after a significant timeout, new messages could sometimes be returned in a second
response. (NEXUS-5099)

• When a contact disconnects from a Chat session before the agent does, now only one "Participant Left a
session" message is displayed to the agent. (NEXUS-4702, NEXUS-3483)

• Messages are no longer delivered a second time. Previously, when the client was retrieving new
messages, already delivered messages were sometimes delivered again if filtering is not applied.
(NEXUS-4376)

November 4, 2020 (9.0.000.68)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.
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October 13, 2020 (9.0.000.67)

What's New
Resolved Issues

• When push notification is enabled for the session, Chat messages are now correctly displayed in the
Communication and Conversation tabs, and agent is now notified about new messages. (NEXUS-4881)

• The current state of a Chat interaction is now correctly displayed to agents. Previously, in some
scenarios, when an agent was trying to join a Chat interaction it might have been displayed as
Completed, not allowing agent to communicate with the contact. (NEXUS-4835)

• Chat interactions are now submitted to the correct queue after the endpoint is updated. Previously in
this scenario, Chat interactions were submitted to the old queue for sessions that were created before
the update. (NEXUS-4832)

• Agents can now create SMS interactions from the the Create Chat button in the Communication tab
when the Send function is disabled. (NEXUS-4828)

• User data is now correctly attached to the current Chat interaction and any follow up Chat interactions
in the same session. Previously, user data was not attached to follow up interactions in the same Chat
session. (NEXUS-4804)

• URLs pushed by agents during Chat sessions are now correctly saved in the Chat transcript for the
interaction. Previously, the Chat transcript did not include pushed URLs. (NEXUS-4799)

October 1, 2020 (9.0.000.65)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

September 22, 2020 (9.0.000.64)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.
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September 3, 2020 (9.0.000.63)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

August 25, 2020 (9.0.000.62)

What's New
Webhook event for Dialogflow

• Media type is now sent as the part of fulfillment webhook event when using a Dialogflow-based bot.

Asynchold queue improvement

• The Asynchold queue no longer re-routes any interaction that was placed into a queue without hold
timeout. Interactions that do not have a designated queue are terminated when they are placed in
Asynchold.

Important: The Workspace Web Edition functionality that allows interactions to be placed on hold
for Chat and SMS is not supported. This functionality should be disabled in Workspace by setting
the value of the interaction-workspace\privilege.chat.can-place-on-hold-async option in to false in
the Workspace application object.

Resolved Issues

• Double clicking the Create button to initiate a Chat or SMS interaction no longer results in two
interactions being created. Agents can now create only one interaction of each media type for each
contact. (NEXUS-4400)

August 6, 2020 (9.0.000.61)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.
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July 23, 2020 (9.0.000.60)

What's New
Resolved Issues

• Messages are no longer removed from the transcript of an agent initiated conversation when the
transcript is saved. (NEXUS-4300)

• Reporting metrics are now correctly attached to interactions when an agent leaves the session with
KeepAlive active. (NEXUS-4275)

• The asynchold queue has been modified to prevent interactions from looping in the queue due to the
inability of the queue to route these interactions. These interactions are now moved to the undelivered
queue if one is configured or the interaction is terminated. (NEXUS-3049)

July 9, 2020 (9.0.000.59)

What's New
UI enhancement

• In the Contact Information column, the tooltips for the buttons enabling agents to create new
interaction now correspond to the appropriate media type.

Localization Support

• Spanish, Portuguese (Brazilian), and Polish languages are now supported.

Communicating with Google Dialogflow

• While communicating with a Google Dialogflow bot in the Designer application, the bot now stays
engaged until one of the "end of conversation" intents is reached. This functionality must be enabled
for each registered bot application individually, not collectively for all the bots on the tenant. Contact
your Genesys representative to enable this functionality.

Resiliency

• This release includes multiple resiliency improvements to enhance product stability.

Resolved Issues

• MMS messages without attachments are now displayed correctly in the chat session. (NEXUS-4134)
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May 28, 2020 (9.0.000.57)

What's New
WhatsApp channel enhancement

• If an agent or bot includes a URL in a WhatsApp message (any string beginning with http:// or https://),
the message is no longer marked to render a preview of the URL. Note: if the URL being sent is invalid,
WhatsApp will reject the message.

May 14, 2020 (9.0.000.55)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

April 30, 2020 (9.0.000.54)

What's New
Communication tab enhancement

• You can choose to disable the Reply functionality from the Communications tab. Instead, agents can
click the channel icon in the Communications tab to launch a new interaction with the selected
contact. Contact Genesys to disable this functionality.

To disable reply functionality, add &disablesend=true to the Communication tab url in
Workspace configuration. (NEXUS-3336)

Image preview enhancement

• Attached image previews are now displayed in a modal window instead of in the right sidebar of the
Conversation tab. (NEXUS-3258)

Undeliverable message redirection

• Interactions that are not submitted to their originally assigned endpoints are now redirected to an
"Undelivered" endpoint for analysis. Interactions placed in this queue can be reviewed using Interaction
Queue Management functionality in Workspace. Interactions that are not moved out of the queue will
be auto-completed after a 14 day timeout. (NEXUS-2771)
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Resolved Issues

• The Genesys Designer application is not disconnected from Chat session due to inactivity timeout. To
disconnect Designer from a Chat session, an explicit request must be sent. (NEXUS-3317)

April 16, 2020 (9.0.000.51)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

April 6, 2020 (9.0.000.49)

What's New
WhatsApp sticker support

• Agents can see WhatsApp stickers as emojis as part of WhatsApp interactions.

Language support

• Dutch

Facebook reaction support

• Facebook reactions are displayed for public Facebook posts and comments.

Facebook private session attachment support

• Agents can now include attachments when responding to a Facebook private message.

Twitter user parameter support

• Twitter metrics, such as Followers, Followings, Tweets, and Retweets made by the contact are displayed
to enable agents to determine how influential the contact is to assign priority to a response.
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March 19, 2020 (9.0.000.48)

What's New
Disable transcript recording

• You can now use an attached data key-value pair to disable the recording of transcripts in UCS. To
prevent the transcript for this interaction from being saved to UCS, set the value of the skipTranscript
key to ucs.

Anonymous session housekeeping

• Chat transcripts are now stored in Digital Channels for a limited time. Anonymous session transcripts,
such as those coming from Genesys Widgets with only First and Last names, are stored for 3 days from
the day of the last message in the session. For other sessions, transcripts are stored for 28 days.

Facebook private session attachment support

• Agents can now include attachments when responding to a Facebook private message.

Resolved Issues

• File names now display correctly for attachments in WhatsApp. Previously, file names were always
displayed as "Untitled". (NEXUS-3079)

March 5, 2020 (9.0.000.45)

What's New
Configurable subscription timeout value

• The time that an interaction is held in asynchold queue can now be changed for the tenant. The
default value has been decreased from 10 to 5 minutes. Please contact Genesys Customer Care if you
need to have this value adjusted for your tenant.

February 20, 2020 (9.0.000.44)

What's New
Read receipt support

• Read receipts are now displayed to agents for chat, SMS, WhatsApp, and Twitter Direct Message.

Digital Channels Gplus Adapter for Service Now

Genesys Engage cloud Release Note 252



February 10, 2020 (9.0.000.43)

What's New
Browser SameSite cookie support

• The SameSite=None attribute for cookie-based stickiness is now set. This enhancement addresses the
new, stricter browser policies being implemented (starting in February 2020 for Google Chrome, and
starting at a later date for other browsers).

Resolved Issues

• The browser no longer becomes unresponsive when an agent that has a large number of associated
contacts logs in to Workspace Agent Desktop and handles a chat interaction. Now only the first 100
associated contacts are displayed in the Communication tab. (NEXUS-2779)

• The Get Messages API now allows you to fetch messages in both forward (negative value for count)
and reverse (positive value for count) directions, in History mode, before and after the specified
index. Previously, it was only possible to fetch messages before the specified index. (NEXUS-2611)

• Agents no longer receive broadcast messages from the bot each time one of their associated contacts
interacts with a chat bot. (NEXUS-2608)

January 23, 2020 (9.0.000.40)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

Resolved Issues

• Contacts can no longer see the messages indicating that a supervisor has connected to or disconnected
from a chat interaction when barging in or coaching. Now the messages are displayed only in the chat
transcript visible to agents. (NEXUS-2571)
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January 9, 2020 (9.0.000.39)

What's New
New Contact Creation

• Agents can now create new contacts by entering a phone number in the Communication tab to launch
a new SMS.

Webhook Notifications

• Support for notifications about chat interactions being started and being finished. Contact Genesys
Customer Care to enable this functionality. As a prerequisite, your environment needs to comply with
API conventions for consumer.

Resolved Issues

• An authentication error is no longer erroneously displayed in the Conversation tab when and interaction
is open or in the Communication tab after the agent has refreshed their browser. Genesys recommends
that agents close the browser tab after exiting (logging out) from Workspace Agent Desktop.
(NEXUS-2715)

• Support for voice super redundancy environments has been improved to enable agents to use Digital
Channel functionality from any of their assigned voice regions. Previously, Workspace displayed an
error message when an agent tried to use Workspace chat controls. (NEXUS-2429)

December 9, 2019 (9.0.000.35)

What's New
Localization Support

• Italian language is now supported.

Resolved Issues

• Support for voice super redundancy environments, enabling agents to use Digital Channel functionality
from any of their assigned voice regions. (NEXUS-2429)
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November 14, 2019 (9.0.000.32)

What's New
Bot support for Agent Assist

• Agent Assist now receives and handles Bot transcripts.

GVP to Google DialogFlow

• A unidirectional audio stream from GVP to Google DialogFlow is now available.

Localization support

• French and German languages are now supported.

October 31, 2019 (9.0.000.31)

What's New
PII Support

• Messages can now be scanned for Personally identifiable information (PII). You can choose to mask PII in
interactions either when they are displayed to agents or after they are closed. To set up PII rules,
contact your Genesys representative to configure them.

October 17, 2019 (9.0.000.30)

What's New
SMS Enhancement:

• Support for assigning multiple mobile numbers to a single contact. One number is specified as the
primary. Agents can choose which number to send SMS to. This enables multiple agents to exchange
SMS with a single contact using different mobile numbers. SMS can be received on any assigned
number; these are tracked as separate conversation threads.
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October 03, 2019 (9.0.000.27)

What's New
Microsoft LUIS support for Bots

• Contact your Genesys representative to enable Genesys Designer to work with Microsoft LUIS for Bots
NLP. Official support for this feature will be available in a future release of Genesys Designer.

Multiple SMS sessions with the same contact

• Multiple SMS numbers can be assigned to a contact.
• Multiple SMS numbers can be assigned within the contact center, for example, for sales, services,

billing, and so on.

MMS Support

• Agents can receive and view inbound MMS messages.

September 05, 2019 (9.0.000.25)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

Resolved Issues

• The Conversation and Communication tabs no longer receive duplicate messages. Previously, in
some rare situations, duplicate messages were received. (NEXUS-1967)

August 22, 2019 (9.0.000.22)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.
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August 08, 2019 (9.0.000.21)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

July 25, 2019 (9.0.000.19)

What's New
Compatibility and Performance

• This is an update for compatibility and performance improvement.

June 28, 2019 (9.0.000.18)

What's New
WhatsApp enhancements

• Support for receiving and viewing PDF and Microsoft Office document attachments from WhatsApp.
• Support for receiving and viewing WhatsApp contact location information.
• Support for sending and receiving WhatsApp audio attachments.
• Support for receiving and viewing WhatsApp video attachments.
• WhatsApp contact phone numbers can be handled as a separate attribute that can be utilized in

workflows.
• Agents can now send audio attachments.
• The WhatsApp Connector can access the Contacts API to determine whether one or multiple phone

numbers are enabled for WhatsApp.
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June 17, 2019 (9.0.000.15)

What's New
Resolved Issues

• Agent can now upload image files that have extensions in uppercase; previously, only lowercase was
supported and agents received an error. (NEXUS-1536)

May 31, 2019 (9.0.000.14)

What's New
WhatsApp enhancement

• Support for WhatsApp audio attachments. Whatsapp users can send audio recordings as attachments
and agents can listen to the recordings.

Agent UI enhancement

• Support for multi-channel chat selection.
• Contact Information view. Multiple chat channels are displayed in the following priority order in the

contact information view:
• Facebook
• Twitter
• WhatsApp
• Genesys Chat
• SMS

Double click on a channel to open the latest interaction.

• Communication tab: The Genesys Chat channel is selected by default in the message composition
field unless the contact has sessions in Facebook, Twitter, or WhatsApp.

• Conversation tab: the current interaction channel is selected by default.
• In the Communication tab and Conversation tab message composition fields, to switch between

channels, click the channel icon and select a different channel.
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April 19, 2019 (9.0.000.12)

What's New
SMS enhancement

• Agents can now send a new outbound message to a contact from the Communication tab. This is
helpful when the agent needs to send a notification to a contact that is not in response to an SMS from
that contact.

Conversation tab enhancement

• Agents can now search for contacts within the Conversation tab of any chat or social interaction. Any
contact attribute (phone number, last name, email address, and so on) can be used to find a contact.
The tab displays results as the agent types.

March 29, 2019 (9.0.000.10)

What's New
SMS interactions

• Support for inbound and outgoing SMS interactions.

WhatsApp

• Support for WhatsApp interactions including text, emoji, images, and Highly Structured Messages.

December 21, 2018 (9.0.000.06)

What's New
Asynchronous Chat support

• Asynchronous chat enables agents to continue a chat session after the initial interaction is ended by
using the new Conversation tab in the interaction window or the new Communication tab in the
Connect group.

Facebook support

• The Facebook channel enables agents to engage in private chat sessions with Facebook Messenger
users and public sessions with Facebook users. This enables you to monitor and respond to public posts
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and replies to your organization's Facebook page in a timely manner.

Twitter support

• The Twitter channel enables agents to engage in private chat sessions with Twitter Direct Message users
and public sessions with Twitter users. This enables you to monitor and respond to public Tweets and
replies to your organization's Twitter page in a timely manner.

Genesys Task Routing

• Genesys Task Routing enables you to submit workitems to Genesys from an external source, such as
Salesforce or NetSuite, and route them to the best-skilled agent. See Genesys Task Routing for details
about how to enable this feature.

Known Issues

• In some scenarios, an interaction might be closed before Digital Channels can attach the chat statistics
to the interaction causing interaction reporting data to be missing from reports. (NEXUS-4704)

Limitations

• Smart Failover is not supported. If Workspace Web Edition switches to a backup site, the Conversation
and Communication tabs are not displayed. (NEXUS-5727)
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Genesys Customer Experience Insights (CX
Insights)

Note: Not all changes listed on this page pertain to all deployments.

For information about the latest releases of Genesys CX Insights, refer to Genesys Customer
Experience Insights Release Notes.

• March 05, 2021
• February 11, 2021
• February 01, 2021
• November 20, 2020
• November 13, 2020
• September 29, 2020
• July 31, 2020
• June 29, 2020
• April 30, 2020
• March 25, 2020 (9.0.014.02)
• December 18, 2019 (9.0.013.01)
• October 31, 2019 (9.0.012.01)
• September 29, 2019 (9.0.011.03)
• July 29, 2019 (9.0.011.02)
• June 26, 2019 (9.0.011.00)
• May 24, 2019 (9.0.010.05)
• April 15, 2019 (9.0.010.04)
• December 21, 2018 (9.0.009.00)
• September 21, 2018 (9.0.007.03)
• July 23, 2018 (9.0.006.01)
• Known Issues
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March 05, 2021 (9.0.018.00)

What's New

• When a user attempts to log in with an invalid user name, Genesys CX Insights now displays a detailed
error message. (GCXI-2567)

• Support for MicroStrategy 2021 (Intelligence Server version 11.3.0000.16816). (GCXI-4335)

Resolved Issues

• Components of the Bot Analytical Dashboard are no longer visible in the Designer folder. Previously in
some scenarios, the dashboard was hidden, but related datasets were visible. (GCXI-4448)

• Genesys CX Insights now correctly sorts attributes and metrics on dashboards. Previously, in
deployments where localization was enabled, attributes and metrics on some dashboards were
displayed in an unexpected order. (GCXI-4487)

• Genesys CX Insights now enables users to create copies of the Async Dashboard. Previously in such
scenarios, the copy action failed with an error about missing dependency. (GCXI-4468)

February 11, 2021 (9.0.016.03)

What's New

• iWD Reporting enhancements:
• The Media Type attribute is used to distinguish different type of media (such as workitem or

email). It is added to the following reports: Capture Point Business Value, Capture Point Task
Duration, Customer Segment Service Level, Intraday Process, Resource Performance, Task Age, Task
Detail, Task Work Detail Report.

• The Media Type prompt enables user to filter by different type of media. It is added to reports
containing the Media Type attribute and to the following dashboards: Capture Point, Customer
Segment Service Level, Intraday Process, Resource Performance, Task Age Dashboard.

• The Interaction Type and Interaction Subtype attributes enables data to be organized by
interaction type and interaction subtype. It is added to Task Detail, Task Work Detail Resource
Performance Report. It

• The Interaction Type prompt that allows Task Detail, Task Work Detail and Resource Performance
Report to be filtered by Interaction Type.

For more information, see CX Insights for iWD reports and dashboards.

(CIWD-784)
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February 01, 2021 (9.0.017.01)

What's New
This release contains the following new features and enhancements:

• Operating environment updates — This release includes updates to all included CentOS packages.

Resolved Issues
This release contains the following resolved issues:

• The Application prompt is removed from the Designer > Activity Summary Report. This prompt was
present in previous releases, but not supported. (GCXI-4351)

• On the Bot Analytical dashboard, values are now displayed without digit group separators (,). Previously,
numbers larger than 1000 were displayed with the format ##,###,###, rather than ## ### ###.
(GCXI-4299)

• On the Final Disposition Dashboard, trend lines for the following metrics now appear on the bar chart:
• Entered in Self-Service
• Contained in Self-Service
• Entered in Assisted Service
• Abandoned in Queue
• Routed to DN
• Routed to Agent

Previously, the trend lines were missing. (GCXI-4297)

• SSO authentication now completes successfully in scenarios where AWS Application Load Balancer is
deployed an MPLS environment. Previously in such scenarios, authentication could fail. (GCXI-4291)

• In the Agent Details Activity Report, filtering by State Name now works correctly. Previously in some
circumstances, applying this filter could result in an error similar to the following: Error when editing
filter sub expression. Please review your answers. Warning! Incorrect number format,
please try again. (GCXI-4262)

• Long values are now displayed fully in the Interaction ID, Session Key, and other GUID fields of several
reports. Previously, values 19 digits or longer were not displayed in full. (GCXI-4225)

November 20, 2020

Deprecations

• Genesys Interactive Insights — As of November 20, 2020, Genesys has deprecated the legacy
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historical reporting product called Genesys Interactive Insights (GI2).

Genesys Customer Experience Insights (Genesys CX Insights or GCXI) is offered in Genesys Engage
cloud (formerly known as PureEngage Cloud) as the new historical reporting tool that replaces GI2.
GCXI provides a presentation layer that extracts data from the Genesys Info Mart database and
presents it in readable historical reports, thereby enabling business and contact center managers
to make better business decisions for streamlining operations, reducing costs, and providing
better services. For more information, see Deprecation: Genesys Interactive Insights.

November 13, 2020 (9.0.016.02)

What's New
This release contains the following new features and enhancements:

• Designer reporting enhancements:
• Bot Analytical Dashboard — This new dashboard appears in the Dashboards and Designer

folders. It provides detailed reporting on bot activity during interaction flows that involve Genesys
Designer applications, and contrasts self service sessions with and without bot participation, which
can help you understand how bots impact the customer experience. (GCXI-3669)

• Final Disposition Dashboard — This new dashboard appears in the Dashboards and Designer
folders. It provides detailed information that you can use to understand trends in interaction
outcomes by exploring how key KPIs change over time. (GCXI-3447)

For more information, see the Designer Reports descriptions in the Historical Reporting with
Genesys CX Insights guide.

September 29, 2020 (9.0.015.04)

What's New
This release contains the following new features and enhancements:

• Deployment scheme improvement — Genesys now recommends running the PostgreSQL container
on a worker node using nodeSelectors, which is the default configuration. Earlier releases of Genesys
CX Insights recommended running the PostgreSQL container on the control plane node. For more
information, see the Genesys Customer Experience Insights Deployment Guide. (GCXI-3141)

• Operating environment updates — This release includes updates to all included CentOS packages.
• Support for Java 11.0.8 — See the Prerequisites section on the Genesys Customer Experience

Insights page in the Genesys Supported Operating Environment Reference Guide for more detailed
information and a list of all prerequisites. (GCXI-3724)
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Resolved Issues

This release contains the following resolved issues:

• Genesys CX Insights now creates a CMDMGR log file only at startup. Previously in some scenarios, a
large number of log files were generated. (GCXI-3822)

• The Agent Details Activity report no longer fails with a timeout error in environments with a large
number of records. Previously, a problem with SQL optimization caused delays when processing data,
which resulted in a timeout error in some scenarios. (GCXI-3767)

• Genesys CX Insights now continues to operate correctly after updating a deployment that contains
duplicated projects. Previously, in some scenarios where a project was duplicated and Genesys CX
Insights was subsequently updated to a later release, Genesys CX Insights failed to run, and an error
was logged about Cannot save, move or copy this ServerDef object ... because it has been
changed in the Metadata. (GCXI-3757)

• When generating LOVs for prompts and searching in LOVs, Genesys CX Insights now waits 120 seconds
before displaying a Request timeout error. This timeout period is controlled by the MicroStrategy server
Request timeout property, which previously was set to 40 seconds, which could result in a timeout in
scenarios where an LOV had a large number of rows. (GCXI-3612)

July 31, 2020 (9.0.015.02)

What's New

• Miscellaneous enhancements:
• Support for MicroStrategy 2020 Update 2 (11.2.0.0200.39920) (GCXI-3466)
• Support for VitaraСharts 4.5.1.696 (GCXI-3466)
• Support for Microsoft Edge Chromium 2020 (GCXI-3452)

Resolved Issues
This release contains the following resolved issues:

• An unused report is no longer visible in the Support Genesys CX Insights folder. (GCXI-3355)

June 29, 2020 (9.0.015.01)

What's New
This release contains the following new features and enhancements:
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• SSO support — Genesys CX insights now supports Genesys Engage Single sign on (SSO). If SSO is
enabled, users must log on using their SSO logon credentials. Contact your administrator, or your
Genesys Representative, for more information about SSO.

• Transfer reporting enhancement — A new attribute, Source Last VQueue in the CX Insights > Detail
> Transfer folder, enables data to be organized by the name of the last virtual queue in which the
interaction traveled before it was handled. (GCXI-3118)

• Miscellaneous enhancements:
• Support for MicroStrategy 2020 Update 1 (11.2.0100.38862)
• Support for VitaraСharts 4.4.5.627 (GCXI-3064)

Resolved Issues
This release contains the following resolved issues:

• When exporting dossiers (dashboards) to PDF, VitaraСharts widgets are now exported correctly.
Previously in such scenarios, VitaraСharts widgets were displayed with a black background. For more
information, see the VitaraСharts web site.

• The GCXI container no longer fails to start in scenarios where the TOMCAT_ADMINPWD environment
variable contained parenthesis. Previously on GCXI release 9.0.014.02 deployments, the container
failed to start in such scenarios.

• When localization is applied to GCXI projects, project properties are not affected. Previously in such
scenarios, project properties were reset to default values.

April 30, 2020

Deprecations

• Genesys Interactive Insights — On November 20, 2020, Genesys will deprecate the legacy historical
reporting product called Genesys Interactive Insights (GI2).

Genesys Customer Experience Insights (Genesys CX Insights or GCXI) is offered in Genesys Engage
cloud (formerly known as PureEngage Cloud) as the new historical reporting tool that replaces GI2.
GCXI provides a presentation layer that extracts data from the Genesys Info Mart database and
presents it in readable historical reports, thereby enabling business and contact center managers
to make better business decisions for streamlining operations, reducing costs, and providing
better services. For more information, see Deprecation: Genesys Interactive Insights.
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March 25, 2020 (9.0.014.02)

What's New
This release contains the following new features and enhancements:

• Genesys CX Insights for iWD reporting enhancements — A new report and dashboard provide
enhanced iWD reporting:
• ETL Audit Dashboard — provides a historical overview of iWD Datamart job execution statistics,

including duration, status and other more detailed information stored in the ETL_AUDIT table.
• Capture Point Task Duration Report — provides tools to identify and plan remediation for bottlenecks

in the system.
• Capture Point Dashboard — provides insights into the business value driven through capture points,

and the volume of work processed through each capture point.
• Capture Point Business Value Report — provides tools to understand the distribution of tasks by

process and point of entry (capture point) into the iWD system.

• Expanded Localization Support:
• GCXI now supports displaying the reports and user interface in two additional languages: Dutch and

Polish.
• GCXI now supports displaying the Genesys CX Insights for iWD reports in several languages in

addition to US English.

December 18, 2019 (9.0.013.01)

What's New

• Chat reporting enhancements — A new report in the Chat folder, Async Interactions Report, provides
detailed information about interactions that are initiated by customers outside of regular business
hours.

• Designer reporting enhancements — Three new reports are added to provide detailed reporting
about Activities, Assisted-service interactions, and Self-service interactions respectively:
• Activity Summary Report
• Assisted Service Interactions by Last Milestone Report
• Self Service Statistics Report

• Genesys Predictive Routing enhancements — The following enhancements and corrections are
introduced in the Predictive Routing reports:
• A new metric, Result, is added to the the Predictive Routing Operational Report.
• In the Predictive Routing Operational Report, the metric "Turnaround Time" is renamed as "Avg

Turnaround Time (Fmt)".
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• Miscellaneous enhancements
• Default user accounts (Developer, Editor, Viewer), which were enabled in previous releases, are now

disabled by default.
• New attributes, GSW Call Type and Dimension 2 Gen - Dimension 10 Gen, in the "User Data

Example" folder in the CX Insights project, are mapped to two new custom attached data tables
(USER_DATA_GEN_DIM_1, USER_DATA_GEN_DIM_2) in the Info Mart database.

• The folder My Reports is now visible only for users who have sufficient privileges to write files into
the folder.

• New columns are added to the AG2_AGENT, AG2_AGENT_GRP, AG2_AGENT_QUEUE, and AG2_ID
tables to capture post-call survey data, including survey details, in addition to call, agent, company,
and product scoring data.

Resolved Issues
This release contains the following resolved issues:

• The Predictive Routing - AHT & Queue Dashboard now generates correctly. Previously in some scenarios,
the following error was returned, even though aggregated data was available: No data returned for
this view".

• In the Predictive Routing Detail Report, the "Routing Target" metric now correctly shows the target of the
routing strategy when the target is a skill expression or agent group name. Previously, in some
scenarios, a value of "UNSPECIFIED" was erroneously displayed.

• In the Predictive Routing Operational Report, values are displayed correctly for predictor and model
name when Predictor switch is "OFF". Previously in some scenarios, these values erroneously displayed
NO_VALUE.

• The Predictive Routing A/B Testing Report now shows correct values for the First Contact Resolution
(FCR) metric.

October 31, 2019 (9.0.012.01)

What's New

• Chat Reporting enhancements — A new report (Interactions Acceptance Report) and dashboard
(Interactions Acceptance Dashboard) provide detailed reporting on Interaction acceptance rates and
percentages.

• Genesys CX Insights for iWD reporting enhancements — A new report (Task Work Detail Report)
and two new dashboards (Capture Point Dashboard and Resource Performance Dashboard) provide
additional reporting about iWD.

• Interaction Flow Report enhancements — The definition of the report query is enhanced to improve
performance for partitioned PostgreSQL RDBMS, including in scenarios where explicit Start Time and
End Time values are specified.

• Predictive Routing Operational Report enhancements — Genesys CX Insights now provides more
detailed reporting about the time that interactions waited for predictive routing scoring to be
completed, including a new metric (Avg Turnaround Time) in the Predictive Routing Operational Report.
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Resolved Issues

The Chat Thread Report now runs correctly on all platforms. Previously, on some deployments, this
report could fail to run.

September 29, 2019 (9.0.011.03)

What's New
Agent Details Report Performance Enhancements

• The definition of Free Form SQL in the Agent Details Report is enhanced to provide better database
query performance. This leads to improved performance of the report in many scenarios.

Resolved Issues

• Attributes in the Transfer Details Report are now configured more accurately, allowing the report to run
normally in scenarios where Genesys Info Mart attached data is configured with redundant attributes.
Previously in such scenarios, the Transfer Details Report report sometimes generated an error that
included the following string: ...invalid column name - CUSTOM_KEY_2

July 29, 2019 (9.0.011.02)

What's New
Interaction Flow Report enhancements

• The definition of the report query is enhanced to improve performance for partitioned PostgreSQL
RDBMS, including in scenarios where explicit Start Time and End Time values are specified.

Agent Details Report enhancements

• The definition of the SM_RES_STATE_RSN_FACT logical table is enhanced to provide improved Resource
State Reason reporting, which improves the performance of the Agent State Details Report.
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June 26, 2019 (9.0.011.00)

What's New
Genesys intelligent Workload Distribution (iWD) reporting

• Genesys intelligent Workload Distribution (iWD) reporting is supported through one report and one
dashboard, along with associated metrics, attributes, and other objects. For more information, see
Genesys CX Insights for iWD reports.

• The hierarchy of folders in the GCXI User Manager is reorganized to account for the addition of iWD user
groups, and changes to the provisioning of access restrictions. For more information, see the
Administrator's Guide.

iWD reporting is provided through a separate project, Genesys CX Insights for iWD.

Chat reporting enhancements

• A new report, Chat Thread Report, and new metrics that support it, summarizes information about chat
sessions and threads.

Enhanced reporting performance

• The following enhancements improve reporting performance:
• Underlying queries for the Agent Details Activity Report are updated to enhance performance.
• A new JDBC wrapper optimizes the performance of SQL queries.

Enhancements to user groups and permissions

• The hierarchy of folders, user names, groups, and management roles are changed in the GCXI User
Manager. For more information, see the Genesys CX Insights Deployment Guide.

User Data Examples

• The following enhancements support user attached data:
• Handling User Data Example — Sixteen attributes (Detail 1 - Detail 16) in the User Data Example

folder enable the measurement of Info Mart data based on custom userdata attributes. Each new
metric captures the value of the attached data for a particular interaction whose key is CustomData
key (where * is the corresponding value between 1 and 16).

• Transfer Detail Report enhancements — Two folders with ten attributes in each were added into
Transfer folder - Target User Data Examples and Source User Data Examples.
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May 24, 2019 (9.0.010.05)

What's New
Resolved Issues

• Text on the Microstrategy Web GUI now displays correctly in scenarios where the default language is
changed. In release 9.0.010.04, changing the language (Preferences > Language) could cause some
characters to be replaced by question marks , and could cause a JavaScript error to appear on
subsequent logins. (GCXI-1751)

• The logical definition of the USER_DATA_CUST_DIM_2 table is corrected, and now uses the actual
Genesys Info Mart table. Genesys CX Insights attributes Dimension 6 through Dimension 10 now link
directly to the USER_DATA_CUST_DIM_2 Info Mart table. (GCXI-1660)

April 15, 2019 (9.0.010.04)

What's New
Chat reporting

• Two new chat reports are added:
• Chat\Chat Session Report
• Chat\Chat Engagement Report

Omnichannel agent activity reporting

• A new report is added to provide detailed agent activity reporting across all media channels:
• Agents > Agent Omnichannel Activity Report

Enhanced agent group reporting

• A new report is added to provide information about how agents are distributed among agent groups:
• Agents > and Detail > Agent Group Membership Details Report

Expanded localization support

• GCXI now supports displaying the reports and user interface in two additional languages:
• Arabic
• Korean
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December 21, 2018 (9.0.009.00)

What's New
Genesys Task Routing reporting

• This release adds support for reporting on Genesys Task Routing (GTR), including two new dashboards:
• Task Volume Dashboard
• Agent Task Dashboard

Notes: In this release:

• Reports in the Task Routing folder are available on request; talk to your Genesys representative
about making them available for you to use.

• Reports in this folder depend on data provided by other Genesys components, and may not be
ready for you to use at this time. Check with your administrator to see if your environment is
configured to run this report.”

Co-browse reporting

• This release adds support for reporting on Co-browse sessions, including more than twenty new metrics,
and two new reports:
• Co-browse Detail Report
• Co-browse Summary Report

Note: In this release, the reports in the co-browse folder are available on request; talk to your
Genesys representative about making them available for you to use.

Localization support

• GCXI now supports displaying the reports and user interface in several languages in addition to US
English. The following languages are supported by this release:
• Chinese (Simplified)
• French (Canada)
• French (France)
• German (Germany)
• Italian
• Japanese
• Portuguese (Brazilian)
• Russian
• Spanish (Latin America/Mexico)
• Turkish

New Speed of Accept report
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• A new report, Speed of Accept (Seconds), is added, which is similar to the existing Speed of Accept
(Hours) report, but is more appropriate for media types for which contact center responses are
expected to be fast, such as voice and chat.

Resolved Issues

• Data is no longer double-counted in reports in scenarios where agents or queues are members of more
than one group, and access restrictions are configured for all groups of which the agent or queue is the
member. (GCXI-1509)

September 21, 2018 (9.0.007.03)

What's New
Email reports

• The following new reports, in a new Email folder, support reporting on email interactions:
• Agent Summary Activity Email Report
• Agent Utilization Email Report
• Interaction Volume Business Attribute Email Report

Dashboards

• The following new Dashboards are added in the Dashboards folder:
• Agent Performance Dashboard
• Contact Center Dashboard
• Queue Dashboard

Callback

• The Callback reports now include a new metric / attribute, FORCED_DIALED, which captures information
about Callback queue flushing.

Genesys Predictive Routing

• The PR Performance Dashboard is removed from the Predictive Routing folder (it was replaced by other
dashboards and reports in a previous release).
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July 23, 2018 (9.0.006.01)

What's New
Initial release

This is the first release of Genesys CX Insights for Genesys Engage cloud.

Genesys CX Insights provides a wealth of historical reporting capabilities, built on a MicroStrategy
platform.

It includes reports and dashboards based on hundreds of unique and standardized metrics and
attributes, and allows you to customize and create new reports.

To learn how to use Genesys CX Insights, including how to access, run, read, or customize historical
reports, see the Genesys CX Insights page in the Reporting in the cloud guide.

If you are an Administrator learning how to manage Genesys CX Insights user accounts, see the
Genesys CX Insights User Management page.

Known Issues

• In deployments with MicroStrategy release 10.11.1, when users select widgets on the dashboard, data
appearing on other widgets does not automatically update. For example, clicking on an agent name
does not focus the dashboard on that agent.

Workaround

1. Log in with an account that is a member of the Genesys Super Administrator group (or use the
preconfigured user GenSupAdm).

2. Run the dashboard, and select the source widget.
3. On the source widget configuration menu (at top-right corner of the widget), choose Select

Targets...
4. On each target widget, clear the checkbox Targets'. The Target placeholder disappears from the

target widget.
5. Click Apply.
6. On the source widget configuration menu (at top-right corner of the widget), choose Select

Targets...
7. Select each target widget. The Target placeholder appears in the target widget.
8. Click Apply.
9. Select File > Change Prompt Option and Save. A confirmation requester appears.

10. Select And discard current answers, and click Confirm and Save.

• Some reports can run more slowly than expected, and, in some cases, timeouts can occur. To resolve
this issue, contact your Genesys representative. (GCXI-1595)
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• When you change the language used to display the reports to Turkish, only some objects will be
localized, causing some parts of the reports to appear in English.
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Genesys Mobile Services
Note: Not all changes listed below may pertain to your deployment.

• March 8, 2018 (8.5.112.05)
• August 17, 2016 (8.5.105.12)
• Known Issues

March 8, 2018 (8.5.112.05)

What's New
Rebranding

• The interfaces have been rebranded.

Bulk options

• Support for the Bulk Cancel and Export of callback records. A new CANCELLED_BY_ADMIN state was
introduced to make a distinction between a cancellation by an administrator as opposed to a
cancellation requested by a customer.

Resolved Issues

• Callbacks in PAUSED state are now displayed in the Callback UI. (GMS-5713)
• The selection box in the Add New Service dialog was getting cut off for small screens. The Service

Management UI now allows the user to scroll to see all selections. (GMS-5415)
• The Advanced Options dialog in the Callback UI now works correctly. Previously, it might have

displayed the following error: Maximum callbacks must be a number. (GMS-5331)
• GMS now correctly updates final callback status for Callback calls. Previously, an issue sometimes

occurred when, after successfully connecting a callback to a customer, an unwanted second call was
placed to the same customer because the final status of the callback was not updated properly.
(GMS-4797)
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August 17, 2016 (8.5.105.12)

What's New
Initial release

This is the initial release of Genesys Mobile Services, a plugin for Platform Administration that gives
you the tools to:

• Create and manage Callbacks
• Create and manage Business Hours
• Create and manage Capacity
• Configure Historical and Real-Time Reporting

Known Issues

• User-originated callbacks may stay in QUEUED state if the call does not occur within the configured
booking expiration timeout. (GMS-5650)

• In some rare cases, the state of the callback service may remain QUEUED and may not change to
COMPLETED although the callback is being executed. (GMS-2952)
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Genesys Portal
For information about the latest releases of Genesys Portal, refer to Genesys Portal Release Notes.

Note: Not all changes listed below may pertain to your deployment.

• January 12, 2021 (8.5.300.06)
• August 24, 2020 (8.5.300.04)
• March 31, 2020 (8.5.300.03)
• January 10, 2020 (8.5.300.02)
• December 4, 2019 (8.5.001.05)
• April 10, 2017 (8.5.000.17)
• January 13, 2017 (8.5.000.16)
• Known Issues

January 12, 2021 (8.5.300.06)

What's New

• Genesys Portal now conforms to Web Content Accessibility Guidelines (WCAG) level A for users with
physical limitations. (PECP-24)

• All documentation help links, Customer Care, and Training URLs were updated.
• All widget icons are replaced with new icons matching UX 3.0 guidelines.
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August 24, 2020 (8.5.300.04)

What's New

• An icon for Workforce Engagement Management (WEM) hybrid integration is now available in Genesys
Portal. (PECP-65)

March 31, 2020 (8.5.300.03)

What's New

• Interaction elements on the landing page can now be accessed through a keyboard by using the
following keys:
• Tab—to navigate forward
• Shift + Tab—to navigate backward
• Enter—to simulate clicking an object
• Up/Down arrows—to navigate in a combo box

(PECP-45)

January 10, 2020 (8.5.300.02)

What's New

• The following third-party libraries are upgraded to their latest versions to resolve security issues:
• The JQuery library is upgraded from version 1.11.0 to 3.4.1.
• The Bootstrap library is upgraded from version 3.1.1 to 3.4.1.
• The Less library is upgraded from version 1.6.3 to 3.9.0.

(PECP-13)
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December 4, 2019 (8.5.001.05)

What's New

• Genesys Portal now supports German and French languages for European customers only. Users can
select the appropriate language from the drop-down menu on the header. Previously, Genesys Portal
did not have the user interface localized. (PECP-18)

April 10, 2017 (8.5.000.17)

Resolved Issues

• Genesys Portal now supports widget icons for Genesys applications to be visible in multiple categories.
Previously, Genesys Portal supported only a single category per icon. (GH-1306)

• The copyright year shown on Genesys Portal has now been corrected to show 2017. Previously, it was
showing 2014. (GH-1305)

January 13, 2017 (8.5.000.16)

What's New
New icons

• Icons for Agent Setup, Social Analytics, and Outbound Administration are now available in Genesys
Portal, depending on the applications enabled for your environment.

Known Issues

There are currently no known issues.
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Genesys Predictive Engagement
Genesys Predictive Engagement was previously called Altocloud.

Notes: Not all changes listed below may pertain to your deployment.

• April 8, 2020
• May 23, 2019

April 8, 2020

What's New
Administrators

• Architect workflows: Administrators and contact center managers can now create workflows in
Architect. This feature allows customers to streamline business processes by using Predictive
Engagement to build in-house and third-party integrations. For more information, see Work with
workflows and About Architect.

• Architect flow action: Predictive Engagement administrators can now use a new Architect flow action to
configure action maps that trigger Architect flows that integrate with in-house and third-party systems.
For more information, see About Architect flow actions.

• Predefined data actions and workflow create leads in Salesforce and assign campaign attributions:
Predictive Engagement facilitates an integration with Salesforce by providing predefined Genesys Cloud
data actions and an example Architect workflow. An admin can build an action map that uses the
Architect flow action along with these data actions and workflow to create leads and assign campaign
attributions in Salesforce when qualified users arrive on your website. For more information, see
Salesforce lead creation and campaign attribution.

• Also consult the following:
• Genesys Predictive Engagement
• Predictive Engagement in Genesys Cloud Release Notes
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May 23, 2019

What's New
Initial release

• Genesys Predictive Engagement is now available in Genesys Engage cloud. Predictive Engagement is an
AI-powered Journey Optimization solution for real-time engagements of visitors browsing websites, by
triggering a WebChat widget to engage visitor at the right moment. Predictive Engagement provides AI-
powered functionality for agents and administrators.

• Agent: For agent capabilities available with Predictive Engagement in Genesys Engage cloud, see Agent
Desktop (9.0.000.34) and consult the following resources:
• Get started
• A visitor's experience and Genesys Predictive Engagement Chat Interaction
• About journey analytics in Genesys Engage (Agent Desktop)

• Administrators: To enable Predictive Engagement in Genesys Engage cloud, see Agent Setup
(9.0.000.49) and consult the following: Genesys Predictive Engagement.
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Genesys Predictive Routing

Important
Not all changes listed below may pertain to your deployment.

• October 7, 2022 (9.0.022.01)
• May 20, 2022 (9.0.021.02)
• April 29, 2022 (9.0.021.01)
• February 24, 2022 (9.0.020.00)
• November 19, 2021 (9.0.019.01)
• September 22, 2021 (9.0.019.00)
• July 12, 2021 (9.0.018.15)
• July 7, 2021 (9.0.018.14)
• May 6, 2021 (9.0.018.13)
• April 12, 2021 (9.0.018.12)
• April 1, 2021 (9.0.018.11)
• February 9, 2021 (9.0.018.09)
• January 28, 2021 (9.0.018.08)
• January 22, 2021 (9.0.018.07)
• January 14, 2021 (9.0.018.06)
• November 11, 2020 (9.0.018.03)
• September 23, 2020 (9.0.018.01)
• August 4, 2020 (9.0.017.05)
• May 26, 2020 (9.0.017.03)
• April 23, 2020 (9.0.016.13)
• February 20, 2020 (9.0.016.11)
• January 14, 2020 (9.0.016.07)
• December 20, 2019 (9.0.016.00)
• Known Issues
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October 7, 2022 (9.0.022.01)

What's New
This release includes improvements related to internally-performed upgrades of the GPR Core
Services.

• Reporting of normalised score logs in GPR Proxy is now disabled to improve the score response time and
to avoid additional delays. The GPR scoring proxy no longer sends a copy of the normalized score to the
GPR service when sending scores back to the client thus eliminating additional delays. (PRR-7737)

May 20, 2022 (9.0.021.02)

What's New

• This release includes improvements related to internally-performed upgrades of the GPR Core Services.

April 29, 2022 (9.0.021.01)

What's New
This release includes improvements related to internally-performed upgrades of the GPR Core
Services.

• A new Glue job trigger option is included to call the feature engineering API to schedule the Glue Job
daily. (PRR-7431)

• The inputS3key parameter passed in feature engineering now accepts the dictionary fields as input for
the glue job to support Multiple KPIs. (PRR-7458)

• GPR Feature engineering now supports multiple KPIs. (PRR-7429)

February 24, 2022 (9.0.020.00)

What's New
This release includes improvements related to internally-performed upgrades of the GPR Core
Services.
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• A new Virtual Queue Clustering feature for glue jobs has been included to improve performance.
(PRR-7361)

• The glue job parameters have been included with Amazon's Spark Shuffle Manager for improved
performance. (PRR-7369)

November 19, 2021 (9.0.019.01)

What's New
This release includes improvements related to internally-performed upgrades of the GPR Core
Services.

• The Base OS is changed to RedHat UBI8 from CentOS 7 to comply with Genesys Security requirements.
(PRR-7280)

• The paths of files for datasets and jobs have been reorganized for easier management. The content of
the datasets and files have not been changed. (PRR-7252)

September 22, 2021 (9.0.019.00)

What's New
This release includes improvements related to internally-performed upgrades of the GPR Core
Services.

Resolved Issues

• Affects Staff users only - The Predictor models training screen has been updated to allow the Customer
Features and Agent Features fields to be scrollable. (PRR-7272)

July 12, 2021 (9.0.018.15)

Resolved Issues

• Affects Staff users only - Reporting-related Genesys Predictive Routing (GPR) jobs no longer fail when
the minimum and maximum scores are identical and the specified normalization factor, combined with
the computed scores, results in normalized score values above 100,000. Previously in this unusual
scenario, the GPR reporting jobs failed when they tried to write these high-value scores to the
database. This failure happened because most reporting tables in the Genesys Info Mart database are
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configured for values <= 99999. (PRR-7251)
• Affects Staff users only - The highest valid Max Normalization Score value has been changed from

1000000 to 10000. This field is a part of predictor configuration. For more information and configuration
instructions, see the description of the Max Normalization Score field in the Create a predictor
section of the "Create and update predictors" topic in the Predictive Routing Staff Help. (PRR-7251)

July 7, 2021 (9.0.018.14)

What's New

• Feature for Staff use only - Genesys Predictive Routing (GPR) now normalizes agent scores to ensure
accurate agent scoring when agents work multiple queues. For more information and configuration
instructions, see the descriptions of the Problem Type and Max Normalization Score fields in the
Create a predictor section of the "Create and update predictors" topic in the Predictive Routing Staff
Help. (PRR-7215)

• Feature for Staff use only - GPR now supports the use of XGBoost custom parameters in model training.
See the description of the XGBoost parameters field in the Configure a model section of the
"Configure, train, and test models" topic in the Predictive Routing Staff Help. (PRR-7208)

May 6, 2021 (9.0.018.13)

What's New

• This release includes improvements related to internally-performed upgrades of the GPR Core Services.

Resolved Issues

• The Export and Import model buttons have been removed from the GPR web application Models and
Predictors windows, respectively. This functionality is not supported in hybrid deployments. This
functionality is available to Staff users only. (PRR-6992)

• The Override and Expression fields are now correctly removed from the Predictor configuration
window when you select Dataset Generated as the agent identifier or None as the customer identifier
during predictor configuration. This functionality is available to Staff users only. (PRR-2184)
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April 12, 2021 (9.0.018.12)

What's New

• This release includes improvements related to internally-performed upgrades of the GPR Core Services.

April 1, 2021 (9.0.018.11)

What's New

• The KPI Outcome tab is now available for users with the Admin and Reviewer roles. (PRR-7035)
• A non-functional menu has been removed from the Account list view (available to Staff users only).

Previously, this menu appeared to enable you to select whether to view test or production accounts,
but the functionality underlying the UI control was not implemented. (PRR-7018)

• Links from the GPR web application to the Help now open correctly for all windows visible to Admin and
Reviewer users. The Help links on windows available only to Staff users generate a misleading error
saying you need to log in. Logging in does not correct it. Staff users should open the Staff version of the
Help directly. (PRR-6985)

February 9, 2021 (9.0.018.09)

What's New

• This release includes improvements related to internally-performed upgrades of the GPR Core Services.

January 28, 2021 (9.0.018.08)

What's New
This release includes no new features.

Resolved Issues

• This release includes improvements to resolve inconsistencies in the internal configuration related to
backend operation of the GPR Core Services.
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January 22, 2021 (9.0.018.07)

What's New
This release includes no new features.

Resolved Issues

• This release corrects an issue that prevented the feature engineering pipeline from deploying correctly.
The feature engineering pipeline processes data uploads, augments your datasets with engineered
features and data joins, and automatically performs complex data selection and manipulation steps
that otherwise require much more hands-on effort.

January 14, 2021 (9.0.018.06)

What's New

• Upgrades to the GPR Core Services, which are performed by Genesys, now use a blue-green
deployment model. In this model, Genesys supports two deployed production environments, enabling
the one not serving customers to be upgraded and tested for stability and performance before
switching users to the new version. This ensures that users experience no downtime or negative issues
with upgrades and allows for immediate rollbacks to the previous version if some unexpected issues
arise in a customer environment. (PRR-6566)

Resolved Issues

• This release includes the following corrections and improvements to the way the GPR web application
displays the graphs on the Feature Coverage and Model Accuracy windows:
• The model error lines on the Model Accuracy graph are now clearly visible. (PRR-7029)
• The date values on the Feature Coverage Trends graph are now spaced so you can read them

clearly. (PRR-7040)
• The dates displayed on the x-axis of the Model Accuracy graph no longer shift when you switch to

the KPI Outcomes window and then return. Previously, the dates shown shifted each time you
navigated away and returned. (Note: The KPI Outcomes report is available only to users with STAFF
permissions.) (PRR-7041)

• Export of the KPI Outcomes report now works correctly. (Note: This report is available only to users with
STAFF permissions.) (PRR-7039)
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November 11, 2020 (9.0.018.03)

What's New

• Anonymization of sensitive data and personally identifiable information is no longer done in the cloud. If
you have data to anonymize, GPR now anonymizes it in your environment before uploading it to the
GPR Core Platform. (PRR-6821)

• The Predictors > Simulator tab has been removed from the GPR web application. The bar chart
showing the features with the strongest impact on your chosen metric, which previously appeared on
the Simulator tab, now appears on the Predictors > Feature Coverage tab. This features chart has
also been improved to display all features with an impact on the metric equal to or greater than 0.01,
listed in descending order of impact. (PRR-6783)

• GPR now uses only one model type rather than three. All models are now of the type formerly known as
Global models. Hybrid models and Disjoint (also known as Local or Agent) models are no longer used.
(PRR-6870)

• Predictive Routing has converted to a managed service, which means that many functions are now
handled internally in a way transparent to end users. As a result, GPR now uses the following roles:
Staff (internal users), Service (used only by Data Loader), Admin, and Reviewer. These roles can do the
following:
• STAFF - Access more than one account. Within the active account, add and edit users, assign roles,

and set password policies. Create, edit, update, and delete Agent and Customer Profile data,
datasets, predictors, and models. View the Feature Coverage, Model Accuracy, and KPI Outcome
graphs. Generate Agent Variance and Feature Analysis reports, and view jobs.

• ADMIN - Access a single account, update password permissions, and manage users. View predictor
Feature Coverage and Model Accuracy graphs.

• REVIEWER - View the Feature Coverage and Model Accuracy graphs. Change their own password.

To support the change to GPR as a managed service, Predictive Routing Help has been separated
into the following two versions:

• STAFF users: https://all.docs.genesys.com/Draft:PE-GPR/Staff/Help
• ADMIN and REVIEWER users: https://all.docs.genesys.com/PE-GPR/9.0.0/Help

(PRR-6819); (PRR-6827); (PRR-6825); (PRR-6826); (PRR-6411)

• Composite predictors, created by combining multiple simple predictors, are no longer supported.
(PRR-6907)

• The Tenant ID field in the Account Update and New Accounts windows has been renamed to
Genesys Engage Tenant ID and made mandatory. Previously it was labeled PEC Tenant ID.
(PRR-6718)

Resolved Issues

• The bar chart showing the predictor features ranked in terms of how strongly they affect the metric now
rounds the importance values to the nearest thousandth. (PRR-6987)

• A misconfiguration in AI Monitoring resource prefixes has been corrected so that it no longer leads the
search and analyze functionality to fail with a table does not exist error message. (PRR-6916)
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September 23, 2020 (9.0.018.01)

What's New

• Documentation explaining how to use the GPR Search and Analyze API is now available. If you need
access to this documentation, contact your Genesys representative. (PRR-6765)

• A new button enables users with STAFF permissions to turn audit data collection on or off. This control
appears on the Accounts settings window. (PRR-6751)

• The Feature Coverage report now displays tooltips, which explain the data on each dial. (PRR-6341)
• The context-sensitive Help link on the GPR Core Platform user interface now points to the

documentation for the hybrid (Genesys Engage cloud + on-premises) releases of GPR. (PRR-6071)

Resolved Issues

• This release corrects an internal issue that prevented the KPI Outcome report from appearing in certain
scenarios. (PRR-6864)

• Weighted dials on the Feature Coverage tab now correctly display negative coverage when features
having a strong impact on the target metric are missing. (PRR-6863)

• The job that populates billing data now produces correct results. (PRR-6811)

August 4, 2020 (9.0.017.05)

What's New

• Audit trail information is now available by request from your Genesys representative. This change is the
result of updates to the underlying architecture that provides audit data. Previously, you could access
audit data from the GPR web application Accounts tab. (PRR-6641, PRR-6642)

• The new KPI Outcome tab shows a comparison of KPI results using GPR and without. See View KPI
outcome for a description of this graph and for how to configure your environment to supply the data
required to use this tab. Note: The KPI Outcome tab functionality is available only to users with the
STAFF role. (PRR-6477)

• The new Model Accuracy tab enables you to track how well a model functions over time. See View
model accuracy for how to interpret this graph. (PRR-6539)

Resolved Issues

• The agent feature-related dial graphs on the Feature Coverage tab no longer appear if there are no
agent features included in the selected model. (PRR-6339)

• A Clear query link no longer appears above the table listing datasets created for your account on the
Settings: Datasets window. This field was introduced in error. (PRR-3623)
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Upgrade Notes
An upgrade to technology underlying the GPR machine learning capabilities renders models made
using earlier releases of GPR invalid in this and later releases. To use an updated release of GPR, you
must recreate your models. (PRR-6394)

May 26, 2020 (9.0.017.03)

What's New

• If your environment has been configured for anonymization on-premises, users with the ADMIN role can
only view datasets, the Agent Profile, and the Customer Profile. Users with the ADMIN role cannot use
either the GPR web application or the GPR API to create, modify, or delete the specified objects.
(PRR-6269)

• To improve performance, a number of changes have been made to the Agent and Customer Profile
schema functionality:
• The maximum number of indexed fields is now five fields per schema. (PRR-6260)
• The number of features is now limited by default to 50 features per schema. If necessary, STAFF

users can change the limit. Existing Agent and Customer Profile schemas are unaffected by this
change. However, the limit takes effect the first time you change a schema. (PRR-6253)

• The information displayed on the Agents and Customers pages has been simplified. The Details
tabs now show tables containing the top 15 features that you marked as Visible when you
prepared the schema. Details tab filtering is now done only by indexed fields, and you can select
only one filter parameter at a time. The Distribution tabs no longer enable filtering. You can select
from any of the indexed fields in the Distribution tab Group By parameter. (PRR-6216)

• Controls for starting, stopping, and restarting jobs have been removed from the Jobs tab in the GPR
web application. The functionality these controls were intended to support was not implemented.
(PRR-6202)

• The GPR web application now includes a new feature coverage report, located on the Predictors > AI
Monitoring tab. For a complete description of how to use this tab, see Monitor predictor feature
coverage in the Predictive Routing Help. (PRR-6009)

• A progress indicator now appears on the GPR web application Settings > Datasets page, showing the
percent of data uploaded as GPR uploads the dataset. (PRR-5554)

Resolved Issues

• The value for the latency field in scoring requests is now reported correctly. Previously, the returned
value was always 0. (PRR-6252)
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April 23, 2020 (9.0.016.13)

What's New

• The GPR Core Platform now supports data anonymization on premise, as well as anonymization in the
cloud. For more details, see Data Anonymization. The Accounts window in the GPR web application now
includes a read-only field that indicates where GPR anonymizes data. (PRR-6230)

February 20, 2020 (9.0.016.11)

What's New

• The Predictors analysis window has been completely replaced with new Simulator functionality,
which provides improved insights into Predictor performance. You can now run simulated scoring
requests to match customers in your Customer Profile with agents in your Agent Profile. For a complete
description of the updated page, see Assess Predictor performance in the Predictive Routing Help.

• Audit trail records are now automatically retained for 365 days. Previously, this was a configurable field
in the Account configuration window, presented in the Predictive Routing Help. The new value complies
with global data retention requirements.

• The Jobs window has been updated to improve performance. The fields available for filtering the job
displayed are now static lists containing all possible values. Previously, Genesys Predictive Routing
(GPR) created these lists dynamically. For a full description, see Monitor jobs in the Predictive Routing
Help.

January 14, 2020 (9.0.016.07)

What's New

• Users with the ADMIN role can use the Model export/import functionality. For an explanation of how to
use this feature, see the following documentation topics:
• Export a Model
• Import a Model

(PRR-6089)

• You can now make updates to already-uploaded records in the Agent Profile and Customer Profile
datasets, even if you have reached the limit on the maximum number of records GPR supports (20,000
agents and 20 million customers). (PRR-5350)

• The GPR API response to a GET request to the /schemas endpoint now indicates whether you have
reached the limit on the number of records you can upload to the Agent Profile and/ Customer profile
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datasets.
For example, a response containing entity_limit_remaining : 0 indicates that you have
uploaded as many records as GPR supports.

(PRR-5290)

• During Predictor configuration, you can now enter an expression that specifies data to be skipped. See
Step 6 under Create a Predictor for more information.

December 20, 2019 (9.0.016.00)

What's New
Initial release

• The Genesys Predictive Routing (GPR) Core Services platform (also known as AI Core Services) is now
available in Genesys Engage cloud. It provides the following functionality:
• Account and user configuration
• Predictors and Models
• Agent Scoring
• Analysis Reports (the Feature Analysis and Agent Variance Reports)
• The GPR application
• The GPR API

• The Dataset Trend tab has been reconstructed to make the information clearer and more intuitive. The
Dataset Details tab has been removed.

Consult the following documentation for help using the Core Platform functions:

• Predictive Routing Help

Use of GPR requires on-premises components as well. Consult the following documentation for
information about these components:

• Predictive Routing Deployment and Operations Guide
• Predictive Routing Configuration Options
• Data Loader Release Note
• URS Strategy Subroutines Release Note
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Known Issues

• The Help links on windows available only to Staff users generate a misleading error saying you need to
log in. Logging in does not correct it. Staff users should open the Staff version of the Help directly.

• Some graphics do not appear when you open the Predictive Routing Help from the GPR user interface.
(PRR-6857)
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IVR Administration
Note: Not all changes listed below may pertain to your deployment.

• October 27, 2015 (8.5.200.83)
• Known Issues

October 27, 2015 (8.5.200.83)

What's New
Audio Resource Management

• New Interface – The Audio Resource Management interface has been overhauled to enable you to
quickly upload and manage audio resources and personalities.

Resolved Issues

• IVR Administration now provides an error message if you upload an audio resource and the operation
fails. Previously in this scenario, IVR Administration provided an error message, but the message
content could have been blank. (GAX-6674)

• The Description field is no longer visible in the Parameter Groups list. (GAX-6327)

• IVR Administration now properly displays certain letters (for example, g and q) in the user interface.
Previously, the bottom of these letters might have been cut off in some dialog boxes. (GAX-6068)

• Internet Explorer users are no longer logged out of IVR Administration after they press Enter in the text
input fields of certain plug-ins. (GAX-5777)

Known Issues

There are currently no known issues.
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GVP PaaS
Note: Not all changes listed below may pertain to your deployment.

• December 21, 2018 (9.0.0)
• Known Issues

December 21, 2018 (9.0.0)

What's New
Initial release

GVP platform-as-a-service (PaaS) enables your business to preserve the VXML applications you have
invested in and retain control of the applications in your environment. At the same time, you can take
advantage of a secure, future-proof voice platform that uses the Genesys cloud-based solution.

PaaS allows you to maintain applications including the following:

• VXML
• Speech grammars
• Middleware
• Database connectivity
• Audio resources
• ECMAScript resources

Over a secure channel (that is, MPLS), Genesys connects to that application and executes it on its
voice platform. So, while you retain control of the application, the voice platform and telephony are
hosted and managed in the cloud by Genesys.

You can use Genesys Intelligent Automation (GIA), Genesys Composer, or any tool for authoring
applications, as long as the output is VXML 2.1-compliant code.

Additional information about the PaaS administration and reporting interfaces are available at:

• Manage DID Groups with IVR Administration
• Provision IVR Profiles
• PaaS IVR Reporting

Click the links below for release notes pertaining to the available interfaces:
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• IVR Administration
• GVP Reporting

Known Issues

There are currently no known issues.
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GVP Reporting
Note: Not all changes listed below may pertain to your deployment.

• January 23, 2017 (8.5.151.29)
• May 8, 2016 (8.5.151.22)
• Known Issues

January 23, 2017 (8.5.151.29)

What's New
IVR Profiles

• Creating, editing, or cloning an IVR Profile now inherits the parameters newly added in the Default IVR
Profile Template. Also, the IVR Profile inherits the existing parameters from the template if they are not
already available in the IVR Profile.

Resolved Issues

• The values of mandatory fields on the General and Voice Platform tabs are now correctly validated
before saving an IVR Profile to prevent the creation of corrupted IVR Profiles. (GVP-23418)

• The Call Peaks report no longer fails to be generated in the Operational Report tab. (GVP-23261)
• Installing the GVP Reporting plugin for Platform Administration now correctly saves configuration objects

that use time input fields.(GVP-22982)
• Call Details accessed by clicking on the GVP-GUID or ON the Session ID field of a Call Browser report are

no longer empty. (GVP-22977)
• The GVP Reporting plugin no longer fails to locate some resources when the default root URL, gax/ in

gax.properties, has been overwritten. (GVP-22958)

May 8, 2016 (8.5.151.22)

What's New

• DID group provisioning succeeds when you remove the conflicting entries in overlapping ranges
(example: 100-200 and 150-250). Previously in this situation, validation failure prevented the changes
from being saved.

IVR Administration GVP Reporting

Genesys Engage cloud Release Note 298



• A user with appropriate permissions can access and provision IVR profiles:
User is able to see all tabs on the IVR profile edit page, including options and Permissions

User is able to update initial and alternate page URLs on the Voice Platform tab in existing IVR
profiles. Those users will be able to see DID Group assignments but will not be able to modify
them.

User is able only to update DID Group assignments in existing IVR profiles. Also able to see the
initial and alternate page URL assignments, but not able to modify them.

• User can provision DIDs to DID Group mapping.
• Now you can use IVR Administration to provision IVR profiles and map DID Groups to IVR profiles.
• Backend filtering no longer removes the call record from a report when you use an IVR profile, a Tenant,

or a component in the filter. Instead, these filtering rules apply:
When an IVR profile is a parameter in the query, filtering hides the component field and tenant
field that the user doesn't have permission to read.

When tenant is a parameter in the query, filtering hides the component field and IVR profile field
that the user doesn't have permission to read.

When component is a parameter in the query, filtering hides the tenant field and IVR profile field
that the user doesn't have permission to read.

When none of the three query parameters is provided, the backend forces a tenant ID into the
query, and then follows the above filtering rules.

Resolved Issues

• The Voice Platform tab now displays the correct fields for a Voice Platform profile that is defined in a
tenant with no DID groups. Previously, when a tenant with no DID groups was accessed, the Voice
Platform tab did not display any fields. (GVP-22745)

• Refreshing the Voice Platfrom tab in an IVR profile's details no longer generates an error. (GVP-22697)
• GVP reports generated with the GVP Reporting Plugin for IVR Administration no longer fail and display

the error Unsupported Media Type. (GVP-22684)
• To work around a paging limitation, the GVP Reporting Plugin for IVR Administration backend now

automatically puts a user's Owner Tenant ID into the filter, when the tenant filter, component, and IVR
Profile filters are all empty. One exception: when the owner tenant ID is 1. (GVP-22256)

Known Issues

There are currently no known issues.
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Outbound
Note: Not all changes listed below may pertain to your deployment.

Important
This is legacy Outbound content. For the latest Outbound functionality, refer to CX
Contact.

• April 6, 2020 (15.15.0)
• November 12, 2019 (15.14.0)
• September 23, 2019 (15.13.0)
• August 5, 2019 (15.12.0)
• June 12, 2019 (15.11.0)
• March 11, 2019 (15.10.0)
• October 17, 2018 (15.8.0)
• August 8, 2018 (15.7.0)
• June 1, 2018 (15.6.0)
• May 7, 2018 (15.5.0)
• April 5, 2018 (15.4.0)
• March 12, 2018 (15.3.0)
• February 12, 2018 (15.2.0)
• January 22, 2018 (15.1.0)
• January 8, 2018 (15.0.0)
• November 13, 2017 (14.15.0)
• October 23, 2017 (14.14.0)
• Known Issues
• Archive
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April 6, 2020 (15.15.0)

New Features
This release contains no new features.

Resolved Issues

• The DNC filtering option for a sub-campaign is now disabled (grayed out) when the account parameter
for utilizing DNC data is set to false. Previously, this filtering option was enabled. (DVP-6246)

• It is now possible to configure an international mobile (wireless) number as the dial out destination for a
remote agent. (DVP-89674)

• Validation of the channel on suppression lists now functions as expected. (DVP-89670)
• When editing a scheduled Agent State report that uses an output spec, the output spec field (drop-down

box) is no longer empty and is now changed in the scheduled report edit dialog box, as expected.
(DVP-89660)

• Duplicated devices no longer appear as blocked. (DVP-89659)

November 12, 2019 (15.14.0)

New Features
This release contains no new features.

Resolved Issues

• When viewing a sub-campaign profile all of the time zones are now displayed consistently. Previously,
the time zones were not displayed consistently. (DVPU-6236)

• Security fixes for Oracle Java SE have been addressed. (DVP-89643)
• Exception errors no longer occur when scheduled report jobs are run. (DVP-89641)
• Inbound sub-campaigns now appear in the Campaign page as expected. (DVP-89628)
• Errors about text messages associated with MAX_CALL_DURATION no longer occur. (DVP-89564)
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September 23, 2019 (15.13.0)

New Features
This release contains no new features.

Resolved Issues

• Research was conducted to clarify expected behavior for the Time Zone Source that was set to "Contact
and Device." If Time Zone Source is set to "Contact and Device" and the derived time zones for both
the contact and device are not the same, the contact attempt will be limited to the USA/Non-
Geographic "safe" dialing window. However, if there are also active compliance rules governing both
derived state locations for the contact and device, the attempt will be flagged as
INCOMPATIBLE_DEVICE_CONTACT_TZ and no attempt will be made. No subset of a safe window is
created based on USA/Non-Geographic combined with any configured limiting windows for the states
involved. (DVP-89615)

• List Rule performance has significantly improved under heavy load conditions (for example, when
multiple large lists process against rules).(DVP-89622)

• Agents are no longer randomly disconnected from the desktop.(DVP-89624)

August 5, 2019 (15.12.0)

New Features
This release contains no new features.

Resolved Issues

• When an error is encountered during the process of importing a PGP key, an error message appears.
Previously, the error message did not appear. (DVP-89559)

• The sub-campaign action log now includes an agent count based on the Call Center Schedule entry and
not the Live Agent Count. (DVP-89576)

• Callbacks scheduled for the opening or closing of a calling window no longer fail when they are outside
of the configured compliance boundary. (DVP-89577)

• An error no longer occurs when creating a new account or enterprise user. (DVP-89590)
• Only an Admin user type can now move, add, change and delete PGP keys. Previously, multiple user

types were able to move, add, change and delete PGP keys. (DVP-89596)
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June 12, 2019 (15.11.0)

What's New
Resolved Issues

• Multiple conversations can no longer be created for the same campaign-client ID combination. As a
result, irregular behavior associated with subsequent conversational actions (for example, script-driven
text messaging responses) no longer occurs. (DVP-89513)

• A Trigger rules list now waits for the list upload process to complete before initiating a sub-campaign. As
a result, sub-campaigns are no longer empty. (DVP-89547)

March 11, 2019 (15.10.0)

What's New
Resolved Issues

• Multiple List Automation jobs running in tandem can now use the same specification file for the list
being imported. Previously, in this scenario, the system deleted the file and returned an error during
the list import process. (DVP-89459)

• An internal system error potentially affecting List Automation jobs for triggering new sub-campaigns has
been resolved. (DVP-89498)

• List Automation set-up previously followed historical automation pattern matching, where file naming
conventions could span list load and sub-campaign trigger events. This has been updated so that a new
sub-campaign triggers only when the list is uploaded by the same List Automation job. (DVP-89507)

• An internal system error potentially affecting and ignoring contact suppression rules has been resolved.
(DVP-89497)

October 17, 2018 (15.8.0)

What's New
Resolved Issues

• For List Automation, trigger events now adhere to the time zone specified for the List Automation job.
Previously, triggered events would adhere to the account’s time zone, resulting in improperly-timed
triggered events. (DVP-89394)
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• For Upload Rules using custom splitting, the Selection Rule name is now correctly applied to the
<RULENAME> token in the output name format. Previously, the Upload Rule name, which is reserved
for remainder files, was applied to the <RULENAME> token. This error resulted in duplicate file names,
and the system was unable to identify the output file linked to each Selection Rule in the custom split.
(DVP-89399)

• Login authentication issues have been resolved. Previously, in some cases, users were denied access
because the system failed to reset the failed login attempts counter after successful authentication.
(DVP-89416)

• Sub-campaigns using a Location Rule with many regions selected (>=29 regions) will now run as
expected. Previously, if the Location Rule was applied at the sub-campaign loading time and it
contained a large number of regions (>=29 regions), the system would cancel the sub-campaign.
(DVP-89427)

• Completed sub-campaigns now appear in Find Done results. Previously, in some cases, some sub-
campaigns were omitted. (DVP-89432)

• Previously, the user interface displayed the incorrect start time for a sub-campaign pass after the
original start time for the pass was revised. This has been corrected. (DVPU-6207)

• Previously, Genesys Engage cloud Outbound users were unable to access the Scheduled Reports page.
This has been corrected. (DVP-89413)

August 8, 2018 (15.7.0)

What's New
Resolved Issues

• On the List Automation page, the option Delete files after import has been changed to Delete files after
processing. (DVPU-6205)

• On the List Automation page, the Delete files after import option (now labelled Delete files after
processing) now functions as expected. Previously, when this option was enabled, empty files
sometimes remained on the remote FTP site. (DVP-89383)

• If a List Automation job has been disabled or deleted, the system will stop attempting to execute the
job, as expected. Previously, the system would sometimes continue to execute a job that was disabled
or deleted. (DVP-89397)

• The Find Done page now displays all completed sub-campaigns, as expected. Previously, an error
prevented some sub-campaigns from displaying on the Find Done page. (DVP-89296)

• The Trigger Rules feature now functions as expected. Previously, the system would sometimes attempt
to load a sub-campaign without first ensuring a contact list was successfully uploaded into Engage.
(DVP-89360)
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June 1, 2018 (15.6.0)

What's New

• Several compliance enhancements have been made to better enable customers to comply with Right to
Access (“export”) or Right of Erasure ("forget") requests from their customers. For more information
about Genesys Engage cloud support for GDPR compliance, see Genesys Engage cloud Support for
GDPR. For general information about GDPR, see General Data Protection Regulation (GDPR).
(DVP-89201) (DVP-89222)

Resolved Issues

• The Campaigns dashboard now displays accurate statistics for sub-campaign passes. Previously, in
some cases, the dashboard displayed zero (0) counts for all sub-campaign passes even though the
database and sub-campaign reports displayed actual counts. (DVP-89249)

May 7, 2018 (15.5.0)

What's New
Resolved Issues

• Changes made to a List Automation schedule in the user interface now take effect immediately.
Previously, in some cases, the system would continue to run any queued jobs based on the previous
schedule before it would honor the new schedule. (DVP-89289)

April 5, 2018 (15.4.0)

What's New
Resolved Issues

• When editing List Automation schedules, you can now successfully switch between the date picker
(calendar) functionality and the Crontab functionality. Previously, if you set a schedule using the
calendar and then tried to edit the schedule using a cron string instead, the edits would not save and
the system would not throw an error message. (DVP-89051)

• List Automation schedules have been enhanced to facilitate traversing the GMT timezone boundary.
Previously, List Automation schedules could not cross a GMT boundary - the only workaround was to
create multiple List Automation schedules. (DVP-88505)
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• For List Automation, wildcards are no longer supported in the Minute field of a cron string, and job runs
are limited to a maximum of 12 runs per hour. Previously, a wildcard in the Minute field meant that a
job run would take place every minute. (DVP-89052)

• On the List Automation page, the Delete files after import option now functions as expected when the
SFTP protocol is used. Previously, this option worked for the FTP protocol only. (DVP-89188)

• The List Size column on the Campaigns dashboard now displays accurate figures for On-demand sub-
campaigns. Previously, for some On-demand sub-campaigns, the figure in this column was twice the
size of the actual number of contacts associated with that sub-campaign. (DVP-88850)

March 12, 2018 (15.3.0)

What's New
Resolved Issues

• Contact Trace records are now sorted so that the newest records display first. Previously, if a Contact
Trace returned a large number of records, the oldest records displayed first. (DVP-89048)

• Email verification for a password reset now functions as expected. Previously, verification failed for
email aliases containing the character string mac. (DVP-89032)

• If an update to a List Automation job traverses the GMT date boundary, a context-specific error
message displays at the top right-hand corner of the List Automation page. Previously, a generic
system error message appeared. (DVPU-6183)

February 12, 2018 (15.2.0)

What's New
This release contains no new features.

January 22, 2018 (15.1.0)

What's New
This release contains no new features.
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January 8, 2018 (15.0.0)

What's New
User Interface

• The Reports tab on the user interface is now accessible to all customers. Previously, access was
restricted to customers with the Email or SMS channel enabled.

Resolved Issues

• All sorting issues with the time zone list on the List Agents page have been corrected.
• For enterprise accounts, the Restrict IP addresses for sign-in to field, on the Security tab of the Settings

page, now accepts up to 512 characters. Previously, the maximum was 256 characters.

November 13, 2017 (14.15.0)

What's New
Resolved Issues

• All readability issues with pop-over text on SMS Self-Serve scripts have been resolved. (DVPU-6127,
DVPU-6126)

October 23, 2017 (14.14.0)

What's New
Campaigns

• Pass Retry Options now include the following Call Result options:
• Answering Machine
• Delivered Person

Resolved Issues

• Statistics now display throughout the user interface as expected. Previously, some statistics failed to
populate.
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Known Issues

There are currently no known issues.

Archive
[+] Click to show archived release notes

September 21, 2017 (14.13.0)

What's New
List Automation

• The new List Automation feature can now be used to scan FTP sites for lists matching a specified rule
criteria. When a list matching the criteria is found, one of the following occurs:
• The list is loaded into Engage as a contact list.
• The list is loaded into Engage, which then initiates a sub-campaign.
• Contacts within the list are appended to a suppression list.

User Interface

• Customers creating a self-serve SMS campaign can now use the Test button to test an SMS script.

• On the List Rules page, all details about a rule now appear on the right-hand side of the screen when
that rule is selected.

Resolved Issues

• In some cases, self-serve SMS script templates and instances appeared on the On-demand Strategies
page. This has been resolved.

• The Save and Cancel buttons on an SMS Edit page now function as expected. Previously, if an error
occurred, the Save button would re-run the incorrect information, and the Cancel button would close
the page and erase all information.
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August 15, 2017 (14.12.0)

What's New

• The new Self-serve SMS feature enables you to create and modify SMS scripts for the following types of
interactions:
• Alert
• Surveys (three questions)
• Opt-in (via inbound keywords)
• Interactive

Starting in a later release, the script templates will be auto-deployed to accounts. For now, your
account representative can manually load them onto your account.

July 27, 2017 (14.11.0)

What's New
Resolved Issues

• The trigger rule process now runs as expected in cases where multiple lists are created around the
same time on accounts with multiple trigger rules (40+). Previously, in this scenario, some lists were
excluded from evaluation during the trigger rule process.

June 26, 2017 (14.10.0)

What's New
Resolved Issues

• In some cases, new strategies created within a campaign were not be saved as templates. This has
been resolved.

• The Account Manager User Interface now displays the new Genesys logo.
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June 2, 2017 (14.9.0)

What's New
Resolved Issues

• Clicking on the name of an account in Enterprise Manager previously opened an old version of the
Account Settings page in Account Manager. This has been corrected.

May 16, 2017 (14.8.0)

What's New
Sub-campaigns

• You can now create inbound sub-campaigns using text and web channels, as follows:
• Text - used when you want customers to use short codes to interact with an SMS script. All

interactions are handled by the SMS script and results are stored in Engage reports.
• Web - used when you want to provide a clickable link in the text message, which then takes

customers to a personalized web page. The SMS script is used to create the NanoClick URL, and an
inbound script contains the web content. Results are stored in Engage reports.

Account Settings

• The Text Settings page has been removed, and is now a tab, labelled Text Settings, on the Account
Settings page. All content remains the same.

Resolved Issues

• In some cases, the system generated empty reports. This has been corrected.
• In some cases, the company logo on the Account Manager User Interface appeared truncated. This has

been corrected.

April 25, 2017 (14.7.0)

What's New
Reports

• Accounts with text and email channels enabled now have access to account, campaign, and sub-
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campaign reports under the Reports tab.

API

• The following new API endpoints have been added to the REST web services interface: showScript,
changeCampaign, evaluateComplianceRules, and showContactBatchState.

Resolved Issues

• All campaign statistics now appear on the Campaigns page. Previously, some statistics mistakenly
appeared as 0.

April 1, 2017 (14.6.0)

What's New
Resolved Issues

• Contact Trace results that include recordings now display the correct campaign and sub-campaign
name. Previously, the results sometimes displayed the wrong campaign and sub-campaign name.

• The safe window (allowed calling hours) for manual/on-demand calls to non-geographic time zone
phone numbers (for example toll-free numbers) is now set to 12:00pm to 9:00pm EST, if the pass is set
to 9:00am to 9:00pm local time. Previously, the safe window hours was mistakenly based on GMT
instead of EST.

• The sub-campaign end time on the Find Done page has been corrected to show the actual end time of
the sub-campaign in the time zone setting of the pass.

• If an admin user resets another user's password, the User may upload scripts and specification files
option is no longer affected. Previously, this option would automatically reset once a user's password
was reset.

• If a contact file or a report has a field beginning with an equals sign ("="), that field will be preceded by
a single quotation mark when the file or report is exported. This will prevent that field from being
interpreted as a formula when the file is loaded into Excel.

For example, a field containing:

=HYPERLINK("http://www.genesys.com", "click here") ) will be exported as

'=HYPERLINK("http://www.genesys.com", "click here") )
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March 1, 2017 (14.5.2.0)

What's New
SMS and Email channels

Outbound SMS and Email channels are now available.

Outbound Text and Email channels can be blended with existing Voice (Outbound IVR), Dialer, and
Preview channels to create a multi-channel, or blended, campaign. Blended interactions enable you
to leverage more than one channel to complete a single customer interaction. For example, you could
schedule a service call by phone and then send an SMS reminder the day before the appointment.

Notes:

• SMS can be one-way or two-way interactive. With two-way, interactions take place between the script,
via a dialogue engine, and the customer; agents are never involved.

• Email is one-way outbound only. While custom REPLY TO addresses for direct responses are supported,
auto-response (dialogue engine) functionality is not supported. Inbound email is supported through
eServices.

• Text and Email scripts are created in Engage. Voice scripts are still created in Designer.

• Up to 10 devices are supported.

• Existing customers must sign a contract addendum to add Outbound SMS and/or Email services.

About Outbound for Genesys Engage cloud

Genesys Outbound for Genesys Engage cloud enables customers to create, monitor, and fine-tune
proactive outbound communication using a variety of integrated channels including agent-assisted
dialing (Predictive, Progressive, and Preview), as well as agentless voice messaging, SMS, and Email.
The user interface offers List Management, Campaign Management, and Compliance Management
controls to manage effective multi-channel outbound campaigns.
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Platform Administration (GAX)
Note: Not all changes listed below may pertain to your deployment.

• October 29, 2017 (8.5.220.47)
• June 6, 2016 (8.5.220.25)
• March 8, 2016 (8.5.220.20 UPDATE)
• October 14, 2015 (8.5.220.20)
• Known Issues

October 29, 2017 (8.5.220.47)

What's New
Translation support

• Platform Administration is available in the following localized versions:
• Dutch_Standard, 8.5.230.05
• French_France, 8.5.230.05
• German_Germany, 8.5.230.03
• Italian_Italy, 8.5.2.03

• As of May 29, 2020, Platform Administration is also available in the following localized versions:
• Spanish_Mexico, 8.5.230.04
• Portuguese_Brazilian, 8.5.230.03
• Polish, 8.5.230.03

Increased granularity for scheduling Operational Parameters

• In the Operational Parameters Management module, the granularity of scheduling Operation Parameters
can be set to 5 minutes, and the default value has been reduced to 15 minutes from 30. This option is
set in User Preferences.

Enhanced interface
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• In the Agents window, the list of Agents now includes an Employee ID column, making it easier to view
Employee IDs without viewing the agent details.

Resolved Issues

• When using Routing Parameters, Parameter Groups and Parameter Group Templates, if the mandatory
checkbox is selected, you must enter a value before the record can be saved. (GAX-8655)

• If a column filter is set when you click Select All to select Agents, you will see only those Agents that
match the column filter. (GAX-8654)

• GAX now correctly displays configuration objects that contain multiple binary data in their configuration
options. Previously, GAX was unable to display these options, and stopped responding if a user tried to
open the Options tab of a Person object. (GAX-8715, GAX-8706)

• GAX now displays the contents of the Options tab correctly for an object, even if there are empty
sections. Any empty sections are removed when the object is saved. Previously, the options were not
displayed and the object could not be saved, regardless of whether the Options tab was displayed.
(GAX-8497)

• Clicking the SIP Server Application Options properties in GAX now correctly loads the existing empty
sections and sections containing integer values. Previously in this scenario, when the section contained
empty or integer values, it prevented the application from correctly loading the page. (GAX-9402)

• GAX now attempts to reconnect when its connection to Configuration Server is disrupted. GAX has a
Reconnect Timer which is activated when the connection to Configuration Server is disrupted or when
there is an error from the PSDK library. Two scenarios cause GAX to lose its connection to Configuration
Server:

Errors from the PSDK — For example, any network failure or exception from the PSDK library could
cause warm standby to go into infinite switch-overs/reconnection attempts even when the
connection to Configuration Server is still active.

Network glitches — For example, warm standby might be turned off in PSDK.

Previously in scenarios like these, GAX did not attempt to connect to Configuration Server when
the existing connection was disrupted due to a network failure or an error from the PSDK library.
(GAX-9384, GAX-9401)

• This version of GAX fixes a few security vulnerabilities. (GAX-8708, GAX-8678, GAX-8425, GAX-8644)

June 6, 2016 (8.5.220.25)

What's New
Resolved Issues

• Tenant Administrators and Supervisors can now access an agent's Options tab or change the Skills
assigned to the agent even if the user does not have Write permission to the Transactions/
UserPreferences folder. (GAX-8680)
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• You can now import a configuration file that contains configuration options with no assigned values (for
example, 1TRG= ) into a Transaction object. (GAX-8653)

• This release fixes security vulnerability. (GAX-8576)

March 8, 2016 (8.5.220.20 UPDATE)

What's New

• Support for the following web browsers:
Apple Safari 7

Apple Safari 8

Resolved Issues

• This version fixes a potential security vulnerability known as Session Fixation. (GAX-8509)
• Platform Administration now displays a confirmation message when a user has successfully changed

their own password. (GAX-8439)
The message reads as follows:

Password Changed

Your password has been successfully changed.

The user must click OK to close the message before continuing.

Previously, Platform Administration did not indicate the success or failure of the password change,
and returned to the list of Persons.

• Platform Administration now displays an error message when the key and value in custom lists for
parameters are longer than 255 characters. Previously, the interface allowed the user to enter more
than 255 characters, but when you tried to save the custom lists, Platform Administration generated an
error message. (GAX-8431)

• Platform Administration now prevents memory leaks when a user switches from a dashboard view to a
list view multiple times. Previously, this memory leak caused the user's browser performance to
degrade over time, especially on older machines that had a limited amount of memory. (GAX-8283
[GAX-8238])

• This release fixes a potential security vulnerability relating to leakage of information. (GAX-8183
[GAX-8427])

• Platform Administration now correctly moves multiple agents from one Agent Group to another, when
instructed. Previously, Platform Administration added the agents to the destination Agent Group, but
did not remove them from the original Agent Group. (GAX-8142)

• Platform Administration removes an XML external injection vulnerability. (GAX-7744)
• This version of Platform Administration removes a potential password exposure vulnerability.

(GAX-8069, GAX-8049)
• Platform Administration now clones a Person object correctly. Previously, all of the parameters of the
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original object were sometimes not copied. (GAX-8010)
• This release removes a potential cross-site scripting vulnerability. (GAX-7809)
• Platform Administration no longer terminates unexpectedly after an unsuccessful login attempt.

Previously, Platform Administration running in IE 9 would sometimes terminate unexpectedly if, after an
unsuccessful login attempt (because you entered an incorrect password), you corrected the password
and tried to log in. (GAX-7677)

• In Internet Explorer 9, the Skills filter field now works properly. The placeholder value does not become
part of the filter expression. Previously, the placeholder value was not removed when the field was
cleared and remained as the whole, or part (if another value was entered) of, the query expression.
(GAX-7985)

• When cloning an Agent in the Agent Management screen, the original Agent stays associated with its
original Place. Previously, the original Agent became disassociated from its Place. (GAX-7680)

October 14, 2015 (8.5.220.20)

What's New
Resolved Issues

• When working in Genesys Engage cloud, Platform Administration (GAX) no longer creates additional
Agent Logins after editing an agent in the Agents view, if Agent Logins are already associated with the
agent. Previously, if an agent had already been associated with an Agent Login using Configuration
Manager, and the agent is modified later in the Agents view, additional Agent Logins would be created.

Note

Even after the fix, if the Default Number (DN) of the agent is changed during editing, additional
Agent Logins will still be created. (GAX-8175)

• After creating an object using GAX Configuration Manager, the list of objects now refreshes
automatically to include the new object in the list. Previously, GAX sometimes did not show the new
object on some systems because of a race condition. (GAX-8365)

Known Issues

• When updating an object that has no configuration options in its annex, Platform Administration
displays the CFGUniquenessViolation error message, and the update is not made. (GAX-8497)

• When using the Internet Explorer 9 web browser, actions in the System Dashboard are sometimes
processed slowly or not at all, and a JavaScript error is generated. (GAX-8458)

• Unsaved changes in a form can be lost if the panel containing the form is closed by means other than:
(GAX-1322)

Selecting another item from a list or tree-view panel.

Using the links in the Navigation Bar to go to another screen.
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Closing the tab or window of the browser.
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Recording, QM and Interaction Analytics
Note:

• Not all changes listed below may pertain to your deployment. The solution includes Interaction
Recording with Quality Management and Speech Analytics as optional add-on's. Click Learn More for
details about the different deployments. Learn More [+]

Genesys Interaction Recording (GIR) Genesys Interaction Recording (GIR) provides cradle to grave dual channel voice
recording and screen recording for customer-ivr and customer-agent conversations as they occur within the Genesys Engage
cloud Contact Center. GIR is able to automatically stitch together call segments and capture all relevant call meta data to provide
the information you need to fulfill important use cases within your business including Compliance, Dispute Resolution and
Workforce Training and Coaching. The GIR User Interace (UI) is provided by the SpeechMiner UI, which is the unified interface for
recording, quality management and interaction analytics capabilities within the Genesys Engage suite.

Quality Management (QM) Quality Management (QM) enables you to monitor quality and evaluate agent performance on a
periodic and consistent basis while minimizing effort through automated interaction selection to improve customer experience
and engage with your staff. QM includes a robust and feature rich form designer along with a number of evaluation schedule
types to meet the SLAs required by your business in providing core use cases around Quality Management as well as input to
Coaching and Training through form based scoring of interactions.

Genesys Interaction Analytics (GIA) In Genesys Engage cloud, Genesys Interaction Analytics (GIA) only encompasses Speech
Analytics. GIA provides automated speech analytics capabilities on 100% of interactions to provide deep insight into customer-
agent conversations. GIA provides automated transcription and employs Speech-to-Phrase grammar based recognition along with
non-linguistic analysis of recordings to create meaning from otherwise unstructured data. Organizations can use this data to fulfill
key use cases around Agent Performance Improvement (for example, decrease AHT, increase FCR, Sales Conversion, and so on.),
Compliance and Customer Satisfaction (for example, NPS). Additionally, GIA employs advanced unsupervised machine learning
algorithms to surface salient or unexpected terms to enable use cases around Uncovering Emerging Trends or Discovery of New
Phrases and Intents.

• This Recording, QM and Speech Analytics release note is focused on changes within the SpeechMiner UI.
Screen Recording Service and Recording Cloud Backup Service are separate from this and have their
own release notes. Please refer to those release notes for a complete and overall view in to all
corrections, changes or enhancements that affect Recording, QM and Speech Analytics.

• December 23, 2020 (8.5.510.35)
• January 22, 2020 (8.5.510.30)
• September 25, 2019 (8.5.510.28)
• August 20, 2019 (8.5.510.27)
• February 21, 2019 (8.5.510.22)
• September 26, 2018 (8.5.510.13)
• July 27, 2018 (8.5.509.13)
• June 13, 2018 (8.5.509.11)
• May 14, 2018 (8.5.509.10)
• June 12, 2017 (8.5.507.01)
• August 12, 2016 (8.5.504.02)
• March 8, 2016 (8.5.502.03)
• Known Issues
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• Recommendations

December 23, 2020 (8.5.510.35)

What's New
This release only includes resolved issues.

Resolved Issues

• A deactivated time based report no longer continues to send reports. Previously, the deactivated time
based report sometimes continued to send reports. (PRSM-27229)

• Report results are now accurate when more than one metadata value for the same metadata filter is
configured. (PRSM-27193)

• When generating a report with multiple metadata filters, an unhandled exception is
thrown.(PRSM-26970)

• When a report is saved, it is now saved with the metadata filter. (PRSM-26969)
• The maximum number of roles that can be granted to a user has been increased. (PRSM-26966)
• All topics with a high confidence level are now highlighted in the interaction transcription. Previously,

not all such topics were highlighted. (PRSM-26937)
• When creating/editing an Ad-Hoc Evaluation, you can now select Required Forms. Previously, the

Required Forms were not available. (PRSM-26936)
• A new permission named Edit All Evaluations was added to the system. Administrators can now review

evaluations associated with all users. (PRSM-26629)
• SpeechMiner Auditing now includes the following events: Create, Delete, Save, Export, Complete,

Archive, Cycle Interactions. (PRSM-26626)
• The Evaluation summary report displays the correct session per user value. Previously, the value

appeared twice. (PRSM-26408)
• Non-segmented interactions can now be exported from SpeechMiner UI. Previously, they could not be

exported. (PRSM-26377)
• Failed logins no longer occur due to a failed connection to the Configuration Server. (PRSM-26327)
• When working with Exploration an error no longer occurs when a bulk clustering task is imported.

(PRSM-26179)
• When an Evaluator completes an evaluation session and notifies the agent, the agent receives an

Action Item. Without appropriate permissions, the agent can no longer see the evaluation session
score. Previously, the agent was able to see the evaluation session score. (PRSM-26096)

• Business alert emails are sent to the recipient when the recipient is a Genesys user. (PRSM-25952)
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January 22, 2020 (8.5.510.30)

What's New
This release only includes resolved issues.

Resolved Issues

• When using the SpeechMiner UI to edit tags associated with an interaction that has screen recordings,
the user will no longer receive an error. Previously, users received an error that stated that the tags
were not updated, even though they were.

• When a user logs into SMConfig, the ConfigServer table is now updated with accurate information,
when the Authentication field in the SM Config Login window is left empty. Previously, this empty
field resulted in inaccurate information in the ConfigServer table.

• The Interaction Time column in the exported QM Session spreadsheet now contains the Local time.
Previously, this column contained the UTC time and not the Local time.

• When running the Agent Evaluation Comparison or Evaluator Evaluation Comparison reports,
the Average Score is no longer missing from the Agent\Evaluator table.

• Measures have been taken to improve the prevention of potential security threats to the web
application.

September 25, 2019 (8.5.510.28)

What's New
Language enablement

• Spanish numbers in the Spanish US language have been added to the English US language and English
US language numbers have been added to the Spanish US language. (PRSM-25589)

Resolved Issues

• When you select N/A for a Quality Management form Scale question during an evaluation session, the
total score is now calculated as expected. (PRSM-25627)

• When a text interaction contains a line similar to the following example, the Recognition task no longer
fails. For example, $90 + $9.75 + $3 equals $102.75 times 2 = $205.50, not $210.25? (PRSM-25602)

• When an interaction's duration = 0 the Media Player now displays a "No Audio Available" message.
Previously, there was no indication on the Media Player that an interaction with duration = 0 did not
contain audio. (PRSM-25169)

• When you playback an interaction, the wave graph now loads for a recording with a long duration.
Previously, the wave graph did not load for a recording with a long duration and when this happened
you could not click the wave graph to move to a different portion of the interaction. (PRSM-24296)

• When the Index Backup task fails, the system now automatically attempts to perform a backup.
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Previously, when the Index Backup task failed, the system did not automatically attempt to perform
another backup and you were forced to manually restart the system to backup the index. (PRSM-25185)

• The Available Templates page in the SpeechMiner User Manual no longer includes broken links.
(PRSM-25652)

August 20, 2019 (8.5.510.27)

What's New
Language enablement

• Training material is now available in UK English.

Quality Management reports

• It is now possible to select a Creation Date for three Quality Management Reports (Agent Evaluation
Comparison, Team Evaluation Comparison, Evaluator Evaluation Comparison).

Resolved Issues

• Configuration of Sensitive Data privileges now works as expected. (PRSM-25452)
• Category name recognition is no longer case-sensitive. Previously, category name recognition was case-

sensitive. (PRSM-25434)
• When an SQL timeout exception occurs, interactions that are being indexed at the same time are now

re-entered into the Index queue. Previously, when an SQL timeout exception occurred, interactions that
were being indexed at the same time were not re-entered into the index queue. (PRSM-24502)

• Interaction Receiver no longer fails to process recordings with a valid .wav file format, no audio data,
and duration = 0. (PRSM-25135)

• Interaction segments with long external IDs are now exported as expected. (PRSM-25470)
• UPlatform continues to work after the machine name is changed to FQDN. Previously, changing the

machine name to FQDN prevented the UPlatform from working. (PRSM-25295)
• When you edit one form associated with a completed evaluation that includes multiple forms, the

answers associated with the forms you are not editing are no longer deleted. (PRSM-25501)
• When an interaction contains Silence time in 2 or more different segments, the Silence time is now

calculated separately. Previously in this scenario, the interaction may have been calculated as
continuous when it should not have been because the segments are different. (PRSM-19715)
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February 21, 2019 (8.5.510.22)

What's New
Documentation

• A new Recording, Quality Management and Speech Analytics user manual is now available online.

Resolved Issues

• When playing an interaction, the playback is continuous until the end of the interaction. Previously, for
some interactions the playback rewound during playback and looped back to the beginning of the
interaction. (PRSM-24883)

• Changes made to an existing scheduled report are now saved. Previously, changes made to an existing
scheduled report were viewed as saved, but the changes were not saved. (PRSM-24727)

• A SpeechMiner session no longer times out after 13 minutes of inactivity or continuous activity.
(PRSM-24429)

• A user, who is not a part of any Configuration Server access group, no longer causes login issues for all
the users in the system when they try numerous times to log into SpeechMiner. (PRSM-24507)

• When an SQL timeout exception occurs, interactions that are being indexed at the same time are now
re-entered into the index queue. (PRSM-24502)

• When logged into SpeechMiner, occurrences of not being able to view interactions until IIS is reset no
longer occurs if the value of the loadAccessGroupsAtLogin parameter in the WebServiceParams
database table is 1. (PRSM-24490)

Note: The default loadAccessGroupsAtLogin parameter is 0 and should only be changed by an
administrator after consulting with customer care. This parameter should only be set to 1 if you
are not able to view interactions until IIS is reset. Also, if your users have a large amount of access
groups, it is not recommended to change the value to 1.

• Measures have been taken to improve protection against the potential security threats to the web
application. (PRSM-24481, PRSM-24128, PRSM-24127)

• The session timeout was lowered to 15 minutes to improve security protection. (PRSM-23961)

• When you export a multi-segment interaction, the exported file now includes all of the segments.
(PRSM-24326)

• When the same question is added more than once in a single Quality Management Evaluation Form or
Group, the Evaluation Summary report now lists the question that appears in the form/group more than
once. Previously, the Evaluation Summary report did not list the question that appeared in the form/
group more than once. (PRSM-24047)

• When a user (with the correct permissions) opens an Evaluation created by another user, the Search
filters in the Interaction tab no longer look like they have been reset. (PRSM-23982)

• When the database contains usernames that include other usernames for an Ad-Hoc evaluation, only
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the selected username will be added to the Ad-Hoc Evaluation. Previously, if the database contained
usernames Tom, TomC and TomCruise, and Tom was selected as an evaluator, all three were added as
evaluators. Now only Tom is added as an evaluator to the Ad-Hoc evaluation. (PRSM-23635)

September 26, 2018 (8.5.510.13)

What's New
Screen Recording context menu permission

• A new Enable Video Context Menu permission was added to the SpeechMiner UI to control access to the
Video Context menu when performing a right-click on a screen recording in the player. By default, the
Video Context menu is no longer accessible. If users need this functionality, please enable the
permission in their assigned role.

Interaction Search, Export and Add

• Within the Interactions grid it is now possible to sort by the Agent column. Interactions with multiple
agents will appear after (descending order) or before (ascending order) the alphabetized list of
interactions with one agent. Subsequently, interactions with multiple agents are sorted by the number
of agents and then relevance. [+]

The new Agent column heading now includes sorting options:

The previous Agent column heading appeared as follows:

• It is now possible to search for a specific set of interactions based on a list of Interaction IDs. A list of up
to 50 Interaction IDs is supported. This can be useful when working with a specific set of interactions.
[+]

The new Interactions ID field contains a new resize option in the bottom right corner of the field that enables you to view the
Interaction ID:

The previous Interactions ID field did not contain this option:

• You can now easily export all the metadata associated with interactions from an interaction search, up
to the maximum number of listed interactions, without having to scroll through all interactions in the
search results. [+]
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The new Export window enables you to select the interactions that should be exported. The following window appears before the
previous Export window:

The previous Export window did not contain this option:
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• You can now easily add all interactions from an interaction search to an Interaction List without having
to scroll through all interactions in the search results. [+]

The new Add To... window enables you to select the interactions that should be added to the selected list:
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The previous Add To... window did not contain this option:
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• Quick filters have been added to certain Search Filters. These include Speakers, Languages, Types and
Metadata filters.

Quality Management

• Forms and Questions within Forms now have an expanded Question Description field that can be used
to store the standard definition or rubric used by your Quality Managers to ensure consistency when
performing evaluations of Agents. [+]

The new Question Description field contains a new resize option in the bottom right corner of the field:
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The previous Question Description field did not contain this option:

• The Forms Manager grid and the Evaluations Manager grid now includes a Description column; if a
description is long, the full content is shown in a tooltip. In addition, when you hover over the Form or
Evaluation name, a tooltip with the description of the specific Form/Evaluation is shown. [+]

When you hover over the Form / Evaluation name, the description appears in the tooltip as shown in the following image:

Reporting

• The Dashboards now support a 50/50 layout for widgets in addition to existing layouts.

SpeechMiner Web UI

• SpeechMiner Web UI is now supported for all existing supported browsers (for example, Chrome and
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Internet Explorer) on systems running Windows 10 64-bit.

Resolved Issues

• SpeechMiner no longer times out when you add an interaction to a static interaction list during a
Coaching session, and the list is updated. (PRSM-23720)

• Measures have been taken to improve the potential security threats to the web application
(SpeechMiner UI). (PRSM-23723, PRSM-23926)

• Chrome no longer disconnects when you try to search for and/or listen to a long recording.
(PRSM-23482, PRSM-22317)

• When a comma, quotes and/or a new line is entered in a Quality Management Free Form field, it now
appears as it should in the exported evaluation .csv file. (PRSM-23523)

• When the capitalization of a Username and/or External ID name are changed in GAX, the specific Agent
name may now appears in the SpeechMiner Agent filter even when Access Control is enabled.
Previously, capitalization changes sometimes removed Agent names from the filter when Access
Control was enabled. (PRSM-23346)

• Numbers at the end of a recording (that is, at the end of a channel) are now redacted and transcribed
for the interactions pushed via Fetcher and IR components. (PRSM-23525)

• Exporting 150 completed Quality Management sessions no longer takes more than a minute. Previously,
exporting 150 + completed QM sessions took more than a minute if the sessions included
approximately 20 questions. (PRSM-23215)

• A Saved Report no longer disappears from the Saved Reports list. (PRSM-23226)

• The Media Player displays the No Interaction message for non-existing recordings or recordings that
have not been processed. Previously, it displayed the Loading the interaction message instead.
(PRSM-23217)

• When the Trending report is created, user partitions are now considered. Consequently, the report
results are now based on the interactions associated with the user's partitions. (PRSM-23218)

• You can now delete a Quality Management evaluation from the Evaluation Manager. (PRSM-22798)

• Measures have been taken to improve the potential security threats to the web application.
(PRSM-23124, PRSM-23126, PRSM-23634, PRSM-23676, PRSM-23677, PRSM-23678, PRSM-23679,
PRSM-23680, PRSM-23681, PRSM-23682, PRSM-23683, PRSM-23684, PRSM-23685)
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July 27, 2018 (8.5.509.13)

What's New
Resolved Issues

• Agent names are no longer missing from the Search Filter > Agents list due to case sensitivity problems.
(PRSM-23351)

• When the capitalization of an Agent name is changed in Platform Administration, the specific Agent
name now appears in all the SpeechMiner Agent filters. Previously, capitalization changes sometimes
removed Agent names from the filter. (PRSM-23350)

• When a large number of agents are selected in the Agent filter in QM Evaluation Sessions page, the
Agent filter no longer appears empty due to the selection size. (PRSM-23058)

• Saved reports are no longer missing from the database. (PRSM-23054)

• Measures have been taken to improve the prevention of potential security threats to the web
application. (PRSM-23127, PRSM-23125, PRSM-23123)

June 13, 2018 (8.5.509.11)

What's New
Resolved Issues

• The process of exporting 150 completed Quality Management sessions has improved. Previously,
exporting 150 + completed QM sessions took more than a minute when the sessions included a large
number of questions. (PRSM-22967)

• SpeechMiner UI closes all connections to RWS and RCS. Previously, these connections were not closed
and as a result SpeechMiner UI periodically became unavailable after an extended period of work.
(PRSM-22917)

• You can now delete an Evaluation Session that you did not create when you have the permission that
enables you to do so. Previously, you could not delete an Evaluation Session you did not create even
with the permission that should have enabled you to do so. (PRSM-22274)
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May 14, 2018 (8.5.509.10)

What's New
General

• Tooltips in the SpeechMiner UI in various locations now provide more detail; for cases where even more
space is required, clicking on the element loads a modal window with all the information. Affected areas
include: Current Filter at the top of the Interactions Grid, and Action Items details.

Recording

• When working with Chrome, the SpeechMiner UI Media Player now contains an Audio Wave Graph that
enables the user to see where there are silences in the audio. From the Audio Wave Graph the user can
also distinguish between when one speaker is talking vs. the other. Note: This feature is not supported
when working with Internet Explorer.

• When using the Users filter option in the Search Filter in Search the names are listed alphabetically
according to the user's full name, also the filter now filters based on username and full name.

Quality Management

• When using the Users filter option in the Search Filter in Evaluation Sessions, or when selecting
Evaluators in Evaluation Manager, the names are listed alphabetically according to the user's full name,
also the filter now filters based on username and full name.

• You can now filter the Evaluation Sessions grid according to the date on which the session was created
as well as when the session was completed.

• The workflow to close an Evaluation Session has been optimized to reduce the number of clicks
required.

Interaction Analytics

This is the first release of Genesys Interaction Analytics in Genesys Engage cloud. Note, that only
Speech Analytics is supported. The following capabilities are being made available:

• All voice interaction recordings are processed for transcription and speech analytics.
• When using any supported browser (i.e. Chrome or IE), the SpeechMiner UI Media Player now includes

an Audio Wave Graph when deployed with Speech Analytics. Also, the wave graph includes interaction
events detected, including Topic markers, and non-linguistic events, such as silence and music.

• When accessing an interaction, users can view the transcript generated by speech analytics processing.
• Configured Topics and Phrases are tagged throughout the transcript. These are shown as markers in the

player and transcript view.
• Interactions are categorized based on customer defined Categories; Categories are based on linguistic

(voice) and non-linguistic linguistic (DTMF, silence, music, meta data, etc.) aspects of the interaction.
• This capability allows strings of digits, as detected by speech analytics, to be skipped during playback of

the call.
• Find voice interactions based on output generated by speech analytics, this includes words or phrases

in transcripts, Topics and Categories.
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• Monitor interactions to discover and surface unexpected or emerging business issues or identify new
phrases or topics for ongoing analysis of customer and agent conversations.

• Schedule daily emails with information on Topic activity. Notifications can be sent based on changes,
thresholds or trends.

• Alerts ('On Event') provide a notification whenever a programmed condition is met based on Topic
detection using speech analytics.

• Users can create and modify custom reporting views based on speech analytics criteria. Report views
can be added to dashboards. A number of predefined report templates are available:
• Agent Bubble Chart
• Agent Comparison
• Agent Trend
• Category Bubble Chart
• Category Distribution
• Category Trend
• Metadata Frequency
• Performance Profile
• Team Comparison
• Top and Bottom Performers

• All reports can be downloaded in PDF or .CSV format.
• Schedule report to be send via email to specific email addresses.
• Supported Languages: US English, UK English, Australian English, South African English, Indian English

June 12, 2017 (8.5.507.01)

What's New
Configuration Data

• User lists now include only users associated with the context in which they are shown (for example, a
list of evaluators will only include users with QM permissions).

• Changes to the Configuration Database have an immediate effect on the system (for example, when a
user is given QM permissions, his/her name will appear in the evaluators list the next time you view the
list).

Default Call List Order

• A new configuration option that enables you to determine the order of interactions in an interaction list.
The new sort options are: Descending by Date Added, Ascending by Date Added, Descending
Alphabetical and Ascending Alphabetical.
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Export to PDF

• Enables users to export a completed evaluation session as a PDF file.

Export Completed QM Sessions

• Users can now export completed evaluation sessions according to a specific date range.

Auto fail report

• A drill-down report that focuses on auto-fail Quality Management questions and agents is available.

Distributed evaluations targeted to specific agents

• Supervisors have the ability to evaluate specific agents repeatedly over time.

Quality Management - Agent Notification

• Enables agent collaboration to provide agent feedback against evaluations and related scores

Show Evaluation Session Score Permission

• Enables a user to turn on/off the evaluation session Show Score option.

Replace interaction

• A user (based on existing search criteria) can select an alternative interaction due to the interaction's
quality.

Ad-Hoc evaluation

• You can launch an evaluation from the player against a specific media asset.

Resolved Issues

• When you try to filter the search results in the following SpeechMiner UI grids, when you are not viewing
the first search results page, the filter will now redirect you back to the first search results page:
(PRSM-16249)
• Interactions Lists
• Saved Searches
• Users
• Saved Reports

• When you playback a screen recording an error no longer appears in the Browser Console log.
Previously, an error appeared in the Browser Console log. (PRSM-16189)

• When the database contains less than 1000 interactions, the number of interactions in the report now
matches the number of interactions in the grid that appears when you drill-down. Previously, the
number of interactions in the reports did not match the number of interactions in the grid.
(PRSM-16022)
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• When a calibration evaluation is not created because not all evaluators have permissions to view the
selected interaction, the status of the evaluation is now correctly marked as Inactive. Previously, the
status of the evaluation was incorrectly marked as Active. (PRSM-16063)

• The Apply option in the Edit Comment window is now only enabled for users with the required
permission. Previously, it was enabled for all users with or without the required permissions.
(PRSM-16061)

• A user that does not have permission to view a specific evaluation session, can no longer view the same
evaluation session from REST API. (PRSM-15930)

• Saving a search functions as expected. Previously, saving a search took longer than
expected.(PRSM-16424)

• All SpeechMiner UI roles now have the Edit Action Items permission. (PRSM-14637)

• When a saved search is run after it has already been run once, the results are now accurate and no
longer reflect the results of the previous search. (PRSM-17137)

• When using a metadata filter in reports, the number of interactions in the result set is correct and there
is no longer an inconsistency between the report and its drill down. Previously, the number of
interactions in the result set was sometimes higher than the actual number of interactions that the
report should have retrieved. (PRSM-18278)

• When you select to configure a custom date range for an evaluation, you only need to click the desired
date once for it to be selected. (PRSM-15938)

• SpeechMiner UI menus now close when a selection is made from the menu. Previously, in this scenario,
the menu stayed open. (PRSM-17136)

• The total call time no longer overlaps the time line in the Evaluation Manager player when the total time
is more than 1 hour. (PRSM-17088)

• In the Metadata Frequency report the number of interactions filter now supports a double digit (>=10).
Previously, it only supported a single digit (0-9). (PRSM-17189)

• When Sharing an interaction list with another user, a delay no longer occurs as soon as you type the
first letter of the users name. (PRSM-17992)

• When you listen to a long call (longer than 20 minutes) without doing anything else in the UI, your
session remain alive, and you will stay logged in the application. (PRSM-17833)

• The name of the Action Item assignee no longer extends beyond the Action Item window. (PRSM-17620)

• The time that appears in an Action Item comment is the same as the time that appears in all other
SpeechMiner UI comments. Previously, the time in the comments were not the same. (PRSM-17622)

• In the QM Question Library, the Save option is now disabled when Low or High title value is removed
from Sliding scale question and the following error message no longer appears: Failed to save the
Question Library. (PRSM-17325)

• A message appears when an attempt is made to use the < and > characters in an Interaction List
name. The message informs the user that these characters cannot be used in the Interaction List name.
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Previously, an error occurred when the characters were part of the name. (PRSM-17678)

• When an Interaction list is renamed using Japanese letters, all the letters appear as Japanese letters.
Previously, the letters appeared as question marks (????). (PRSM-18108)

• A console error no longer occurs when refreshing the Quality Management Evaluation Manager page.
(PRSM-17726)

• The number of lines displayed in the different Evaluation Manager tabs is now consistent when moving
from tab to tab and back to the original tab. (PRSM-17610)

• The designation arrows in a new Evaluation Form are now aligned. (PRSM-17384)

• Tool tips are no longer missing for the following options in the following pages: (PRSM-17464)
• Interaction lists: Edit, Add, Delete
• Content Browser: Refresh
• Saved Reports: Delete, Schedule
• Edit Reports: PDF, Excel

• You now must provide a new name when renaming an interaction list. If you attempt to leave the name
field empty when selecting to rename an interaction list, a warning message appears. (PRSM-17473)

• When a shared Interaction List is included in the Interaction List grid, you can now clear all the check
boxes at once. (PRSM-18124)

• It is no longer possible to change the status of a form from active to inactive when the form is
associated with more than one evaluation session. For this reason, such a form cannot be deleted.
(PRSM-16948)

• When a report is cached, the report parameters are now accurate and as a result the report is now
taken from the cache. (PRSM-16642)

August 12, 2016 (8.5.504.02)

What's New
Encrypt exported interactions

• Exported interactions are encrypted. A password is required to access the interactions.

Search page

• When the Search page is accessed, the Filter Panel will be opened and a search will not be run.

Recording, QM and Interaction Analytics GVP Reporting

Genesys Engage cloud Release Note 335



Resolved Issues

• Performance improvements were made to the speed at which the Interactions grid is loaded.

• The Apply option in the Edit Comment window is now only enabled for users with the required
permission. Previously, it was enabled for all users with or without the required permissions.
(PRSM-16061)

• When a calibration evaluation is not created because not all evaluators have permissions to view the
selected interaction, the status of the evaluation is now correctly marked as Inactive. Previously, the
status of the evaluation was incorrectly marked as Active. (PRSM-16063)

• When you playback a screen recording an error no longer appears in the Browser Console log.
Previously, an error appeared in the Browser Console log. (PRSM-16189)

• When using the Hide Filter arrow in the Edit Report page in a Chrome environment, the report now
covers the entire page. (PRSM-11685)

• When you try to filter the search results in the following SpeechMiner UI grids, when you are not viewing
the first search results page, the filter will now redirect you back to the first search results page:
(PRSM-16249)
• Interactions Lists
• Saves Searches
• Users
• Saved Reports

March 8, 2016 (8.5.502.03)

What's New
Enhanced Segment Data and Metadata

• The Attributes page now contains data for interaction segments.

QM Evaluation Score Visualization

• When a QM evaluation is completed and saved, the evaluation score appears.

Screen Column Customization

• Now you can change the column order in the Interactions, Events, and QM grids per user.

Resolved Issues

• When working with Internet Explorer 10 and 11, the media player's Full Screen mode is now functional.
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(PRSM-13695)

• SpeechMiner UI functions properly when processing a large number of items in the filter hierarchy.
(PRSM-14134)

• It is now possible to change the column order in the Interactions, Events and QM grids per user.
Previously, it was not possible to change the column order. (PRSM-12898)

• When you play a new interaction recorded in mono audio in Internet Explorer, the duration shown is
now the same as the actual duration of the interaction. (PRSM-12744)

• The Player synchronization problems in Internet Explorer are now solved. (PRSM-11927)

Known Issues

• A security issue occurs in the Saved Trending page. (PRSM-21358)

• An Ad-Hoc evaluation session cannot be created for interactions without agent information.
(PRSM-21090)

• When you run a report with a Metadata value that includes a + sign, the report will not return
data.(PRSM-20742)

• When a large amount of agents are selected in the Agent filter in QM Evaluation Sessions page, the
Agent filter appears empty. (PRSM-20710)

• When you run a report with a Metadata value that includes a + sign, the report will not return data.
(PRSM-20592)

• SpeechMiner UI may receive an error from the Configuration Server when trying to load the current
users details. As a result, the current users details will not be loaded into the system. (PRSM-20488)

• When working with Internet Explorer 11, the following Report editing steps cause the Filter selection to
disappear:(PRSM-20381)
1. Select to edit a report.

2. In the report page open a filter and right-click.

3. If a menu appears (since not all filters have menus), select an option. The filter closes when it
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shouldn’t .

• After an event is selected within the transcript, it is not possible to navigate to the same event.
(PRSM-20150)

• When a form is created with a name that contains 200 characters, the form name is not aligned under
the Forms title in the Evaluation Summary. (PRSM-19986)

• When exporting some reports to PDF format, blank pages may appear in the report. (PRSM-19728)

• Tool tips for some of the Interaction list columns may contain lists with the term undefined appearing
one or more times in the list. (PRSM-19717)

• When you select to open and play an interaction from an Evaluation session in a new window, the
interaction begins to play in the background before the interaction is fully loaded. (PRSM-19689)

• When working with Internet Explorer, the Custom scheduling option enables an unnecessary drill down
that does not exist when working with Chrome. This occurs when you edit an Action item and export a
completed Quality Management session.(PRSM-19678)

• The Media Player waveform does not progress along with the Audio and Screen Recording when the
interaction is played back. (PRSM-19669)

• When a phrase is within a phrase, the Event tag is only placed next to the internal phrase. An Event tag
is not placed for the outer phrase. (PRSM-19668)

• The row height for the Usage Tracking report is too small and as a result, the date and time are not
visible.(PRSM-19665)

• When the following characters are entered in the Search Filter > Comments field and a search is run,
the search is not performed and an error occurs: @ \ ! \ ? \ . \

• \ # \ $ (PRSM-19569)

• The list of Topics and Agents in the Search Filter is not in alphabetical order when one or more Topic /
Agent includes a sub-topic/sub-agent. (PRSM-19568)

• Differences in SpeechMiner UI performance exist between Internet Explorer 11 and Chrome.
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(PRSM-19510)

• When a user receives a Quality Management > Shared Evaluation session, but does not have
permission to access the users associated with the specific Shared session, the user will not be able to
assign the Evaluation Session to himself/herself. The user should be able to assign the session to
himself/herself. (PRSM-19503)

• When two users apply a tag to the same interaction at the same time, the first user to save the tag
loses his/her changes. (PRSM-19259)

• The Alerts field does not accept fractions for percent values and the wrong error message: Value range
should be positive, appears twice. (PRSM-19138)

• When exporting an Evaluation Session, interaction metadata is not filtered. As a result, all of the
metadata is exported. (PRSM-19092)

• SpeechMiner UI reports display the US date format in the report footer when the system is configured
with a date format that is not US. (PRSM-18923)

• The link to interactions within an Alert email does not work. (PRSM-18886)

• When working with Chrome in a Recording Only deployment, playing an interaction with a Screen
Recording will cause an error in the console. (PRSM-18809)

• When working with a resolution below 1280X1024, some of the options in the Date Range filter in the
Explore > Search > Search Filter page may expand upwards and be hidden behind the Media Player.
(PRSM-18785)

• The Explore > Saved Search list takes longer than expected to load. (PRSM-18669)

• When running multiple reports in the Dashboard the following error may appear: Item has already been
added. Key in dictionary: 'searchId' Key being added. (PRSM-18429)

• When you attempt to view a report in a Dashboard at the same time numerous users are trying to do
the same, an error occurs. (PRSM-18428)

• When 2500 characters are entered in the SpeechMiner UI Dashboard widget, the user is redirected to
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the Login page. (PRSM-18329)

• The Genesys Interaction Recording System has a size limit for exporting audio interactions. Exporting
large audio files may cause the export request to timeout. (PRSM-18191)

• The Agents cache is not cleared automatically after a certain period of time. Users must manually clear
the cache in the Manage Cache page. (PRSM-17101)

• The amount of memory usage grows exponentially when a user opens an evaluation from the
Evaluation Manager, uploads interactions, scrolls to the bottom of an interaction transcription and
returns to the Evaluation Manager page to select an additional evaluation. As a result, the interactions
do not playback as expected and SpeechMiner UI slows down. (PRSM-16722)

• Not all pages visited by a user in SpeechMiner UI were logged for auditing. (PRSM-16598)

• A single Interactions report generated as a pdf can support up to 20,000 interactions. Interaction
reports with a larger interaction amount should use a different format (for example, CSV).
(PRSM-16331)

• Sorting an Interaction list and an Events list takes longer than expected. (PRSM-16105)

• When you create an Evaluator Evaluation Comparison report, results appear for all users that edited or
completed the selected evaluators' sessions (and not only for the selected evaluator). (PRSM-16050)

• In the following pages, the web server time zone is used instead of the client time zone. Due to this
issue, results may not be as expected. (PRSM-15047)
• Views/My Messages / Received Time

• Saved Searches / Created On

• Content Browser / Date Range filter

• Reports / Date Range filter

• Tools / Monitor System page

• Tools / Purge System page
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• Tools / Reprocess Interactions

• When the Playback session expires, the user does not receive a message telling him/her to log in again.
The user must log in again to play the interactions. (PRSM-14696)

• When working with the Media Player in a detached mode, the following will not appear in the evaluation
session embedded Media Player until you refresh the session (PRSM-13712):
• Add Comment

• Change Manual Category

• Change Column Configuration

• Calibration Score Report - when exported to an Excel worksheet the first row in the first group appears
at the top and again at the end of the table. (PRSM-12860)

• When you playback an interaction with a segment, the interaction is not played sequentially. The
playback stops between every two segments. (PRSM-12853)

• Every time you click the Back to Forms Manager, Back to Evaluations Manager or Back to Evaluation
Sessions link you are asked to save your changes even when you already saved the changes or you did
not make any changes. (PRSM-12559)

• When you exit a form, evaluation and/or evaluation session using options other than Back to Forms
Manager, you do not receive a warning message that informs you that your changes were not saved.
(PRSM-12471)

• When trying to search for interactions that include a specific comment together with a specific type (for
example, bad, good and neutral), the system retrieves interactions that include the comment and type
even if they are not together. (PRSM-11947)

• When using the Find box for the different search filters, the filter tree is not expanded automatically. You
must expand the tree in order to see the filtered values. (PRSM-11691)

• Spelling suggestions for searched terms is not supported. (PRSM-11653)
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• In the Interaction and Event Grids, the sort function does not work as expected. Sorting by workgroups,
agents, categories and all metadata columns is disabled. (PRSM-10937)

• The Interaction and Event grids cannot be sorted by relevance. (PRSM-10821)

• Date and Time is not displayed on every page in the SpeechMiner UI. (PRSM-10655)

• When defining an alert, the interface does not allow the user to send alerts to someone based on their
role. Users must key-in the email address to whom the alerts should be sent. (PRSM-9676)

• Performance Profile report: collapsing or expanding 2 agents from within the report can cause an error.
(PRSM-8938)

Recommendations

• The Topic Analysis Audit report can only be enabled on a case by case basis via a MACD request with
the customers consent. To avoid a performance degradation of the platform, this report should not be
run for a longer period than 30 days. Since this report may run longer than other reports, it is
recommended that you schedule its execution.

• To avoid performance degradation and significant indexing delays, the number of unique metadata or
KVP should not exceed 500 per single customer tenant. This issue will be addressed during the next
maintenance bulk upgrade when SpeechMiner will be upgraded to version 8.5.512 or higher and the
Lucene index will be replaced with Elastic Search. When these changes occur this limitation will be
removed.
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Recording Cloud Backup Service
For information about the latest releases of Recording Cloud Backup Service, refer to Recording Cloud
Backup Service Release Notes.

Note: Not all changes listed below may pertain to your deployment.

• July 8, 2019 (8.5.299.28)
• January 8, 2019 (8.5.297.61)
• May 15, 2018 (8.5.295.01)
• February 27, 2018 (8.5.290.49)
• March 29, 2017 (8.5.270.73)
• December 20, 2016 (8.5.265.71)
• September 27, 2016 (8.5.260.59)
• July 14, 2016 (8.5.241.13)
• March 1, 2016 (8.5.240.80)
• October 2, 2015 (8.5.220.91)
• Known Issues

July 8, 2019 (8.5.299.28)

Important
RCBS version 8.5.298.58 has been deprecated and replaced with version 8.5.299.28. If
you are using version 8.5.298.58, please upgrade to version 8.5.299.28 immediately.

What's New
Validation mode

• RCBS now has a validation mode that validates its connection to AWS S3.

Interaction Recording Web Services

• RCBS now sends its version number to Interaction Recording Web Services (RWS) when querying the
download API.
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Recovery report

• The RCBS Recovery Tool now includes a script that calculates the percentage of undecryptable
recordings and generates a recovery report.

Resolved Issues

• The skipLastRecordingCheck parameter is no longer configurable and it is now always considered
false. (GIR-25902)

• The shardBy parameter is no longer configurable and it is now always set to 1. (GIR-25938)
• The downloadMode parameter is no longer configurable and it is now always set to single.

(GIR-25952)

January 8, 2019 (8.5.297.61)

What's New
Recovery Tool

• The RCBS Recovery Tool allows you to recover undecryptable recordings and is required for the following
circumstances:
• RCBS exits unexpectedly when downloading recordings in the multi-threaded mode.
• Some recordings downloaded before the unexpected exit are not decryptable by OpenSSL

commands.

The new tool allows users to recover these recordings and decrypt them through OpenSSL
commands. For instructions on how to use the tool, refer to <RCBS_installation_folder>/tool/
rcbs_recovery_script/recovery_README.

May 15, 2018 (8.5.295.01)

What's New
Resolved Issues

• Recording Cloud Backup Service (RCBS) now prints the version number correctly in the logs. Previously,
RCBS was printing the version as "DEVELOPMENT-VERSION" in logs.
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February 27, 2018 (8.5.290.49)

What's New

• When started from the command line, Recording Cloud Backup Service (RCBS) now shows incremental
progress of the download process by showing the percentage downloaded for the requested backup
time period.

Resolved Issues

• RCBS no longer displays an error when handling multi-part screen recordings. Previously, an error was
displayed when renaming the screen recordings from "mp4.bin.part" to "mp4.bin". (GIR-8759)

• If the configured download period is more than 1 day, the last_recording_endtime.txt file is updated
every shardBy day (by default, 1 day) during the download process. This file cannot be viewed on
Windows when the download process is in progress, but it can be viewed on Linux during download.
(GIR-17788)

• In the multi-threaded mode, RCBS no longer takes a lot of time for processing the recordings after
download. (GIR-17837)

March 29, 2017 (8.5.270.73)

What's New

• The commons-collection library used by the Recording Cloud Backup Service has been upgraded to
version 3.2.2 to address a potential security issue.

December 20, 2016 (8.5.265.71)

What's New

• Recording Cloud Backup Service (RCBS) supports AWS Signature version 4 for requests sent to Amazon
S3 Services. RCBS also supports optional payload signing during the transfer. To enable the payload
signing, set the option usePayloadSigning to true. Since payload signing affects performance, set the
option to false to disable it if your installation does not require authentication. The default value is
false.

• Recording Cloud Backup Service (RCBS) now supports a query based on the startTime only, and no
longer requires the overlap to be specified, when two consecutive runs with two windows adjacent to
each other takes place. Previously, an overlap value had to be specified to avoid missing recordings
when RCBS used two back-to-back download windows.
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Resolved Issues

• Recording Cloud Backup Service (RCBS) no longer uses the deprecated RFC2109 cookie format.
Previously, the RFC2109 cookie format may have caused requests sent by RCBS to be rejected.
(GIR-8286)

September 27, 2016 (8.5.260.59)

What's New

• Recording Cloud Backup Service (RCBS) now supports multi-threaded and multi-instance download. For
multi-instance RCBS, the download of the recordings can be shared by different RCBS instances running
in parallel. For multi-threaded RCBS, the download tasks and the post-processing tasks can be carried
out by multiple threads within the RCBS process.

Resolved Issues

• Recording Cloud Backup Service (RCBS) now supports the minDate configuration parameter, which
allows specifying the minAge with an absolute date instead of an offset value. (GIR-6834)

• RCBS now supports disabling the download of the screen recording files through the configuration
parameter. (GIR-6467)

• RCBS no longer exports originalMediaDescriptor as part of the metadata export fields. (GIR-6008)

July 14, 2016 (8.5.241.13)

What's New
Resolved Issues

• Recording Cloud Backup Service (RCBS) now supports the shardBy parameter to resolve deep
pagination. This parameter allows the user to instruct RCBS to query recordings during a smaller period
of time, using a minAge and maxAge range. The default value is "1" (day). Previously, if a user
specified an exceptionally long range using the minAge and maxAge values, RCBS sent the complete
range all at once to RWS, causing RWS to occasionally time out and return an empty result due to an
Elasticsearch deep pagination issue. (GIR-6429)
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March 1, 2016 (8.5.240.80)

What's New

• Support for muxed screen backup.

October 2, 2015 (8.5.220.91)

What's New

• This is the initial release of the Recording Cloud Backup Service. The Recording Cloud Backup Service
allows you to make a backup copy of your Genesys Interaction Recording voice files (some or all) prior
to their automated deletion as per the Cloud retention policy.

Known Issues

• If you are using Recording Cloud Backup Service (RCBS) version 8.5.298.58, you must roll back to
version 8.5.297.61. RCBS version 8.5.298.58 will send incorrect queries to RWS and will receive 400
errors when downloading recordings. (GIR-26684)

• If RCBS receives a 403 HTTP status code, an error that states that your credentials are incorrect is
added to the logs. This may occur even when your credentials are valid, so logs should be examined to
determine the actual error. (GIR-25958)

• RCBS might terminate unexpectedly if the connection between the RCBS and RWS is broken while RCBS
is waiting for the HTTP response. (GIR-6683)

• If you are using RCBS 8.5.260.59 or a later version, you must set the downloadMode parameter to
single. This is required to avoid a known issue that caused undecryptable recordings in the downloaded
files. (GIR-25719)

• If RWS has CSRF enabled, the RCBS might not handle the CSRF token properly and the request might
fail. (GIR-6542)

Workaround

Disable the CSRF on the RWS side.

• If awsRecordingPrefix and bucket are configured under the Recording Cloud Backup Service (RCBS)
section, but the media file is stored under WebDAV, RCBS will attempt to download the files from
Amazon S3 and a 404 error will occur in the logs. Currently, RCBS only supports downloading via
Amazon S3. (GIR-4843)

Workaround
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Remove the awsRecordingPrefix and bucket configuration values. This parameter no longer needs
to be specified for RCBS 8.5.240.80 and higher.

• When the Recording Cloud Backup Service's (RCBS) Web Services and Applications credential is from an
EService agent, running RCBS may cause the status of the specific agent to remain Ready, even if the
agent has already logged out of the agent desktop. (GIR-4781)

Workaround

To create a Contact Center Administrator credential for RCBS, do not assign the specific agent a
default place and do not add him to the EService agent group.

• Genesys Web Services rejects the server settings group configuration values for the Recording Backup
Cloud Service exceeding 256 characters. (GIR-3137)

Workaround

Specify the configuration parameter in the config.properties file instead of using the server settings
group.

• When specifying a path name for the Recording Cloud Backup Service component in the configuration,
use a forward-slash ("/") as the path delimiter for both Windows and Linux OS-es, since the single
backslash ("\") is stripped off by the Java property reader. For example, use 'C:/TargetFolder instead of
C:\TargetFolder when specifying the targetDir configuration value. Alternatively, a double backslash
("\\") will work on Windows also—for example, C:\\TargetFolder. (GIR-2925)
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Screen Recording Service
For information about the latest releases of Screen Recording Service, refer to Screen Recording
Service Release Notes.

Note: Not all changes listed below may pertain to your deployment.

• March 30, 2021 (8.5.370.93)
• December 7, 2020 (8.5.370.85)
• September 29, 2020 (8.5.370.82)
• April 24, 2020 (8.5.370.78)
• December 20, 2019 (8.5.370.68)
• September 3, 2019 (8.5.370.63)
• May 8, 2019 (8.5.366.12)
• January 4, 2019 (8.5.365.01)
• February 2, 2018 (8.5.351.06)
• December 15, 2017 (8.5.350.65)
• Known Issues

March 30, 2021 (8.5.370.93)

What's New
Resolved Issues

• If a screen recording is long enough to be sliced, Screen Recording Service (SRS) now correctly records
all subsequent slices. (GIR-30151, GIR-30152)

• On Windows 10, if the screen recording is paused and then resumed, the screen recording is no longer
lost. (GIR-30144)

• When the maxWidth and maxHeight parameters are set, Screen Recording Service now correctly
applies the settings. Previously, it used the default resolution that was set in the display settings.
(GIR-27591)

• Screen Recording Service no longer crashes when Data Execution Prevention and Validate heap
integrity are enabled in Windows Defender's Exploit Protection for GenesysServiceHandler.exe.
(GIR-29369)
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December 7, 2020 (8.5.370.85)

What's New
Citrix Virtual Loopback support

• The Screen Recording Service (SRS) can now be configured to listen on loopback addresses other than
127.0.0.1. This enables SRS to work in an environment where the Citrix Virtual Loopback Feature is
being used. (GIR-30165)

September 29, 2020 (8.5.370.82)

What's New
Resolved Issues

• An issue that caused Screen Recording Service (SRS) to stop responding if Data Execution
Prevention and Validate heap integrity are enabled in Windows Defender's Exploit Protection for
GenesysServiceHandler.exe is now corrected. (GIR-29369)

• The SRS uninstaller now removes the root certificate that is created when a self-signed certificate is
generated during the SRS installation process.

Note: This fix takes effect starting with upgrades subsequent to this release. The issue still applies
when upgrading to this release. (GIR-29666)

April 24, 2020 (8.5.370.78)

What's New
Proxy server support

• The Screen Recording Service (SRS) now supports the use of a proxy server to act as an intermediary
between SRS and Interaction Recording Web Services (RWS).

Resolved Issues

• An issue that caused cookies associated with cross-site resources to have the SameSite=None and
Secure attributes set when using HTTP is now corrected. (GIR-29182)

• If the Screen Recording Service is uninstalled, the certificates it created during installation are now
removed from the Windows Certificate store. (GIR-28531)
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December 20, 2019 (8.5.370.68)

What's New
Browser compatibility support

• The Screen Recording Service (SRS) is updated to set the SameSite=None and Secure attributes for
cookies associated with cross-site resources. This is to support forthcoming releases of Chrome
(starting with v80) and other browsers that will only deliver cookies with cross-site requests if they are
set with these attributes. (GIR-28630)

September 3, 2019 (8.5.370.63)

What's New
Third-party libraries

• Several third-party libraries have been upgraded to mitigate security vulnerabilities. (GIR-23212)

May 8, 2019 (8.5.366.12)

What's New
Resolved Issues

• Screen recordings now complete when the recording is paused or resumed. Previously, in version
8.5.365.01 or higher, SRS encountered an error and failed to complete a recording when the recording
was paused or resumed. (GIR-26010)

• Encryption certificates are now stored using shorter filenames. Previously, SRS could encounter I/O
errors due to long filenames of encryption certificates. (GIR-25628)

• The VLC HTTP timeout has an increased default value of 10 seconds. Additionally, the vlcHttpTimeout
parameter is introduced to allow users to adjust this timeout. Previously, SRS failed to complete a
recording due to a VLC Http stop failed with ConnectTimeout error. (GIR-25170)

• SRS no longer encounters a recorder.pyc error. Previously at times, SRS did not record an agent's
screen when there were back-to-back login and logout requests. (GIR-26155)
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January 4, 2019 (8.5.365.01)

What's New
Resolved Issues

• Screen Recording Service now supports HTTPS mode in Firefox 58 and later versions. (GIR-24283)

February 2, 2018 (8.5.351.06)

What's New
Resolved Issues

• The Screen Recording Service (SRS) no longer encounters a large number of missing frames in the
screen recording on slow machines when the preLoadVlc parameter is enabled. Previously, some
frames were missing in the screen recording on slow machines. The dummyRecordingDuration
parameter can be set to a value less than 60 seconds to launch VLC for the configured time; this helps
to cache the recorder DLL files for a faster response. (GIR-16951)

December 15, 2017 (8.5.350.65)

What's New
Resolved Issues

• Screen Recording Service now supports new parameter called "isVlcSlowCapture" to enable/disable
update of startTime with recording file creation time. Earlier, in slow machine there was misalignment
between actual start time of video and the start time in metadata. (GIR-15643)

• The SR Service no longer stops uploading recordings after it fails to upload a recording due to
authentication errors. The SR Service now skips the problematic recording and continues to upload the
next agent recording. (GIR-12110)

• The Screen Recording Service (SRS) now displays the "Genesys Screen Recording Service, Version :
<ipversion>" message in the Windows "Services" application. (GIR-12553)

• Screen Recording Service installer now installs SRS in the HTTPS mode when the default "Standard"
installation option is chosen. Previously, the SRS installer installed SRS in the HTTP mode. (GIR-6611)

• Screen Recording Service installer UI now shows additional option to reboot the machine by detecting
the presence of rra files during upgrade. Earlier, if the SRS service is not stopped when the setup.exe is
running during the SR Service (SRS) upgrade, there may be rra files created in the SRS installation
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folder. Workaround: Reboot the machine for the upgrade to complete properly. (GIR-5945)

• Screen Recording Service no longer supports update of "certificate" parameter value with an api
request from the agent desktop clients. (GIR-6615)

• SRS now properly adds the certificates to the Firefox certificate store during the installation.
(GIR-11072)

• The Screen Recording Service (SRS) no longer displays a security pop-up window from Internet Explorer
if you are using a self-signed certificate generated during the SRS installation process. Previously,
Internet Explorer displayed a security pop-up window in all the Windows operating systems other than
Windows 10. (GIR-13109)

Known Issues

• Screen recordings may be truncated by a few seconds at both the start and end of the recording.
(GIR-30605)

• When playing back a screen recording in SpeechMiner using Internet Explorer the screen and voice may
be slightly out of sync. (GIR-30611)

• If VLC crashes, SRS may fail to create screen recordings afterwards due to a problem with VLC. This
would be shown in the logs with a log message like "The recording file size is too small (0 bytes)".
(GIR-30594)

Workaround: Delete %APPDATA%\vlc and restart Screen Recording Service. To restart Screen
Recording Service, stop and then start the Genesys SRS Service Windows Service.

• When upgrading SRS on a Windows 10 machine, the upgrade might fail. If this happens, restart the
machine and try again. (GIR-29547)
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Real-Time Reporting (Pulse)
Note: Not all changes listed below may pertain to your deployment.

• August 18, 2017 (8.5.106.05)
• August 21, 2015 (8.5.102.03)
• Known Issues

August 18, 2017 (8.5.106.05)

What's New
User Interface

• Genesys Pulse now provides a Wallboard for displaying Key Performance Indicator (KPI) widgets to
enable you to broadcast and share information to your entire team.
• Wallboards are similar to dashboards, but designed for large screens in public places.
• The wallboard KPI widget is different from the dashboard KPI widget in that you can choose only one

object and one statistic and either a regular or sparkline widget.
• For a full screen view of your wallboard, launch the wallboard using the tab more menu. You can

enable your wallboards to cycle at a specified interval in fullscreen mode. You can also customize
the wallboard header (name, header color, and text color).

• Users can change the size of the Donut widget, which now displays up to 10 statistics. The value in the
center can be none, total, average, maximum, and minimum of the statistics displayed.

• The Grid widget and Data view provides a quick search to filter agents based on their status.
• The following charts were renamed: Line to Time Tracking, and Grid to Data.
• You can now filter logged-out agents from your reports within a report template.

Administration

• You can import and export Pulse Dashboards, Wallboards, and Widget Templates from one environment
to another.

• You can now manage Pulse Dashboards, Wallboards, and Widget Templates from corresponding
management screens accessible from the Manage menu. You can remove, edit, clone, export or move
Dashboards, Wallboards, and Widget Templates from one location to another in the central repository.

• You can select and move one or more of these items to a different folder. The access permissions setup
for individual items saved in Genesys Configuration Server remain the same after you move the items
between Genesys Configuration Server folders.

• You can now save and share custom dashboards with other users.
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• Genesys Pulse now provides Twitter Media Activity and Facebook Media Activity templates.

Support

• Genesys Pulse now supports statistics with GroupBy feature of StatServer release 8.5.103 and higher in
the Grid widget.

• Genesys Pulse now supports the following browsers:
• Microsoft Internet Explorer 11
• Microsoft Edge 12+
• Mozilla Firefox 42+
• Google Chrome 46+
• Apple Safari 9+

Resolved Issues

• Pulse can now process unlimited simultaneous widget data requests. Previously, Pulse could process up
to eight simultaneous requests. (WBRT-8434)

• Graph colors now provide more contrast. (WBRT-7925)
• Genesys Pulse now displays all warnings and errors in widgets for all supported languages. Previously,

Genesys Pulse did not display this content for some languages. (WBRT-7866)
• Pages displayed as IFRAME tabs no longer quit unexpectedly when switching between tabs.

(WBRT-6624)
• In FireFox, after you delete a widget, other widget content now remains. Previously, the content might

disappear. (WBRT-6297)
• Genesys Pulse no longer displays warning messages about unsaved changes during statistic changes

and all changes are saved automatically. Previously when one statistic was deleted while another was
created, Genesys Pulse might display an unnecessary warning message "Please Confirm. Any changes
you have made will be lost." (WBRT-5868)

• Widgets now successfully load in a browser window if you edit the widget in another browser window.
(WBRT-5595)

• Genesys Pulse Grid row order in maximized view no longer changes after you hide a statistic used for
sorting. (WBRT-4909)

August 21, 2015 (8.5.102.03)

What's New

• The Line Widget now includes:
Time interval controller options: 15 min, Hour, and Day

Alerts
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Tooltip with value

• Ability to set limit of widgets per user.

• Ability to hide statistics on template level. Pulse does not display hidden statistics on widgets, although
it uses them in formula calculations.

• New templates:
Chat Agent Activity

Chat Queue Activity

Email Agent Activity

• Template updates:
New hidden statistics with enabled User Data is now added to Agent Login template for Service
Type, Customer Segment, Service Sub Type, and Business Result metrics calculations. User Data
examples now added to Agent Login template.

Minor updates to Agent KPIs, Agent Group Status, and Chat Queue KPI templates.

Resolved Issues

• After Pulse is upgraded to 8.5.102.03, Pulse now displays all templates with statistics during the
statistics step in the widget wizard. Previously when Pulse was upgraded to older versions, some
custom templates might have shown an empty list on the statistic selection screen of the wizard.
(WBRT-5672)

• Pulse now preserves the sorting order in the Grid widget after you reload the dashboard. Previously, the
sorting order reloaded as ascending. (WBRT-5650)

• The help link now correctly opens the Pulse help. Previously, the link incorrectly opened the
documentation landing page. (WBRT-5650)

• Column sizes in the grid on some Platform Administration screens (like Persons) are now correct after
your perform edits on a widget. Previously, after your performed an edit of a Pulse widget, the size of
Name column on subsequent Platform Administration screens was sometimes too small. (WBRT-5645)

• Pulse now applies changes to templates immediately without requiring that you close the wizard dialog.
Previously, you might sometimes have seen the previous version of a template if you updated the
template while creating a new widget. (WBRT-5643)

• The Grid widget performance while loading and updating data is now improved. Previously, the
dashboard might have momentarily frozen or the scrolling might have slowed. (WBRT-5615)

• You can now continue to use your dashboard after you try to reset it to the default dashboard.
Previously, if you did not have privileges to change your own Person object, the selected dashboard
stopped functioning. (WBRT-5480)

• Thresholds in the Line chart are no longer lost when another action, such as Statistic selection, is
performed in another chart. (WBRT-5402)

• Pulse now shows data in the Agent Login template for the Service Type, Customer Segment, Service Sub
Type, and Business Result metrics with default settings. Previously to see these metrics in your report
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data, you had to clone the Agent Login template, edit the Current Status metric and select the User
Data check-box, and then create a new widget from your cloned template. (WBRT-5354)

Known Issues

• Objects (Dashboards, Wallboards or Widget Templates) may be imported with same name as another
one if their names are identical, except the copy suffix.

Workaround

Use Save As to save an object with a new name after the import. (WBRT-8724)

• An empty space can appear on Grid Widget (or Whole widget can become empty) after some action
involving sorting and scrolling.

Workaround

Scroll the grid up or down. (WBRT-7441)

• Scrollbars are always visible on the Grid widget and Data View even if they are not needed.
(WBRT-6881)

• Starting from release 8.5.104.01, the Genesys Pulse top level menu, including the Genesys Pulse User
menu, is different from the Platform Administration menu. The Genesys Pulse User menu does not
provide the ability to set a user's home page or change the user or system preferences.

Workaround

Switch to Platform Administration to access all menu options. (WBRT-6785)

• The Link to Configuration Manager for shared dashboards and templates does not work with Platform
Administration release 8.5.000.xx.

Workaround

Navigate manually to Platform Administration Configuration Management. In Environment/Scripts,
you can find the Genesys Pulse Dashboards and Templates saved in Configuration Server as
scripts. (WBRT-7405)

• Genesys Pulse becomes unresponsive while switching between dashboards.
Workaround

Reduce the number of widgets per dashboard (especially grid and line widgets). (WBRT-7020)

• Users cannot select or clear a selection from the All columns in the Data view on an expanded widget.
Workaround

To clear selection or select all, users must manually click on every column. (WBRT-7005)

• Widgets positions are not preserved during dashboard cloning.
Workaround

After cloning a dashboard, move the widgets to desired positions manually. (WBRT-6935)

• The order of rows in the Genesys Pulse Data view in an expanded widget might change and became
unpredictable when you hide the statistic used for sorting, although the column Name is still
highlighted as sorted by.

Workaround

Sort again by the desired column. (ARK-1604, WBRT-7019)
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• Lists in the Widget and Template wizards might display partial data after switching between tabs and
returning to previous steps.

Workaround

Scroll the list up or down until data appears. (ARK-1602, ARK-1422, WBRT-6966)

• If the same dashboard is opened in two different browsers (or different windows of the same browser),
changes made in a widget on the dashboard in one session might be not applied to the second session.

Workaround

Reload your browser window to synchronize the updated information in the second session.
(ARK-1424)

• Users with Genesys Pulse View Dashboard privilege only cannot download debug info immediately after
switching to debug mode.

Workaround

After switching to debug mode, reload the page. (WBRT-4971)

• Genesys Pulse does not immediately update Agents added to an Agent Group (including Virtual Agent
Groups that use scripts) in widgets with Quick updates enabled. Genesys Pulse updates the agents
when you receive a full snapshot. (WBRT-4900)

• The Line Widget not available in the widget wizard when objects are selected By Group. (WBRT-5282)
• In widgets that are expanded to tab, you can no longer print directly from the widget.

Workaround

Starting from Genesys Pulse release 8.5.x, printing is replaced with the Download Widget option.
You can save the widget as a CSV file, which can then be printed. (WBRT-3722)

• The object display name format configured in Genesys Pulse Collector option object-name-format may
not correspond to the object display format in the Object picker of Wizard. It works for Widget display
only, but not for the Object selector. (WBRT-3186)

• Statistic and object names overlap each other when you click the All Statistics checkbox in Grouped Bar
charts several times. (WBRT-2583)

• When you add or edit a widget, Genesys Pulse cannot load all the objects in the Select object dialog box
if there are more than 2000 objects. (WBRT-3219)

• Statistics that have values of string type cannot be displayed in the chart. You must use the Grid to view
statistics with values of string type. (WBRT-1633)
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Real-Time Reporting (v9)
For information about the latest releases of Real-Time Reporting, see Real-Time Reporting (Genesys
Pulse) Release Notes.

Note: Not all changes listed below may pertain to your deployment.

• September 28, 2020 (9.0.006.00)
• June 29, 2020 (9.0.005.02)
• March 6, 2020 (9.0.004.04)
• Known Issues

September 28, 2020 (9.0.006.00)

Resolved Issues

• The CVE-2020-11612 vulnerability is resolved. (WBRT-14288)
• The CVE-2019-11358 vulnerability is resolved. (WBRT-14223)
• Genesys Pulse is now properly propagates Widget Template changes. Previously, in rare cases, Widget

Template changes were not propagated to other user's Widgets due to the "Could not connect to
database" error message. (WBRT-14196)

• Genesys Pulse no longer provides API endpoints exposing potentially sensitive information from
Configuration Server. (WBRT-14106)

• The Widget Count column of the Widget Management screen now updates correctly. Previously, it did
not show the actual values after remove operations were performed from the same screen.
(WBRT-14037)

• Multilingual characters of shared Dashboard, Wallboard, or Widget Template can now be saved in
Configuration Server. (WBRT-13955)

• Genesys Pulse is now displaying the reason of failed login attempt when using GWS SSO page and
allows user to navigate back to the login page for retry. Previously, the raw error text was shown
without ability to re-enter login credentials. (WBRT-13563)

• Genesys Pulse user logout is now terminating only its own session while sessions in other Genesys
applications using GWS SSO remain intact.(WBRT-12408)

• Genesys Pulse now detects preferred languages set via the "Settings / Internet Options / Languages"
dialog in Internet Explorer 11. (WBRT-11713)
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• The object selection in Widget with the allowed object type DN/Queue Group is now restricted to ACD
Queues and Service Numbers groups. Previously, unsupported Network Ports and Single Ports
groups were available for selection. (WBRT-7048)

June 29, 2020 (9.0.005.02)

What's New

• Support of Screen Readers.

Resolved Issues

• Alert Widgets now can be edited by users without Pulse Manage Users privilege. (WBRT-14033)
• Dashboard, Wallboard, or Widget Template can now be saved only to the appropriate sub-folder of

Configuration Unit or Site folder. (WBRT-13973)
• Improved application stability and availability: decreased possibilities of errors when attempting to login

into Genesys Pulse. (WBRT-13932)
• Voice statistics are being updated in widgets based on the Agent Login template. (WBRT-13426)
• Genesys Pulse now updates values in widgets based on eServices Queue KPIs template. (WBRT-13410)
• If the Language specified via GAX User preferences and the browser's interface language is not

available among installed Language Packs, Genesys Pulse interface falls back to English. (WBRT-13088)
• "Select All" check boxes now reflect partial selection in tables on Management Screens. (WBRT-12042)

March 6, 2020 (9.0.004.04)

What's New
User Interface

• Ability to change Language and Time Zone preferences from the user menu in the Genesys Pulse
navigation bar. Language and Time Zone selected in GAX User preferences menu are automatically
picked up by Genesys Pulse User Preferences but not vice versa.

• Dutch (Netherlands) Language support.
• Keyboard Navigation support.
• Changes in the User Interface to match recent Genesys User Experience guidelines.
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• New Alert Widget template. It allows you to create and configure an Alert widget to monitor all
widgets alerts from a single panel, which provides a notification center for multiple dashboards.

• Ability to specify thresholds for alerts in decimal numbers.
• A dark theme is now available for the Wallboard in fullscreen mode.
• Ability to display broadcast information to its audience with a new Text Widget type. The new Text

Widget can be displayed as a news feed ticker and edited by Administrators.
• Line Chart view is now renamed to Time Tracking view.
• The transpose mode is now added to the Time Tracking view and for Line Widget.
• You can now pin the Name column in the Grid Widget as defined by the Display Options.
• Ability to select or clear selections from columns in the Data view on the expanded widget using the

new Select All.
• The Grid Widget and the Data View have new Compact and High Color Contrast modes. New options

are available on the Display Options tab of the Widget Wizard for the Grid widget and in the new
Customize menu of the Data view:
• Row Density:

Comfy (default) or Compact–Enables compact presentation for the high data density
• Row Color Contrast:

Low (default) or High–Enables High Color Contrast for better accessibility

• The Name column is now always pinned in the Data View.
• Ability to filter rows in the Grid Widget and Data View by column to display the current agent status

even if the Show Agent State Icon is enabled for this statistic.
• If the user has no access to the selected objects in the view or headline of the widget, instead of

showing "Object Unavailable", Genesys Pulse displays other objects from the selected objects in the
widget.

• Ability to show or hide the widget title for any type of widgets.

Administration

• New display format status. This new display format is applicable only for statistics using Statistical Type
ExtendedCurrentStatus. It allows to specify values displayed for the status (icon, name, media,
duration) or use user-defined formatting based on JavaScript string literals syntax), to show "Do Not
Disturb" status with its duration and to select current status statistics on any chart.

• You can propagate template changes to user's widgets without recreating the existing widgets from
scratch. Genesys Pulse asks you to propagate changes when you save updates to the template if there
are any widgets based on that template.

• Ability to track the number of dashboards and widgets used, remove or deactivate obsolete widgets
based on additional information related to the widgets (last modified date).

• Limits for both personal Widgets and Dashboards (including wallboards). This functionality is supported
by new configuration options on the Annex tab of the Access Groups :
• max_tabs_per_user
• max_widgets_per_user

• Ability to embed custom links to any third-party website in the Navigation bar.
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Support

• Genesys Pulse is no longer a GAX plug-in.
• Genesys Pulse now supports SSO via GWS.
• Genesys Pulse now supports the SameSite=strict cookie attribute in order to mitigate the risk of a

cross-origin information leakage.
• Genesys Pulse now supports the following browsers:

• Microsoft Internet Explorer 11
• Microsoft Edge 44, 79+
• Mozilla Firefox 70+
• Google Chrome 77+
• Apple Safari 12+

Localization Support

Genesys Pulse supports the following localizations:

• Arabic: 9.0.004.01
• Chinese (Simplified): 9.0.004.01
• Czech: 9.0.004.01
• Dutch 9.0.004.01
• French: 9.0.004.01
• French Canadian: 9.0.004.01
• German: 9.0.004.01
• Italian: 9.0.004.01
• Japanese: 9.0.004.01
• Korean: 9.0.004.01
• Polish: 9.0.004.01
• Portuguese: 9.0.004.01
• Russian: 9.0.004.01
• Spanish: 9.0.004.01
• Turkish: 9.0.004.01

Resolved Issues

• The "Select All" checkbox in Dashboard, Wallboard, and Widget Template Management interfaces does
not work when the "Search by Column" function is enabled.
Workaround: Disable the "Search by Column" function. (WBRT-14405)

• Genesys Pulse Collector now allows up to 4999 characters in the VAG script. (WBRT-12667)
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• Formula-based statistics for Skills levels now reflect skill-level changes made in the object properties.
(WBRT-12655)

• The selection of a Campaign Group object now works properly on the Objects tab of the Widget Wizard.
(WBRT-12436)

• The session token, which is stored in cookies, is now invalidated before a new login for security reasons.
Previously, the same token value was reused for each user logging in from the same browser.
(WBRT-12380)

• The First and Last name of the current user is now displayed in the navigation bar. Previously, the
username was displayed in the navigation bar. (WBRT-12370)

• Grid widgets that contain statistics with Group By columns do not show drill-down rows when no Group
By columns are selected. (WBRT-12302)

• The username is no longer stored in the browser's local storage for security reasons. (WBRT-12161)
• To improve Genesys Pulse performance under high load, an excessive number of database transactions

are no longer opened. (WBRT-12157)
• For security reasons, the server name and the version are no longer present in HTTP headers and on

error pages. (WBRT-12152)
• It is now possible to store Dashboards, Wallboards, and Templates in folders inside Configuration Unit or

Site folders of Configuration Server. (WBRT-12092)
• The Abandoned formula in the Chat Queue Activity template is corrected to exclude the current number

of waiting chats. The Abandoned_15M statistic is removed from the template. (WBRT-12010)
• Genesys Pulse Collector correctly calculates formula-based statistics that contain the ERROR value

along with valid values (WBRT-11709)
• The correct error message with explanations is shown on the login page if a user does not have the

Read access to its own Person object in Configuration Server. Previously, there was no error messages
in such case. (WBRT-11231)

• The Line widget now always shows the first line segment for the selected time interval. (WBRT-11604)
• Genesys Pulse properly handles the situation if a shared Dashboard or Wallboard, without any title, is

published using API. (WBRT-11468)
• Folders in Wallboard/Dashboard and Widget Template management are now correctly displayed.

Previously, the structure of folders might become incorrect after the clone operation. (WBRT-11338)
• Users do not lose active dashboards if any of the management screens are opened before the loading of

launched dashboards is completed. (WBRT-10713)
• The following vulnerabilities are resolved: CVE-2018-7489, CVE-2018-1199, CVE-2017-15095,

CVE-2017-7525, CVE-2015-9251, CVE-2015-2156, CVE-2014-3488, CVE-2014-0193, CVE-2014-0107,
CVE-2013-4517. (WBRT-10623)

• The Wait Time statistic in widgets created from the Queue KPIs template now shows proper values.
Previously, values shown could be up to two times larger than the correct values. (WBRT-9277)

• The user with Read access is not allowed to move the Dashboard/Wallboard/Widget Template from one
folder to another folder of the same tenant. Previously, such object could be moved even if the "Access
Forbidden" message was shown to the user. (WBRT-9612)

• When the Group-By functionality is enabled for a widget, the Line chart and the Time Tracking chart now
display correct data. (WBRT-9498)

• Genesys Pulse now checks that the data being imported is compatible with the current version of
Genesys Pulse. Previously, during the import it was possible to select incompatible data exported from
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the newer version of Genesys Pulse. The data from an old version still can be imported to the newer
version of Genesys Pulse. (WBRT-9417)

• The column width in the Grid Widget is now preserved between page reloads even when it is changed
by a double click. Previously, changes in the column width were preserved only if the column had been
resized by dragging the column border. (WBRT-9384)

• The Current AWT statistic in widgets created from the Queue KPIs template now has a correct value.
(WBRT-9204)

• The Cancel button now works correctly in the Move To dialog. Previously, the button closed the dialog,
but did not stop the moving process. (WBRT-8848)

• A unique number is now added to imported objects if they are identical to existing objects. Previously,
they were imported with the same name. (WBRT-8724)

• Thin sectors of Donut charts are now displayed properly. (WBRT-8713)
• Genesys Pulse no longer has memory leakage when you switch between tabs. (WBRT-8661)
• All Genesys Pulse tabs and windows within the same browser log out and in simultaneously, which

prevents you from creating malfunctioning or losing widgets or tabs. (WBRT-8596)
• Autoplay functionality in KPI and Donut widgets now continues to function when you switch between

pages. (WBRT-8520)
• You can now successfully save template changes after a series of edits including renaming and

overwriting the template. Previously in this scenario, Genesys Pulse displayed a TEMPLATE_NOT_FOUND
message. (WBRT-8502)

• You can no longer perform any actions while the Genesys Pulse DB is unavailable. Previously when you
performed actions, you might lose widgets and tabs that you previously created. (WBRT-8424)

• Genesys Pulse now correctly displays statistics with different formats and values on line widgets.
Previously, the statistics might have been incorrectly scaled. (WBRT-8355)

• Your changes to the Grid widget settings are now preserved after you edit the widget. Previously,
settings such as column width and filter were reset to their default values. (WBRT-8304)

• Genesys Pulse leaves the column menu open when you unselect column. Previously, it might close.
(WBRT-8254)

• Downloads for Dashboards, Wallboards, Templates, and Widgets now start automatically in the Safari
browser. (WBRT-8075)

• Items can now be successfully selected on touch screen computers using the mouse. Previously, in
Google Chrome browser, items could not be selected by the mouse on touch screen computers.
(WBRT-8072)

• Date and time in the Wallboard, launched to a full screen, are now formatted according to the selected
locale. Previously, the selected locale did not affect the date and time formatting. (WBRT-7732)

• Scroll bars in Grid Widget and Data View have an updated style are now hidden when they are not
needed. (WBRT-6881)

Known Issues

• SSO login is not enabled for tenants with Private MPLS provisioned for Genesys Pulse. (WBRT-15017)
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• Widget Count columns on the Widget Management screen do not show the actual values after remove
operations performed from the same screen.
Workaround:
Use the Refresh button. (WBRT-14037)

• The Use System Settings option selected for Language or Time Zone in GAX User preferences is not
picked up by the Genesys Pulse User preferences. (WBRT-13055)

• Genesys Pulse interface uses an invalid Time Zone if the Time Zone, specified via GAX User preferences,
is removed.
Workaround:
Change the Time Zone to the available one using Genesys Pulse User preferences menu.
(WBRT-13024)

• Management screens might become not accessible by keyboard navigation after Search operations with
no results. (WBRT-12384)

• Widget Template changes cannot be propagated to deactivated widgets. (WBRT-12344)

• The Grid Widget and Data View that contain statistics with Group By columns might reset the vertical
scroll position within the next data update. (WBRT-12275, WBRT-11792)

• Lists in Wizards might display partial data after switching between tabs and returning to previous steps.
Workaround:
Scroll the list up or down until the data appears. (WBRT-12177, WBRT-6966)

• The Stacked Bar Chart values are not accessible by keyboard navigation. (WBRT-12175)

• Widgets on the Wallboard launched to full screen might overlap each other in rare conditions.
Workaround:
Visit the Wallboard tab, containing overlapped widgets, and relaunch to full screen
afterward. (WBRT-12089)

• The scrollable content of the Text Widget, List Widget, and Donut Widget is not accessible by keyboard
navigation. (WBRT-11838)

• Languages which are set in Internet Explorer 11 via the "Settings / Internet Options / Languages" dialog
could not be detected by Genesys Pulse. The language of the browser interface is used instead.
Workaround:
Change the browser interface language by setting an appropriate language pack for
Internet Explorer 11 or use newer Microsoft Edge browser. (WBRT-11713)

• Currently, daylight saving time (DST) works only if the user preferences are set to anything other than
system settings in GAX. When the user preferences are set to system settings, the system preferences
show DST time correctly if use local is selected. Selecting a specific timezone in system preferences
with a certain offset will hard code the offset to be literally what is shown, without adjusting for DST.
(WBRT-8275)

• Genesys Pulse becomes unresponsive while switching between dashboards.
Workaround:
Reduce the number of widgets per dashboard (especially grid and line widgets).
(WBRT-7020)

• The object display name format, configured in Genesys Pulse Collector option object-name-format may
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not correspond to the object display format in the Object picker of Wizard. It works for Widget display
only, but not for the Object selector. (WBRT-3186)

• Genesys Pulse Collector might terminate unexpectedly if String.localCompare() is used in the formula.
(WBRT-13098)
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Genesys Softphone
For information about the latest releases of Genesys Softphone, see Genesys Softphone Release
Notes.

Note: Not all changes listed below may pertain to your deployment.

• April 23, 2021 (9.0.015.04)
• March 25, 2021 (9.0.015.03)
• December 21, 2020 (9.0.014.13)
• December 17, 2020 (9.0.014.12)
• September 24, 2020 (9.0.013.03)
• June 25, 2020 (9.0.012.04)
• April 30, 2020 (9.0.011.03)
• February 27, 2020 (9.0.010.08)
• December 10, 2019 (9.0.009.05)
• November 14, 2019 (9.0.009.03)
• August 30, 2019 (9.0.008.05)
• June 27, 2019 (9.0.007.09)
• May 10, 2019 (9.0.006.02)
• April 5, 2019 (9.0.005.10)
• March 8, 2019 (9.0.005.08)
• December 21, 2018 (9.0.004.10)
• July 2, 2018 (9.0.003.04)
• May 31, 2018 (9.0.002.06)
• March 29, 2018 (9.0.001.01)
• January 23, 2018 (8.5.401.05)
• December 20, 2017 (8.5.401.03)
• July 13, 2017 (8.5.400.04)
• May 5, 2017 (8.5.300.07)
• March 23, 2017 (8.5.300.04)
• December 10, 2015 (8.5.200.10)
• Known Issues
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April 23, 2021 (9.0.015.04)

What's New
Resolved Issues

• Genesys Softphone now plays local DTMF feedback tones correctly for calls established in Opus codecs.
Note: When a stereo output device is used for playback, the feedback tones are played on the left
channel only. This is by design, to differentiate them from the incoming audio stream.
(SOFTPHONE-1057)

March 25, 2021 (9.0.015.03)

What's New

• Support for macOS 11 (Big Sur) operating system. The Apple M1 processor is supported through the
macOS 11 Rosetta 2 compatibility feature. See the Genesys Softphone page in the Genesys Supported
Operating Environment Reference Guide for more detailed information and a list of all supported
operating systems.

• Genesys Softphone now ships with several ringing tones corresponding to the same sound but with
different levels of loudness. These files can be used in the Softphone ringing tone configuration. Also,
the legacy default ringing.wav file is now 10dB lower than previously.

• In a macOS environment, it is now possible to install Genesys Softphone so that it runs automatically
when the agent is opening the OS session.

• Genesys Softphone using WebRTC now interacts with Agent Desktop (WWE) to transparently renew their
connection when the WebRTC Gateway session has expired. Previously, after a long session, the DN
changed to Out of Service and agents had to logout and login to re-establish the session.

Resolved Issues

• In macOS environments, the audio quality interactive alerts now show up as configured.
(SOFTPHONE-1035)

• In a macOS environment, when configured in connector mode, Genesys Softphone now automatically
recycles at the end of a Registration session to preserve long-term stability in cases of long-running OS
sessions. This behavior is controlled in the configuration file by the option
policy.connector.auto_restart=1. (SOFTPHONE-951)
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December 21, 2020 (9.0.014.13)

Resolved Issues

• The Softphone Telemetry is now fully operational. Previously, starting with version 9.0.014.12, part of
the Telemetry stream was no longer reported. (SOFTPHONE-998)

December 17, 2020 (9.0.014.12)

What's New

• Genesys Softphone now automatically re-tries SIP registration attempts if the DNS fails to resolve the
SIP FQDN on startup.

• Genesys Softphone can now be installed on macOS version 10.15 Catalina.

Resolved Issues

• In Connector mode, the Agent Desktop client session clean-up is improved. (SOFTPHONE-992)
• The selection of Secure Real-Time Transport Protocol (SRTP) over non-secure RTP is improved.

(SOFTPHONE-977)
• A call to the API DELETE /softphone/v2/session now sets the path attribute correctly to ensure that

the session cookie is removed. (SOFTPHONE-956)
• When an API call to /softphone/v2/audio is populated with an invalid request body, Genesys

Softphone now responds with a 400 Bad Request error message. (SOFTPHONE-955)

September 24, 2020 (9.0.013.03)

What's New

• When Genesys Softphone is running in Connector mode and is used as the voice channel support for a
user-facing Agent Desktop application, it does not prevent this user-facing application from claiming
WCAG 2.1 levels A and AA when the application supports this format for its own UI.

Resolved Issues

• When the Administrator selects Standalone mode while executing the Genesys Softphone installation
package (interactive or silent) to upgrade from a previous version, it is now possible to specify whether
the new version will overwrite the existing Softphone.config file or preserve the former version of the
configuration file. (SOFTPHONE-941)
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• Genesys Softphone has improved recovery from audio device failures adding additional attempts to
restart the audio stream in case of errors. (SOFTPHONE-931)

• In environments where SIP is configured over TCP or TLS, the resiliency to connection errors has been
improved. Previously, in case of connectivity errors at SIP Registration time, there could be a long delay
in the registration process. (SOFTPHONE-928)

• The HTTP REST API exposed to application developers now ignores letter case in HTTP Headers.
(SOFTPHONE-899)

June 25, 2020 (9.0.012.04)

What's New
Localization support

• Genesys Softphone is now localized in the following languages: Arabic, German, Spanish, French, French
(Canada), Italian, Japanese, Korean, Dutch, Polish, Portuguese (Brazil), Russian, Turkish, Chinese
(Traditional), and Chinese (Simplified).

Resolved Issues

• In Connector mode, Genesys Softphone now better supports situations where the client (for example,
WWE) did not fully initialize the connector session. Previously, in that situation, Genesys Softphone
required a restart to be able to accept a new client session. (SOFTPHONE-878)

• In Standalone mode, Genesys Softphone no longer exits unexpectedly when a new call is received in
environments where the setting gui_tabs does not contain the value calls.(SOFTPHONE-864)

• Genesys Softphone now correctly accepts "best-effort SRTP" offers (RFC 5939). (SOFTPHONE-856)
• In Connector mode, the resiliency of the session management by Genesys Softphone was improved

under conditions where the request sequence from the connector client around the end of the session
is not reliable. Previously, under those conditions which could happen when the client browser
encounters performance issues, a manual Genesys Softphone restart might have been required.
(SOFTPHONE-854)

April 30, 2020 (9.0.011.03)

What's New
Resolved Issues

• DNS resolution resiliency has been improved to reduce the impact of system delays on the endpoint.
(SOFTPHONE-853)

• VS2013 Redistributable Update 5 is included in the Genesys Softphone Installation Package.
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(SOFTPHONE-845)
• Developers can now use the /softphone/v2/register API endpoint in deployments where Genesys

Softphone is configured to run in WebRTC mode. (SOFTPHONE-842)
• When Genesys Softphone is configured to run in Connector mode, it is no longer possible to manually

start a second instance of the process. Previously, when Genesys Softphone restarted automatically at
the end of a first agent session, agents could start a second instance manually. (SOFTPHONE-825)

February 27, 2020 (9.0.010.08)

What's New
Resolved Issues

• Agent Desktop now correctly connects to Genesys Softphone when Softphone is installed on a non-
English Windows Operating System in Connector mode with a self-signed certificate. (SOFTPHONE-821)

• In environments where Genesys Softphone connects to the WebRTC Service through an HTTP Proxy, the
resilience of the connections has been improved. (SOFTPHONE-810)

December 10, 2019 (9.0.009.05)

What's New
Browser connectivity support

• When running in Connector mode with HTTPS enabled, Genesys Softphone now sets cookies with the
following attributes:
• SameSite=None
• Secure

This enables connectivity support for the forthcoming versions of Chrome (v80 in February 2020)
and Firefox that will reject insecure SameSite=None cookies for security reasons.

November 14, 2019 (9.0.009.03)

What's New
Windows Server 2019 support
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• Support for Microsoft Windows Server 2019 operating system for Genesys Softphone.
• Support for Microsoft Hyper-V Server 2019 for VDI deployments.

HTTP REST API support

• You can now deploy Genesys Softphone in Connector Mode and control it from a custom agent
desktop by using an HTTP REST API, similar to how Genesys Softphone integrates with Workspace Web
Edition and Workspace Desktop Edition for configuration, registration, and volume control.

Resolved Issues

• In multi-region deployments, switch-over is now limited to situations where all the resources of the
primary region are unavailable. (SOFTPHONE-741)

August 30, 2019 (9.0.008.05)

What's New
Quality of Service improvement

• The determination of the quality of service of the Voice channel has been improved.

Ringtones for auto-answered calls

• Genesys Softphone can now be configured to play the specified ringtone once for its full duration, even
if the call is answered while the tone is playing. This capability is most applicable to environments
where Genesys Softphone or the agent application is set up to answer calls automatically.

June 27, 2019 (9.0.007.09)

What's New
FIPS 140-2 compliancy

• Genesys Softphone secured communication channels, such as Secured RTP, are now compliant with
FIPS 140-2.

TLS 1.2 support

• You can now force the communication between Agent Desktop and Genesys Softphone to use TLS 1.2
by setting the "sec_protocol" option in the "connector" section of the softphone.config file to the value
"TLSv12".

Genesys Softphone Screen Recording Service

Genesys Engage cloud Release Note 372

https://docs.genesys.com/Documentation/PSAAS/Public/Administrator/SPOptions#ringing_file


Resolved Issues

• Genesys Softphone improved audio processing during hold/retrieve operations when interoperating with
other SIP clients, such as Microsoft Skype for Business. (SOFTPHONE-704)

• Genesys Softphone HTTP connector security has been improved. (SOFTPHONE-634)

May 10, 2019 (9.0.006.02)

What's New
Virtual Environments

• Genesys Softphone can now be installed on all supported Windows 32-bit operating systems.
(SOFTPHONE-657)

• Support for Windows 2016 in Citrix VDI environments. (SOFTPHONE-626)

WebRTC support for disaster recovery

• When integrated with Agent Desktop 9 in a WebRTC environment, Genesys Softphone automatically
follows Agent Desktop fail-over from primary to backup. (SOFTPHONE-623)

Resolved Issues

• The security of the Genesys Softphone HTTP Connector has been improved by limiting the maximum
size of the HTTP Request body. (SOFTPHONE-665)

• The robustness of the connectivity between Genesys Softphone and the WebRTC Gateway has been
improved to reduce the number of session disconnections. (SOFTPHONE-662)

• Genesys Softphone has been improved to prevent distortion at the beginning of calls on certain
headsets. (SOFTPHONE-649)

April 5, 2019 (9.0.005.10)

What's New
Resolved Issues

• Genesys Softphone no longer fails to establish a second WebRTC request through an HTTP Proxy when
the second request immediately follows the first. Previously, a 3pcc SingleStepConference initiated
from Agent Desktop could fail in a deployment where an HTTP Proxy was configured. (SOFTPHONE-638)
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March 22, 2019 (9.0.005.09)

What's New
Resolved Issues

• The analysis of voice call quality has now been improved so that agents no longer receive misleading
voice call quality alerts immediately after a call has been established or retrieved. (SOFTPHONE-631)

• You can now deploy Genesys Softphone in connector mode set up with a Self Signed Certificate so that
it can be configured and activated from Agent Desktop running in Firefox. Previously, starting with
Firefox version 57, it was not possible to use the self-signed certificate of the HTTPS connector from a
web application running in Firefox. (SOFTPHONE-545)

March 8, 2019 (9.0.005.08)

What's New
HTTP Proxy support

• Genesys Softphone running with WebRTC signaling now supports HTTP Proxy with no authentication
enabled.

Virtual desktops

• Genesys Softphone can now be deployed in the Citrix XenApp 7 and XenDesktop 7 virtual desktop
infrastructures. Deployment requires Genesys Softphone VDI Adapter to be installed on the client
workstations. Refer to the Supported OS and the Supported Virtualization system guides for details
about the supported versions.

Resolved Issues

• When Genesys Softphone is set up to communicate with Genesys Engage cloud through WebRTC
protocol, the HTTPS certificate verification now behaves as expected. Previously, under some network
conditions, the certificate could be incorrectly refused. (SOFTPHONE-622)

• Genesys Softphone now correctly initializes when it is using HTTP Connector and Agent Desktop is
specifying a different log setting than the Softphone configuration file. (SOFTPHONE-608)
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December 21, 2018 (9.0.004.10)

What's New
Resolved Issues

• Genesys Softphone is now able to maintain a sticky registration session with one data center when the
connectivity is significantly delayed. (SOFTPHONE-568)

• Genesys Softphone now correctly displays audio device names that are defined with 2-byte characters
(for example, Japanese characters) in the 'devices' view of the user interface. Previously, these audio
device names were not displayed in the Softphone user interface. (SOFTPHONE-547)

• Genesys Softphone no longer insecurely stores connectivity credentials. (SOFTPHONE-564)
• You can now use Environment Variables and both forward slash and backslash characters when you

specify the path to the Genesys Softphone log file using the
sipendpoint.system.diagnostics.log_file option in Agent Desktop. (SOFTPHONE-561)

• Calls no longer get dropped if it takes extra time to establish the audio portion for a particular call.
(SOFTPHONE-529)

July 2, 2018 (9.0.003.04)

What's New
WebRTC Media Service

• Genesys Softphone can now handle both inbound and outbound voice calls by communicating with the
Genesys Engage cloud platform through the WebRTC Media Service. Signaling and media encryption
capabilities of WebRTC Media Service ensure appropriate security for voice communications over the
public network. This communication supports G.711 and Opus codecs.

Resolved Issues

• The change of IP Address detection has been improved when, for example, the workstation switches
from a wired network connection to a WiFi connection. (SOFTPHONE-485)

May 31, 2018 (9.0.002.06)

What's New
Local IP address
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• The local IP address selection mechanism of Genesys Softphone has been improved to better support
environments where the network to be used for SIP Communication, typically a VPN, is enabled after
Genesys Softphone has started SIP registration. Edit the configuration file that is included with your
Genesys Softphone package to set the value of the 'public_address' option to the network subnet
addresses: "$net:<subnet>". For example: "$net:192.168.0.0/16".

Automatic Gain Control

• Genesys Softphone now supports Automatic Gain Control for the customer audio stream. This allows
agents to hear their customers with a normalized volume level, meaning that they will not have to
constantly manually adjust the volume controls. Edit the configuration file that is included with your
Genesys Softphone package to set the value of the 'rx_agc_mode' option to '1'.

Resolved Issues

• If the HTTP Connector does not allow proper operations of Genesys Softphone in Agent Desktop, agents
are now informed by a message in the System Tray. (SOFTPHONE-447)

• When Genesys Softphone is installed with a Secured HTTP connector based on a self-signed certificate
by an Administrator, agent can now run Genesys Softphone with a non-Admin Windows account.
(SOFTPHONE-472)

March 29, 2018 (9.0.001.01)

What's New
Real-time voice quality indicator

• The Genesys Softphone icon in the system taskbar now notifies agents of possible voice quality
problems.

Resolved Issues

• Genesys Softphone now better handles the sending of dialing tones in different connection scenarios.
(SOFTPHONE-398)

• The Disaster Recovery mechanism that switches from one Session Border Controller to another has
been improved. (SOFTPHONE-408)
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January 23, 2018 (8.5.401.05)

What's New
Resolved Issues

• Genesys Softphone now continues to leverage a particular SIP Proxy location after it handles an
incomplete or timed-out SIP Communication from SIP Proxy. (SOFTPHONE-359)

• Genesys Softphone no longer drops outgoing calls when it has an issue initiating a connection with SIP
Server. (SOFTPHONE-366)

• Genesys Softphone now uses the Default Communication Device specified in Windows Audio Settings
when no audio device is specified in provisioning or the specified device is not found. (SOFTPHONE-362)

• Genesys Softphone now uses the audio-in and audio-out devices that you specify when you edit the
application configuration file. Previously, if the entire name of the device was specified, the device was
not found. (SOFTPHONE-360)

December 20, 2017 (8.5.401.03)

What's New

• For improved security, the local IP address is no longer included in the Call-ID header of SIP messages
sent by Genesys Softphone.

• You can now specify the value for the 'headset_name' option when the value of the 'use_headset' option
is set to '1' (indicating that Genesys Softphone selects the device specified as the default in the
Windows Audio Settings). Previously, the value was not supported as a valid value.

July 13, 2017 (8.5.400.04)

What's New

• You can now specify the TCP port range used for client-originated connections when SIP communication
is configured to be transported over TCP or TLS protocol by using the tcp_port_min and tcp_port_max
options.

• The resilience of Genesys Softphone during network events, such as an IP address change, caused by
workstation Sleep/Wake, VPN Connect/Disconnect, and so on, has been improved. This new behavior is
permanent.

• You can now configure Genesys Softphone to include the MAC address of the host in the SIP message
headers. This capability is enabled by using the include_mac_address option.

Genesys Softphone Screen Recording Service

Genesys Engage cloud Release Note 377



• Genesys Softphone installation package now upgrades the application when it detects that an older
version is already installed on the workstation. It is no longer possible to install multiple instances of
Genesys Softphone on a single workstation.

• Genesys Softphone is rebranded to reflect the new Genesys logo.

May 5, 2017 (8.5.300.07)

What's New

• Genesys Softphone now supports DNS SRV resolution for the URI specified in the server parameter of
the Connectivity tag. You do not need additional configuration to enable this feature, but as described
in RFC 3263, you should not include the port number in the server URI.

March 23, 2017 (8.5.300.04)

What's New

• Genesys Softphone now uses the pjNAT library for improved ICE, STUN & TURN support.
• The payload type for the telephone-event is now set correctly in the SDP Answer. Previously, Genesys

Softphone put in the SDP Answer the payload type selected from a previous offer instead of using the
payload type delivered in last SDP Offer, causing problems with some equipment that does not support
asymmetric RTP payloads.

• You can now configure the Domain to be specified in the SIP REGISTER request separately from the
address when this request is sent by using the domain option of the proxies sections.

December 10, 2015 (8.5.200.10)

What's New

• Basic first party call control, including answer, hold, retrieve, and hang up.
• Support of multiple DNS A-records for multisite deployments.
• Windows 10 support.
• Removal of the Microsoft .NET framework as a dependency.
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Known Issues

• A Chromium-based browser with the policy RequireOnlineRevocationChecksForLocalAnchors
enabled cannot open an HTTPS connection to the Genesys Softphone Connector. (SOFTPHONE-1064)

Workaround:

To avoid this issue, ensure that this policy is not enabled in your browser. For example, to do this
for Google Chrome, go to the Windows registry and add or modify the HKEY_LOCAL_MACHINE\
SOFTWARE\Policies\Google\Chrome key as follows:

• Name: RequireOnlineRevocationChecksForLocalAnchors
Type: REG_DWORD

Value data: 0

Further information for Google Chrome can be found in the Chrome Enterprise policy list.

For Microsoft Edge, you can find more information about this policy on the Microsoft Edge - Policies
page.
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Genesys Softphone VDI Adapter
For information about the latest releases of Genesys Softphone VDI Adapter, see Genesys Softphone
Release Notes.

Note: Not all changes listed below may pertain to your deployment.

• March 25, 2021 (9.0.015.03)
• December 17, 2020 (9.0.014.12)
• September 24, 2020 (9.0.013.03)
• July 2, 2020 (9.0.012.05)
• June 25, 2020 (9.0.012.04)
• April 30, 2020 (9.0.011.03)
• February 27, 2020 (9.0.010.08)
• November 14, 2019 (9.0.009.03)
• August 30, 2019 (9.0.008.05)
• June 27, 2019 (9.0.007.09)
• May 10, 2019 (9.0.006.02)
• March 22, 2019 (9.0.005.09)
• March 8, 2019 (9.0.005.08)
• Known Issues

March 25, 2021 (9.0.015.03)

What's New

• Genesys Softphone using WebRTC now interacts with Agent Desktop (WWE) to transparently renew their
connection when the WebRTC Gateway session has expired. Previously, after a long session, the DN
changed to Out of Service and agents had to logout and login to re-establish the session.
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December 17, 2020 (9.0.014.12)

What's New

• Genesys Softphone now automatically re-tries SIP registration attempts if the DNS fails to resolve the
SIP FQDN on startup.

Resolved Issues

• The selection of Secure Real-Time Transport Protocol (SRTP) over non-secure RTP is improved.
(SOFTPHONE-977)

September 24, 2020 (9.0.013.03)

What's New
Resolved Issues

• Genesys Softphone has improved recovery from audio device failures adding additional attempts to
restart the audio stream in case of errors. (SOFTPHONE-931)

• In environments where SIP is configured over TCP or TLS, the resiliency to connection errors has been
improved. Previously, in case of connectivity errors at SIP Registration time, there could be a long delay
in the registration process. (SOFTPHONE-928)

July 2, 2020 (9.0.012.05)

What's New
Resolved Issues

• In an eLux RP6 environment, Genesys Softphone VDI Adapter no longer exits unexpectedly when Citrix
ICA is established over a VPN. (SOFTPHONE-906)
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June 25, 2020 (9.0.012.04)

What's New
Resolved Issues

• Genesys Softphone now correctly accepts "best-effort SRTP" offers (RFC 5939). (SOFTPHONE-856)

April 30, 2020 (9.0.011.03)

What's New
Resolved Issues

• DNS resolution resiliency has been improved to reduce the impact of system delays on the endpoint.
(SOFTPHONE-853)

• VS2013 Redistributable Update 5 is included in the Genesys Softphone Installation Package.
(SOFTPHONE-845)

February 27, 2020 (9.0.010.08)

What's New
eLux RP6 64-bit support

• Genesys Softphone VDI Adapter can now be installed on the 64-bit version of eLux RP 6.
Limitation: The 32-bit version of eLux RP 5 is no longer supported.

Resolved Issues

• In environments where Genesys Softphone connects to the WebRTC Service through an HTTP Proxy, the
resilience of the connections has been improved. (SOFTPHONE-810)
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November 14, 2019 (9.0.009.03)

What's New
Resolved Issues

• In multi-region deployments, switch-over is now limited to situations where all the resources of the
primary region are unavailable. (SOFTPHONE-741)

August 30, 2019 (9.0.008.05)

What's New
Quality of Service improvement

• The determination of the quality of service of the Voice channel has been improved.

Ringtones for auto-answered calls

• Genesys Softphone can now be configured to play the specified ringtone once for its full duration, even
if the call is answered while the tone is playing. This capability is most applicable to environments
where Genesys Softphone or the agent application is set up to answer calls automatically.

June 27, 2019 (9.0.007.09)

What's New
FIPS 140-2 compliancy

• Genesys Softphone secured communication channels, such as Secured RTP, are now compliant with
FIPS 140-2.

Operating systems

• Genesys Softphone VDI Adapter can now be installed on eLux RP 5 Operating Systems to support
Genesys Softphone running in Citrix XenApp or XenDesktop environments.

Resolved Issues

• Genesys Softphone improved audio processing during hold/retrieve operations when interoperating with
other SIP clients, such as Microsoft Skype for Business. (SOFTPHONE-704)
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May 10, 2019 (9.0.006.02)

What's New
Resolved Issues

• The robustness of the connectivity between Genesys Softphone and the WebRTC Gateway has been
improved to reduce the number of session disconnections. (SOFTPHONE-662)

• Genesys Softphone has been improved to prevent distortion at the beginning of calls on certain
headsets. (SOFTPHONE-649)

March 22, 2019 (9.0.005.09)

What's New
Resolved Issues

• The analysis of voice call quality has now been improved so that agents no longer receive misleading
voice call quality alerts immediately after a call has been established or retrieved. (SOFTPHONE-631)

March 8, 2019 (9.0.005.08)

What's New
VDI Adaptor plugin

• Genesys Softphone VDI Adapter is installed as a plugin to the Citrix Workspace App (formerly known as
Citrix Receiver) on client workstations to enable Genesys Softphone to be deployed in the Citrix XenApp
7 and XenDesktop 7 virtual desktop infrastructures. Consult the Supported OS and Supported
Virtualization system guides for details about the supported versions.

Known Issues

• In eLux RP 6.x (64-bit) thin client environments, when using Pulse Audio as the default audio layer,
audio device selection made in the application takes no effect; audio always comes to/from the audio
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device selected in the eLux control panel. (SOFTPHONE-819)
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WebRTC Media Service
For information on later releases of WebRTC, click here: WebRTC

Note: Not all changes listed below may pertain to your deployment.

• April 22, 2021 (9.0.000.88)
• January 12, 2021 (9.0.000.80)
• October 14, 2020 (9.0.000.62)
• September 25, 2020 (9.0.000.61)
• August 31, 2020 (9.0.000.57)
• June 26, 2020 (9.0.000.56)
• May 06, 2020 (9.0.000.52)
• April 15, 2020 (9.0.000.51)
• April 03, 2020 (9.0.000.49)
• January 31, 2020 (9.0.000.47)
• November 07, 2019 (9.0.000.43 UPDATE)
• October 02, 2019 (9.0.000.41 UPDATE)
• July 03, 2019 (9.0.000.37 UPDATE)
• April 11, 2019 (9.0.000.37)
• December 21, 2018 (9.0.000.27)
• June 29, 2018 (9.0.000.15)
• Known Issues

April 22, 2021 (9.0.000.88)

What's New

• WebRTC metrics reporting to Prometheus monitoring system is expanded with a new metric named
wrtc_max_clients_per_instance to display the maximum number of agents that the WebRTC
instance can handle.

• WebRTC Media Service now supports proactive authentication renewal. This feature allows WebRTC
endpoints to refresh WebRTC authentication before its expiration in the WebRTC Media Service. The
proactive authentication renewal feature prevents service interruption due to the authentication
expiration of the WebRTC endpoints.
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• To reduce the number of stale HTTP connections, WebRTC Media Service now responds with the 200 OK
message to the previous /wait request if a new /wait request is received.

• ElasticSearch messaging is now extended with the following new fields:
• direction—to distinguish between incoming/outgoing messages
• logfile—to display the name of the current workflow logfile
• color—to mark the color of deployment that produced the ElasticSearch message

• WebRTC JavaScript API now supports proactive authentication renewal.
• WebRTC JavaScript API client now sends JSAPI-version in the /sign_in request.

Resolved Issues

• WebRTC Media Service now allows multiple browser tabs to be opened for the same session. The first
signed-in browser tab becomes the master tab within the session. This master tab handles all the
incoming and outgoing calls and interactions within WebRTC Media Service. Other browser tabs (clients)
within the same session are kept in the session queue. The maximum queue size is 5 clients. Any
subsequent sign-in beyond this limit is rejected.

When the master tab is signed out, the next tab in the queue becomes the master. When all the
browser clients sign out, the WebRTC Media Service session is closed. WebRTC Media Service handles
these multiple browser tabs by providing a unique tab id for each tab. This tab id is generated by the
WebRTC JSAPI library and passed to WebRTC Media Service via an HTTP request parameter. For
example: 'webrtc-uri/sign_in?tab=id12345'. Previously, all opened browser tabs sent long-polling/
wait requests with the same session id to WebRTC Media Service, which caused session conflicts.
(WRTCMS-557)

• WebRTC Media Service now correctly handles the rtcp-mux attribute in the WebRTC client re-INVITE SDP
and uses only one RTP component for the Interactive Connectivity Establishment (ICE) session.
Previously, this attribute was handled incorrectly when an initial offer was sent from the WebRTC Media
Service.

The incorrect handling of the rtcp-mux attribute sometimes caused WebRTC Media Service to select
two components for the ICE session (RTP+RTCP) instead of one (RTP). As a result, ICE checked for the
RTCP component failed and the media path was not established (to provide audio). (WRTCMS-689)

January 12, 2021 (9.0.000.80)

What's New

• TURN Server is upgraded to version 4.5.1.3.
• WebRTC metrics reporting to Prometheus monitoring system are expanded with a new metric named

wrtc_client_errors {type="dropped_on_signout"}. This metric is incremented when an active call
is dropped due to an agent sign-out. Also, the default value of the http-session-timeout option is
changed from 20 seconds to 60 seconds.

• WebRTC JavaScript API now uses flags in body parameters to provide additional information to the
WebRTC Media Service. This functionality is used to renew session authentication. This feature is
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available in WebRTC JavaScript 9.0.000.80.

Resolved Issues

• WebRTC Media Service no longer starts an authentication expiration timer when the browser client
sends a subsequent sign-in request due to page reload or connection errors. Previously in this scenario,
WebRTC Media Service incorrectly started an authentication expiration timer for 10 seconds. As a
result, a 403 Authentication Expired response was sent to the client and the client was stuck in an
unauthenticated state. (WRTCMS-550)

October 14, 2020 (9.0.000.62)

What's New
This release includes only resolved issues.

Resolved Issues

• WebRTC Media Service no longer prints RTP/RTCP packets to the log files. Previously, WebRTC Media
Service terminated unexpectedly when printing RTP/RTCP packets to the log file that contained the %r
symbol. (WRTCMS-522)

September 25, 2020 (9.0.000.61)

What's New

• When the number of concurrent authentication attempts exceeds the limit set by the new auth-conn-
limit option (whose default value is 280), WebRTC Media Service rejects the next authentication
attempt with an error code of 429 Too Many Requests.

• WebRTC Media Service now gets the session ID from cookies instead of from the request URI's session
identification parameter. This feature is supported in WebRTC Java Script API v9.0.000.61.
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August 31, 2020 (9.0.000.57)

What's New
This release includes only resolved issues.

Resolved Issues

• WebRTC Media Service moved the environment functionality to a separate thread. Also, WebRTC Media
Service now provides an anti-throttling mechanism that resolves the main thread deceleration.
(WRTCMS-476)

• Starting with release 9.0.000.47, WebRTC JavaScript client supports Edge Chromium 2020 browser.
(WRTCMS-483)

June 26, 2020 (9.0.000.56)

What's New

• WebRTC Media Service now adds the color label to WebRTC metrics that report to Prometheus
monitoring system. The value of the color label is configured in the api-path option that is used
during deployment for active and inactive deployment colors. That is, if WebRTC Media Service belongs
to green deployment and if api-path=green, then all metrics will contain the label color=green.

May 06, 2020 (9.0.000.52)

What's New

• WebRTC Media Service now quickly detects if the selected transport for a SIP Tenant is out of service
and searches for a new active transport using active in-service detection for SIP Tenants. Using active
in-service detection, WebRTC Media Service sends a request to the DNS server to resolve the SIP
Server/SIP Proxy FQDN. It then selects one SRV/A record from the list of the resolved destinations and
sends a SIP OPTIONS request to the selected transport. If a SIP 200 Ok response is received within the
configured time that is defined in the option oos-force, the selected transport is marked as in-
service and used for subsequent SIP transactions. The next check for this transport, which is
configured in oos-check, will be performed after the defined time period expires.
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April 15, 2020 (9.0.000.51)

What's New
This release includes only resolved issues.

Resolved Issues

• WebRTC Media Service now correctly retrieves an inbound call that was put on hold by a browser-based
WebRTC agent after the second call was released. Previously, the third-party call control (3PCC)
retrieve was not processed correctly. (WRTCMS-431)

April 03, 2020 (9.0.000.49)

What's New

• The Coturn server of WebRTC Media Service is upgraded to version 4.5.1.1 to allow the WebRTC Media
Service to work with the Federal Information Processing Standards (FIPS) compliant version of OpenSSL
library.

Resolved Issues

• The Third-party call control (3PCC) retrieve operation in WebRTC Media Service now works properly
when it is initiated by a browser-based WebRTC agent that uses the Opus codec. Previously, the agent
did not receive the media. (WRTCMS-420)

• When WebRTC Media Service processes remote Interactive Connectivity Establishment (ICE) candidates,
it now checks only the relay candidates. This improves the media connection establishment time.
Previously, WebRTC Media Service checked all types of candidates including the host. (WRTCMS-416)

• To improve the media connection establishment time, WebRTC Media Service does not re-Invite the
WebRTC participant from the SIP server side if:
• There is a SIP re-Invite without Session Description Protocol (SDP).
• The SIP re-Invite SDP media direction and the active/inactive state was not changed, and it does

not have any new media types.

For the above cases, WebRTC Gateway creates new offer/answer SDP based on the previously used
local SDP. (WRTCMS-415)

• WebRTC Media Service now properly processes the second SIP INVITE without SDP by replying with a
SIP 200 Ok response with an SDP offer. Previously, when WebRTC Media Service received two
subsequent SIP INVITE requests without SDP, it sent a SIP 200 Ok response for the second INVITE
without an SDP offer. It violates the Request for Comments (RFC) 3261 standard and can lead to media
connectivity establishment failure. This can affect the following scenarios:
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• Route call to WebRTC agent with recording
• 3PCC call from WebRTC agent with recording
• Consult call from WebRTC agent with recording

(WRTCMS-413)

• WebRTC Media Service no longer allows G722 codec usage for media connections. (WRTCMS-409)

January 31, 2020 (9.0.000.47)

What's New

• The WebRTC Media Service now provides call quality statistics using the HTTP call message PUT-STATS.
This message is automatically sent by WebRTC Gateway to the WebRTC JavaScript client at the end of
each call and contains call quality statistics in JSON format.

The WebRTC JavaScript library then passes the call quality statistics to WWE 9. WWE 9 then includes
the call quality statistics in the AttributeUserData of the RequestDistributeUserEvent message
that is distributed to SIP Server at the end of the interaction. The corresponding key-name is retrieved
from the value of interaction-workspace/webrtc.quality.statistics.key-name configured at the
Application/Person level.

Important
This feature is applicable only for browser-based WebRTC clients with WWE 9.

Resolved Issues

• WebRTC Gateway now includes SameSite=None and Secure attributes to all Set-Cookie headers
generated by the Gateway. (WRTCMS-300)

November 07, 2019 (9.0.000.43 UPDATE)

What's New
Legacy SIP Environment

• WebRTC Media Service now works with SIP Server operating in Standalone mode. Previously, WebRTC
Media Service was integrated only with SIP Cluster.

Microservice Monitoring
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• WebRTC metrics reporting to Prometheus monitoring system is expanded with a new metric named
wrtc_system_error to capture internal problems that occur in the WebRTC Media Service. Based on
this new metric, the Prometheus monitoring system will raise an alert when an internal problem occurs.

October 02, 2019 (9.0.000.41 UPDATE)

What's New
Elasticsearch

• WebRTC Media Service now supports Elasticsearch by sending different data into Elasticsearch. This
feature allows you to store and quickly analyze large volumes of data in real-time.

Resolved Issues

• Stability improvements have been made in WebRTC Media Service to prevent WebRTC gateway from
terminating unexpectedly under certain conditions. (WRTCMS-253)

July 03, 2019 (9.0.000.37 UPDATE)

What's New
WebRTC Agent timeout

• WebRTC Agent will now be signed out of the session if the connection between the Endpoint and
WebRTC gateway is broken for more than the configured time. For improved security reasons, this time
period is set to 5 seconds by default. However, it is configurable up to 15 minutes.

April 11, 2019 (9.0.000.37)

What's New
SIP addresses

• WebRTC Media Service now retrieves the SIP address from Genesys Web Services (GWS) version 9
automatically and users are not required to configure the SIP address while provisioning Agent Desktop.
The Agent Desktop supported version is 9.0.000.21 and above.
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December 21, 2018 (9.0.000.27)

What's New

• WebRTC Media Service now supports OAuth 2.0 authentication and authorization method to validate the
user credentials passed from Agent Desktop. The Genesys Softphone compatible version to support
OAuth 2.0 is 9.0.004.05 and above and the Agent Desktop version is 9.0.000.17 and above.

June 29, 2018 (9.0.000.15)

What's New
Initial release

This is the initial release of WebRTC Media Service for the Genesys Engage cloud (formerly known as
PureEngage Cloud [PEC]) solution. Agents can handle both inbound and outbound voice calls through
WebRTC-capable devices like Genesys Softphone by communicating with the Genesys Engage cloud
software through the WebRTC Media Service. The WebRTC Media Service supports Genesys Softphone
version 9.0.003.04+.

The key features of the WebRTC Media Service are:

• Supports G.711 and Opus codecs.
• Provides real-time media transcoding whenever required.
• Supports audio calls only.
• Signalling and media encryption capabilities of WebRTC Media Service ensures appropriate security for

voice communications over the public network.

Known Issues

• When WebRTC is used by WWE with zero-footprint (browser-based endpoint), you can only use one
(current) tab with WWE in the browser. Opening a second tab with WWE results in double-registration
and permanent re-registration of the agent. This limitation is applicable to the following supported
browsers:
• Edge Chromium 2020
• Google Chrome
• Firefox
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Genesys Widgets
For information about the latest releases of Genesys Widgets, refer to Genesys Widgets Release
Notes.

Important
As of release 9.0.017.01 Genesys Widgets is no longer available to download through
the Genesys Downloads Center. Instead, it can be downloaded as a zip file from the
Content Delivery Network (CDN).

Note: Not all changes listed below may pertain to your deployment.

• Product Alerts
• March 31, 2021 (9.0.017.17)
• March 23, 2021 (9.0.017.16)
• March 09, 2021 (9.0.017.15)
• January 25, 2021 (9.0.017.14)
• December 15, 2020 (9.0.017.13)
• November 30, 2020 (9.0.017.12)
• October 23, 2020 (9.0.017.11)
• October 16, 2020 (9.0.017.10)
• October 06, 2020 (9.0.017.09)
• September 18, 2020 (9.0.017.08)
• September 04, 2020 (9.0.017.07)
• August 20, 2020 (9.0.017.06)
• July 21, 2020 (9.0.017.05)
• July 08, 2020 (9.0.017.04)
• June 26, 2020 (9.0.017.03)
• June 11, 2020 (9.0.017.02)
• June 08, 2020 (9.0.017.01)
• May 15, 2020 (9.0.017.00)
• April 03, 2020 (9.0.016.17)
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• March 31, 2020 (9.0.016.16)
• February 14, 2020 (9.0.016.07)
• February 7, 2020 (9.0.016.04)
• February 5, 2020 (9.0.016.03)
• January 31, 2020 (9.0.016.02)
• January 17, 2020 (9.0.016.00)
• January 3, 2020 (9.0.015.19)
• December 24, 2019 (9.0.015.18)
• November 29, 2019 (9.0.015.11)
• November 12, 2019 (9.0.015.08)
• November 6, 2019 (9.0.015.07)
• October 11, 2019 (9.0.015.02)
• September 27, 2019 (9.0.014.13)
• September 6, 2019 (9.0.014.09)
• August 9, 2019 (9.0.014.06)
• July 26, 2019 (9.0.014.05)
• July 3, 2019 (9.0.014.00)
• June 24, 2019 (9.0.013.06)
• June 7, 2019 (9.0.013.03)
• May 24, 2019 (9.0.013.02)
• May 14, 2019 (9.0.011.01)
• April 17, 2019 (9.0.010.02)
• March 27, 2019 (9.0.009.06)
• March 21, 2019 (9.0.009.04)
• February 4, 2019 (9.0.008.04)
• January 28, 2019 (9.0.007.09)
• December 20, 2018 (9.0.007.07)
• October 25, 2018 (9.0.006.02)
• September 26, 2018 (9.0.005.00)
• September 5, 2018 (9.0.004.03)
• July 27, 2018 (9.0.003.03)
• Known Issues
• Archive
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Product Alerts

• The following regions have been added to the list of CDN URLs: Canada, UK (London), and Seoul.
• The legacy version of the Offers Widget has been deprecated as of version 9.0.015.11. Offers is now

embedded in the existing Engage Widget. If you're currently using the legacy Offers widget and need
help, please reach out to your Genesys representative.

• As announced in version 9.0.010.02, customers must migrate to new CDN URLs, as the legacy URLs at
app.genesys.cloud are now disabled, and will not be kept up to date with any later versions.

March 31, 2021 (9.0.017.17)

Resolved Issues

• This release applies to Genesys Engage on-premises customers only.

March 23, 2021 (9.0.017.16)

Resolved Issues

• When using JAWS with widgets, and using the arrow keys to navigate in the form, the screen reader now
correctly reads the Genesys logo as "Powered by Genesys logo." Previously, the screen reader did not
read the logo correctly. (CXW-233)

• In the WebChat Widget, when using the JAWS screen reader and receiving the system message to
announce the queue position, the message and timestamp are now read separately. Previously, JAWS
read the system message and time stamp together, as one item. (CXW-225)

• In the WebChat Widget, the emoji menu now displays properly in the browser at 400% zoom level.
Previously, the emojis were not all appearing in the browser at 400% zoom level. (CXW-218)

• In the WebChat Widget, users are now able to navigate in the emoji button menu using up and down
arrow keys in the JAWS screen reader. Previously, the user was not able to navigate to the previous and
next elements with up and down arrow keys using JAWS. (CXW-210)

March 09, 2021 (9.0.017.15)

Resolved Issues

• Handlebars.js library version is upgraded to 4.7.4, resolving a security issue. (CXW-205)
• The title attribute is now added to the textarea element to pass the WCAG 1.3.1 Info and

Relationships (A) criteria. Previously, this attribute was not present. (CXW-204)
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January 25, 2021 (9.0.017.14)

Resolved Issues

• In the Callback Widget, the Calendar plugin now correctly generates available time slots. Previously, the
Calendar plugin would freeze when a time slot was generated. (CXW-190)

• In the WebChat Widget, using keyboard navigation now correctly tabs to focus on the Close button in
the End Chat dialog box. Previously, the focus was set to the chat container. (CXW-184)

December 15, 2020 (9.0.017.13)

Resolved Issues

• In the Callback Widget, Calendar now only highlights the previously selected time slot when it is
reopened. The default time slot is no longer also highlighted. (CXW-166)

November 30, 2020 (9.0.017.12)

Resolved Issues

• In the WebChat Widget, the WebChatService.getTranscript command now returns valid transcript
data when the chat ends. Previously, the command returned an empty transcript. (CXW-176)

October 23, 2020 (9.0.017.11)

Resolved Issues

• In the Webchat Widget, using the Firefox browser, the color contrast between the Type your message
here placeholder text and the background is now adequate. Previously, the color contrast was not
adequate, and did not meet the minimum 3:1 contrast ratio. (CXW-167)

• In the Webchat Widget, when the user performs minimize/maximize actions by pressing Enter, the
screen reader now reads only the widget status. Previously, the form fields were read by the screen
reader whenever the widget was minimized/maximized. (CXW-161)

• In the Callback Widget, form submission is now successful only if the date and time are selected along
with other required fields when the immediateCallback configuration option is set to false.
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Previously, the user was able to submit the form successfully with the same configuration, without
providing the date and time. (CXW-131)

October 16, 2020 (9.0.017.10)

Resolved Issues

• In the WebChat Widget, the WebChat.minimize command now works as expected when the
minimized option is set to false. Previously, the WebChat.minimize command was ignored when
the minimized option was set to false. (CXW-158)

October 06, 2020 (9.0.017.09)

Resolved Issues

• In the WebChat Widget, when users access the VoiceOver screen reader in iOS, unnecessary swipe
stops (screen reader focus) on screen reader elements are now removed. Previously, in iOS VoiceOver,
when navigating with swipe gestures, extra swipe stops existed for "Emoji picker is opened/closed" and
"Type your message here” text area labels. (CXW-144)

• In the WebChat Widget, "Type your message here” is no longer read by the screen reader (JAWS) when
the input container is disabled. Previously, the label was read by the screen reader (JAWS) when
navigating with arrow keys, even with the input container disabled. (CXW-141)

• In the WebChat Widget, the aria label on the emoji picker is now removed. Previously, the aria label was
present and deemed unnecessary. (CXW-139)

• The jQuery plugin in Widgets is now migrated from version 3.4.1 to 3.5.1, which relates to security
vulnerabilities in version 3.4.1. (CXW-115)

September 18, 2020 (9.0.017.08)

Resolved Issues

• This release applies to Genesys Cloud customers only.
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September 04, 2020 (9.0.017.07)

Resolved Issues

• In Widgets, aria-labels and visible text on the buttons are now identical. Previously, they were different
in some cases. (CXW-138)

• URLs in WebChat messages containing special characters are now properly formatted, and display
correctly as links. Previously, the URL link was invalid. (CXW-132)

August 20, 2020 (9.0.017.06)

Resolved Issues

• When the WebChat Widget is minimized, and a new message arrives, the JAWS screen reader now
properly announces the arrival and number of new message(s). Previously, the screen reader read the
arrival notification improperly.

• The emoji button is now read correctly by the screen reader.
• The focus order is now correctly maintained on the window control icons.
• Disabled content is no longer read by the screen reader. Previously, the text input area was read even if

it was disabled.
• In WebChat, the tab stop for cx-transcript has been removed. Previously, the screen reader read all

contents of cx-transcript when focus was placed on it.
• Decorative SVG icons and the emoji menu are now correctly read by the screen reader.

(CXW-134)

July 21, 2020 (9.0.017.05)

Resolved Issues

• The scheduled callback time now correctly processes when using the custom registration form with
custom input validation in the Callback Widget. Previously, the callback was scheduled as soon as
possible and not at the requested time. (CXW-74)
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July 08, 2020 (9.0.017.04)

Resolved Issues

• The Agent typing indicator now correctly appears in Internet Explorer 11 and Edge browsers. Previously,
the typing indicator in the UI was slightly obscured. (CXW-53)

• In WebChat, markdown processing is now correctly applied only to messages sent from the business
(bot or agent) to the end-user. Previously, markdown processing was applied to all messages. (CXW-37)

June 26, 2020 (9.0.017.03)

Resolved Issues

• The data-icon configuration option in the chatButton.template now functions properly. Previously, it
showed the chat icon irrespective of the preferred configured data-icon. (CXW-20)

June 11, 2020 (9.0.017.02)

What's New

• This release applies to Genesys Cloud customers only.

June 08, 2020 (9.0.017.01)

What's New

• The Cookies sameSite attribute default value is set to strict.

Resolved Issues

• Images and quick replies now display correctly in WebChat. Previously, in certain instances, they did not
appear in the chat transcript. (CXW-80)
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May 15, 2020 (9.0.017.00)

Resolved Issues

• Widgets no longer causes excessive CPU usage in iPhones. Previously, there was a problem with a
runaway loop that could cause excessive CPU usage when running Widgets in Safari browsers.
(CXW-52)

• Widgets has a larger outline thickness on focusable elements to increase contrast for accessibility
requirements. Previously, the outline thickness was not sufficient, causing accessibility issues.
(CXW-50)

• Widgets has improved compatibility with iOS VoiceOver swipe controls to keep the focus within the
WebChat widget while it is running in full-screen mobile mode. Previously, the cursor moved outside the
widget to the background page. (CXW-49)

• In the WebChat registration form, the correct field is now the focus after closing a validation error.
Previously, the wrong input field would be highlighted and focused after a validation error when
submitting the WebChat registration form. (CXW-23)

April 3, 2020 (9.0.016.17)

Resolved Issues

• WebChat Widget now displays images correctly when using Genesys Engage V3 API. Previously, any
images uploaded in the WebChat Widget or sent by an agent were not displayed. (CXW-2914)

March 31, 2020 (9.0.016.16)

What's New

• Genesys Widgets has been optimized for accessibility on the web, adhering to and meeting the WCAG
2.1 Level AA standard. Changes include keyboard accessibility, color contrast, font size adjustments,
screen reader support, and more. For more detailed information, visit the new Accessibility section in
our Genesys Widgets Deployment Guide.
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February 14, 2020 (9.0.016.07)

What's New

• Expanded WebChat's markdown implementation to support setting the target for links by following this
expanded syntax:

[Genesys](http://www.genesys.com{{target="_self"}})

(CXW-2769)
Resolved Issues

• WebChat Widget now displays properly when multiple messages are sent. Previously, the message
timestamp could overlap the avatar of the next message when one rich message appears immediately
after another rich message. (CXW-2804)

• WebChat Widget now displays a download button when a supervisor attempts to send an attachment.
Previously, files sent by a supervisor did not present a download button to the customer. (CXW-2793)

• WebChat Event Lifecycle now treats Bots as agents so that the WebChat.completed event is
published after the customer ends the chat with a Bot. Previously, when the customer ended the chat,
WebChat.cancelled was published. (CXW-2792)

February 7, 2020 (9.0.016.04)

What's New
Resolved Issues

• The Async WebChat Widget with Genesys Engage v3 API now displays both old and new messages in
the correct order. Previously, in some cases, while fetching older messages, the order of messages
shown was incorrect. (CXW-2775)

February 5, 2020 (9.0.016.03)

What's New
Resolved Issues

• Resolved an issue found in release 9.0.016.02 where Quick Replies would not appear if sent without a
text message. (CXW-2800)

Genesys Widgets Genesys Softphone VDI Adapter

Genesys Engage cloud Release Note 402



January 31, 2020 (9.0.016.02)

What's New
Resolved Issues

• Corrected an issue where existing Quick Replies would not appear in the transcript when restoring a
chat after a refresh or page navigation is initiated. (CXW-2697)

• Updated display of Rich Messages within WebChat to include avatar, name, and timestamp of the
sender. (CXW-2621)

January 17, 2020 (9.0.016.00)

What's New

• WebChat Widget now supports a new Customizable Emoji Menu.

January 3, 2020 (9.0.015.19)

What's New
Resolved Issues

• Removed a library that could cause a JavaScript runtime exception on certain website configurations.
(CXW-2750)

December 24, 2019 (9.0.015.18)

What's New
Resolved Issues

• The WebChat Widget now recovers from a chat session that has been invalidated on the server.
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Previously, when trying to restore and start an Async chat that no longer exists, WebChat Widget
couldn't respond and would freeze. (CXW-2498)

• The Async WebChat Widget with Genesys Engage v3 API now opens and restores without page
refresh or page navigation. Previously, after ending the chat session, a page refresh or navigation was
needed to open the WebChat and to show previous chat history. (CXW-2203)

November 29, 2019 (9.0.015.11)

What's New
Offers

• The new Offers Widget is now redesigned and available with the Engage plugin, which supports multiple
layouts and rendering options.

Resolved Issues

• Callback, and other Widgets, now display correctly on mobile devices. Previously, while a Widget was
opened and minimized on a mobile device, opening a new Widget didn't display anything.

• The WebChat Widget now shows the PushURL message as a clickable URL that is sent from Agent
Workspace Web Edition. Previously, when using the WebChat Widget with Genesys Engage V3 API,
PushURL messages were not shown. (CXW-2679)

• The WebChat Widget now avoids making duplicate start chat requests when starting a new chat
session. Previously, multiple start chat API requests were made when opening WebChat in lazy load
mode, along with autosubmit. (CXW-2673)

• Active WebChat sessions are now supported across multiple browser tabs at the same time. Previously,
when using the WebChat Widget with Genesys Engage V3 API, opening the same WebChat session in
a new browser tab resulted in some unexpected browser console errors. (CXW-2594)

November 12, 2019 (9.0.015.08)

What's New
Localization

• Widgets has been localized into Dutch. To configure Genesys Widgets for Dutch, see Localize widgets
and services.

Resolved Issues

• Adding new lines in WebChat messages now works properly using Shift + Enter. Previously, new lines in
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messages would not display properly in the transcript when markdown was disabled.

November 6, 2019 (9.0.015.07)

What's New
Resolved Issues

• The WebChat Widget now displays the size of the file uploaded by the agent. Previously, the file size did
not appear in the agent's message. (CXW-2601)

October 11, 2019 (9.0.015.02)

What's New
Resolved Issues

• The character count of the WebChat Widget now listens to mouse events and correctly updates the
remaining character count when pasting text using the mouse. Previously, the remaining character
count was not updating correctly. (CXW-2576)

• WebChat Widget now avoids making any duplicate file download requests. Previously, in some cases,
the file downloaded twice when the user clicked the download button. (CXW-2574)

• Error messages due to file upload failure now display correctly. Previously, after a page refresh, the file
upload failure error was not shown. (CXW-2587)

September 27, 2019 (9.0.014.13)

What's New
Resolved Issues

• WebChat's character counter now correctly resets after clicking Send and the focus returns to the text
area. (CXW-2546)

• WebChat Widget now correctly sends emojis and text messages when using the maxMessageLength
configuration property. Previously, if the last character in a message using the maximum character
length was an emoji, the customer wouldn't receive the message. (CXW-2496)

• SVG spinner animation now functions as expected on Safari browsers of iOS devices. Previously, on
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some Safari browsers, the spinner appeared as a static icon. (CXW-2524)
• WebChat no longer counts sent messages as new incoming messages when a chat window is

minimized. Previously, in some cases, WebChat incorrectly counted a sent message as a new unread
message if the client sent the message and minimized the chat window simultaneously. (CXW-2550)

• SVG graphics now render properly in Safari browsers. Previously, in some cases, SVG graphics were
improperly scaled. (CXW-2492)

September 6, 2019 (9.0.014.09)

What's New
Localization

• Widgets has been localized into the following languages: Spanish, Finnish, French, Italian, Japanese,
Korean, Norwegian, Polish, Brazilian Portuguese, Swedish, Thai, Turkish and Chinese. Language support
is integrated into the Installation Package; there are no separate Language Packs to install.

New configuration option

• Added new pluginMap configuration option for CXBus that allows you to override the target JS files for
a given plugin namespace. CXBus loads the configured JS files from the pluginMap option instead of
from the default location. This can be used to replace a standard widget with your own or to disable a
widget entirely by mapping it to false. This feature only works when you utilize the Lazy-Loading
method of running and loading Genesys Widgets. If you use the all-in-one bundle, you cannot override
the plugins included in the bundle.

WebChat

• WebChat Widget now supports Chat Bot avatar icon with Genesys Engage Chat.
• WebChat Widget now supports adding new lines in the input text area using the shift+enter key

combination.
• WebChat metadata now contains a unique lifecycle "id" property. This helps identify an instance of a

Chat session and its associated events.

Resolved Issues

• Callback Widget now supports the localization of an "office closed" error message. Previously, this type
of error code response could not be localized. (CXW-2468)
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August 9, 2019 (9.0.014.06)

What's New
Resolved Issues

• In the Callback Widget, the selected Immediate Callback option is now correctly sent in the request.
Previously, after selecting a date and time and then switching back to the Immediate Callback option,
the previously selected date and time continued to be sent in the request. (CXW-2436)

• The Estimated wait time 'Available' status now correctly displays in the ChannelSelector Widget.
Previously, the 'Available' status did not display when the wait time was 0. (CXW-2430)

• Cookie values are no longer duplicated in the WebChat Widget. Previously, when navigating between
pages during an active WebChat session, certain cookie values of the WebChat Widget were duplicated
in the browser. (CXW-2428)

July 26, 2019 (9.0.014.05)

What's New
Localization

• Widgets has been localized into the following languages: French, German (Germany). Language support
is integrated into the Installation Package; there are no separate Language Packs to install.

• The WebChat markdown feature can now be enabled or disabled using the markdown configuration
option.

Resolved Issues

• Custom defined strings in the WebChat Widget can now be localized. Previously, custom defined strings
for System Messages would not display. (CXW-2409)

• Fetching previous Chat history messages using the keyboard now only happens when using the UP
arrow and PAGEUP keyboard keys. Previously, some minor scrolling would happen even with normal
characters keys, resulting in the Chat transcript needlessly fetching previous messages. (CXW-2363)
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July 3, 2019 (9.0.014.00)

What's New
Resolved Issues

• An estimated wait time alert icon is no longer displayed for unavailable channels in the ChannelSelector
widget. (CXW-2373)

• The mobile device browser detection when using the Common.getBrowserandOS() method has been
corrected and enhanced. (CXW-2367)

• The Calendar.showAvailability command now works as expected allowing proper updates to
Calendar timeslots. (CXW-2360)

• Alert dialog boxes in the Callback Widget can now be dismissed. Previously, in some IOS devices,
Widget controls were disabled when a dialog box was displayed. (CXW-2284)

June 24, 2019 (9.0.013.06)

What's New
WebChat

• Added a new avatar icon for chat bots to WebChat.
• Added support for Markdown text formatting in WebChat.

Resolved Issues

• Localization text is now available for the Wait Time units in the Channel Selector plugin. (CXW-2279)
• When a Chat is ended due to user inactivity, the "idle close" message now displays as expected.

(CXW-2295)
• WebChat Widget now supports displaying contentType notification messages as normal text messages.

(CXW-2318)
• The input label "When should we call you?" in Callback Widget now displays correctly. Previously, in

some scenarios, this label would not display. (CXW-2326)
• Fixed the link to launch Co-browse from the CallUs widget. Now it correctly starts a Co-browse session

when the link is clicked. (CXW-2337)
• When using the soft scrollbar in the Async WebChat window, the user scroll is now properly detected.

Previously, old messages could not be fetched when scrolling. (CXW-2341)
• The colors of the Warning and Alert icons for the Estimated Wait Time now display correctly in Channel

Selector. (CXW-2370)
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June 7, 2019 (9.0.013.03)

What's New
Resolved Issues

• Widgets Lazy Load bundles now integrate properly with websites that use Webpack. Previously, in
certain instances, errors in the console would appear when using Webpack.

May 24, 2019 (9.0.013.02)

What's New
Invites

• Invites created by the Engage plugin can now be programmatically revoked after they have been
presented.

Mobile Devices

• WebChat Widget can now restore in a minimized state during a new page load on mobile devices.

Cookie options

• A new configuration option, cookieOptions, has been added that enables you to modify Widgets
cookie options at the global level.

Resolved Issues

• In WebChatService, the AgentConnected and AgentDisconnected events are now always correctly
published. (CXW-2303)

• The Callback and ClicktoCall widgets now correctly display the form when maximized. Previously, when
maximized to full screen after device re-orientation, the form was not * * In mobile devices, the
Callback Widget now correctly shows only the available time slots when hideUnavailableTimeSlots
configuration option is enabled. Previously, this configuration option in the Calendar plugin was ignored
and the unavailable time slots were still displayed. (CXW-2276)
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May 14, 2019 (9.0.011.01)

What's New
Resolved Issues

• The WebChat.submitted event now contains the form metadata object. Previously, the form data was
missing in the submitted event. (CXW-2275)

April 17, 2019 (9.0.010.02)

What's New
CDN URLs

• Widgets are now available via new Public Content Delivery Network (CDN) regional URLs. The previous
CDN URLs are deprecated and are no longer accessible. Customers must migrate to new CDN URLs, as
the legacy URLs at app.genesys.cloud are now disabled, and will not be kept up to date with any later
versions. (CXW-2145)

Engagement

• The new Engage Widget is now available to support use cases for Proactive Engagements triggered by
Altocloud.

Resolved Issues

• Callback Widget now correctly displays one error dialog box at a time. Previously, in some cases,
multiple dialog boxes would appear at the same time. (CXW-2224)

March 27, 2019 (9.0.009.06)

What's New
Resolved Issues

• Localization strings are now correctly applied to the chat invite triggered by the command
WebChat.invite. (CXW-2182)

• The Chat Widget no longer auto-zooms in the iOS mobile Safari browser when a user taps on any input
field. (CXW-2158)
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March 21, 2019 (9.0.009.04)

What's New
Offers Widget

• Offers Widget is updated with new features, layouts, and improvements.

Dynamic polling

• WebChat's GMS REST mode now utilizes dynamic polling instead of a fixed 3-second poll rate. The poll
rate increases when the user sends messages and decreases over time as they become idle. This
increases responsiveness for the user without overburdening the server. (CXW-2167)

Resolved Issues

• Chat arrow bubbles and messages now display correctly in the WebChat Widget during an active chat
session. Previously, in some scenarios, they appeared misaligned. (CXW-2162)

February 4, 2019 (9.0.008.04)

What's New
Genesys Engage cloud v3 API

• WebChat Widget now supports Genesys Engage cloud v3 API via the WebChat transport configuration
option.

Resolved Issues

• Fixed an issue where Quick Replies would not appear due to a JavaScript error. Previously, the error
"SCRIPT438: Object doesn't support property or method 'toLowerCase'" would appear when
attempting to generate quick replies. (CXW-2077)

• WebChat bubble arrows are now displaying correctly by properly pointing to either the Agent or the
Customer in the active Chat transcript window. Previously, the bubble arrows were slightly misaligned.
(CXW-2071)
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January 28, 2019 (9.0.007.09)

What's New
Resolved Issues

• Callback Calendar time slots now display correctly based on the availability. Previously, when choosing
between days, some of the available time slots were shown as disabled. (CXW-2124)

December 20, 2018 (9.0.007.07)

What's New
Public CDN URLs

• Widgets are now accessible via Public CDN URLs. This includes both All-in-one and Lazy loading bundles.

Resolved Issues

• WebChat Widget now correctly listens to the inactivity timeout event from the Chat Server and ends the
chat session. Previously, the chat session could not be ended at the right time when the inactivity
timeout had occurred. (CXW-1920)

• The custom form in WebChat Widget now opens correctly in the Lazy Load mode. Previously, when
opening the WebChat for the first time, it would not display the configured custom form. (CXW-1947)

October 25, 2018 (9.0.006.02)

What's New
Deployment IDs

• Genesys Widgets now supports Deployment IDs. This allows you to specify multiple configurations, each
with a unique deployment ID that prevents cookies and other session data from carrying over to a page
with a different deployment ID. For example, you can use one deployment ID for your public site and
one deployment ID for users who are logged in, to prevent an authenticated chat from restoring after
the user logs out.

Resolved Issues

• Callback Widget now correctly shows the selected country code for the phone number field. Previously,
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deleting a phone number from the callback entry would also remove the country code and it could not
be re-added. (CXW-1828)

• The originalMessage sub-property now contains the original, unaltered message data from the server.
Previously, the event WebChat.messageReceived returned the wrong value for the sub-property.
(CXW-1907)

• Cross-browser compatibility has now been optimized for Callback Widget. (CXW-1889)

September 26, 2018 (9.0.005.00)

What's New
API compatibility

• Widgets is now compatible with Genesys Engage cloud Engagement / Estimated-wait-time API
(/engagement/v3/estimated-wait-time), for accessing Estimated Wait Time in Genesys Engage cloud.

• Widgets is now compatible with Genesys Engage cloud Engagement / Callbacks API (/engagement/v3)
for requesting and booking of Callback requests.

Resolved Issues

• Offers Widget now functions correctly according to its configuration documentation. (CXW-1815)

September 5, 2018 (9.0.004.03)

What's New
Estimated wait time

• Genesys Widgets now supports fetching estimated wait time (EWT) for a single virtual-queue or for a
group of virtual-queues.

Cookies

• A fully qualified domain name (FQDN) is no longer required for cookies to persist across page refreshes.
Test environments like localhost or direct IP addresses are now compatible with our cookies. Previously,
cookie-based features like WebChat restore would not function on a site without a FQDN.

Resolved Issues

• The Authorization header is now passed correctly when lazy-loading Genesys Widgets. (CXW-1793)
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July 27, 2018 (9.0.003.03)

What's New
Lazy-load plugins

• Genesys Widgets can now automatically lazy-load plugins from separate files, instead of loading one
large file containing all plugins.

Usability

• Improved scrollbar usability across platforms.

Before method

• A new "before()" method in CXBus plugins allows you to trigger actions before a chosen command
executes, manipulate options passed to the command, or block execution of the command.

Toaster plugin

• The Toaster plugin has a new event, Toaster.opened, that is published when a toast is opened.

Resolved Issues

• The SendMessage widget now correctly displays the OK button in alert dialogs. Previously, this button
might have displayed as EmailOk. (CXW-1735)

• JavsScript use strict mode no longer triggers an error when using a dropdown in a custom form.
(CXW-1734)

• This release disables the plugins configuration array in _genesys.widgets.main. Previously, using this
array might have caused unexpected JavaScript errors. (CXW-1731)

• Dropdowns and textareas no longer reset to text inputs when using the custom form feature.
(CXW-1710)

• Genesys Widgets now correctly collects and transmits user agent details for Microsoft Internet Explorer
10/11 and Edge browsers. This allows chat sessions to receive more accurate user agent details for
these browsers. (CXW-1697)

Known Issues

When running the same chat session across multiple browser tabs, the unread message counter may
show improper values.

ID: CXW-100 Found In: 9.0.017.01 Fixed In:
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When activating WebChat's close button with the spacebar in FireFox, it may trigger twice, causing it
to accept the successive confirmation dialog unexpectedly. This is caused by a known issue in
FireFox: https://bugzilla.mozilla.org/show_bug.cgi?id=816437.

ID: CXW-101 Found In: 9.0.017.01 Fixed In:

Archive
[+] Click to show archived release notes

June 26, 2018 (9.0.002.06)

What's New
Interaction Lifecycle Event

• Each widget now publishes a new Interaction Lifecycle Event (“submitted”) whenever a form is
submitted by a visitor. This event includes standard lifecycle metadata including the Form Registration
data submitted by a visitor when starting a new interaction (WebChat and Callback). This can be used
for more accurate client-side JavaScript logic alongside other Interaction Lifecycle Events published by
Widgets.

May 11, 2018 (9.0.001.04)

What's New
Resolved Issues

• The Offers Widget now provides an option to use client-side localization. (CXW-1354)

• Fixed an issue in custom forms where the check box input type was not sending the appropriate
selected value. Previously, even though the Send transcript check box was deselected, Widgets would
still send the user data. (CXW-1391)

• Fixed an issue where localization override was not happening as expected. Previously, the default
localization strings were absent for Webchat and Callback resulting in an App.setLanguage error in the
browser console.(CXW-1394)

• The Callback Widget is now redesigned to appear as docked in the bottom-right of the web page for
desktop browsers. Additionally, you can customize labels and input fields in the registration form so
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they can be propagated as Key Value Pairs (KVP) to the Callback API. (CXW-1404)

• Fixed URL messages displayed in WebChat. Previously, in certain instances, WebChat was truncating
part of the URL text. (CXW-1514)

March 28, 2018 (9.0.000.10)

What's New
Resolved Issues

• The ChannelSelector Widget now properly hides the unavailable channels in mobile mode. Previously, in
mobile mode, when the Estimated Waiting Time for a channel was set to a value greater than its
maximum threshold value configured, ChannelSelector would not hide the channel. (CXW-1353)

• The Callback Widget now properly displays the available time slots in mobile mode. Previously, clicking
Today would not correctly display the available time slots for that day. (CXW-1341)

March 7, 2018 (9.0.000.08)

What's New
New design

• The new design of the Chat Widget provides improved usability:
• New input area and Send button to submit new messages
• Easier access to in-app Chat features like Emojis
• New Chat avatars and Chat bubbles layout
• Improved Inactivity Timeout handling
• New character counter which highlights when 10 or fewer characters remain

• Widgets is updated with new, improved Agent icon.

Offers Widget

• The new Offers Widget is now available to offer advertising or marketing content to site visitors, and
redirect to the appropriate URL. Multiple content layouts are available, including the capability to show
text, images, and embed video from external sources such as YouTube and Vimeo.
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Resolved Issues

• Improved ESC key accessibility in the Callback Widget. Previously, in certain instances, the Widgets UI
would disappear after pressing the ESC key. (CXW-1302)

• Corrected the display of the Emoji menu after restoring chat. Previously, in certain instances, the use of
emjois was enabled when reconnecting after a connection was lost, even though this feature was not
enabled in the configuration. (CXW-1257)

• Improved error messages in the Callback Widget. Previously, in certain instances, the Callback Widget
was not displaying the error dialog box. (CXW-1306)

• Optimized callback scheduling in the Callback Widget. Previously, in the Callback widget, when "As soon
as possible" was selected, the variable _desired_time was wrongly sent to the server in the network
request. (CXW-1283)

January 2, 2018 (8.5.009.03)

What's New
Icon dimensions

• Optimized icon dimensions throughout Genesys Widgets.

Resolved Issues

• Resolved an issue in WebChat where using arrow keys were ineffective in the message input. Previously,
navigation with the arrow keys was not possible in the chat registration form. (CXW-1197)

• Resolved an issue where new messages received while WebChat is in a minimized state may not be
visible after expanding WebChat. Previously, iscroll was not updated after the agent ended the chat
while the chat was minimized. (CXW-1221)

• Resolved issue where the typing notification notice could be sent repeatedly under certain
circumstances. Previously, the Widget would continue to send "typing off" notices even after the chat
session had ended. (CXW-1215)

• Updated Genesys Widget's internal jQuery instance to the next stable version, which includes security
patches. (CXW-1156)

November 14, 2017 (8.5.008.08)

What's New
WebChat registration forms
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• You can now build customized WebChat registration forms.

Sidebar widget

• A new Sidebar widget is available for mobile and desktop browsers, enabling users to trigger any widget
from a customizable list of Widgets icons.

Browser Support

• Microsoft Edge

October 10, 2017 (8.5.007.03)

What's New

• WebChat widget now exposes new parameter maxMessageLength to limit the length of messages sent
during a chat session.

August 18, 2017 (8.5.006.07)

What's New
Re-branding

• Redesigned Genesys Widgets with new icons and Genesys logo to align with new Genesys branding.

Country Code flag icons

• Removed country code flag icons used by Callback Widget in the phone number field to reduce
Cascading Style Sheet (CSS) download size.

Classnames

• Prefixed CSS classnames with "cx-" to avoid conflicting classnames on host site.

Optimized CSS

• Optimized CSS throughout to reduce download size.
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July 28, 2017 (8.5.005.30)

What's New
New widgets

• Widgets exposed to Genesys Engage cloud Customers now include:
Callback capability - this enables Customers to request an Immediate or Scheduled Callback to
their phone number. Two new widgets are provided: Callback and CallbackService.

Calendar capability - this widget enables customization of the Calendar UI.

• WebChat and ChannelSelector widgets provide improved behavior on desktop browsers, as the scrollbar
can now be used to scroll the widget's content accordingly.

April 17, 2017 (8.5.005.08)

What's New
Resolved Issues

• The webchat submit buttons no longer overlap into the footer area when viewing webchat in landscape
mode on small mobile device screens. (CXW-631)

• WebChat's confirm before closing dialog prompt (which is enabled by default) now only appears while
the user is filling out the registration form and only if information has been entered into some of the
fields. (CXW-755)

February 15, 2017 (8.5.004.26)

What's New
Co-browsing assist

• Customers who are on a phone call will now be able to request co-browsing assistance from the agent
via the Channel Selector widget. Customers on chat can continue to start co-browse directly from the
Chat Widget.
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Workforce Management
Note: Some changes listed below might not pertain to your deployment.

For information about the latest releases of Workforce Management, refer to Workforce Management.

• June 26, 2023 (8.5.219.77)
• August 30, 2021 (8.5.218.43)
• December 23, 2020 (8.5.218.07)
• October 31, 2020 (8.5.217.18)
• May 28, 2020 (8.5.216.11)
• February 28, 2020 (8.5.216.06)
• January 8, 2020 (8.5.215.07)
• September 30, 2019 (8.5.214.20)
• November 2, 2018 (8.5.211.06)
• August 09, 2016 (8.5.101.29)
• July 8, 2016 (8.5.101.27)
• Known Issues

June 26, 2023 (8.5.219.77)

What's New
Windows 2022 support

• Support for Microsoft Windows Server 2022. See the Workforce Management page in the Genesys
Supported Operating Environment Reference Manual for more detailed information and a list of all
supported operating systems.

Performance enhancements to Time-Off wizard

• The Add Time Off wizard in the Time Off module for agents is enhanced as follows to increase the
efficiency and ensure that the WFM Server is not unnecessarily loaded:
• The Time off parameter is no longer set by default. Only after the agent selects the desired dates

and the desired time off type, they will be shown wait-list details and time-off limits for the selected
dates.

• The number of API calls required to display the actual wait-list information and time-off limits for
selected dates is now reduced.
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Time-Off limits validation performance enhancement

• Checking the Multi-Site Activity (MSA) time-off limits is now significantly faster when inserting a time-off
item in the schedule or calendar.

Preserving the paid hours for Overtime bids

• A new WFM option, OvertimeMode, provides the ability to accommodate added overtime for a
scheduled shift substitution by preserving the paid hours of the original shift plus any added overtime.

Minimum Distance Between Shift Items

• WFM now respects the Minimum Distance Between Shift Items constraint for breaks or meals that
precede or follow generic Exception states that are used to fill the gap between the shift and the
overtime inserted outside shift hours.

Marked Time now can overlap Time Off

• WFM now allows Marked Time to overlap Time Off schedule states as long as the Marked Time is not
used to mark overtime. (WFM-34694)

Displaying Day-Off in agent bidding view

• Day off is now displayed as Day off in the Agent > Bidding view. Previously, it was displayed as 12:00
AM - +12:00 AM.

Ability to delete default service level objectives

• You can now delete the Default forecasting objectives settings for activities if its settings were once
done using the new Delete button.

Intra-day Schedule Rebuild for multiple days

• Intra-day Schedule Rebuild Wizard now allows the user to select multiple days (within 2-weeks date
range) and rebuild schedules for the selected date(s) instead of rebuilding schedules for only one day.
As part of this feature, the following changes are done:
• The Date selector now displays 3 calendars for a wide range of date selection.
• The Start from field now applies the starting time to all the date(s) selected in the schedule.

Ability to filter by contract in schedule intraday rebuild wizard

• When rebuilding intra-day schedules, you can now filter agents by contract by selecting the
Additionally filter agents by contracts check box.

Adding Time-Off comments/Memos in schedule view

• Supervisors can now add comments/memos to Time-Off items in the schedule views. An agent can view
the comments/memos added by a supervisor in the Schedule and Time-Off modules.

Extra precautions to prevent mistaken deletion of BU or Sites

• When a user selects a business unit or site for deletion, WFM Web now requires the user to also enter
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the name of the business unit or site on the confirmation form. This extra step is added to protect
against the accidental deletion of business units and sites.

WFM Web for Agents inactivity interval

• A new configuration option is introduced to specify the inactivity interval (in minutes) for WFM agents
before sessions time out.

Building Staffing Forecast for multiple activities simultaneously

• You can now build forecast staffing for multiple activities at the same time by using the default service
level objectives settings for each activity. In addition, the Build Staffing Wizard now provides the
ability to use the default service level objective settings and to save any changes as the new default
service level objective settings for the activity when building the staffing.

WFM Web for Agents UI accessibility improvements

• The WFM Web for Agents UI includes accessibility improvements that follow the Web Content
Accessibility Guidelines (WCAG) 2.1 level AA standards.

Internal self-system health

• Internal self-system health check enhancements for WFM Web is introduced in the latest WFM versions.

Dual Roles support

• Workforce Management supports dual-role assignments (Agent and Supervisor) for a single agent
account.

Resolved Issues
Web for Supervisors

• Time-off limits wizard is fixed to perform time zone conversion when limits are set for MSA with
different from site time zone.

• If the First Come First Serve time-off bidding method is used, the agent's order or priority will now be
based on the timestamp of the last time-off submission within the bidding period rather than the
timestamp of the agent’s Ready state.

• Agents will now be able to add overtime to the beginning of their shift schedules containing part-day
time-offs.

• All expected breaks are now scheduled after overtime insertion before the shift start if possible.
• The performance of the agents' schedule trade eligibility checking operation is improved.
• Enhanced the load time of the agent's schedule-bidding view. Previously, this view was taking a long

time to load when the bidding scenario contained a big number of profile agents.
• Adding comments to agent's schedule with different time zone from the current one now shows a

warning message.
• WFM no longer freezes when an agent is selected in Master Schedule > Weekly screen on the

Supervisor page.
• Login and the password parameters are now encrypted before being sending them over the network.
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Previously, these parameters were not encrypted and were sent in plain text.
• WFM builder now correctly schedules the duration specified in the Minimum duration between the

start times of two consecutive working days constraint. Previously, this constraint was not
satisfied for some agents when rescheduling only a part of the schedule scenario.

• Added an additional check for which font should be used on the WFM client side. Previously, in some
cases, the client could incorrectly start using a font that doesn't support the Unicode characters.

• The waitlisted calendar time-off items are now correctly removed from Wait-list when those items can
no longer be auto-granted for any reasons. Additionally, the number of past days to be processed in the
waitlist process can be configured by using the new option.

• Correct Time Steps are now shown in the Performance > Intra-Day view (that is, starting with 12.00
AM) when the Site's/BU's time zone and Show Whole Day options are selected.

• The Required Staffing values are now loaded from the template. Previously, at the end of the
template import, the Req column was blank.

• Anticipated values for the actual Abandoned Interactions %, Service Level %, and Average
Speed of Answer (ASA) statistics are now displayed in the Performance > Intra-Day view even if
the Coverage column is not selected. Previously, anticipated values for those statistics were not
displayed if the Coverage column was not selected.

• Handling the Time Off requests by WFM is now enhanced for improved performance.
• Warning messages are now displayed, as expected, when agents create overtime requests that

violate the duration constraint of unpaid meals or breaks.
• The activities tree is improved in the new UI's Forecast > New Scenario wizard. The Create button is

now enabled only when all required data is loaded in the activities tree. The tree is also updated to
improve overall performance. Previously, a request to create a scenario could be sent before the data
related to the required activities was loaded, and as a result not all activities were added to the created
scenario.

• No error occurs when users try to expand or check a team node in the Available Agents tree of the
Reports Scheduler task creation wizard.

• WFM Web no longer adds new Calendar Items to agents which were not selected in the Add
Calendar Item wizard. Previously, in some scenarios, when the user chose to override warnings in the
Review calendar messages dialog and proceeded adding Calendar Items, Calendar Items were
added to agents which were not selected for insertion initially.

• WFM Web no longer reruns the one-time report generation task if the report has been deleted by user in
the Generated Reports view. Previously, WFM Web reran the one-time report generation task if
previously generated report was deleted by user within 30 minutes after the scheduled report
generation time.

• The Available Agents tree in the report creation wizard is updated to load agent information without
errors when expanding or checking a team node. Previously, an error would occur when users tried to
expand or check a team node.

• WFM Web now removes Agent Day for the selected Scenario or Master Schedule if the user copies a
blank day to a day with some schedule. Previously, the user could only copy a blank day in the Master
Schedule.

• The text size limit for generated reports is now increased.
• WFM Web no longer displays an internal error when closing a module. Previously, an error appeared

when the user closed an additional window with a module in which data is periodically updated.
• The Master Schedule module now displays the history without any errors. Previously, the Schedule

Restore dialog did not show schedules correctly if the Full Day Time Off was created above a full day
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item.
• WFM Web now removes any characters from text fields that are not valid for use in XML. Previously,

users could enter invalid characters in certain text fields, which prevented the text from being saved
correctly.

• WFM Web no longer saves auto-generated blank reports to a specified report folder. Previously, WFM
Web generated empty report files with no data and these files could not be removed from the
Generated Reports list.

• WFM Web now uses the default time format if the local time format is not supported by the time editing
component. Previously, an error displayed if the time editing component was not compatible with the
local format.

• The time-off balance is now correctly deducted for paid time-off items, where the paid time is
resolved to zero.

• Changes to agent skill levels are now synchronized consistently. Previously, change-based
synchronizations could sometimes omit certain changes and a full synchronization was necessary to
correctly synchronize agent skill levels.

• The open hours for Multi-Site Activities (MSA) are now taken into account when the Scheduled
Headcount daily total values for MSA are calculated.

• Agents who are promoted to supervisor can now log in to WFM Web if they were terminated from their
agent position. Previously, a former agent could not log in as a supervisor if they had been terminated
from the agent position.

• It is now possible to build schedules for several sites simultaneously. Previously, the schedule for each
site in the scenario had to be built one at a time.

• In the Schedule > Intra-Day module, you can now use the progress bar to monitor the process of
saving changed Agent Days or click Cancel to stop the process (for example, if it is taking too long).
Previously, you could not check the status of the saving process or cancel it.

• In the latest WFM Web for Supervisors UI, WFM now adds all matching activities for a BU when creating
a new Forecast scenario. Previously, WFM did not always wait for all matching activities to be loaded
before creating the Forecast scenario, which resulted in some activities not being added.

• The Edit Multiple dialog no longer displays duplicated Exceptions rows for agents. Previously, in the
new Edit Multiple dialog within a Schedule Scenario (for a particular team), Exceptions rows were
incorrectly duplicated for some agents.

• The Calendar Items filter now correctly displays only calendar items of the selected types. Previously,
the applied filter displayed extra unselected Calendar item types if multi-site time-off types were
selected in the filter.

• Supervisors can now see only Calendar items from sites they have access to. Previously, supervisors
could see existing Calendar items of agents that were moved out of the site even after the
supervisor’s access to that site was revoked.

• WFM now loads Calendar items in the Intra-day view of the Schedule much faster. Previously, users
sometimes experienced significant delays when accessing this view

• The default value of the SupervisorSessionInactiveTimeout configuration option is set to 180
(minutes). Previously, this configuration option had a default value of 0.

• Messages are now displayed correctly. Previously, unexpected characters appeared in the message text
instead of a break to indicate the start of a new paragraph.

• When a user is creating a new schedule, WFM Web now displays the correct number of calendar days if
the user selects the last day in a month (for example, day 31) and then changes the view to a different
month that has fewer days. Previously, in this scenario, the number of days was not displayed correctly.
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• WFM Web no longer displays an exception if a user tries to use the wizard to remove agents from the
Schedule scenario. Previously, the user could receive an exception if any attached agents were unable
to work on scenario activities.

• WFM Web now permits users to select days by clicking on the weekday names in the Calendar module.
Previously, this feature was missing and users could not select days by tapping and selecting the
weekdays.

• Agents are no longer able to request Time-Off types that are not assigned to their current time off
rule. The Time-Off type drop down list now consists only of Time-Off types that are manually
assigned to an agent without a rule or assigned to the agent by a linked Time-Off rule, or at least one
of the dates from a time-off request falls into the active assigned period of this Time-Off type
(between the start and end date of the linked rule or the Time-Off type directly assigned to the agent).
In the event that many dates are selected and the end date of the time off rule occurs between these
dates, WFM Web now checks the selected dates and time off type with the agent’s time off rule and
displays ineligible dates in red.

• To prevent Cross-Site Scripting (XSS), the following special characters are forbidden from being used in
the Name field that is displayed in various views of the WFM Web for Supervisors (Classic) interface:
• Quotes (‘,“)
• Greater-than, less-than signs (<,>)
• Ampersands (&)

• The WFM Web for Supervisors (Classic) UI now correctly escapes (and replaces) any forbidden special
characters or symbols that users enter in input fields. For items that already contain a forbidden
symbol in the Name field, the name will be changed after saving. In addition, WFM now displays a
validation warning if users enter forbidden characters in the Comments field.

• Users are now able to build schedules if the scenario includes a site with no agents by excluding this
site from the build operation (a message is displayed notifying users to check the schedule scenario
and adjust it as needed). Previously, an internal error message was displayed.

• WFM no longer displays an internal server error message when an agent is moved to a different site.
• WFM now calculates the carry-over balance correctly if the end date of a bonus is after the carry-over

date.
• Users can now copy an empty shift to a different day of the schedule, even if another event was

previously scheduled for that day (such as a shift or time off). Previously, empty shifts could only be
copied to days where nothing else was scheduled.

• WFM now calculates the State Group Daily Totals correctly. Previously, the State Group Daily
Totals were counted as zero for the unpaid full-day time off items after a time off item was inserted
over the existing day off item.

• When the Delete states functionality is selected from the View or Edit Intra-day schedules dialog,
WFM now only deletes states for the selected agents in that site. Previously, WFM incorrectly deleted
similar states for agents in all other sites associated with the selected Business Unit.

• When viewing a forecast scenario in the latest WFM Forecast interface, the Activities tree now
displays only the activities that are selected for that forecast scenario. Previously, all available activities
were displayed.

• WFM now displays the correct username in the Schedule History and Audit reports after the Intra-
Day Schedule is rebuilt. Previously, the username was incorrectly displayed as blank or as System.

• WFM no longer auto-commits schedule changes after the Intra-Day Schedule is rebuilt if the auto-
commit setting is unchecked in Web for Supervisors. Previously in this scenario, WFM incorrectly auto
committed the changes.
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• The Rotating Pattern Properties Report no longer displays an error when users open the Data page
and expand the Site.

• In WFM Web for Supervisors, the Schedule State Group (SSG) History view now displays the SSG
details as expected. Previously, WFM failed to load and display the details in this view.

• WFM now creates the Calendar Audit Report in CSV-friendly format and exports the data to a .csv file
with no issues. Previously, if the last line on the page was long, WFM incorrectly split the text into
multiple short lines when generating the report.

• In the latest Web for Supervisors UI, if there are preset date ranges for some Scenarios, WFM now
displays the Historical date range grid in the Build Volumes Wizard > Historical date range
step, by default. If there are no preset historical date ranges in Scenarios, WFM displays the historical
indicator date range in the grid (as in Web for Supervisors [Classic]).

• WFM now saves the selected available Marked Time in the Schedule Marked Time Report and
Schedule Marked Time Total Report. Previously, the WFM Report Scheduler did not save the
selected available Marked Time for these reports unless users also selected the entire site.

Web for Agents

• An agent can now successfully request a time off in Classic UI. Previously, it was impossible due to
application error.

• Login and the password parameters are now encrypted before being sending them over the network.
Previously, these parameters were not encrypted and were sent in plain text.

• The Add Time Off wizard now requests time-off limits only once for each configuration change.
Previously, WFM Web requested time-off limits twice when the list of dates or time-off types were
changed.

• The Add Time Off wizard for agents now displays the Time-off Limits for the selected dates correctly
and no longer changes the time-off type to the default setting.

August 30, 2021 (8.5.218.43)

What's New
Windows 2019 Support

• Support for Microsoft Windows Server 2019. See the Workforce Management page in the Genesys
Supported Operating Environment Reference Manual for more detailed information and a list of all
supported operating systems.

Control WFM Session Inactivity Intervals

• You can now set the inactivity interval for WFM Web for Supervisors sessions before they time out. This
feature requires some configuration. Ask your Genesys Account Representative for help to enable this
feature.

Improved Security in WFM Web
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• WFM Web has the following security improvements:
• Auto-complete is disabled on the Login page.
• New secure headers in server responses: X-Content-Type-Options and X-XSS-Protection.
• Unnecessary options were removed from server responses that might disclosure server details.

Auto-Hiding Messages for Agents

• In the WFM Web for Agents Configuration > My Settings view, agents can now check/enable the
Prevent messages from auto-hiding check box to prevent Error, Confirmation, and Validation
messages from disappearing after 5 seconds. Messages now remain open until the agent clicks Close.

Move Schedule States by Using the Wizard

• Supervisors can now move schedule states to other dates, by using the new Move to date setting and
date-selector in the Select states dialog of the Edit Multiple Wizard. This functionality is available in
the following Web for Supervisors (Classic) views:
• Schedule > Scenarios > State Group Totals
• Master Schedule > State Group Totals
• Schedule > Scenarios > Intra-Day and > Agent-Extended
• Master Schedule > Intra-Day and > Agent-Extended

Wait-Listing and Bidding Processes Improved

• WFM's Wait-Listing and Time-Off Bidding processes and memory management are now optimized to
improve performance. This feature requires an upgrade to other WFM components. Ask your Genesys
Account Representative for help when enabling this feature.

New Role Privileges for Supervisors
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• Supervisors can now be granted the following privileges in the under Configuration > Agents in the
Role Privileges view:
• Read
• Allow Move
• Edit Properties
• Edit Activities
• Edit Contracts & Rotating Patterns
• Edit Time Off
• Edit Time-Off Bonuses

Read more about his new feature in Configuration Role Privileges in the WFM Web for
Supervisors (Classic) Help.
This feature is dependent on an upgrade to more than one WFM component. Ask your
Genesys Account Representative for assistance when setting up this feature.

Resolved Issues

Web for Supervisors

• WFM Web now uses the X-Forwarded-Proto request header when generating .jnlp or .wfm files that
open Java modules.

• In the latest Web for Supervisors Forecast module, users can now see the Target name of the Multi-
Site Activity (MSA), Activity, Site, or Business Unit that is selected in the Scenario's Activity tree. In
addition, the Activity tree in the left-side panel now auto-scrolls to enable the selection of items when
the Scenario is opened.

• Users must now select at least one item in the Colors list to update color configurations in the WFM
Web for Supervisors Configuration > Colors views, preventing WFM from incorrectly changing colors
in all sites.

• In the latest Web for Supervisors UI, WFM now imports Forecasting data correctly when users initiate the
Forecast > Import action.

• WFM Web now correctly assigns roles to restored agents.
• In the latest Web for Supervisors UI, WFM now automatically selects the associated child activities when

users select Multi-Site Activities (MSA) in a Forecast > Scenario using the Add Activity dialog.
• Data preparation for the Team Weekly Schedule Report is updated, and WFM now loads data for sites

associated with the selected Schedule Scenario.
• Users can now make changes in WFM Web for Supervisors Configuration > Agents > Time-Off

Bonus Properties view when only the Configuration > Agents > Edit Time-Off Bonuses privilege
is enabled.

• WFM's user input validation is updated to remove the ESAPI library and no longer accepts incorrect
values.

• In the WFM Web for Supervisors Schedule Bidding view, users can expand the Bidding Profiles table
rows to display shift start and end times for each week, and now see a Confirmation dialog prior to
removing a bid.

• In the Web for Supervisors Time-Off Rules view, the Assignments data grid now displays an empty
cell when information about time-off types is unavailable.
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• The Web for Supervisors Time-Off Rules data grid now converts the time value to a string with no
offset.

• The Web for Supervisors Time-off Management Report now avoids errors when preparing data for the
report when time-off bonuses for agents were sorted by the Expiration date, and had specified
Expiration dates.

• WFM has improved the time it takes to insert time off into the schedule when Multi-Site Activity limits
are set for that Time-Off type.

• WFM now retains the time that is entered for preferences in the Web for Agents (Classic) >
Preferences view.

• WFM now correctly performs automatic carry-over for all time-off rules and time-off types assigned to
agents when they have multiple assigned time-off rules and time-off types.

• WFM now displays Calendar items for the correct business unit (BU) if agents in the BU were moved to a
different one, but still had Calendar items in the initial BU.

• Recalled time-off requests are now processed correctly during the Time-Off Bidding process if they are
saved after being edited.

• WFM no longer displays an Unexpected Error message when users change the performance target by
enabling the Use Multi-Site Activity' setting in the Schedule Intra-Day view.

• When using the Edit Multiple Wizard in Schedules views and modifying the duration of paid
schedule states (Exceptions, Time-Off items, Meals, or Breaks), the agent's daily paid hours are now
calculated correctly.

• WFM now displays the correct bid information for agents in the Schedule > Scenario > Profiles/
Bidding view and no longer displays all zeros in the Bid column.

• WFM now correctly auto approves overtime bids that are within set limits if the overtime offer is created
for an activity under a specific site and multiple additional sites are assigned to the offer.

• WFM no longer incorrectly auto-declines overtime bids when the requested overtime overlaps existing
schedules from the previous or next day.

• WFM now correctly calculates Schedule State Group (SSG) daily total hours when the time zone is
changed.

• WFM now correctly displays overtime bids only for agents responding to the selected Overtime Bidding
Offer.

• WFM now successfully completes its automatic Overtime Bidding process and no longer pauses or
becomes disabled.

• WFM now correctly calculates available time-off slots for requests that fall on days that are designated
as day off in the Rotating Pattern.

• The WFM Calendar service is now updated and the Time-Off Management and Time-off Balance reports
now contain the correct data for each agent when generated for multiple agents.

• Users can now scroll Help pages after opening them from the latest WFM Supervisor UI views using the
Microsoft Internet Explorer browser.

• In the WFM Web for Supervisors Forecast > Import view, users can now import historical data for a
period of one year or more without displaying errors.

• WFM no longer auto-declines overnight Overtime bids with the error The overnight schedule
overlaps with schedule on the following day when the following day is a scheduled day off.

• WFM now successfully displays the schedule coverage and saves back-logged activities in schedules.
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• WFM now correctly returns the time-off type description together with the agent information, when
requested.

• WFM now correctly determines the date for full-day time-off requests when they are on the same date
as the day-off in the agent's Rotating Pattern.

• WFM now processes Time Off requests applicable to bidding periods only after the bidding period
processing start date.

• The State Group Totals view in WFM Web for Supervisors now correctly displays the Forecasted
Staffing and Schedule Coverage data in the graphs, based on the selected time zone.

• WFM now correctly refreshes the Schedule view after profile agents are removed from Schedule
Scenarios and no longer displays blank schedules.

• WFM now accounts for Overlay events when building Forecasts when users select the AI-Powered
Forecasting method.

• WFM now correctly shows the Last Login Time information.

Web for Agents

• The WFM Web for Agents (Classic) UI now uses the ESAPI library for input validation, thereby preventing
the Go Back error page from displaying when agents attempted to log in.

• Agents can no longer change the status of Granted and Recalled time-off types in the WFM Web for
Agents Calendar view, thereby causing negative time-off balances. WFM does not approve Recalled
and Granted time off types.

• In Web for Agents Schedule Bidding scenarios, WFM now assigns the ranking values using first-in,
first-out logic when users add multiple profiles to the Desired list.

• The WFM Web for Agents Status Report template now enables users to export the report data in all
available formats without losing data.

• The WFM Web for Agents UI has improved accessibility and readability, as follows:
• The readability of the main menu when using JAWS and zoomed to 200%
• New JAWS announcements for shift timing in the My Schedule view
• Zoom to 200% in the browser is supported with no overlapping components

• WFM now retains the time that is entered for preferences in the Web for Agents (Classic) >
Preferences view.

• Agents can no longer submit duplicate full-day time-off requests for the same day when submitting
them simultaneously.

December 23, 2020 (8.5.218.07)

What's New
New Edit/Delete Multiple Wizard

• Supervisors can now edit schedule states in Intra-Day schedules by using settings in the new View or

Workforce Management Genesys Softphone VDI Adapter

Genesys Engage cloud Release Note 430



Edit Intra-Day Schedules dialog to invoke the new Edit Multiple Wizard in the following Web for
Supervisor views:
• Schedule > Scenarios > State Group Totals
• Master Schedule > State Group Totals

Or open the wizard directly by using the toolbar or Actions menu in the following views

• Schedule > Scenarios > Intra-Day and > Agent-Extended
• Master Schedule > Intra-Day and > Agent-Extended

Supervisors can also delete multiple schedule states in Intra-Day schedules by using the
View or Edit Intra-Day Schedule dialog in the following Web for Supervisor views

• Schedule > Scenarios > State Group Totals
• Master Schedule > State Group Totals

This feature is dependent on an upgrade to more than one WFM component. Ask your
Genesys Account Representative for assistance when setting up this feature.

New Role Privileges for WFM Supervisors

• By assigning role privileges, WFM Administrators can now enable users to view and read information in
the WFM Web UI while preventing them from making configuration changes in the following views:
• Configuration > Schedule State Groups
• Configuration > Time Off Bidding Periods
• Configuration > Activities and Multi-Site Activities
• Policies > Meetings
• Schedule > Overtime Bidding
• Trading

This feature is dependent on an upgrade to more than one WFM component. Ask your
Genesys Account Representative for assistance when setting up this feature. For more
information, see Role Privileges in the Workforce Management Web for Supervisors
(Classic) Help.

Options for Agents When Filtering Activities

• When filtering a list of agents in the the Create Trade proposal, and Trades views, agents now see
either their Primary activities only or their Primary or Secondary activities. Some configuration and an
upgrade to more than one WFM component is required to enable this feature. Ask your Genesys
Account Representative for assistance when setting up this feature.

Resolved Issues

Web for Supervisors

• Users no longer see error messages in the Web for Supervisors Configuration > Colors view after
selecting Exception Types in the drop-down filter for one business unit (BU), and then switching to
another BU and clicking Get Data.
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• The Agent Properties Report no longer includes the Time-Off Rules section if there is no rules data.
Previously, the Time-Off Rules table sometimes appeared in the report even though the table
contained null values.

• WFM now displays a complete and accurate list of scenarios in the Schedule > Scenarios view and no
longer incorrectly contains empty items.

• WFM now consistently saves changes to agent properties when a time-off type assigned to the agent's
time-off rule was recently deleted.

• WFM now counts paid hours correctly when calculating time-off balances.
• WFM now consistently displays up-to-date data in the Schedule reports and elsewhere when multiple

WFM Servers are deployed and schedule auto-cleanup is enabled.
• WFM now enables users to enter multiple, longer memos for Exception schedule states and uses

compression which decreases truncation and preserves user-entered memos in all but the most
extreme cases.

• WFM now consistently displays all time zones as expected.
• WFM now opens schedule scenarios successfully when schedule scenarios have a specified extended

end date.

October 31, 2020 (8.5.217.18)

What's New
Granular role configuration for Organizations

• Administrators can now separately assign the Edit and Add/Delete role privileges for the
Organization. Splitting the Add/Edit/Delete privilege enables WFM to provide improved security by
allowing specific users to edit the organization while preventing them from (accidentally or
intentionally) deleting the entire organization. To support backward compatibility, user roles that
previously had the Add/Edit/Delete privilege, now have Add/Delete and Edit privileges.

To implement this feature, contact your Genesys Professional Services representative.

Filter State Group Totals by name

• Improvements made in the WFM Web for Supervisors (Classic) Master Schedule > State Group
Totals and Schedule > Scenario > State Group Totals views, enable users to choose to view the
State Group Totals aggregated by name within the business unit, and select the time zone for which the
State Group Totals data is displayed.

Support for Microsoft Edge browser

• WFM Web UIs (with the exception of Web for Agents (Classic) UI) now support Microsoft Edge browser
version 84.0.552.40 and later. See the Supported Browsers section on the Workforce Management page
in the Genesys Supported Operating Environment Reference Guide for more detailed information and a
list of all supported browsers.

New filter/settings in Web for Agents
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• A new setting, Primary activities only, in WFM Web for Agents enables agents to filter and show only
agents with matching primary activities. If agents deselect Primary activities only, WFM shows all
agents with activities that match the primary or secondary skills of the logged-in agent. Agents will see
the filter in the following views:
• In the My Schedule view, when creating trade proposals and selecting agents in the Create trade

proposals dialog, the Primary activities only check box is selected by default.
• In the Other Schedules view, a new section Show Agents with Matching in the Filter

Schedules dialog enables agents to filter Primary activities only (default) or Primary or
secondary activities.

• In the Trading > Trades view, agents can use Filter by primary activities only when the list is
filtered by Community.

Time-Off Transferring Rule Enhancement

• An enhancement changes the behavior of the time-off transferring rule when configured as follows:
• The rule End Date falls on the carry-over day of that ending rule
• The balance is transferred to the next rule
• The transferred balance (in hours) is greater than the configured maximum carry-over balance of

the ending rule

Then, the transferred balance is equal to the configured maximum carry-over balance of the
ending rule.
WFM applies this functionality only to new carry-over periods (not carry-over periods that
have been processed).

Filter agents contributing to Schedule State Totals

• WFM Web enables supervisors to view and change the schedules of agents contributing to a Scheduled
State Total in the Intra-Day view. This feature is available in the Master Schedule > State Group
Totals and Schedule > Scenarios > State Group Totals views. See Master Schedule State Group
Totals and Scenarios State Group Totals in the Workforce Management Web for Supervisors (Classic)
Help.

Bulk assignment of time-off rules

• In the Policies > Time-Off Rules view, WFM Web enables users to perform bulk assignments of time-
off rules, based on agent hire dates. See Associating Agents Based on Hire Dates in the Workforce
Management Web for Supervisors (Classic) Help.

New columns in Performance > Intra-Day

• The grid in the WFM Web Performance > Intra-Day view has two new columns under Staffing. The
Diff. Calc. and Diff. Req. columns show the values that reflect the difference between Coverage and
Calculated, and Coverage and Required staffing for each activity. In addition, the (existing) Coverage
column is now under Staffing in the grid.

Resolved Issues

Web for Supervisors

• In the WFM Web for Agents Schedule > Other Schedules, My Schedule > Create Trade Proposal,
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Trade > Community views, when filtering a list of agents by selecting My team, My site, or My
business unit, if the Primary activity only option is selected and WFM finds no matching primary
activity, the filter results show only the logged-in agent. Previously, when using these options to filter
agent lists, the filter results incorrectly showed agents who did not match the filter criteria.

• In the Web for Agents Other Schedules view, when filtering agents' schedules with the Primary
activities only option selected, the filter results now show only agents who have at least one
matching primary activity. Previously, in special cases, the filter results incorrectly showed agents who
did not have matching primary activities.

• In environments where Single Sign-On (SSO) is setup, users with the correct credentials who have not
been assigned access rights to WFM now see the message "The user does not have adequate WFM
access to complete this request" in the login error page. If the user refreshes this page in the browser,
the error message "Access Denied" displays.

• Users that do not have role privileges to the Organization > Time Zones view can now successfully
copy and save business units, with no error messages displayed.

• A typo was corrected in the following warning message that displays in the Web for Supervisors
(Classic) Organization > Sites view: WFM cannot identify the time zone. Please select a
time zone from the list.

• To provide clarity, WFM now displays the following updated message in the Master Forecast view
when users select a date range that is too long: Specified date range is too long. It replaces the
message: A WFM Web internal error occurred. Please login again or call your system
administrator for help.

• When the Select agents to view their Intra-Day schedule dialog opens in the WFM Web for
Supervisors Classic Schedule > State Group Totals view, WFM now correctly uses the same Name
order (first/last name) for agents as the one displayed in the Objects pane.

• In environments where Single Sign-On (SSO) is setup, while logging into WFM using the correct
credentials, some users received the "Oops" error message if they had not been assigned access rights
to WFM. WFM now has an updated error message that provides more information in such cases.

• In the Web for Supervisors (Classic) Master Schedule > Intra-Day view, the Filter now resets the
Agent > Activities tree only when the selected site or business unit is changed.

• WFM now creates the Individual Schedule Report in CSV-friendly format and exports the data to a .csv
file with no issues when the last line on the page is a long one.

• In the latest Forecast UI, users can now successfully select events in the Select Events dialog of the
Forecast Build Volume Wizard, even if an overlays does not have associated activities.

• Users who do not have the Edit Master Schedule permission can no longer make or save changes in
the Accessible Schedule Details dialog in the Web for Supervisors Master Schedule > Intra-Day
and > Agent-Extended views.

• In the WFM Web for Supervisors Master Schedule' > Intra-Day'Bold text view, all agents in the
Schedule Agents tree, including terminated agents, now display as expected if the view was opened
by the WFM UI Launcher and the CFG_SHOW_TERMINATED_AGENTS option was set to true.

• WFM now schedules an appropriate shift for overtime even when the overtime is requested outside of
the shift.

• WFM now displays all time-off items in batch requests in warning messages, enabling users to check all
items and resubmit the entire batch.

• WFM now provides improved scheduling of multiple group meetings by scheduling all groups at the
earliest Start Date and Time only if there are no better dates/times for the meetings, or if the
configuration is not sufficiently flexible to accommodate them.

• Unpaid breaks and meals now can be moved when rescheduling the shift to accommodate overtime,
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unless the overtime partially overlaps the meal—in that case, WFM does not move it.
• Schedule State Group (SSG) history overrides now affect the agent's historical adherence by correctly

starting from the specified effective date of the override.
• WFM now consistently displays up-to-date data in the Schedule reports and elsewhere.
• WFM Web was updated to remove a potential vulnerability in links to contextual Help.
• Editing and saving User Profiles no longer results in database errors.
• WFM no longer adds historical change records to the Schedule State Group (SSG) history log if user

updates produce no material changes to the SSG.
• WFM now consistently and correctly preserves the schedule change history, no longer preserving empty

schedule history records following schedule modification if the same schedule scenario was previously
published more than once.

• The Master Schedule Change Approval view in Web for Supervisors now correctly displays
unapproved schedules of agents that were moved to a different site.

• WFM now retains the <None> team folder after moving agents to/from that team.
• An issue is resolved where the WFM ETL cycle sometimes stalled and had to be restarted if a database

error (like ORA-25408) occurred during a database writing transaction and was not cleared by re-
running the transaction.

Web for Agents

• The Web for Agents Preferences > Details view now loads and displays correctly after agents log in to
the UI using Internet Explorer (IE). (WFM-33386)

• Now, users can see the actual names of Exceptions and Time-Off items as generic names when
hovering their cursor over truncated items in the WFM Web for Agent Other Schedules view. Contact
Genesys Professional Services if you want to implement this feature.

• WFM now correctly applies filters and displays the results if users enter symbols in the Filter by field in
the WFM Agent application's Configuration > Browse Shared Transport view.

• WFM now correctly applies the selected filter in the WFM Agent application's Configuration > Browse
Shared Transport view if users select a filter other than the default filter in the Filter by drop-down
menu.

May 28, 2020 (8.5.216.11)

What's New
WFM Supports W3C/WCAG 2.1 Accessibility

• The WFM Web for Agents UI now supports W3C/WCAG 2.1 Accessibility (Level – A and Level - AA)
recommendations for users with physical limitations.

New complimentary caching method

• The new, optional cache synchronization method is complementary to WFM's existing automatic
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synchronization. It reduces database round trips and improves WFM Server performance. This feature is
disabled, by default.

Improved responsiveness

• WFM Server's responsiveness is improved by up to 40% in the Web for Supervisors Schedule > Intra-
Day view.

Improved efficiency: cache limitation removed

• The efficiency of the Schedule cache is improved, limiting the maximum cache size only by available
memory.

Improved extraction of statistics

• The WFM ETL database performance is improved when Activity Performance statistics are extracted
from WFM Server.

Generic unpaid Exceptions replace unpaid Breaks

• When processing overtime requests, WFM now uses generic unpaid Exceptions instead of generic
unpaid breaks to cover gaps between shifts and overtime when overtime is inserted outside of the shift
start/end times.

New Dimension tables in ETL Database

• The WFM ETL database Dimension tables WFM_BU and WFM_SITE now have an additional column
named IANA_TIMEZONE, which is a standard Internet Assigned Numbers Authority (IANA) time zone
name assigned to business units and sites. For more information about this feature, see When to use
IANA time zones in the Workforce Management ETL Database Reference.

Important
The latest WFM Forecast UI requires IANA time zones.

Resolved Issues

Web for Supervisors

• Comments that were entered in the Web for Supervisors (Classic) Forecast UI now display in the latest
Web for Supervisors Forecast > Scenarios view.

• WFM now displays the updated data in the Web for Supervisors Schedule > Intra-Day and > Agent-
Extended views if they are refreshed after first being opened.

• WFM now displays all items in the Activities tree without delay in the Web for Supervisors Templates
and Overlays views when there are a large number of prechecked items in the Activities tree.

• In the latest Web for Supervisors Forecast UI, the Activities tree now lists all sites and activities.
• To improve performance in WFM Web for Supervisors Schedule > Intra-Day view, the Performance

Graph is based on the targeted multi-site activity (MSA), which is a single MSA selected in the
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Activities tree.
• In the latest Web for Supervisors Forecast UI, when supervisors create forecast scenarios and select or

deselect multi-site activities (MSA) in the tree, WFM now selects/deselects the associated child
activities automatically.

• In latest Web for Supervisors Forecast > Scenarios view, new comments now display with the correct
date.

• In the latest Web for Supervisors Forecast UI, when users create forecast scenarios using the Create
based on setting, activities that were checked in the original scenario in the Activities tree are now
checked automatically for the new scenario, as expected.

• In latest Web for Supervisors Forecast > Scenarios view, WFM now correctly displays comments for
the selected week, based on the business unit week start day.

• Activities that are added to scenarios in the Web for Supervisors Classic Forecast UI now display in the
latest Forecast UI after users switch from one UI to the other.

• In the latest Web for Supervisors Forecast > Scenarios and Master Forecast > Overlays and >
Templates views, when a session times out, the message You have been logged out. Log in to
resume the session now displays with the correct link.

• When setting the properties for Overlay Events, users can now enter negative values in the Strength
setting in the latest Web for Supervisors Forecast UI.

• In the latest Web for Supervisors Forecast UI, Activity trees are now collapsed by default, and only
expand when users click business units or sites in the tree.

• In the latest WFM Web for Supervisors Forecast > Scenarios > Remove activity dialog, all activities
now display in the Activities tree if the number of activities in the scenario is greater than 100.

• In the latest WFM Web for Supervisors Forecast > Scenarios > Add activity dialog, all activities now
display in the Activities tree if the number of activities is greater than 100.

• In the latest WFM Web for Supervisors Forecast > New Template and New Overlay dialogs, all
activities now display in the Activities tree if the number of activities within a site is greater than 100.

• In the latest WFM Web for Supervisors Forecast > Overlays view, users can now scroll in the selected
Overlay's Impacted activities tab if the number of activities is greater than 100.

• In the latest Web for Supervisors Forecast dialogs, all sites now display in the Activities tree if the
number of sites is greater than 100.

• The Dark mode theme setting now works correctly in both the Web for Supervisors (Classic). To restore
this functionality, reset the Dark mode theme.

• WFM Web now correctly displays the value in the Number of hours earned field after creating or
updating time-off rules and no longer rounds off the value after saving.

• WFM now shows the overstaffing and understaffing data for Calculated and Required staffing, even
when the Use Multi-Site Activities option is selected in the Schedule Coverage view.

• Users no longer receive Review Batch Request messages when granting multiple Preferred time-off
requests from multiple agents, on multiple days.

• In the latest Web for Supervisors Forecast > Master Forecast > Volumes, > Staffing, or >
Shrinkage views, users are now correctly prompted to log in again when a session times out.

• WFM now correctly shows Preferred time-off requests as Granted in the published schedule if auto
publishing is enabled and the agent edits the request.

• When autogranting time off, WFM now uses standard hours in Contracts to determine the paid hours in
special cases.
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• WFM now correctly determines the start/end times for full-day time-off items during the Time-Off
Bidding process in certain configurations when they were set in Rotating Patterns.

• WFM login sessions no longer fail in load-balanced environments with large loads. Previously, login
sessions sometimes failed in these environments, requiring a server restart to clear the failed login
message.

• WFM's Master Schedule Change Approval process now reliably approves selected schedule changes
only.

• WFM Server no longer terminates intermittently when performing user authentication.

Web for Agents

• The Dark mode theme setting now works correctly in the Web for Agents (Classic). To restore this
functionality, reset the Dark mode theme.

• Changing the time zone in Web for Agents (Classic) now affects only the logged-in agent who makes the
change.

February 28, 2020 (8.5.216.06)

What's New
Improved readability in JAWS screen readers

• To improve readability when using JAWS screen readers, the WFM Web Application controls, page layout,
and other interface elements now have improved display and accessibility.

Access token is refreshed

• WFM Web now refreshes the access token so it no longer expires after one hour, causing unexpected
errors to occur in various places in the application.

Same site Cookies defined

• WFM Web's SameSite Cookies property is now set to Strict to ensure that cookies are used only for
same site purposes, preventing the Google Chrome browser v80+ default behavior from changing and
stopping the delivery of cookies.

WFM Integration with Genesys Cloud API

• WFM supports integration with Genesys Cloud API for Forecasting using the Genesys Cloud upload
service, which supports payloads greater than 3 MB.

Validation of the Overtime Offers

• WFM now performs validation on the length of Overtime Offers, and no longer saves offers that exceed
6 weeks.
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Resolved Issues

Web for Supervisors

• All available activities now display in the Activities tree in the New Scenario dialog in the latest WFM
Forecast module when the number of activities is greater than 100.

• WFM Web now correctly publishes multiple Calendar items to the Master Schedule without displayed
errors, even if they contain warning messages.

• WFM Web now displays the correct error message when users attempt to log in using invalid
credentials.

• All activities now display in the Activities tree in the latest WFM Web for Supervisors Forecast >
Scenarios > Add activity and Remove activity dialogs when the number of activities in the scenario
is greater than 100.

• All activities now display in the Activities tree in the latest WFM Web for Supervisors Forecast > New
Template and New Overlay dialogs when the number of activities within a site is greater than 100.

• All sites now display in the Activities tree in the latest WFM Web for Supervisors Forecast dialogs
when the number of sites is greater than 100.

• WFM now processes all Time-Off bidding periods, regardless of the site with which they are associated.
• Issues are resolved that sometimes caused WFM Forecast coverage to be less than expected when the

UME algorithm was used and the forecast included historical events.

Web for Agents

• In WFM Web for Agents Other Schedules view, the first week day displayed in the schedule details
correctly matches the week start day that was selected in the Calendar.

• WFM now consistently saves agent information that has been modified.

January 8, 2020 (8.5.215.07)

What's New
JSP files in Tomcat Secured

• Following best practices and to improve security, JSP files in the WFM Web Application are now stored
inside Tomcat's /WEB-INF directory, thus preventing users from browsing directly to these files.

Time-scale bar in Web for Agents

• A time-scale bar with 1-hour segments (above the Time-Off Limits bar) is now available to agents
when adding and editing time-off requests in the WFM Agent Time-Off > Calendar view. Agents can
also click anywhere in the Time-Off Limits bar to see the Period, Time-Off Limit and Wait-List details
for that interval.

Start/End times in Web for Agents Calendar
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• Agents now see the start and end times for calendar or scheduled items by using the new Show start/
end times setting in the WFM Agent Preferences > Calendar view and Schedule > Other
Schedules view. Agents can optionally change the settings to see the name of the calendar or
scheduled items (such as Availability, Vacation, etc.) by clearing the Show start/end times check box
in the Settings dialog.

Schedule details in Agent UI tooltip

• The Agent UI enables agents to see schedule items details displayed in a new tooltip by hovering the
cursor over truncated schedule items in the Schedule > Other Schedules view.

Agent (Classic) UI deprecated

• The WFM Web for Agents (Classic) UI is deprecated and will be unavailable in future releases. Genesys
recommends that you change the configuration to display the current Agent UI instead of the Agent
(Classic) UI. Contact your Professional Services Representative for assistance.

WFM Graph Reports not supported with OpenJDK

• WFM graph reports are no longer supported with OpenJDK.

Resolved Issues

Web for Supervisors

• The Performance > Intra-Day view now displays empty cells if WFM returns non-integer values.
• In the latest WFM Supervisors UI, WFM now renders the week start day in the date range calendar,

based on the browser's locale setting.
• Supervisors attempting to access the WFM subsystem, are now redirected to the Login page if they do

not have access permission.

September 30, 2019 (8.5.214.20)

What's New
Redesigned Forecast module

• WFM Web for Supervisors now includes a redesigned Forecast module, enabling access to existing
forecasting functionality and features, but with many user-friendly enhancements, wizards, and tools.
Web for Supervisors (Classic) Forecast module is still supported and available. The Forecast module is
currently available only in English.

• The Forecast module can include a setting that lets Supervisors switch between the Classic Forecast UI
and the re-designed UI. The Forecast UI must be configured to include the setting. If the New UI setting
is not included in your WFM Web for Supervisors Forecast module, contact your Genesys Customer Care
representative to request the feature.
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• AI-powered forecasting is introduced in the redesigned Forecast module, providing a sophisticated,
automated build method that uses the best of the best forecasting algorithms provided through the
Genesys hosted-cloud infrastructure.

• The Workforce Management Supervisor Help is a context-sensitive Help that describes the redesigned
Forecast interface. The Workforce Management Supervisors (Classic) Help is still available.

• The Overlays view in the redesigned WFM Web Forecast interface is enhanced, enabling supervisors to
adjust Spread over distribution to 15 or 30 minutes (in addition to 60).

Log In splash screen

• The WFM Web Log In splash screen is updated, displaying the latest Genesys branding and logos.

WFM Web UI Launcher

• The WFM Web UI Launcher application can be downloaded from within WFM Web for Supervisors and
after deployment, used as the default application to open .wfm files in the same session. For
instructions on how to deploy the UI Launcher, see the Workforce Management Web for Supervisors
(Classic) Help.

OpenJDK support

• WFM Web now supports OpenJDK 11.

WFM Web for Agents interface options

• The WFM Web for Agents interface can be configured so that only the Agent interface or only the Classic
Agent interface appears, with no option to switch, or it can be configured so that the Agent interface
appears but with an option in the Log off drop-down menu that enables agents to switch to the Classic
Agent interface. To request a change in how your WFM Web for Agents interface displays for users, talk
to your Genesys Customer Care representative.

Enhancements to Payback Exceptions feature

• Agents can now use their desktop or mobile devices to insert Payback without adding an Exception.
Your system must be configured for this functionality. Contact your Genesys Customer Care
representative to request this feature.

Editable fields in Skills tab

• The values in the Min. level and Max. level fields in the Web for Supervisors Activity > Skills tab can
now be edited at any time.

Supported browsers

• Google Chrome 73.0 or later
• Mozilla FireFox 60.5 or later

Discontinued support

• Java 7 is no longer supported.
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Resolved Issues

Web for Supervisors

• WFM Web now calculates the duration of full-day Time-Off items and Exceptions as follows:
• The duration of paid, full-day Time-Off items and Exceptions is equal to Paid Time.
• The duration of unpaid, full-day Time-Off items and Exceptions is equal to Standard Daily Paid Hours

from the agent's contract.

If Start Time and End Time values are specified for Time-Off items and Exceptions, the
duration is estimated as the difference between those values.
In Genesys Administrator, if the Reports > TotalsInStatesReport property is set to true, WFM
uses the daily totals for calculations.

• The size of the [X] Weeks text field has been increased to 55 pixels in the Performance Report >
Date Range settings.

• The values in WFM Web's Time-Off Balance and Time-Off Management reports are now the same.
Starting in 8.5.212.21, the balances differed by 1 minute due to the way in which WFM Web rounded off
seconds in time-off balances .

• WFM Web now excludes duplicate information about selected activities from the Contact Center
Performance report.

• WFM Web for Supervisors Schedule > Intra-Day and Schedule > Agent-Extended views now show
all scheduled items in the correct colors.

• Exceptions and Time Off items that are ineligible for schedule trades now display in their default color
and do not appear as separate items in the Legend in the Other Schedules view.

• Users can now activate the "Skip to main content" link by pressing the Enter key in JAWS. Users who
are not using JAWS can activate this link by pressing the Enter key or Space bar.

• WFM now restricts editing of Agent Properties in the Web for Supervisors UI unless users are assigned
the Add/Edit/Delete privilege in Configuration > Organization.

• WFM Web now processes updated Calendar items without errors after validation.
• WFM Web's Java applet signing certificate signature includes a timestamp, meaning the code signature

will not expire after the code signing certificate expires.
• WFM Web has a renewed certificate for signing Java code. The certificate provided in previous WFM

versions expired on June 11, 2019. Continuing to use an older release of WFM after the expiration date
might cause Warnings or Error messages to appear when you use Web for Supervisors Java-based
views.

• The RUN_JAVA_STANDALONE setting in WFM Web for Supervisors About > Settings is now of type
ENUM and can be set to Off (plug-in used) or Java Web Start. Previously this setting was of type
BOOLEAN.
When RUN_JAVA_STANDALONE is set to:
• Off (plug-in used) (default)—The Java-based modules in WFM Web opens in a separate windows

using the Java plug-in, in the browser.
• Java Web Start—WFM displays the following message: The selected view opens as a separate

application. If it does not open automatically, save the file with the .jnlp extension and open it
separately. The .jnlp file is then generated automatically and the Java-based modules in WFM Web
open in a separate window.

• The list of weekday names now appears in the correct language in the Forecast > Volumes view,
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according to the configured locale.
• WFM Web for Supervisors Java Plug-In now uses Arial Unicode MS font when translated into Chinese and

running on Windows 10 version 1803 or higher.

Web for Agents

• Buttons and check boxes in WFM Web for Agents are now labelled to support JAWS accessibility
standards.

• WFM now trims the seconds from time-off balances before displaying them in Web for Agents. For
example, 5:59:47 now displays as 5:59 in the agent's Time-Off Balance pane.

• To provide clarity in WFM Web for Agents, the word "Slots" was changed to "Bids" in the list of
Overtime Offers and in the Details pane to the right of this view. Also, the label Shift used for
overtime in the drop-down list was changed to Add overtime to this shift.

November 2, 2018 (8.5.211.06)

What's New
Minimum Consecutive Working Days

• The new setting Minimum consecutive working days, in the WFM Web for Supervisors Contracts >
Constraints tab, enables supervisors to set the minimum number of consecutive working days an
agent must be scheduled before any scheduled day off.

Platform Support

• Support for Java 10. Starting with Java 9, browsers no longer support Java plug-ins. WFM provides a
workaround to enable Java Webstart to start as a standalone application that contains Web for
Supervisor Java-based views. To enable this feature, speak to your Genesys Customer Care
representative.

• Support for the Microsoft Hyper-V virtual platform.
• Support for Microsoft Windows Server 2016.

Overtime Bidding

• Enables WFM to schedule agents' overtime bids (associated with Overtime Offers) within the existing
overtime scheduling process. Supervisors with the appropriate role privileges can create Overtime
Offers in the new Overtime Bidding view and initiate the automated overtime scheduling process.
Agents can then bid on overtime slots in Overtime Offers in the Bidding > Overtime view after the
supervisor marks the offer as "Open".

Agent Mobile Client

• The Workforce Management Agent Mobile Client now includes the My Schedule, Trading, Time Off,
Preferences, and My Settings modules and views, enabling agents to perform the several tasks on
their mobile devices.
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Presentation Properties in My Schedule

• In WFM Web, agents can now narrow the range of hours in the My Schedule view to display only the
hours in their contract. Agents enable this feature by opening the Settings dialog box and checking
the Presentation Properties > Use contract hours check box.

Multi-Site Trading

• WFM Web now supports multi-site trading. Agents use the the new Trading > Trades view in the Agent
UI to trade schedules with other agents located at different sites when Activities within the schedule
are configured as Multi-Site Activities.
The following views in the WFM Web for Agents UI are enhanced to support multi-site
trading

• Schedule > Other Schedules
• Schedule > My Schedule > Create Trade Proposals
• Schedule > My Schedule Details > Create Trade Proposals

• Warning messages in Web for Supervisors Trading > List of Trades view are improved to support
multi-site trading. Now supervisors see:
• Appropriate warning messages when approving trades that involve agents from two different teams

when they only have access rights to one of those teams.
• Warning messages for each non-compliant agent involved in the trade.

Enhancements to Time-Off Bidding

• WFM now shows the bidding period status as Processed in the WFM Agent interface Time-Off Bidding
Periods view and on the Status tab in Web for Supervisors Configuration > Time-Off Bidding
Periods view when the agent's time-off requests have been processed.

• Available agents in WFM Web can now be associated with a bidding period when filtered by Multi-Site
Activity.

• WFM Web's Time-Off Bidding Period property Processing Finish Date and Time has been renamed
Closing Date and Time.

• Supervisors can (optionally) configure WFM to allow agents to submit only full-day time-off requests for
a specific bidding period.

• Supervisors can now see the selected agents' time-off details in Web for Supervisors Configuration >
Time-Off Bidding Periods > Status view.

Agent Mobile Client Preview

• WFM introduced a preview version of the WFM Mobile Client for Agents that includes functionality in the
Schedule, Time off and Preferences views, similar to the WFM Web for Agents desktop UI. The
Mobile Client is supported on:
• Android devices running the latest version of the Google Chrome browser.
• iOS devices running the latest Apple iOS platform update and built-in Safari browser.

Exceptions with Payback

• Exceptions with Payback enable supervisors and agents to insert unpaid part-day Exceptions into
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schedules to indicate missed work time, and insert work intervals into schedules to pay back or recoup
it. WFM automatically optimizes these agents' schedules. The inserted work, which is indicated by
Marked Time of type Payback, provides metrics for the Schedule Marked Time Report and Schedule
Marked Time Totals Report.

Ability to Rollback Exceptions

• Rollback Exceptions enable agents to roll back to a committed schedule after successfully entering
Exceptions.

Role-based Access to Web for Agents

• Role-based access to WFM Web for Agents enables administrators to determine which agents have
access to certain features and functionality in WFM Web for Agents. Using Genesys Administrator, they
can add agents to Access Groups that are assigned to appropriate WFM roles, or assign individual
agents directly to roles. To enable this feature, contact your Professional Services representative.

Non-Tradable Items in Other Schedules

• Agents can use a new setting in the WFM Agents Other Schedules view to see which schedules are
non-tradable. After enabling this setting by selecting the Indicate non-tradable items check box,
schedules that cannot be traded are displayed with a gray background.

Hide Non-Tradable Exceptions and Time-Off

• Administrators can now replace the actual names of non-tradable Exceptions and Time-Off items with
generic names in the Web for Agents' Other Schedules view, enabling them to hide sensitive
information, if required. To enable this feature, contact your Professional Services representative.

Improved Report Generation

• WFM has improved generation of the Agent Adherence Report when it contains millions of records.
(WFM-27127)

New WFM Agent Interface

• A new WFM Agent user interface is introduced in this release.

New WFM Agent Help

• The Workforce Management Agent Help is introduced in this release, which describes the new Agent
user interface and explains how to use it. The previous version of the Help is renamed Workforce
Management Web for Agents (Classic) Help

Added Features in New Agent Interface

• In the Schedules view, agents can now print their schedules for 1-6 weeks or for the Planning Period.
• In the Time Off view, agents can now choose the month from which to present data to more easily view

and request time off in the view, rather than navigating between calendar year periods.
• The Schedule > Other Schedules view now:

• Displays Activities details, such as start and end times.
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• Clearly identifies full-day Time-Off items by name and with a colored bar above the name.
• Displays Activity Sets in their configured colors, enabling agents to see who is working on which

Activity Set.
• Agents can now search on agents' names.

New Marked Time Type Preserved

• WFM now preserves Marked Time of type Overtime and Payback during Intra-Day schedule
reoptimization. The Marked Time of type Payback is new in this release.

New Column in Agent Extended Views

• The Web for Supervisors Master Schedule > Agent Extended and Scenario > Agent Extended
views now include a Weekday column, that shows the name of the weekday.

Ability to choose Scheduling Mode

• The Scheduling mode in WFM Web is now set in Policies > Contracts > Constraints, enabling both
Task Sequences and Activity Sets to be scheduled for a site simultaneously in one Schedule Scenario.

New Schedule Scenario Wizard

• In WFM Web's New Schedule Scenario wizard, when Schedule Scenarios are based on Forecast
Scenarios, all Activities from the Forecast Scenario are selected, by default.

Improved Visibility for Auto-commit Indicator

• In the WFM Web for Supervisors Schedule > Master Schedule > Intra-Day view, the Auto-commit
icon now clearly indicates when the auto-commit action is enabled and disabled, by displaying brightly
when enabled (on) and dimly when disabled (off).

Specify Colors for Business Units Separately

• WFM Web for Supervisors Configuration > Colors view now enables supervisors to specify distinct
default colors for each Business Unit.

Enhancements to Time-Off Bidding

• A new implementation of the Time-Off Bidding feature includes the following improvements and
enhancements:
• A new bidding process flow, in which time-off requests for a bidding period are processed multiple

times, allowing agents to make changes to comply with time-off limits and bidding period
constraints.

• The option for supervisors to create and configure multiple Bidding Period objects for the same
time-off request interval.

• New properties in the Bidding Period object, enabling better control and assignment of agent
time-off requests, such as:
• The First come, first served property now uses the time that the agent last changed his/her

status to Ready as the sorting criteria to ensure a uniform sort order in the bid assignment
process.
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• The Maximum number of <weeks, days, hours> that can be requested properties restrict
the number of weeks, days, and hours that an agent can request within a bidding period.

• The new Minimum Consecutive Days property, which replaces Minimum Days.
• The Do not process property enables supervisors to suspend or resume the bid assignment

process.
• The Allowed Agent Timeout property enables supervisors to set a timeout interval to allow

agents to change their time-out requests to conform with time-off limits and bidding period
constraints.

• New agent bidding statuses, enabling supervisors to manage the flow of the bidding process in Web
for Supervisors, and agents to manage their status when bidding for time off in Web for Agents.

• A new constraint requires agents to submit time-off requests, in which all items in the request are
either within or outside of the bidding period time-off interval. Agents must enter time-off requests
that cross the bidding period boundaries as multiple separate requests.

• WFM now counts only Granted and Scheduled time off when presenting values in the Time-Off
Limits view in Web for Agents. Agents will see these values when requesting time-off within an open
bidding period.

• A new Notification of Time-Off Bidding Changes is sent to supervisors and agents when time-off
requests cannot be granted, or when the agent is skipped after the configurable timeout interval
has expired.

• This feature supports migration of earlier 8.5.x releases.

Java Plug-In for Browsers

• WFM Web now allow supervisors to use Java-based views in browsers that do not support the Java plug-
in.
The RUN_JAVA_STANDALONE setting in Web for Supervisors About > Settings... view enables
users to run Java views from browsers that do not support Java Plug-Ins. If this setting is
checked, WFM generates a file, downloads it, and automatically launches the applet.
However, you might have to save the file to your hard drive and start it, as you would any
other application. It then starts as a standalone Java Webstart application, containing Java-
based supervisor views. There are limitations when using the Java plug-in. To enable this
feature, contact your Professional Services representative.

Added Windows Server Support

• Added Microsoft Windows Server 2016 support.
• Added Microsoft Windows 10 support for the WFM web-based application only (Supervisors and Agents).

Detection of Proxy Settings in Browsers

• WFM Web now detects the browser's proxy settings when running Java applet-based views in Web for
Supervisors, preventing issues that could arise (applet-based views could stop working) if the proxy
was configured in the browser for network connections.

Sorting and Filtering in Schedules

• In WFM Web for Supervisors Schedule > Intra-Day and Schedule > Weekly views:
• Filtering by Shift Name is now enabled.
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• Sorting by the Shift End Time is now enabled.

Prevention of Deserialization Vulnerabilities

• WFM Web now prevents the class of vulnerabilities related to Java deserialization. This update prevents
not only the specific case described on the web page (linked below), but any other yet unknown cases
by explicitly restricting deserialization only to specific known classes. For more information about this
vulnerability, see foxglovesecurity.com.

Protection Against Clickjacking

• WFM enables enforcement of protective measures against clickjacking. Clickjacking, also known as "UI
redress attack" is a malicious technique that tricks a Web user into clicking on a button or link on
another page when they intended to click on the the top level page, thereby hijacking clicks and
routing them to another page, most likely owned by another application, domain, or both.

Protection Against Session Fixation

• A new WFM security feature prevents vulnerability of Session Fixation by changing the session identifier
after a user logs in and logs out.

New Time Zone Setting

• A new Time Zone setting named Local is now available in the Calendar Items view. Selecting this
setting displays calendar items in each site's time zone for the selected days. Calendar items from
different sites are not directly comparable when this setting is selected.
In addition, selecting this setting enables you to publish calendar items to schedules
without having to switch to the specific time zone (as described in WFM-25117), even if the
items displayed are from different sites with different time zones.

Exception Memos

• When adding Exceptions in Web for Supervisors Schedule views, supervisors can now add exception
memos (or comments) consisting of up to 256 characters to the following:
• Intra-Day Schedule view
• Agent-Extended Schedule view
• Individual Schedule report
• Team Schedule report

Supervisors with privileges to access these views can also edit exception memos.

Meeting Name Displayed in Schedules

• When Meeting Exceptions are scheduled in Web for Supervisors Schedules views, the meeting name
is now shown next to the Meeting Exception name. For example, exception_name, meeting_name
(exception_memo) will be shown in the Intra-Day and Agent-Extended schedules.

Exception Memos in Agent UI

• Agents can now enter Exception memos in the WFM Web for AgentsMy Schedule view and then see
them (read only) in the Schedule Details views, and printed schedules.
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Comment Field Renamed

• The Comment field in Exception properties is renamed Memo. In the following views and reports,
where there are lists, grids, or reports with columns used not only for memo, but also for comments
about other Calendar item types, the name is changed to Comment/Memo:
• In Web for Agents Preferences view
• In Web for Supervisors:

• Calendar > Calendar Items view
• Reports > Calendar Items report and report wizard
• Reports > Calendar Audit report and report wizard

Improved Presentation of Performance Data

• In Web for Supervisors Schedule > Intra-Day, the presentation of performance data is improved and
now displays strings with empty values as empty (rather than zero).

Added Virtual Platform Support

• Support for virtual platform ESXi 5.5.

Added Browser Support

• Support for Firefox ESR 38.

Resolved Issues

This is the first WFM 8.5.2 release in Genesys Engage cloud. There are no resolved issues.

August 09, 2016 (8.5.101.29)

What's New
Improved Response Time

• WFM's response time is improved when inserting Time-Off items.

Resolved Issues

Web for Supervisors

• The Calendar Items view in Web for Supervisors now shows week day names correctly if the time zone
is changed when using English\New Zealand or English\Australian regional settings.

• WFM Web no longer displays the message An unexpected issue occurred while processing this request
when users logs out after a new window is opened and then closed.
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• The WFM Web for Supervisors interface no longer freezes when several windows are open and users are
working/performing actions in these windows.

• WFM Web's Schedule > Intra-Day view now consistently refreshes Performance data when switching
between dates.

• In specific scenarios, WFM no longer allows agents to request time off when they have insufficient Time-
Off balances, as it could result in negative Time-Off balances.

July 8, 2016 (8.5.101.27)

What's New
Improved Forecast Import Functionality

• WFM Web for Supervisors Forecast Import functionality is improved and now enables partial-day data to
be imported successfully.

Resolved Issues

Web for Supervisors

• WFM Web for Supervisors Schedule > Intra-Day view now consistently refreshes Performance data when
switching between dates, and correctly displays matching data in the Schedule.

• WFM Web for Supervisors Home screen now displays the correct background colors when applying the
High Contrast theme, improving usability.

• Supervisors can now enter locale decimal numbers into the Wage field in the Web for Supervisors'
Configuration > Agents view and save the data.

• WFM Web for Supervisors now displays the correct message when the size of the imported file exceeds
the configured limit in the Forecast > Import view and the Import progress bar now shows accurate
progression.

• WFM Web for Supervisors Forecast Import functionality now provides improved handling of data
containing gaps or days that should be ignored, and no longer causes errors.

• WFM Web for Supervisors Forecast > Import wizard has a new field, enabling optional specification of
the character set if a character set must be specified in special cases and used to save imported data
files.

• WFM Web for Supervisors Statistics pane in the Organization > Activities view now opens faster in
browsers when the Genesys Configuration database contains thousands of objects.

• After changing and saving Role Privileges in WFM Web for Supervisors Configuration > Roles view, you
can select No or Cancel with no error messages displaying.

• WFM now displays information in the Web for Supervisors Master Schedule > Changes Approval view
without empty lines being added to tables or error dialogs displaying.

• WFM now correctly displays shifts in schedules in WFM Web for Supervisors Master Schedule > Intra-
Day view after opening the Schedule History dialog and clicking Cancel.
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• WFM Web for Supervisors now correctly copies Shifts to the same site and the references to the
associated Task Sequences are copied when the Task Sequences must always be used option is
specified.

• When separate WFM Web for Supervisors instances are configured to generate reports, supervisors can
now continue working in WFM Reports without having to log in again.

• WFM now accurately detects total Distribution Value percentages in Web for Supervisors when it adds
up to 100 percent and no longer produces an error message.

Known Issues

• In WFM Web for Supervisors Classic UI, Schedule State Groups (SSG) are incorrectly displayed in the
site's time zone when a child activity (within a multi-site activity) is selected in the Forecast >
Shrinkage view.

• When using FireFox ESR browser on Windows, if a Help topic is opened from any dialog within WFM Web
for Supervisors interface, the topic appears with the dialog window on top of it and you cannot scroll
the page until the dialog window is closed. When using Internet Explorer, the dialog overlaps the Help
topic, but you can scroll the page without closing the dialog.
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